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Overview 
The System Administrator Guide defines the overall principles for installation and operation of a 
Maconomy installation. This guide is updated as new features are added or removed, but some 
functionality or details may be documented in separate guides. 

How This Document is Organized 
This document is organized so that you can go quickly to the section you need. Use CTRL+F to easily 
find the term you’re searching for, or see the table below to find the section to help you. 

Section Description Purpose of This Section 

Understanding Your System A detailed description of all the 
major components of your 
Maconomy system, and how 
upgrades and installations work, 
as well as hardware 
requirements. Also discusses 
security considerations for your 
Maconomy system.  

 Introduction and high-level 
details and concepts 

 Description of Maconomy, 
typical setup and 
components, such as 
installation server, and so 
forth 

 Helps to acquaint you with 
terminology and processes 
used in Maconomy 

 Orients new users to the 
system and its components 

Installation and System 
Configuration 

Provides setup and 
configurations for your system, 
including servers, passwords, 
access control, and fonts. Also 
provides setup within 
Maconomy, including User 
Masking and Scheduled 
Background Tasks. 

 Initial setup and configuration 

 Provides experienced users 
with process and steps 

 One-time or infrequent use 

System Maintenance and 
Regular Use 

Includes details for performing 
overall maintenance on your 
Maconomy system, including 
database surveillance and 
regular routines. Also includes 
steps for regular use, including 
using data import packages and 
the MDoc Data Dictionary. 

 Common procedures and 
check lists for regular system 
use 

 Details routine system admin 
duties, such as running 
regular maintenance, and 
importing system data 

Extend Your System Details all the ways you can 
extend your Maconomy system 
through different integrations, 
Maconomy Extender, and 
localization. 

 Instructions for integrations 

 Procedures that go beyond 
the usual setup, such as 
localization steps 
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Section Description Purpose of This Section 

Troubleshooting Includes troubleshooting as well 
as frequently asked questions 
for key areas of Maconomy 
including Maconomy Server and 
Scheduled Background Tasks. 

 Provides a repository for 
common questions and errors 
with likely solutions 

COMMANDS Contains command line section 
with all Maconomy commands 
and options. 

 Provide commands for all 
tools used outside of 
development 

Audience 
The intended audience for this guide is: 

 Maconomy System Administrators 

 Database Administrators 

 Technical Consultants 

 Maconomy and Maconomy partners and customers 

In addition, this guide may be beneficial for users who want to understand the components of Maconomy 
in more detail. 

The first few sections are written as informative sections, whereas the remaining sections are expected to 
be used as a reference manual when specific actions are to be performed. 

Revision History / What’s New 
The table below shows a quick reference of recent changes.  

Update  Version Description 

Talent Management 2.6.5 Migrated concepts, steps, and field description 
information from the Concepts Guide. 

Ask Dela 2.6.4 Added a section for configuring Ask Dela. 

Configure Maconomy (Single 
Sign-On with OneLogin) 

Configure Maconomy (Single 
Sign-On with Okta) 

Configure Maconomy (Generic 
Support for Third-Party SSO 
Vendors Using OAuth 2.0 OIDC) 

2.6.4 Updated several sections to reflect changes in 
MConfig related to the specification of the default 
redirect URL during SSO setup.  

Background Task Administrator 
User 

2.6.4 Added a section for background task administrator 
user.  
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Update  Version Description 

Creating the Maconomy OS 
User 

2.6.3 Added section to include information on how 
usernames are handled when creating a new node. 

E-invoicing with Pagero 2.6.3 Updated setup instructions for e-invoicing integration 
with Pagero. 

Coupling Service Installation 
and Configuration 

2.6.3 Updated section to include new parameter in 
server.ini for client configuration. 

Maconomy Client Bandwidth 2.6.3 Updated section to include bandwidth updates. 

Handling Login Attempts with 
Incorrect Password 

2.6.3 Added section to detail handling login attempts with 
incorrect password.  

Running an Index Script 2.6.3  Updated instructions and examples for running index 
scripts. 

Blocked and Expired Accounts 2.6.3 Updated section to include User Blocked checkbox. 

Single Sign-On with OneLogin 2.6.2 Updated procedures to accommodate setup changes 
related to the use of an external browser for OAuth 
Login. 

Single Sign-On with Okta 2.6.2 Updated procedures to accommodate setup changes 
related to the use of an external browser for OAuth 
Login. 

Generic Support for Third-Party 
SSO Vendors Using OAuth 2.0 
OIDC 

2.6.2 Updated procedures to accommodate setup changes 
related to the use of an external browser for OAuth 
Login. 

Coupling Service Configuration 2.6.1 Updates throughout the document to support the 
restructuring of the Coupling Service and a new 
section on Coupling Service Configuration. 

Excel Data File Support 2.6.1 Added section to detail support of Excel in Data 
Import Packages and Standard Import Packages. 

Single Sign-On 2.6 
updated 

Added section for blocked user accounts. 

Translations 2.6 
updated 

Made a few edits and clarifications in the section. 

Default Filetypes 2.6 Added new section to list default filetypes in the 
settings.ini that users are allowed to upload. 

Running an Index Script 2.6  Adding instructions and examples for running index 
scripts. 
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Update  Version Description 

Export to Excel Row Summary 2.6 Added Export to Excel Row Summary. 

Native Application 
Authentication 

2.6 Added new section describing the use of OAuth 2.0 
Bearer tokens in relation to Azure Native Application 
authentication. 

OAuth 2.0 Bearer Tokens 2.6 Added new section with a generic description of the 
use cases for OAuth 2.0 Bearer tokens. 

Enabling and Disabling SSL 2.6 Removed this section and other outdated instructions 

Web Client debranding 2.6 Removed specific references to iAccess, which is now 
referred to as Maconomy’s web client. 

Removed outdated / 
desupported references 

2.6  Removed Deltek Collaboration / Kona section. 
Removed Portal references 

 Removed old Kerberos login configuration, 
identified as Kerberos SSO 

Analyzer 2.6 Added a section for the new Web Analyzer, with link 
to information on legacy implementation in the 
Workspace Client. 

Increase Allowed Number of 
Named Users 

2.6 Added instructions for customers who need to 
increase their allowed number of licensed Maconomy 
users. 

Data Import Packages 
Procedures 

2.5.4 
updated 

Updated and added new procedures to the Data 
Imports Packages section. 

Automated Hotfix (CU) 
Installation 

2.5.4 Added new Automated Hotfix (CU) Installation 
instructions (and removed the outdated instructions). 

Printing Right-to-Left Languages 2.5.3 Added Printing Right-to-Left Languages conceptual 
information and setup instructions. 

Okta Support 2.5.3 Added new Single Sign-On with OneLogin support 
information and procedures. 

OneLogin  2.5.3 Updated OneLogin OIDC Metadata URL. 

Option Lists 2.5.3 Added description of Option Lists and Selected 
Values for Data Import Packages. 

2FA Enrollment and 
Reconfiguration 

2.5.3 Added Two-Factor (2FA) enrollment and 
reconfiguration setup steps. 

REST API Container Web 
Access Rules 

2.5.2 
update 

Added REST API Container Web Access Rules, with 
cross-reference to Deltek Maconomy Web Services 
Programmer’s Guide. 
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Update  Version Description 

Integrate with Web Client 2.5.2 Added instructions to integrate People Planner with 
the web client. 

Removed Background Task 
information 

2.5.2 We have created a standalone Deltek Maconomy 
Background Task Guide, for ease of use.  

Security Service File Check  2.5.2  Updated File Check instructions (Simple Magic is no 
longer supported). 

E-Invoicing with Pagero 2.5.2 Added setup instructions for e-invoicing integration 
with Pagero as well as some procedures for 
addressing common errors. 

Restructured document and 
streamlined content 

2.5.1 Restructured document for ease of use and logical 
flow so that you can read background information if 
needed, or skip right to setup information or 
procedures. Additionally, removed outdated material. 

See How This Document is Organized for details.  

Scheduled Background Tasks 2.5.1 Added information on Extended Test Beds, Chained 
Background Tasks, and other updates. 

Two-Factor Authentication (2FA) 2.5.1 Added a warning for an iAccess limitation. 

Font Administration and 
Installation 

2.5 Updated to add support for multiple fonts, setting 
default fonts, and a last resort font. 

Displaying System Information 
on Clients 

2.5 Renamed the Menu Dock section, and added 
iAccess-specific instructions. 

Fonts in MPL2  2.5 Added MPL2 font information. 

OneLogin 2.4.5 Added new Single Sign-On with OneLogin support 
information and procedures. 

Data Import Packages 2.4.5 Added new Data Import Package information and 
procedures. 

Long Text Support 2.4.4 Added section on the Long Text functionality. 

Two-Factor Authentication (2FA) 2.4.4 Updated since iAccess and Touch now support 2FA. 

Updating the Maconomy 
Workspace Client 

2.4.4 Added information on disabling the warning message 
when updating the workspace client. 

Scheduled Background Tasks 2.4.3 Added in Email Reporting and Setup, Coupling 
Service Sliding Panel, Color Coding, and related 
material. 



Overview 

System Admin Guide 6 

 

UNDERSTANDING YOUR SYSTEM 
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System Description 
A Maconomy system is a network-based, multi-tier solution that works in a network-based, distributed 
environment. The following figure shows Maconomy 2.X, including the new services added in 2.X, and it 
shows a typical setup with more Server 2.Xs for redundancy and load sharing. 

 
Deltek has from the initial development of Maconomy focused on following open standards and becoming 
independent from hardware and system software components. Each Maconomy version is certified on 
more hardware and software platforms.  

 
The Maconomy solution is a standard solution that is highly configurable to deliver exactly the 
functionality that is requested by the customer. The Maconomy solution can be used as both enterprise 
solutions and as cloud-based offerings. Deltek offers a cloud-based solution based on Maconomy called 
Deltek First Maconomy Essential (DFME). 

Maconomy solutions are very often integrated with other Deltek offerings, such as Deltek Touch or Deltek 
People Planner, or integrated with third-party systems, such as data warehouses. Deltek’s Maconomy 
team has incorporated integrations with a set of other Deltek offerings and created standard interfaces for 
building integrations with third-party products. 

The physical layout of servers and infrastructure is very customer-specific, starting with everything on one 
server, to scaling out to multiple servers, one for each Maconomy component, or even several equal 
servers to handle load sharing (only possible for some parts of Maconomy). This guide describes how to 
set up and configure Maconomy. 

Attention: For details, see the release notes for the specific versions. 
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Standard Maconomy System Naming 
The term Packing Units (PUs) is used by Deltek to describe the packages in which the entire application 
is distributed before installation. 

The architecture of a Maconomy installation roughly consists of a hardware platform with an operating 
system and a database installed. The Maconomy application consists of a platform-dependent 
Technology layer and a platform-independent Application layer. The Technology layer provides 
connectivity to the database and operating system facilities. The Application layer consists of the 
application business logic. 

You install both layers using an installation program called MConfig. In addition to these packing units, 
there is a documentation package, which is also installed using Mconfig.    

The Pus reflect this architecture: 

 TPU: — Technology Packing Unit 

 APU — Application Packing Unit 

 SPU — Solution Packing Unit 

 IPU — Installation Packing Unit 

 DPU — Documentation Packing Unit 

When new features or error corrections are released, they are released as installable PUs. They can be 
installed separately. For example, you can upgrade the Technology layer (TPU) to exploit new server 
features without upgrading the application (APU). You should, however, observe any preconditions or 
special considerations as listed in the release documentation. 

Maconomy Cumulative Updates (CU) Naming 
The format for Cumulative Update (CU) naming is: 

Maconomy <version> CU <nnn> 

For example, the second CU on the 2.2.x stream is now named Maconomy 2.2.x CU 002 

Packing Unit (PU) types have a single naming convention: 

apu.w2000.sp105a or tpu.NTx86.20_0.p105a? 

Legacy PUs are supported without the need for renaming, and MConfig and other tools are able to handle 
both generations of names. 

BPM 
BPM name formats include: 

 RPU Name: rpu.<main version>.<sp>.<cu>.<build number>.<solution>.zip 

Example: rpu.20.sp103.cu008.1234.s-std.zip 

 BIARs: bpm-<product>.<main version>.<sp>.<cu>.<build number>.<solution>.<database>.biar 

 Documentation of universes: Include version tag. \ 

 ETL analysis: bpm-analysis-etl.<main version>.<sp>.<cu>.<build number>.xml 

Example: bpm-analysis-etl.20.sp103.cu0008.1234.xml 

 ETL peopleplanner: peopleplanner-etl.<main version>.<sp>.<cu><build number>..xml 
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Example: peopleplanner-etl.20.sp103.cu008.1234.xml 
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About Maconomy 
Maconomy is a project-based enterprise resource planning (ERP) solution that integrates projects, 
finances, and people/resources. It is a financial management solution that provides financial insight with 
functionality spanning from creating a project to budgeting, evaluating progress to invoicing and project 
closure. 

Maconomy connects front-office project delivery to back-office financial management, allowing for control 
over projects. Its reporting and filtering capabilities provide visibility into past performance, current status, 
and anticipated results. Additionally, it provides global statutory compliance strategy, including a baseline 
audit, statutory-related functionality, and localization packages to meet country-specific regulatory 
requirements. 

Maconomy has three user interfaces/clients:  

 Workspace Client: A robust on-premise solution perfect for complex financial functionality, 
supporting G/L, A/P, and A/R 

 Web Client: A browser-based interface with streamlined access to activities such as time, 
optimized for in-office as well as remote access use 

 Touch: A mobile application for easy access to such features as time submission and approvals 

Clients 
A Maconomy system can be accessed from different User Interfaces or Clients. Customers are advised 
which user interface best suits the needs of their Users based on their different user roles. For example, 
financial and accounting users prefer a client that supports heavy data processing and complex 
workflows, such as the Workspace Client. Front office Users who mainly work remotely at customer 
locations, such as consultants, may prefer the web-based client, or a client optimized for mobile, touch-
screen devices, such as Touch.  

This section provides an overview of the Maconomy clients: 

 Workspace Client 

 Web Client 

 Touch 

 

Workspace Client 
The Workspace Client is Maconomy’s on-premise client with a customizable system consisting of 
modules, organized hierarchically around a: 

 Business entity (such as a customer) 

 Role (such as a project manager) 

 Process (such as financial reporting 

Workspace Client is comprised of two main areas: Modules/workspaces, and Single Dialogs. The 
workspaces are where users spend the majority of time. Single Dialogs are intended for 
consultants/super-users. These dialog boxes are the components on which (most) workspaces are 
based, and super-users may use these components to customize their workspaces.  

Attention: For more information on these clients, refer to the Web Client and Touch documentation. 
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The Workspace Client contains the following features: 

 Workspaces: Workspaces are a grouping of panels, organized hierarchically around a business 
entity (such as a customer), a role (such as a project manager), or a process (such as financial 
reporting). Workspaces are composed of menus, sections, and panels that allow you to interact 
with specific tools. 

 Search and Filters: You can use search and filters to find business entities with which you need 
to work. There are three main search types: 

 Search using filter lists (CTRL+F) 

 Context-specific search (CTRL+G) 

 Manual search 

 Actions: Actions are things that you can do. They are similar to functions. An action could be as 
simple as Print or Delete, or it could be more complicated, such as Print an Invoice. 

Actions are generally represented as buttons that display in the toolbar at the top of a panel. Each 
panel has it is own actions, and an action acts on the business entity (or entities) in that panel. 

 Wizards: Wizards are special windows that help you perform a specific task in Maconomy by 
guiding you through the steps that are necessary to perform the task. 

Wizards are used extensively in Maconomy. They are meant to guide you safely through complex 
tasks, or through common but complicated tasks. When a wizard is used, it is possible to focus 
on important information, and it is possible to make sure that required fields are filled in. 

An example of a commonly-used wizard in Maconomy is the Create Customer wizard. 

 To-Dos: It is possible to set up Maconomy so that users are notified when certain events occur. 
The users are then alerted by a To-Do that displays up in the user's To-Do menu. The To-Dos for 
each user are grouped into predefined categories. When you double-click a To-Do, the relevant 
workspace opens. 

 Menu Search Capability: The Search Capability feature allows you to enter terms into a search 
field and retrieve information for a particular workspace. This feature lets you navigate the 
workspace menu easily and search for a specific workspace (in English or its localized 
equivalent, depending on your language settings). As you type, it provides you with a list of 
suggestions when it cannot find the exact match. You can also carry out a wildcard search when 
you are unsure about the term for which you are looking. 

 Search Favorites: The Search Favorites feature enables you to take any filter restriction and 
custom sorting that you frequently use and save it as a favorite for searching purposes. These 
Search Favorites then function the same way as the predefined searches in the Workspace Client 
to quickly filter information. 

Web Client 
Maconomy’s webclient is designed for streamlined access to Maconomy functionality supporting front 
office users such as time and expense activities, projects, invoicing, approvals, and so on. It is based on 
the same business logic as the workspace client but features a simpler, easy-to-use tab design that 
allows you to click between workspaces. The browser-based application is optimized for in-office as well 
as remote access use. Look-ups provide quick and easy searches for data and favorites. 

Touch 
Touch is a mobile app for inputting time, making quick approvals, and recording or authorizing expenses 
from Android or iOS devices. You can download the app from the Apple App Store or Google Play.  
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Components/Considerations 

Standard Components 
When planning a Maconomy system, it is important to decide what to install and how to scale and 
configure the hardware to meet the solution requirements. There are several components and add-ons 
that may be beneficial for some users. 

A standard installation has a set of technical components: database (SQLserver or Oracle), Maconomy 
legacy server, Maconomy Server 2.X, web server, and one or more client interfaces (Workspace Client, 
web client, Touch) as well as the Maconomy Application package. 

In addition to these standard components, a customer installation may have a solution installed which is a 
preconfigured Maconomy installation supporting specific industries. 

The combination of selected standard components matches a certain percentage of the customer needs, 
and it can be further customized to fully comply with requirements. 

Analyzer 
The Analyzer is a powerful and highly customizable reporting tool available in both the web and 
Workspace clients; although, the implementation is different for each client. 

The Web Analyzer 
Maconomy 2.6 introduced Analyzer reports to the web client. This functionality allows users to make ad 
hoc queries to the database and view the query results in table form. Specifically: 

 The web client now includes workspaces for two reports: a basic and an advanced report 
template for querying job data.  

 Users can utilize these report templates to customize layouts from which they can generate report 
outputs that fit their specific work requirement.  

 At any time, users have the option to view report outputs from reports that they ran previously.; 
They can also export these outputs to an Excel spreadsheet if needed.   

 Users can also export a report layout, allowing others to import this into their application and run it 
themselves. 

 Companies can add new custom reports or existing standard reports to their application. 

Access Rights 

While the Analyzer report workspaces are available by default, they can only be viewed and utilized by 
users with the requisite access rights.  

Existing steps for granting access rights to workspaces apply. In the Workspace Client, add each report 
workspace to a user group to grant the users assigned to that group access to the workspace.  

You also need to add the report workspace to the web client menu. Use the Extender to modify the 
menu.json file on the server.  

Customization 

 

Attention: For information on customization options and related setup, see the Deltek Maconomy 
Web Client Install Guide. 
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The Workspace Client Analyzer 

 
In general, wherever this document refers to the Analyzer, that information applies to legacy 
implementation in the Workspace Client.  

BPM 
BPM is another reporting solution for Maconomy. BPM is installed and configured using Mconfig and 
contains a set of standard reports. The reports can be viewed/printed from Workspace and web clients. 

Each customer may have special reporting requirements that may require special adjustments or 
customized reports. These are developed either by the customer or by consultants. 

Customizations 
Customer systems may be customized to make the system comply with customer-specific or domain-
specific requirements. 

To a large degree, Maconomy can be customized by configuring the system using MConfig or using the 
client interfaces with Administrator rights. 

Some customization may require that special configuration files, layouts, or even software enhancements 
be added to the standard installation. This type of customization is performed using the dedicated 
development environment, Maconomy Extender.  

 

Servers 

Application Server 
The Application Server consists of two parts: 

 Original Maconomy Server (Legacy Server), which has been maintained in versions prior to 2.X. 

 New server components (Server 2.X), which contain newer server components required by the 
Workspace Client, for example, but also components that have been updated or renewed. 

Work is ongoing to renew server parts, and updated parts will to a large degree be moved to the Server 
2.X. The renewals of server parts is scheduled to obtain the goal of increased scalability and increased 
reliability. 

Legacy Server 
The Legacy Server is installed using MConfig. 

The server can be tuned and optimized if required. 

Attention: For information on the Analyzer functionality in the Workspace Client, go to the Analyzer 
section of this document. 

Attention: For more information, see the Maconomy Extender manual. 
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Server 2.X 
The Server 2.X is also installed using MConfig. 

Client Server Interactions 
In this document the following diagrams show the interactions between a client and a server: 
                    Maconomy 

Client            2.X Server 

|                          | 

|  HTTP                    | 

|  GET /resource           | 

|+------------------------>| 

|<------------------------+| 

This diagram displays a setup where the client connects directly to the Maconomy 2.X server (formerly 
known as the Coupling Service) program using the HTTP protocol and receives a response. 

Handshake 
The Workspace Client and Maconomy 2.X have a protocol where the client, as the very first thing when 
connecting to a system, acquires some of its technical configuration from the server before proceeding 
with the interaction. This is a web service called the “server handshake.” 
                    Maconomy 

Client            2.X Server 

|                          | 

|  HTTP                    | 

|  POST /handshake/1        | 

|+------------------------>| 

|<------------------------+| 

|                          | 

|  HTTP                    | 

|  POST /workspaces-rpc     | 

|+------------------------>| 

|<------------------------+| 

The purpose of this mechanism is to allow the configuration of several connection parameters on the 
server and have these options automatically distributed to the client transparently. 

The following are some important parameters that are sent in the handshake: 

 The mode of encryption: SSL encryption by intermediary, or no encryption (not recommended) 

 The mode of compression: custom-made zip block encryption, no compression (not 
recommended) 

Intermediary Proxy 
In some situations, the best practice is to introduce an intermediary proxy between the client and the 
origin server. 
Workspace            Reverse Proxy             Maconomy 

Client                                       2.X Server 
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|                          |                          | 

|  HTTP                    |  HTTP                    | 

|  GET /handshake/1        |  GET /handshake/1        | 

|+------------------------>|+------------------------>| 

|<------------------------+|<------------------------+| 

The terms “proxy server” and “origin server” are used to distinguish between the two servers. 

In this setup, the proxy server is technically a reverse proxy because the client connects to the proxy 
server that, seen from the client, transparently acts as the Maconomy 2.X server. In other words, the 
client knows only about the proxy server and considers it to be the Maconomy 2.X server. 

 

Why Use an Intermediary Proxy Server? 
The following are some common reasons for deploying a proxy server: 

 SSL termination: Offloading the job of encrypting and decrypting traffic between the client and the 
server away from the origin server 

 Load balancing: Distributing requests from clients to several origin servers 

 Caching: Speeding up access to resources by caching resources at the proxy server, freeing up 
system resources at the origin server 

 Compression: Offloading the job of compressing the traffic away from the origin server 

 Translation: Offloading the job of translating resources to another language away from the origin 
server 

 Monitoring: Monitoring and filtering traffic 

SSL Termination 
SSL termination is when the proxy server encrypts and decrypts the traffic between the client and the 
origin server. The proxy server communicates unencrypted with the origin server. 

This is done to offload the task of encryption from the origin server. 

Offloading encryption from Maconomy software to widely used standard software and hardware has other 
benefits: 

 Increased security because the proxy servers are widely used and actively maintained by 
companies and/or open-source communities. 

 Setup and configuration are well known in customer organizations and fit well with existing 
infrastructure and network architectures. 

 Managing server keys and certificates can be easier when using an SSL termination proxy. 

 
Workspace            Reverse Proxy             Maconomy 

Note: The proxy server and origin server can be deployed on different physical machines, but they 
can also be run on the same physical machine. 

Warning: Because the traffic to and from the origin server is unencrypted, it is very important that the 
origin server is secured, and that the channel between the reverse proxy and the origin server is 
secured. The origin server must not be generally accessible on the network because that could allow 
client programs to send data in an unsecure way. 
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Client                                       2.X Server 

|                          |                          | 

|  HTTPS                   |  HTTP                    | 

|  GET /handshake/1        |  GET /handshake/1        | 

|+------------------------>|+------------------------>| 

|<------------------------+|<------------------------+| 

|                          |                          | 

|  HTTPS                   |  HTTP                    | 

|  POST /workspaces-rpc    |  POST /workspaces-rpc    | 

|+------------------------>|+------------------------>| 

|<------------------------+|<------------------------+| 

Load Balancing 
Load balancing is when the proxy server distributes requests among several origin servers. This is done 
to scale the system to be able to support a higher throughput and thereby a higher number of concurrent 
users. 
Workspace        Reverse Proxy         Maconomy               Maconomy 

Client                               2.X Server             2.X Server 

|                      |                      |                      | 

|  HTTP                |  HTTP                |                      | 

|  GET /handshake/1    |  GET /handshake/1    |                      | 

|+-------------------->|+-------------------->|                      | 

|<--------------------+|<--------------------+|                      | 

|                      |                      |                      | 

|  HTTP                |  HTTP                |                      | 

|  GET /handshake/1    |  GET /handshake/1    |                      | 

|+-------------------->|+------------------------------------------->| 

|<--------------------+|<-------------------------------------------+| 

Caching 
Caching is when the proxy server stores a copy of a resource and serves the copy without contacting the 
origin server. This is done to offload the origin server from generating or serving commonly used 
resources that change infrequently. 
Workspace            Reverse Proxy             Maconomy 

Client                                       2.X Server 

|                          |                          | 

|  HTTPS                   |  HTTP                    | 

|  GET /handshake/1        |  GET /handshake/1        | 

|+------------------------>|+------------------------>| 

|<------------------------+|<------------------------+| 

|                          |                          | 

|  HTTPS                   |                          | 

|  GET /handshake/1        |                          | 

|+------------------------>|                          | 

|<------------------------+|                          | 
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Database Server 
Maconomy can be installed on an Oracle or SQL database. The database selection is often decided by 
the customer and is based on his or her preferences. Deltek recommends using Oracle if the customer 
does not have any strong preference. The list of supported database versions is made available with 
each Maconomy release. 

Application Server 
This section describes the options available for the Maconomy server executable and describes the 
initialization files that influence how the Maconomy server and clients operate. 

The main Maconomy executable—maconomyserver.exe (on the Windows platform) or macoracle.r (on 
Unix)—supports a number of modes and features. These modes and features are controlled by server 
options. 

The options can be used to specify a mode, such as which TCP port the Maconomy server should listen 
to, or a feature, such as forcing the Maconomy server to validate custom print layouts. 

These options are described one by one in the first section of this manual. In addition, Maconomy uses 
initialization files to read options every time that the server or another application is started. These 
initialization files are located in the IniFiles subdirectory of the Maconomy home directory. The second 
section of this manual describes the initialization files: what they apply to, what you can enter in the files, 
and when they are read by the Maconomy server application. 

Coupling Service 
Introduced with the Maconomy 2.0 Workspace Client, the Coupling Service is a Maconomy server-side 
component that acts as a gateway between the Client and the Maconomy server daemon—either the 
Windows Maconomy Daemon or the UNIX internet daemon (inetd/xinetd). 

The Coupling Service contains some server functions. It is written in Java and built on top of the Eclipse 
Equinox implementation of the OSGi platform framework. 

System Requirements 
The following general system requirements apply specifically to the Coupling Service: 

 Memory: 4 GB free memory + 1GB free memory / 1000 users 

 Disk space: 500 MB free disk space 

 Server OS: Microsoft Windows Server (64-bit) and RHEL (64-bit). 

For example: a standalone Coupling Service configured for 2000 users should have at least 6GB of free 
memory. The Maconomy Application server should be sized with similar free memory, and a combined 
server for both the Maconomy Application server and the Coupling Service for 2000 users should have at 
least 12GB of free memory. 

System Architecture 
The Maconomy server consists of both the Maconomy Application Server and the Coupling Service. In 
addition to being part of the server, the Coupling Service functions as a gateway for the Workspace Client 
to the Maconomy Application Server. The service must be able to connect to the Maconomy server on the 
port number that is offered by the server daemon, and to expose its own service ports where clients can 
connect. 
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The Coupling Service often needs to communicate extensively with the Maconomy Application Server, 
which means that parameters such as bandwidth and network latency between the Coupling Service and 
the server are critical. 

The following sections briefly discuss a few possible setups and their impacts on system performance. 

Same Server 
The recommended scenario has the Coupling Service installed on the same physical hardware as the 
Maconomy Application Server, such that communication between the processes can happen without 
needing to go through external network interfaces. 

This setup should provide the best performance possible. 

Co-Located Server 
The Coupling Service can be installed on a separate server machine. Such a setup might be appropriate 
if the Maconomy Application Server is already under a high load, or if network architecture considerations 
make it undesirable to open the required ingoing ports on the server machine. 

Provided that the two servers are co-located and connected by a high-performance (Gigabit) network, this 
setup can generally be expected to provide an acceptable level of performance. 

Remote Server 
In this scenario, the Coupling Service is installed on its own server at a remote location. This setup makes 
the Coupling Server vulnerable to the exact network topography between the two server locations. 

Limitations in the bandwidth (for example, a 10/100 MBit Ethernet) or even moderate network latencies 
could cause an unacceptable degradation in performance, and therefore this setup is not recommended. 

Coupling Service Configuration 
The Coupling Service is configured to ensure consistency between the values seen in MConfig and the 
actual values of the properties as well as avoid situations where MConfig overwrites values that have 
been manually changed. Additionally, the configuration makes clear which properties are static (changes 
take effect only after a CS restart) and which are dynamic (changes take effect immediately). Finally, the 
configuration facilitates the ability to find and keep track of properties for different types of logging as well 
as properties that are specific to extensions.  

The configuration includes: 

 The top-level server.ini is reserved for MConfig-managed settings only. 

 Settings folder and default configuration file 'settings/settings.ini' contain all configurable settings, 
ordered according to category and whether they are dynamic or static. 

 Settings related to extensions, logging, and monitoring are considered "very dynamic" and are 
contained in separate files to make it easier to push/pull configuration settings from a system (and 
readily add and remove, during support cases for instance). These settings include: 

 settings/extension.ini 

 settings/logging.ini 

 settings/monitor.ini 

 settings/mpm.ini 

 All settings encountered in the ini-files are now validated against the full list of known settings. 
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 Most ini-files accept only a limited list of settings, according to the purpose of the file. The default 
.ini files each contain a commented-out section listing the accepted properties for that file. 

 All settings are documented in a separate README.txt file in the Settings folder. 

 The settings.ini file is found in the Coupling Service of a Maconomy System in 
/configuration/settings/settings.ini. 

 

Upgrade Consideration  

Modifications to 'server.ini' cannot be automatically merged when upgrading, and they must be 
reapplied manually. In addition, some settings are renamed, so consult the new default .ini files and 
README.txt for further detail. 
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Installation and Upgrade Overview 

Default webaccess.ini 
A default standard webaccess.ini file is included with all Maconomy installations (including upgrade and 
new installations). For security purposes, the default file includes restrictions that remove direct access to 
all search dialog boxes in Workspace and web clients, but not the search dialog boxes used by Touch. 

The webaccess.ini file is automatically installed by MConfig. It is possible to use Extender to customize 
the file either adding new restrictions or removing the default restrictions. 

 

Release Documentation 
For every new release of Maconomy (service pack or full version), Deltek issues a set of release 
documentation. This documentation describes new features and error corrections in the APU, TPU, or 
SPU respectively. You should always study the release documentation carefully before upgrading. 

Note: Since access to search dialog boxes is restricted, this could potentially impact integrations. 
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Hardware Requirements 
This document provides information for setting up your Maconomy system and using the Maconomy 
Hardware Requirements Scaling Tool, which is a dynamic tool that allows you to input specific 
parameters based on your exact setup, and then generate custom recommendations.  

 

Workspace Client Hardware Requirement 
Deltek Maconomy offers guidelines for hardware requirements for the client computer running the 
Workspace Client as minimum requirements and recommended requirements. 

The hardware requirements below are valid for the Workspace Client delivered with Maconomy 2.0 and 
onward. The recommendations may update for later versions of Maconomy. 

The hardware specification is detailed by running the NovaBench: System Benchmarking Software 
version 3.0.4.  

 

Minimum Hardware Requirements  
The minimum hardware requirements specify a client computer capable of running the Workspace Client 
without monitoring the response times. This is typically sufficient for those using less complicated 
functionality, such as time sheets, expense sheets, and mileage reporting. 

Minimum Hardware Requirements for the Maconomy Workspace Client 

RAM At least 500 MB of free memory (RAM). 

Configuration Depending on the load from other programs running on the machine, a machine 
configured with 2 GB RAM and 1.6 GHz processor should be the minimal 
configuration in practice. 

Hard Disk The client program itself plus the files the client program generates usually occupy 
less than 500MB of disk space. As hard disks typically are much larger, client 
machine disk space is not expected to become an issue in practice. 

Screen Size The absolute minimum resolution is 1024x768 pixels. 

NovaBench The NovaBench scores follow: 

 NovaBench Overall score: 175  

Warning:  
 You must engage with a Technical Consultant from Services to use this document and 

related Hardware Requirements Scaling Tool. Without this engagement, Deltek takes no 
responsibility for the resulting output. 

 This document does not include specific reference to hardware offered by vendors or Cloud 
services (such as Amazon), and it is the responsibility of Services (a Technical Consultant) to 
advise on this. 

Attention: For more information, go to www.novabench.com. 

http://www.novabench.com/
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Minimum Hardware Requirements for the Maconomy Workspace Client 
 NovaBench CPU score: 73 

Recommended Hardware Requirements 
Using standard Maconomy functionality more complicated than time sheet functionality requires more 
robust hardware capabilities, and Deltek recommends the following hardware requirements or better. 

Recommended Hardware Requirements for the Maconomy Workspace Client 

RAM At least 1 GB of free memory (RAM). 

Configuration Depending on the load from other programs running on the machine, a machine 
configured with 4 GB RAM and 2.5 GHz Intel i5 processor is recommended. 

Hard Disk The client program itself plus the files the client program generates will in most 
cases occupy less than 500MB of disk space. As hard disks typically are much 
larger, client machine disk space is not expected to become an issue in practice. 

Screen Size The recommended resolution is 1440x900 pixels or better. 

NovaBench The NovaBench scores follow: 

 NovaBench Overall score: 647 

 NovaBench CPU score: 405 

Configuration Introduction 
This document covers both vertical and horizontal scalability architecture configurations: 

 Vertical scaling: Adds more resources (memory, CPUs, and so on) to a single machine. 

 Horizontal scaling: Adds more machines. 

Choosing between the scaling options is based on individual customer requirements and input from a 
technical consultant considering many factors, including cost. A single high-power server used for vertical 
scaling may cost 10 times more than 2 servers each with 50% the power, but software licensing could 
possibly negate this. Also consider that horizontal scaling of the application server using the scalable 
server of 2.3 GA enables you to have multiple relatively inexpensive servers as opposed to one large 
one. This configuration also allows for inbuilt redundancy as well as an inbuilt overhead for failure. 

The sample configurations in this document show three single-server and three multi-server 
configurations, and they are designed to help in your consideration of future growth.  

From 2.3 GA and onwards, you can move from a single-server to a multi-server setup at any time, as 
business requirements grow. However, as you transition from a two-tier to a three-tier installation (which 
is required for running a scalable server), note that a three-tier installation has an overhead of 
approximately 20% of the total system usage, which is due to the network connection between the server 
and database tier compared to utilization of the internal machines’ communication when the application 
server and database are on a single tier. This finding was the result of the performance tests performed 
on existing Maconomy users using Mercury’s LoadRunner® tool. The tests showed that three-tier 
solutions use TCP/IP-based interfaces (ODBC), which adds an extra communication layer between 
Maconomy and the underlying database. 
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Depending on the budget, specific infrastructure bottlenecks, and other factors, one solution may be more 
appealing over another. The response time requirements will decide which solution should be 
implemented. In general, as hardware becomes cheaper, there may be some financial advantages in 
choosing a mid-size server for the initial phase and then expanding it once or several times in the first 
year, instead of paying a higher price outright to make sure that response times are satisfactory for the 
first one or two years. 

One parameter that is necessary for good performance is the disk subsystem. All configurations 
discussed in this document are configured with high-end internal disk systems, which ensure the fastest 
data access and optimum stability. For high-end systems with more than 2,000 users, Deltek 
recommends an external disk system for the database files. 

 
All sample configurations that are described in this document are designed to handle a standard 
Maconomy solution installation. These configurations assume that 5% of the total number of users are 
heavy users, such as back-office Finance users, 15% are moderate users, such as Project and Resource 
Managers, and 80% are light users, such as Time and Expense users, who may access Maconomy using 
a browser or mobile device. Variance from this split of Users should accordingly be considered when 
sizing. 

In addition, the configurations assume a shared-server program pool of not more than four programs per 
kernel.  

Maconomy works with most Intel-based servers. 

 

Special Actions Required: 
 Discuss with Customer: Services (a Technical Consultant) should discuss considerations 

with the customer regarding a horizontal or vertical solution, as there are many parameters to 
consider which are not covered in this document, such as license and hardware costs, 
possible performance issues in specific customer environment, and so on. 

 Approved by PDM: All use of the scalable server must be approved by PDM prior to 
implementation, as it is in its early stages of adoption. 

Performance Notes: 
 Tiered SANs are often difficult performance-wise for ERP systems because data is moved to 

slower disks. Maconomy must reside on the fastest tier at all times. 

 The number and speed of the disk drives have an impact on the performance of the 
database. 

Note: This document does not discuss backup media, though it is an important part of the technical 
implementation. In general, the backup system for a Maconomy installation must be an integral part 
of the company’s backup strategy. 
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Scalability Considerations 

Maconomy Infrastructure 
The two Maconomy sample configurations below show typical configurations for both a single-server and 
multi-server environment. These configurations can either be installed in a customer’s own on-premise 
setup with physical or virtualized servers, or via hosted virtual environments, such as in Amazon Web 
Services (AWS) infrastructure.  

 
From Maconomy 2.3 and later releases, to increase network security, Deltek recommends running the 
Web server/reverse proxy on the Maconomy Application Server or Servers. This allows running HTTPS 
across the entire Maconomy stack, covering communication from all Maconomy clients (including the 
RESTapi) to the Maconomy Server itself. Deltek recommends running the Reverse Proxy in all single or 
multi-server configurations. 

Single Server Environment 
The following example describes a single-server Maconomy configuration based on the following 
parameters: 

 OS: Linux 

 Database: Oracle 

 Clients: WSC, web client, and RESTful API 

Users Memory (GB) CPU (Kernels) CPU (Clock) IOPS Disk Configuration Server_Max 

500 57 27 2.8 375 350 18 

2000 61 34 2.8 1500 350 36 

5000 70 49 2.8 3750 350 72 

Note: If you have a configuration utilizing virtual environments, please ensure that all resources like 
CPU and Memory are dedicated and not shared between instances. 
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Multi-Server Environment 
The following example assumes equal configuration and utilization across all servers. Note that it may 
also be possible and desirable to set up servers without equal load or operations. For example, you may 
elect to set up one server that is used only for running scheduled tasks. Depending on your needs, you 
may require a different split of the configuration of resources, with different sizing calculations. 

The following example describes a multi-server Maconomy configuration based on the following 
parameters: 

 OS: Linux 

 Application Servers: 3 

 Peak load per server: 50% 

 Database: Oracle 

 Load Balancer: Yes 

 Clients: WSC, web client, and RESTful API 

Users Servers Memory 
(GB) 

CPU 
(Kernels) 

CPU 
(Clock) 

IOPS Disk Configuration 
Server_Max 

2000 Load 
Balancer 

4 2 2.6    

Application 25 19 2.8  100  

Database 34 12 2.8 1500 250 24 
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Users Servers Memory 
(GB) 

CPU 
(Kernels) 

CPU 
(Clock) 

IOPS Disk Configuration 
Server_Max 

5000 Load 
Balancer 

4 2 2.6    

Application 28 24 2.8  100  

Database 37 18 2.8 3750 250  

10000 Load 
Balancer 

4 2 2.6    

Application 33 31 2.8  100 72 

Database 42 28 2.8 7500 250  

 

Other Scalability Considerations 

Databases 
Both Oracle and SQL Server have built in capabilities aimed towards horizontal database scalability; 
although, both vendors recommend vertically scaling loads of up to 10,000 transactions per second.  

As you make server choices, consider that Deltek recommends Oracle (Active) Data Guard and SQL Pier 
to Pier replication for the Maconomy solution, as they provide only read scalability, and this is relevant for 
removing the load related to reporting from the transactional database. 

 

Note: Deltek has not certified running specific options but assumes these options will work with 
Maconomy through Oracle or SQL Server. 
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BPM & People Planner Scaling 
BPM & People Planner scaling should be considered separately or in conjunction with the 
recommendation given regarding this document and the Maconomy scaling tool. This could have an 
impact on Maconomy hardware. 

 

Virtualization 
In general, Maconomy supports systems that run on virtual environments if the OS is certified to run 
Maconomy. Maconomy does not support the virtual environment itself. 

In terms of performance, virtualization translates to additional work for the CPU. The instructions that 
perform the extra work are normally part of the operating system calls. To support virtualization, an extra 
layer of OS calls is introduced, and this layer makes up the biggest share of the virtualization overhead. 

When running Maconomy on a virtual environment, you must allow room for the expansion of both the 
CPU and memory. You may also experience a performance degradation (up to 20% in overhead), 
compared to running Maconomy on a physical machine, due to VM administration, shared I/O, and CPU. 
The best mitigation is to make sure to run on dedicated resources. 

A key challenge for virtualization is the interception and simulation of privileged operations, such as I/O 
instructions and CPU capacity. 

Extra Step with Oracle: 
Maconomy is a 32-bit application on the Intel platform. To install Maconomy with an Oracle 64-bit 
database, you need OracleNet as the interface layer between Maconomy and the database. This 
adds a data communication overhead of up to 20% to the database. On the other hand, large SQL 
statements may run faster due to the larger cache size on the database. 

This setup is required only for Oracle. SQL Server does not have any special setup requirements. 
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Bandwidth Requirements 
This section describes bandwidth testing for Maconomy 2.x+. 

This section describes recommendations and limitations that need to be considered when defining a 
Maconomy solution for customers. Several tests and measurements have been made and taken into 
consideration when outlining the following recommendations.  

This section or subsections of it cannot be part of any Maconomy contract because assumptions can be 
made that cannot be directly transferred to a production system. 

Maconomy Client Bandwidth 
Many Maconomy customers are global companies with offices in several countries. They must consider 
bandwidth and latency between these offices and their central Maconomy installation. 

This section provides information about the bandwidth required to handle the connections from the 
Workspace Client (WSC) or Web Client (Web) to the Coupling Service (CS), as well as estimates of the 
consequences that network latency has on the perceived performance of these clients. 

The theoretical performance impact of network latency is calculated for a number of different latency 
figures and combined request/response data package sizes, covering the conditions that can be expected 
from a range of remote office locations. 

Network Calculations 
Using a few simple formulas, it is possible to calculate the roundtrip delay (RTD) for a request/response 
pair with a given message size when passing data across a network with a known latency and bandwidth. 
The RTD is a calculation of the average time it takes to send a request and receive the response, 
assuming that the data processing at the remote end takes zero time. 

Roundtrip Delay 
For calculating a RTD, use the following formula: 

RTD = (2 * Network Latency) + (Message Size / Network Bandwidth) 

The figure below shows the calculated RTD incurred on a 20 Mbit/s network for different latencies and 
message sizes in a single roundtrip from a Maconomy client application to the CS. This shows that for 
small latencies the RTD is also small, and it is decided by the message size. As the latency grows, so do 
the RTD values and the message size (and therefore network bandwidth) becomes less relevant. The 
typical workspace request message size for the WSC lies around 50 kB, but it may be larger depending 
on how much data is being shown and how many panes are open in the workspace. For the Web Client 
the average message size is smaller and will typically be below 10 kB on average. 
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Logical Operation Delay 
The next figure shows the “operation delay” for a complete workflow in either the Workspace Client or the 
Web Client, as a function of the number of request/response roundtrips between the client application and 
the CS. 

An example workflow could be “create and fill out a time sheet line” or “view and approve 10 project 
entries.” The operation delay is then the total time spent waiting on the network while executing the 
workflow. 

For these calculations we will assume an average request/response message size for the WSC of 50 kB 
and 10 kB for the Web Client. A typical workflow is expected to consist of anywhere between 2 and 20 
server requests. 

Once again, it is apparent that the network latency is a major factor; workflows that are executed with a 
total delay of around 1 second on a low-latency network suffer from a total delay of 5-8 seconds on a 
high-latency network. 

Depending on the operations being performed in the workflow this could translate to an increase in the 
total workflow execution time for a Workspace Client operation of up to 40% for small operations, as 
illustrated by the following figure: 
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Very similar figures can be seen for a Web Client operation as shown below. The delay for a given 
number of requests is slightly smaller compared to the WSC due to the smaller average request/response 
message size. However, in scenarios where the Web Client workspace shows data from multiple data 
sources, it might be necessary to perform several sequential roundtrips to fetch the additional data. This 
will incur an extra network delay, but for typical latency values the differences in network delay 
experienced between the WSC and Web Client are expected to be negligible. 

 

Network Bandwidth 
The following table focuses on the total volume of network traffic across the network as a function of the 
number of active users on the system. This table provides the calculated total network traffic (in Mbit/s) for 
100 – 1000 users and five different message sizes. 

These figures can be used to get an estimate for the network bandwidth that should be reserved to 
handle Maconomy client requests during peak load from a specific number of users without leading to 
network congestion. For the Web Client the required network bandwidth includes both the small (but 
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frequent) network load of each request being performed, and the larger (but less frequent) network load 
incurred during login, when a number of resources have to be transferred to the browser. The extra load 
incurred by login activity is calculated on the assumption that each user will on average log in once an 
hour during peak load activity. 

 
Num

ber of users 

 Web WSC 

100 2 4 

200 4 8 

300 6 12 

400 8 16 

500 10 20 

600 12 24 

700 14 28 

800 16 32 

900 18 36 

1000 20 40 

Conclusion 
Based on the preceding calculation, it is now possible to calculate the required bandwidths and the 
influence of latency. 

For example, if an installation has 250 WSC users located in remote locations, it requires a bandwidth of 
approximately 10 Mbit/s, whereas if there are fewer than 100 users in a remote location, it requires 
approximately 4 Mbit/s. Similarly, 500 Web Client users in remote locations will require approximately 10 
Mbit/s to sustain peak load activity. 

The roundtrip delay (RTD) for a request/response roundtrip between a remote location and the central 
Maconomy installation can be calculated as the following example: if the average message size is 50kb, 
and the latency is 150ms, the RTD is expected to be approximately 300 – 400ms. The Operation Delay 
for typical WSC workflow scenarios is expected to be approximately 5 – 8 seconds, or up to 40% for small 
operations. The Operation Delay for typical Web Client workflow scenarios is expected to be comparable 
to, or slightly less than for the WSC. 

Factors that could invalidate these results include: 

 Changes in network bandwidth and/or latency, either due to changes in the network topology or 
because other services on the same network are causing congestion. 

 A usage pattern during peak hours that differs significantly from the assumed average of 0.1 
requests per user per second. 
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 An average message size significantly greater than the estimated values. Such an increase in 
message size could be the result of disabling compression on the WSC – CS network connection, 
or by users performing common tasks in workspaces with many unnecessary panes open. 
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Security Considerations 
This section discusses the following security areas for you to consider: 

 Access Control  

 Passwords 

 SSL 

Password Security 

General Password Security 
This section describes some guidelines for protecting your system using strong passwords. There is a lot 
if information about this subject on the Internet, but the following provides several Dos and Don’ts for you. 

Default Password 
When you install Maconomy, a default user called Administrator is created. This user has access to 
everything in the system. By default, the password for the Administrator user is 123456. 

In the same way, every time that a user is created, the password is set to 123456. However, Maconomy 
automatically sets the user password as expired for ordinary users. This means that the first time that 
users log in to the system, they are forced to set up a new password in the Change Password window.  

 
Rule number one is to make sure that no password in the Maconomy system is kept as a standard 
password (123456). This especially goes for the Administrator user. 

The importance of passwords and how to create a proper password are explained in the following 
sections. 

Maintaining a High Level of Security 
With external access to web portals, mail servers, and various workstations through the Internet and 
direct dial-in modems, a door for possible unwanted visitors is opened. The only way for an intruder to 
access the system is by guessing the correct combination of user ID and password. The main key to 
secure systems, therefore, is the correct use of passwords. 

It is getting increasingly easy for an intruder to guess simple combinations of ID and password. 

Do not underestimate the ease with which a password can be guessed or stolen. There are many 
techniques available to do this. Another simple and amazingly successful technique for the cracker is 
password-guessing. 

It is up to every individual to ensure that their passwords are safe—a single unsafe password can open 
the door for a computer hacker to violate the integrity of the computer network or to steal information from 
your databases. 

Maconomy supports several different password policies: 

 Length 

 Use of special characters 

 Restricted reuse of passwords 

Attention: For more information, see the “Setup” chapter in the Maconomy Reference Guide. 
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 Periodic expiration dates  

These policies are described by the following example. 

Choosing a Safe Password 
As discussed previously, a secure password is still one of the most important methods for protecting the 
network and servers from unwanted visitors. 

The following simple guidelines are used in the industry to select and manage good passwords. 

Do Not 
 Use simple passwords that are easy to guess. Such as “123456” or “ppu123.” 

 Use any word from a dictionary (of any language) because most forms of password attacks use 
dictionaries as a basis for password-guessing. 

 Use user IDs (such as NFA), birthdays, car registration numbers, room numbers, department 
names, server names, locations, names of wife, husband, children, pets, and so on. Such names 
can be guessed because most of this information is not confidential. 

 Use the same password on multiple accounts. If you have many accounts, do not use the same 
password on each account. If one is broken, then all are broken. 

 Reuse old passwords. 

 Write your password down or save your password on a disk (for example, in an MS Word 
document). 

 Tell or share your password with anyone, by email or by any other means. Note that a PIN for a 
credit card can be compared to a password. If someone has the password, he or she can commit 
criminal acts using the credit card account. 

Do 
 Use a password that consists of at least six characters. 

 Use mixed‐case alphabetic characters. 

 Include special characters—that is, nonalphanumeric characters. Try to place them in the middle 
of the password. 

 Change passwords frequently (for example, every 75th day). 

General Techniques for Generating Safe Passwords 
General techniques for generating safe passwords include the following: 

 Take the first letter from each word of a phrase, sentence, theorem, poem, oo so on (a pass 
phrase). 

 Add some special characters—nonalphanumeric, punctuation, and so on. 

 Deliberately misspell. 

 Use the first letter from each word in an easy-to-remember sentence. 
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Example 

Three Simple Steps to an Acceptable Password 
1. Initial pass phrase: “Go ahead punk, make my day” becomes gapmmd. 

2. Use capital letters. Convert some letters to uppercase: GaPMmD. 

3. Insert some special characters: GaP-MmD!. 

 
If you follow these guidelines, guessing your password should take longer than your password change 
frequency. 

Security Overview 
This section describes the security model that is implemented in Maconomy and some tips to increase the 
security of your Maconomy system. 

Maconomy’s security model, or access control system, is active in all modules in Maconomy, and it is 
based on the user who is logged in. There are two types of access control in Maconomy: 

 One for defining each user’s access to opening windows and changing data 

 One for defining which records in the database each user should be allowed to access 

Default Filetypes 
For security purposes, Deltek limits the default filetypes that users are allowed to upload to Maconomy in 
settings.ini. These types include: 

 Composite Document File V2 Document 

 HTML document 

 Microsoft Excel 2007+ 

 Microsoft OOXML 

 Microsoft PowerPoint 2007+ 

 Microsoft Word 2007+ 

 PDF document 

 JPEG image data 

 PC bitmap 

 PNG image 

 Zip archive data 

 7-zip archive data 

 ASCII text 

 ISO-8859 text 

 Rich Text Format data 

Note: Do not use this example, given that it has been published. 
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 UTF-8 Unicode 

 Unicode text 

 XML 1.0 document 

 news or mail 

Other entries in the settings.ini file to support Maconomy functionality are: 

 data: Necessary to allow files from support documentation functionality to be saved 

 empty: Necessary to allow for files without any content but this is not an allowed filetype 

You can modify this list in settings.ini if needed.  

To modify the default filetypes list: 
1. Navigate to \configuration\settings\settings.ini. 

2. Open the file in a text editor, and find the line: 
security.filecheck.external.1.allowlist = security-filecheck-external-
allowlist-default.txt 

3. Either update this file or change to another file (which can be a copy of the default file). 

The file is by default located in the same folder as settings.ini but a full path can also be used. 

4. Update the relevant file with new lines for file types to be accepted. 

5. A new file type can be found by trying to upload a file which is not accepted. 

Two log lines are added in the maconomy.log file in CouplingService\log\coupling folder: 
WARN c.m.c.s.s.McFileCheckUsingExternalCommand - File check output for file 
'<filename>’: <filetype>, <extra text> 

WARN c.m.c.s.security.McSecurityService - File '<filename>' not accepted by: 
McFileCheckUsingExternalCommand: 

Add the text <filetype> to the allowlist file. 

6. Touch the file settings.ini so the allowlist file is read again by the Security Service (or restart the 
Coupling Service). 

Access Control Elements 
When designing the access control for your Maconomy system, you should be aware of all the elements 
of the Maconomy security model. Consider the following: 

 Access groups: Each user is a member of at least one access group.  

Note that a user’s membership of the access group also defines the user’s access to database 
views (defined for each access group in the View Groups window) and window layouts (defined 
for each access group in the Window Layout Groups window). 

 Window layouts: By assigning different window layouts to different user groups (as mentioned 
previously), you can restrict access to certain fields and features in Maconomy. 

 Actions: For each user, you can specify access to various actions in the Actions window. For 
example, you can grant or deny permission to approve sales orders, print invoices, and so forth. 

 Access levels: Access levels are used for managing user access to database entries. 

While groups determine whether or not a user can open a given window and change information, 
access levels determine the records that are available to the user in each window. 
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Data can be organized in an access hierarchy in which the access level assigned to each user 
determines whether or not they have access to the data. For example, a company in Maconomy 
is given a certain access level. A user only has access to data that is related to that company if 
the user has been granted access to the access level of the company or a higher access level. 
Otherwise, the user cannot find, browse, or see information that is related the company in 
question. 

For another example, when entering time sheet lines, you can only specify jobs in the Job No. 
field to which you have access, and if you use the Find menu to find jobs when entering a new 
time sheet line, the Find window only displays jobs to which you have access (and therefore can 
specify). 

Access levels are defined in the Access Levels window and are assigned to users in the User 
Access Levels window. The individual access levels are assigned to data items in the various 
card windows such as the Company Information Card. 

 Direct and indirect access control: If an access level is specified for an object in Maconomy, this 
object is said to be under direct access control. For example, for a job in the Jobs window, the 
access level that is specified for the job determines which users have access to it. However, there 
are many objects in Maconomy to which you cannot apply direct access control. For example, a 
sales order or a time sheet does not contain a field for access level specification. Instead, access 
to such objects can depend on the user’s access to one or several of the objects to which you 
refer. This way, access to a job entry, for example, can depend on whether or not the job entry 
contains a reference to a job to which you have access. 

 

The Maconomy Access Control System 
This section contains an in-depth description of the Maconomy access control system. 

The purpose of the access control system in Maconomy is to ensure that only information to which a 
given user has been granted access is accessible when using Maconomy. This applies to dialog boxes, 
search windows, and access through third-party products applying ODBC. 

Specification of Access Principles 
To make sure that the access principles are enforced, all reading of information in the Maconomy 
database is done through views, which are defined partly on the basis of the relation and partly on the 
basis of a description of the access principles that apply to the individual relations. The description of this 
information can be found in the database folder for the installation in question.  
c:\maconomy\ <Maconomy-Home>\MaconomyDir\Database 

Among many others, this folder contains the RelationDefinitions and RelationAccessDefinitions files. The 
RelationDefinitions file contains a definition of all relations in the Maconomy database. Similarly, the 
RelationAccessDefinitions file describes the access principles that are associated with the individual 
relations. 

Attention: For a full description of the Maconomy access control system, see the following section in 
this chapter, the introduction to the “Set‐Up” chapter in the Maconomy Reference Manual, and the 
description of the windows mentioned in the preceding summary. The introduction to the “Set-Up” 
chapter also describes examples of access control in the multi-company model and in the Job Cost 
module. 

The chapter “Database Description” in the Maconomy Reference Manual contains a list of the 
relations for which direct access control can be specified. 
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The access principles for each relation are structured as logic expressions, providing you with the 
possibility of assigning one or several expressions to the same relation. The available access principles 
are: 

 NoAccessControl 

 DirectAccessControl 

 IndirectAccessControl 

These access principles can be defined as follows. 

NoAccessControl 
This principle specifies that there should be no access control on the given relation. Any user can see the 
information stored in the relation. 

DirectAccessControl 
This principle specifies that the given relation contains a field with the name AccessLevelName, which 
relates directly to the definitions of access levels in Maconomy. Access to a given entry in a relation with 
this access control principle is granted if the user has access to the access level specified in the entry in 
question.  

 

IndirectAccessControl 
This principle specifies that access to the given relation is dependent on the access to another relation. 
For example, access to journals in the G/L module could be dependent on whether or not the user has 
been granted access to the company that “owns” the journal. This example would be expressed as 
follows: 
Journal : IndirectAccessControl (CompanyInformation, CompanyNumber) 

The preceding line in effect says that “access to a given journal is dependent on whether the user has 
access to the company in the relation CompanyInformation, which has the CompanyNumber specified on 
the journal as key.” 

As mentioned previously, the access principles are structured as logic expressions, which provide the 
possibility of specifying more than one condition. One example could be that to gain access to a 
requisition, a user needs access to the company that “owns” the requisition and access to the job to which 
the requisition is assigned. This example can be expressed as follows: 
RequisitionHeader : IndirectAccessControl (CompanyInformation, CompanyNumber) 

and IndirectAccessControl (JobHeader, JobNumber) 

As a final example, consider that there are no access principles on the relation InterestTableHeader. The 
access principle therefore looks as follows: 
InterestTableHeader : NoAccessControl 

Note that it is not possible to have indirect access control with a reference to a relation for which no 
access control has been specified. The result of this would be that there are no access restrictions on any 
of the relations in question. However, if you do this, you ensure that if, at some later point, access control 
is assigned to the relation to which the reference is made, access control will also be assigned to the 
relations whose access principles refer to this. 

Attention: For more information, see the introduction to the “SetUp” chapter in the Maconomy 
Reference Manual. 
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The general rule is that expressions that specify the access control for access to a given relation can 
consist of one or several elements separated by “and” or “or.” In addition, you can use parentheses, 
which make it possible to specify expressions of the following type: 
DirectAccessControl and 

(IndirectAccessControl (Customer, CustomerNumber) or IndirectAccessControl (JobHeader, 
JobNumber) ) 

Access Control in Servers and Clients 
This section contains a short description of the implementation of extended access control in Maconomy’s 
server and clients. 

General database views offer the possibility of implementing general access control; that is, the 
Technology layer enforces the access control by using the views. The extended access control is 
implemented in the following way. 

In all information maintenance dialog boxes (such as Customer Information Card, Company Information 
Card, and so on), extended access control is used on all database lookups in the upper tab. Entries in the 
subtab are not included by the extended access control unless specified by the Application Department. 

Lookups in the database in connection with printouts are not included by the extended access control 
unless specified by the Application Department. 

All searches and exports from the File menu are included by the extended access control. 

Lookups in the database from RGL reports are included by the extended access control if one of the 
expressions DirectAccessControl or IndirectAccessControl is included in the where clause. 

When developing Analyzer reports, you can use the model for extended access control by using relation 
names prefixed by “AC” instead of “VW.” DirectAccessControl and IndirectAccessControl expressions in 
the where clause are subsequently subject to the same conditions as the Maconomy client. 

The reason for distinguishing between views used in Analyzer reports and views used by third-party 
products is that Analyzer reports are run from the Maconomy client and hence they use another 
connection to the database. Unlike the client, third-party products need a connection to the database, 
which does not use the client’s normal login credentials. Therefore, VW views must be used from third-
party products. 

Because the extended access principles cannot be evaluated by the application, an automatic control of 
all foreign key references is built into the system. This control ensures, for example, that a customer 
number in the Order header refers to an existing customer, and that it can be used by the user according 
to RelationAccessDefinitions. 

REST API Container Web Access Rules 
You can specify web access rules for each of the four primary types of container endpoints: specification, 
filter, data, and field. Addtionally, you can use search as a foreign-key endpoint for each container, 
dynamically translated to search container requests. 

 

Secure Sockets Layer 
The secure sockets layer (SSL) provides endpoint authentication and communications privacy over the 
Internet using cryptography. The protocols allow client/server applications to communicate in a way that is 

Attention: For more details, refer to “Web Access Configuration” section of the Deltek Maconomy 
Web Service’s Programmer’s Guide. 
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designed to prevent eavesdropping, tampering, and message forgery. In the case of Maconomy, a proper 
implementation of SSL means that nobody can “listen in” on the network traffic between the server and 
clients and thus pick up valuable business data. 

SSL has three main functions: 

 Authenticating the client and server to each other: The SSL protocol supports the use of standard 
key cryptographic techniques (public key encryption) to authenticate the communicating parties to 
each other. 

 Ensuring data integrity: During a session, data cannot be either intentionally or unintentionally 
tampered with. 

 Securing data privacy: Data in transport between the client and the server must be protected from 
interception and be readable only by the intended recipient. 

These objectives are met by having the server and the client exchange “handshakes” through a series of 
protocols and mechanisms that establish a secure channel between the server and the authenticated 
client. This channel is established every time that the client connects to the server. 

Considerations 
As with so many other areas, the increased security of SSL comes with a price: the added security layer 
has a performance premium. It is important to consider the tradeoff between security and performance 
carefully. 

Performance 
Every time that an SSL-encrypted connection is established between the server and a client, the SSL 
mechanism is invoked to verify the authenticity of the client and encrypt the data that is transferred. The 
performance overhead of the encryption part is negligible at less than 1%; however, establishing the 
secure connection involves a certain amount of network traffic and thus takes time. 

For web clients, because of the nature of web protocols, a new connection is established and destroyed 
every time data is sent to or received from the client. Hence, a secure connection must be established 
every time, and that does carry a performance price. 

 
Attention: For more information, refer to the Deltek Maconomy Web Client Install Guide. 
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Set Up Server 

Setting up an Intermediary Proxy 
There are several types of traffic to proxy in the Maconomy 2.X server: 

 HTTP traffic 

 Workspaces RPC traffic over HTTP/WebSockets 

Maconomy always exposes HTTP traffic to publish the server handshake and other web services. 

The Workspaces RPC traffic is an interface that is specific to the Workspace Client, and it constitutes 
most of the communication between the Workspace Client and the Maconomy 2.X server. In earlier 
Maconomy versions, it was possible to set this up using a “raw” TCP listen port, but the only supported 
option now is HTTP/WebSockets via the web service endpoint ‘/workspaces-rpc’. 

HTTP and HTTP/WebSockets traffic only requires a standard HTTP proxy. HTTP proxies generally offer a 
large feature set (caching, compression, SSL termination, and so on). Well known HTTP proxy servers 
include: 

 The Apache HTTP server 

 nginx 

 Hardware proxies, such as F5 

 Cloud proxy services when Maconomy is deployed at a cloud hosting provider such as Amazon 

TCP proxies are less widely used because many of the reasons for deploying a proxy server depend on 
the specific TCP application. Things like caching, compression, and translation cannot be done uniformly 
across all TCP applications. It is, however, possible to offer SSL termination using a TCP proxy server. 
Known TCP proxy servers include: 

 tcptunnel (homepage) (GitHub) 

 stud (GitHub) 

 nginx_tcp_proxy_module (GitHub) 

 Hardware proxies, such as F5 

TCP Reverse Proxy – Example 
This section describes how to set up a TCP reverse proxy that forwards to a Maconomy 2.X server. This 
is useful for running a reverse proxy when the coupling service is configured to use TCP as its transport 
protocol. 

These examples use a reverse proxy machine and a Maconomy server machine. In this setup, these are 
separate machines, but they can also be the same machine. 

In this example, the reverse proxy server machine has the IP address 172.16.1.115, and the Maconomy 
server machine has the IP address 172.16.1.150. 

A client connects to the reverse proxy machine and connections are then forwarded to the Maconomy 
server machine. 

In these examples, the handshake is SSL-terminated on the proxy server machine using an HTTP proxy 
(nginx), but this is not required. 

https://httpd.apache.org/
http://nginx.org/
https://f5.com/
http://www.vakuumverpackt.de/tcptunnel/
https://github.com/vakuum/tcptunnel
https://github.com/bumptech/stud
https://github.com/yaoweibin/nginx_tcp_proxy_module
https://f5.com/
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Plain TCP Reverse Proxy 
A plain TCP forwarding proxy does nothing but forward TCP connections to another process or another 
machine. No SSL termination, caching, or similar actions are performed. 
Workspace            Reverse Proxy             Maconomy 

Client                                       2.X Server 

|                          |                          | 

|  HTTP                    |  HTTP                    | 

|  GET /handshake/1        |  GET /handshake/1        | 

|+------------------------>|+------------------------>| 

|<------------------------+|<------------------------+| 

|                          |                          | 

|  HTTP                    |  HTTP                    | 

|  POST /workspaces-rpc    |  POST /workspaces-rpc    | 

|+------------------------>|+------------------------>| 

|<------------------------+|<------------------------+| 

|                          |                          | 

This example uses tcptunnel (homepage) (GitHub). 

We run the program with the following parameters: 
./tcptunnel --local-port=18100 --remote-port=14495 --remote-host=172.16.1.150 --stay-
alive --bind-address=172.16.1.115 --fork 

In MConfig, set up the coupling service to use TCP with either no encryption or local encryption: 

http://www.vakuumverpackt.de/tcptunnel/
https://github.com/vakuum/tcptunnel
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SSL-Terminating TCP Reverse Proxy 
An SSL-terminating TCP reverse proxy provides encryption between the client and the proxy machine 
and forwards unencrypted data to the Maconomy server machine. 
Workspace            Reverse Proxy             Maconomy 

Client                                       2.X Server 

|                          |                          | 

|  HTTPS                   |  HTTP                    | 

|  GET /handshake/1        |  GET /handshake/1        | 

|+------------------------>|+------------------------>| 

|<------------------------+|<------------------------+| 

|                          |                          | 

|  HTTPS                   |  HTTP                    | 

|  POST /workspaces-rpc    |  POST /workspaces-rpc    | 

http://dev-collab/wiki/File:MConfig-TCP-Proxy-Configuration.png
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|+------------------------>|+------------------------>| 

|<------------------------+|<------------------------+| 

|                          |                          | 

This example uses stud (GitHub) 

Run the program with the following parameters: 
stud --ssl -b 172.16.1.150,18100 -f 172.16.1.115,14495 big.pem 

where big.pem is a PEM file that contains the server certificate and private key. This must be the same 
certificate and private key used in the HTTPS handshake. 

In this example, in MConfig the coupling service is set up to use TCP with proxy encryption: 

 

Setting Up Proxy SSL on Server 2.X 
To configure the proxy SSL, set the boolean web.proxy.encryption in settings.ini:  
web.proxy.encryption = true 

https://github.com/bumptech/stud
http://dev-collab/wiki/File:MConfig-TCP-SSL-Proxy-Configuration.png.png
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This configuration specifies that the proxy SSL should be used. 

HTTPS Certificate Checking 

 

Web Proxy Configuration 
See the Web-proxy / server configuration documentation for your particular Web-proxy / server product. 

Regardless of your Web-proxy product, you want to configure the following items: 

 The certificate private and public key certificate files (for example, the .crt and .key files). This is 
done in different ways depending on the particular Web-proxy / server product used. 

 The SSL / TLS version(s): The WSC only supports TLS version 1.2 in Maconomy 2.4. 

 The SSL / TLS cipher suite(s): The WSC supports the following cipher suites in Maconomy 2.4: 

 TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256 

 TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256 

 TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA256 

 TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256 

 The SSL / TLS compression option(s): As a general rule, disable TLS compression and a host of 
other settings specific to the Web-proxy / server product used. 

 
Example 

Apache: 

This is a basic but fully functional example of how to set up Apache as a HTTPS proxy for the CS. 

Listen 4000 

<VirtualHost *:4000> 

ServerAdmin admin@myserver.com 

ServerName myserver:4000 

Note: If the workspace client or Java Analyzer reports an error that explains that it is "certificate 
related," contact your system administrator for more information.  

Issues that are certificate-related could be anything related to certificates being out of date, 
certificates not suitable for the host name used, certificates that cannot be validated by the client or 
operating system, certificates revoked, and so on. 

Most certificate errors are not harmful and are caused by simple client or server setup issues, or 
administrative issues. However, it is possible that an error indicates a real security issue. Therefore, 
the best practice is to report any certificate-related issues to your system administrator, regardless of 
what you suspect the cause to be. 

Note: Ensure that you have procedures in place to renew the certificate(s) used; otherwise, 
access to the system will be denied when the certificate validity period expires. Additionally, 
make sure that you have procedures in place to revoke the certificate(s) in use if the (web)-
proxy server is breached and the certificate private key is stolen. 



Set Up Server 

System Admin Guide 47 

 

 

SSLEngine on 

SSLProxyEngine on 

 

SSLCertificateFile C:\webserver\certificate.crt 

SSLCertificateKeyFile C:\webserver\certificate.key 

 

############################################################################# 

# TLSv1.2 setup 

############################################################################# 

 

SSLProtocol -SSLv2 -SSLv3 -TLSv1 -TLSv1.1 +TLSv1.2 

SSLCipherSuite ECDHE-ECDSA-AES128-SHA:ECDHE-RSA-AES128-SHA:ECDHE-ECDSA-
AES128-SHA256:ECDHE-RSA-AES128-SHA256:!aNULL:!MD5 

SSLCipherSuite ECDHE-RSA-AES128-SHA256:!aNULL:!MD5 

 

SSLHonorCipherOrder on 

SSLCompression      off 

SSLSessionTickets   off 

############################################################################# 

# Proxy Setup 

############################################################################# 

 

ProxyPreserveHost On 

ProxyRequests off 

 

ProxyPass /workspaces-rpc "ws://localhost:5000/workspaces-rpc" retry=0 disablereuse=On 

ProxyPass "/" "http://localhost:5000/" retry=0 

 

<Proxy *:5000> 

Order deny,allow 

Allow from all 

</Proxy> 

</VirtualHost> 

IIS: 
<TODO> 
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 Host name / IP address checking: The workspace client in Maconomy 2.4 now checks the 
hostname and/or IP-address of the server address/hostname used against the certificate as part 
of the HTTPS certificate checks. This means that a certificate appropriate for the server address / 
hostname must be used. 

 Validity checking: The workspace client in Maconomy 2.4 now checks the validity of the server 
certificate as part of the HTTPS certificate checks. This means that a valid server certificate must 
be used at all times. 

 OCSP / CRL checking: The workspace client in Maconomy 2.4 now checks if the server 
certificate has been revoked as part of the HTTPS certificate checks. This check is only done if 
the certificate contains OCSP and/or CRL information. You can disable this check by editing the 
Maconomy.ini file of the workspace client and removing the following options: 
 -Dcom.sun.security.enableCRLDP=true 

 -Dcom.sun.net.ssl.checkRevocation=true 

The changed workspace client must then be distributed to the client machines. Disabling the 
OCSP/CRL checks is useful if the network performance impact of the OCSP/CRL checks is too 
high. 

 Distributing self-signed certificates to client machines: The workspace client uses the list of 
certificates from the personal OS certificate stores on Mac OS X, Mac OS, or Windows to 
determine trust. This implies that if the certificate used by a Maconomy system is a self-signed 
certificate which cannot be validated using the existing (root) certificates in the Mac OS X, Mac 
OS, or Windows certificate stores, then that certificate or its root issuer needs to be added to 
those. 
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Install Scalable Server 
Scalable Server enables you to set up multiple Maconomy application server nodes accessing the same 
database to increase performance and scalability. 

A Scalable Server setup consists of: 

 One Master Node 

 Several Replica Nodes 

Performing a Scalable Server installation involves installing Maconomy on the master node and 
replicating the setup to the replica nodes. These steps are all performed in MConfig. 

Before performing the setup using MConfig, there are several prerequisites that must be checked. 
Furthermore, each node in the setup must be prepared for the setup. These tasks are described in the 
following sections. 

Prerequisites 
A Maconomy Scalable Server installation requires all nodes to be more or less identical. This is 
necessary because the master node’s configuration is replicated across all replica nodes. This includes, 
for example: 

 Server 2.x (Coupling Service) configuration for number of server processes to launch 

 Server 2.x memory settings 

 File system paths to database client software 

 Installed Maconomy extensions 

It is therefore necessary to observe the following prerequisites: 

 All nodes must run the same operating system (OS). A mixed OS setup is not supported. 

 All nodes must have the same amount of memory (RAM) and disk space. 

After preparing the nodes for installation (see next section), the following should be observed: 

 The database client software is installed in the same paths on all nodes. 

 The user maconomy (Linux) or Maconomy (Windows) must have the same home directory on 
all nodes. 

Preparing the Nodes 
Each node (the master node as well as every replica) must be prepared as described in the following sub 
sections. 

The steps are: 

1. Create the Maconomy OS user (not necessary on master node). 

2. Install database client software. 

3. Install OpenSSH and rsync. 

4. Create SSH key pairs on the master node. 

5. Configure SSH for public key authentication on the replica nodes. 
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Handling Operating System (OS) Usernames When Creating a New 
Maconomy Node 
When creating a new node on a server, MConfig will attempt to connect using the 
maconomy@servername format by default. This can cause issues on Windows servers that are 
connected to a domain, as local user accounts are typically prefixed with the server name. As a result, 
MConfig may fail to connect using a local account unless specified correctly. 

For example, if there is a domain account named "Maconomy," MConfig can connect without issues. 
However, to connect to a local Maconomy account, MConfig must use the correct format as recognized 
by Cygwin, which is servername+Maconomy@servername. 

To address this issue, MConfig’s node creation screen now includes a field for the username. A validation 
check ensures that the entered username ends with "Maconomy." If the username does not meet this 
requirement, a warning message is displayed. 

Creating the Maconomy OS User 
Each node must have a Maconomy OS user. This user is used for running all Maconomy processes 
including installed services. 

 

Linux 
To create the Maconomy user on Linux, please follow these steps. 

 
Login as root and at the shell prompt type the following commands to create the Maconomy OS user:  

 
[root@slave ~] # export MACONOMY_HOME_DIR=/data/maconomy 

[root@slave ~] # useradd -d $MACONOMY_HOME_DIR -m -s /bin/csh maconomy [root@slave 
~]# passwd maconomy 

Changing password for user maconomy. New password: ******** 

Retype new password: ****** 

Note: A simple way to prepare all nodes is to prepare the master node (including creating the 
Maconomy OS user1) and then clone the master node into the desired number of replica nodes. This 
is particularly easy in a virtualized environment. 

Note: On the master node, the Maconomy OS user can be created automatically by MConfig. 
However, in order to use the master node as template to clone when setting up replica nodes, you 
must create the Maconomy OS user manually. 

MConfig automatically creates the Maconomy OS user on the master node, but you must manually 
create the user on all slave nodes. 

Note: It is assumed that the home directory of the Maconomy OS user is /data/maconomy. If you 
want another home directory, please change the value of the variable MACONOMY_HOME_DIR in 
the commands below. 

Note: The # sign and the preceding characters is the shell prompt shown when logged in as root and 
it should therefore not be typed. 
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passwd: all authentication tokens updated successfully. 

Next, create and set up the directory /usr/maconomy which is used to hold Maconomy configuration. 
[root@slave ~] # mkdir /usr/maconomy 

[root@slave ~] # chown maconomy:maconomy /usr/maconomy [root@slave ~] # chmod 700 
/usr/maconomy 

[root@slave ~] # touch /usr/maconomy/initmaconomy 

[root@slave ~] # chown maconomy:maconomy /usr/maconomy/initmaconomy [root@slave ~] 
# grep 1^mac:1 /etc/inittab > /dev/null || \ 

echo "mac:2345:wait:/usr/maconomy/initmaconomy > /dev/null" >> /etc/inittab 

Next, set up the Maconomy OS user’s custom login script. 
[root@slave ~] # cat << EOT > /usr/maconomy/maconomy.login alias ll "ls -l" 

alias h history set history=200 set filec=1 

set prompt="\$LOGNAME \! % " umask 022 

setenv PATH $MACONOMY_HOME_DIR/bin:\$PATH EOT 

Please make sure to enter all the lines beneath the command as well. They are not output from the 
command but input to the command. 

Finally, source the custom login script from the default login script. 

 
[root@slave ~] # echo "source /usr/maconomy/maconomy.login" >> ~maconomy/.login 

This completes setting up the Maconomy OS user on Linux. 

Windows 

To create the Maconomy user on Windows: 
1. Create a local user named Maconomy. 

2. Set a secure password for the user as this user will have administrator privileges. 

3. Set the user’s password to never expire. 

4. Add the user to the local group Administrators. 

5. Grant the user the Log on as a service privilege:  

a. Run Local Security Policy.  

b. Navigate to Security Settings » Local Policies » User Rights Assignment. 
c. Select Log on as a service and add the Maconomy user. 

6. Create the directory to be used as Maconomy Server Home (for example, C:\maconomy).  

This must match the directory used on the master node. 

7. Change the permissions on the directory granting the Maconomy user full access. 

8. Change the ownership of the directory to make it owned by the Maconomy user. 

Note: When sourcing a script from another script it is executed as if it was inlined in the other script. 



Install Scalable Server 

System Admin Guide 52 

 

Install Database Client Software 

 

Install OpenSSH and rsync 
A Maconomy Scalable Server setup uses Secure Shell (SSH) and rsync for replicating the initial setup 
and future changes from the master node to the replica nodes. 

SSH provides a secure encrypted channel for between nodes which allows MConfig on the master node 
to execute commands on the replica nodes. Furthermore, the rsync command provides efficient 
replication of files across the established SSH connection. 

On Linux, SSH and rsync are components that are installed with the operating system (OS). During OS 
install, please select to have an SSH server installed (named “SSH Server” or “sshd”). 

On Windows, SSH and rsync are components that are not provided by Microsoft. Deltek recommends 
using Cygwin to get these components installed. Please remember to update the OpenSSH package 
whenever an important update is released. 

Installing Cygwin on Windows 
1. Start the installation by downloading the Cygwin installer from this location: 

https://cygwin.com/setup-x86_64.exe 

2. Launch the installer.  

You can follow these steps or divert from them if your node or Internet connection requires you to 
do so. 

 
3. Select Install from Internet. 
4. Select C:\cygwin as Root Directory for Cygwin. 

5. Select Install for All Users. 

6. Select C:\Users\Maconomy\Downloads as Local Package Directory. 

7. Select Direct Connection as Internet connection. 

8. Choose a download site—preferably one close to your physical location.  

An HTTP-based mirror is preferred over FTP. 

You will now arrive at the package selection screen.  

To select OpenSSH for installation: 
1. Type “openssh” in the search field and locate the openssh: The OpenSSH server and client 

programs package under the Net category. 

2. Select the openssh package for installation by clicking Skip next to the package.  

The text will change to the version scheduled for installation. 

Attention: For details, refer to the Deltek Maconomy Install Guide. 

Note: This could be the case if you need to install to a different location and/or drive or if your 
Internet connection needs to go through a proxy. 

https://cygwin.com/setup-x86_64.exe
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To select rsync for installation: 
1. Type “rsync” in the search field and locate the rsync: Fast remote file transfer program 

package under the Net category. 

2. Select the rsync package for installation by clicking Skip next to the package.  

The text will change to the version scheduled for installation. 

To complete the Cygwin installation: 
1. Click Next on the package selection screen. 

2. Click Next on the Resolving Dependencies screen. 

The installer will now download and install the selected packages. 

3. Click Finish to complete the installation of Cygwin. 

Configuring the Cygwin OpenSSH server (sshd) on Windows 
After installing OpenSSH as part of Cygwin, the OpenSSH server needs to be configured on all replica 
nodes.  

 
If the Maconomy Extender is going to be used for deployments (which always go to the master node), 
OpenSSH server must also be configured on the master node. 

Please follow these steps: 

1. Open a Command Prompt that runs as Administrator (that is, with elevated privileges). 

2. Run the command C:\\cygwin\\bin\\bash 

You are now at the bash prompt. To install the OpenSSH server (sshd), run the command ssh-host-config 
and answer the questions as described below. Please note that most of the output has been cut out 
below. The cut-out parts have been replaced by the text <snip>. For a complete transcript of an ssh-host-
config session, please see Appendix X. 
$ ssh-host-config 

 
*** Info: Generating missing SSH host keys 

<snip> 

*** Query: Should StrictModes be used? (yes/no) yes 

<snip> 

*** Query: Should privilege separation be used? (yes/no) yes 

<snip> 

*** Query: new local account 1sshd1? (yes/no) yes 

<snip> 

*** Query: Do you want to install sshd as a service? 

*** Query: (Say "no" if it is already installed as a service) (yes/no) yes 

*** Query: Enter the value of CYGWIN for the daemon: [] 

<snip> 

*** Info: No privileged account could be found. 

 

Note: For details about setting up OpenSSH under Cygwin, please refer to the file 
/usr/share/doc/Cygwin/openssh.README, which can be located from the Cygwin bash prompt. 
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*** Info: This script plans to use 1cyg_server1. 

*** Info: 1cyg_server1 will only be used by registered services. 

 

*** Query: Do you want to use a different name? (yes/no) no 

*** Query: Create new privileged user account 1NODE\\cyg_server1 (Cygwin name: 1cyg_server1)? 
(yes/no) 

*** Info: Please enter a password for new user cyg_server. Please be sure 

*** Info: that this password matches the password rules given on your system. 

*** Info: Entering no password will exit the configuration. 

*** Query: Please enter the password: 

*** Query: Reenter: 

<snip> 

*** Info: Host configuration finished. Have fun! 

 

To allow SSH connections to the node, the Windows Firewall setting must be adjusted: 
1. Launch Windows Firewall with Advanced Security. 

2. In the left pane, select Inbound Rules. 

3. In the right pane under Actions, click New Rule. 

4. For the rule type, select Port and click Next. 
5. For Specific local ports, select TCP, enter 22, and click Next. 
6. Select Allow the connection and click Next. 
7. Select that the rule should apply only to Domain and Private networks and click Next. 

 
8. Enter sshd port 22 for the name and Firewall rule to allow inbound SSH connections. for the 

description of the new firewall rule.  

9. Click Finish to complete the new firewall rule. 

You can now start the OpenSSH Server service by issuing the command net start sshd at the Command 
Prompt (running as Administrator): 
C:\\>net start sshd 

The CYGWIN sshd service is starting. 

The CYGWIN sshd service was started successfully. 

Please verify that you can log into the node from another machine using password authentication. A 
successful login session could look like this: 
[maconomy@master ~] $ ssh Maconomy@replica  
Maconomy@node1s password:  
Maconomy@replica ~ 

$ exit # logout again  
[maconomy@other-node ~] $ 

This completes setting up the OpenSSH Server on Windows. You are now ready to configure SSH public 
key authentication which is necessary regardless of which OS is used. 

Note: This is the suggested setting, but it should be reviewed by the customer’s information 
security department and could depend on the concrete network topology. 
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Create SSH Key Pairs on the Master Node 
In order for MConfig to be able to log into the replica nodes from the master node with SSH using public 
key authentication, you need to create a key pair consisting of a private and a public key on the master 
node. The private keys are kept on the master node and are protected by passphrases8. The public keys 
are distributed to all replica nodes. 

MConfig needs both to connect as the Maconomy and the Administrator/root OS users on the replica 
nodes. To accomplish that, you generate two SSH key pairs on the master node: one for the Maconomy 
OS user and one for the root (Linux) / Administrator (Windows) OS user. 

 

Creating the SSH Key Pair for the Maconomy OS User 
To create an SSH keypair, use the ssh-keygen command from a bash shell logged in as the Maconomy 
OS user. Please note the parameters forcing the generation of a RSA key pair with a key length of 2048 
bits. You can choose a longer key length if you desire. 

Use the default location for the key pair which is in the .ssh folder in the home directory of the Maconomy 
OS user. 

Please select a strong passphrase as this is protecting the private key. 
[maconomy@master ~] $ ssh-keygen -t rsa -b2048 Generating public/private rsa key pair. 

Enter file in which to save the key (/home/maconomy/.ssh/id_rsa): Enter passphrase 
(empty for no passphrase): 

Enter same passphrase again: 

Your identification has been saved in /home/maconomy/.ssh/id_rsa. Your public key has 
been saved in /home/maconomy/.ssh/id_rsa.pub. The key fingerprint is: 
SHA256:buc55UDFnrTpsRyx0t7Qrhi+8ekmD0A5mC5B3ipjaDI maconomy@master The key1s randomart 
image is: 

+---[RSA 2048]----+ 

|    .     .    | 

|   o . o .  =  | 

|   o + +  = B  | 

| .  + . .o @ . | 

|E.+ o . S. = B | 

|oo o . . .o * o | 

|       o.+* .  | 

|      . o==+.  | 

|         +B=   | 

+----[SHA256]-----+ 

The key pair is now created and ready for use. 

Creating the SSH Key Pair for the Root OS User (Linux Only) 
If you are installing a system on Linux, please repeat the procedure from the previous section, but this 
time logged in as the root user on the master node. 

Configure SSH Public Key Authentication – Replica Nodes 
Configuring a replica node for public key authentication involves these steps: 

Note: Passphrase is just another word for a long password. 
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 Copy the SSH public key generated on the master to the replica 

 Verify public key authentication 

 Disable password authentication on replica 

Copying the SSH Public Key to the Replica Node – Maconomy User 
To copy the public key from the master node’s Maconomy account to the replica node’s Maconomy 
account, use the ssh-copy-id command. You need to enter the password of the Maconomy OS user on 
the replica to copy the SSH key. 
[maconomy@master ~] $ ssh-copy-id maconomy@replica 

/usr/local/bin/ssh-copy-id: INFO: attempting to log in with the new key(s), to filter 
out any that are 

/usr/local/bin/ssh-copy-id: INFO: 1 key(s) remain to be installed -- if you are 
prompted now it is to i 

maconomy@replica1s password: Number of key(s) added: 1 

Now try logging into the machine, with: "ssh 1maconomy@replica1" and check to make 
sure that only the key(s) you wanted were added. 

To verify that the key was copied properly to the replica node, log in. This should succeed without being 
asked for a password; however, you might be asked for the passphrase of the private key. 
[maconomy@master ~] $ ssh maconomy@replica 

Last login: Fri Dec 23 10:40:32 2016 from 192.168.1.2 

 

[maconomy@replica ~] $ exit # logout again Connection to maconomy@replica closed. 
[maconomy@master ~] $ 

Copying the SSH Public Key to the Replica Node – Root User (Linux Only)  
If you are installing a system on Linux, you now need to repeat these steps for the root user. Start by 
logging in as the root user on the master node. 

To copy the public key from the master node’s root account to the replica node’s root account, use the 
ssh-copy-id command. You need to enter the password of the root OS user on the replica to copy the 
SSH key. 
[root@master ~] # ssh-copy-id root@replica 

/usr/local/bin/ssh-copy-id: INFO: attempting to log in with the new key(s), to filter 
out any that are 

/usr/local/bin/ssh-copy-id: INFO: 1 key(s) remain to be installed -- if you are 
prompted now it is to i root@replica1s password: 

 

Number of key(s) added: 1 

 

Now try logging into the machine, with: "ssh 1root@replica1"  and check to make sure 
that only the key(s) you wanted were added. 

Please note that this command might fail if root logins are not allowed on the replica, which is often the 
case per default. In that case, you will need to copy the public key manually to the root user’s 
~/.ssh/authorized_keys file and observe that this file must have the permissions 0600. 

To verify that the key was copied properly to the replica node, log in. This should succeed without being 
asked for a password; however, you might be asked for the passphrase of the private key. 
[root@master ~] # ssh root@replica 

Last login: Fri Dec 23 10:42:42 2016 from 192.168.1.2 
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[root@replica ~] # exit Connection to root@replica closed. [root@master ~] # 

Disabling SSH Password Authentication 
You now disable password authentication on the replica to ensure that only public key authentication is 
allowed. Please edit this file. 

 /etc/ssh/sshd_config (Linux) 

 /etc/sshd_config (Windows/Cygwin) 

Find the commented out line #PasswordAuthentication yes, duplicate it, and modify the copy so the 
file contains these lines: 
#PasswordAuthentication yes PasswordAuthentication no 

Now, reload the SSH Server configuration. On Linux, run this command as:  
root: 

[root @master ~] # service sshd reload 

Reloading sshd: [ OK ] 

On Windows, run this command in bash started from a Command Prompt running as Administrator 
(elevated privileges): 
Maconomy@replica /cygdrive/c 

$ net stop sshd && net start sshd The CYGWIN sshd service is stopping. 

The CYGWIN sshd service was stopped successfully. 

 

The CYGWIN sshd service is starting. 

The CYGWIN sshd service was started successfully. 

Finally, you want to verify that password authentication is disabled. Do this by trying to log into the replica 
from the master using forced password authentication. The login attempt must fail like this: 
[maconomy@master ~] $ ssh -o PreferredAuthentications=password -o 
PubkeyAuthentication=no maconomy@repl Permission denied (publickey,keyboard-
interactive). 

This concludes configuring SSH public key authentication. 

Disabling Root Login on Slave Nodes after Installation (Linux Only) 
If for security reasons you do not want to allow root login to the slave nodes after the installation has been 
completed, you should edit this file: 

 /etc/ssh/sshd_config (Linux) 

Find an existing line containing PermitRootLogin and modify it or if not found add it so it reads: 
PermitRootLogin no 

Now, reload the SSH Server configuration by running this command as root:  
[root @master ~] # service sshd reload 

Reloading sshd: [ OK ] 
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Installing the Master Node 
The master node is installed using MConfig precisely as you would create a Maconomy Standard or PSO 
installation. 

When the installation is completed, continue to the next section. 

Set Up Nodes 
Use the Maconomy Server Node window to define new nodes for an application. Maconomy Server 
Nodes lists servers which will be synchronized for this application. Nodes can be added and deleted from 
the list. 

When adding a node, MConfig checks that you can establish an SSH connection to the node server as a 
user called Maconomy (maconomy on Unix).  

There are two ways to work with nodes: 

 Add new nodes to an existing application: Use the Synchronize node button to bring the node 
up to date and start Maconomy Daemon and Coupling Service. 

 Change the configuration of an application: All nodes are synchronized when changes are 
installed on the main Maconomy server. 

You can only add nodes with the same operating system as the main Maconomy server. 

Initial Setup 
You must create and install an application before it can be synchronized to other servers. After you create 
the application, you can then set up nodes.  

When first installing Maconomy, follow these steps to set up nodes: 

1. Configure the first server as usual, including the database, as described in Standard installation 
or PSO Installation in the Deltek Maconomy Install Guide. 

 
2. Add New Nodes as described below.  

3. Click Synchronize node.  

Adding New Nodes 
Use the steps below if you need to set up several new servers or install other configuration changes as 
well. 

To add new nodes: 
1. On the Application Instance window, click Maconomy Server Nodes. 

Note: You can set up nodes when creating an application before the actual installation. Then, 
nodes are synchronized when the application is installed. 
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2. On the Maconomy Server Nodes dialog box, click Add to set up a new node.  

 
3. On the Maconomy Server Node dialog box, enter a name and the IP address of the new node, 

and click OK. 

 
4. Add more nodes as needed, and click OK when done.  

Changing Configuration 
Use the steps below if you quickly need to set up a new server for an application. 

 

To change the configuration of nodes: 
1. On the Application Instance window, click Maconomy Server Nodes. 

Warning: Once you have created the nodes, MConfig will synchronize the Maconomy setup. Do not 
make manual changes in the configuration files on the node servers, as these will be lost in the 
synchronization. 
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2. In the Nodes description area of the Maconomy Server Nodes dialog box, click Delete if a node 

must be deleted and/or click Add if a new node must be created.  

3. If you added a node, enter the node name and IP address, and click Synchronize node. 

 
4. Click OK.  
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Silent Sign-In 
This section describes Silent Sign In, which uses Maconomy as an external verifier for Business Objects. 
When Silent Sign In is configured, report request tickets are created and stored in the Maconomy system 
and passed to a Business Objects Silent Sign In component. The Silent Sign In component subsequently 
validates the ticket against Maconomy, and on successful validation executes the report. 

Trusted Authentication with Workspace Client 
This section describes how to set up Trusted Authentication for use by the Coupling Service and 
Workspace Client. 

The configuration steps include setting up the server and client, which in the case of the Silent Sign In 
servlet component are on the same server (the BO server). 

The following steps provide an example of how to configure Trusted Authentication, which is based on the 
BO Enterprise Administrator’s Guide found here: 

http://help.sap.com/businessobject/product_guides/sbo41/en/sbo41sp7_bip_admin_en.pdf 

To set up Trusted Authentication for use by the Coupling Service and Workspace Client: 
1. On the BO server, log in to the Central Management Console (CMC) with administrative rights. 

2. Go to the Authentication management area of the CMC. 

3. Click the Enterprise tab and scroll down to the Trusted Authentication section. 

4. Under Trusted Authentication: 

a. Click Trusted Authentication is enabled. 

b. Click New Shared Secret. 
c. Click Download Shared Secret. 
d. On the File Download dialog box, click Save and save the TrustedPrincipal.conf file to: 

<INSTALLDIR>\SAP BusinessObjects Enterprise XI 4.0\win32_x86\ 

 
e. Enter the number of days for the Shared Secret Validation Period and timeout for the Trusted 

Authentication request.  

The recommendation is 1 day and 10000 milliseconds but refer to the BO manual for details. 

5. Click Update to save the settings. 

Next, you must enable Trusted Authentication on the Coupling Service. This is done by updating the 
OSGi settings in MConfig. A checkmark here enables Trusted Authentication, and then you must enter 
the Password from the preceding list. 

Note: There is a chance the generated Shared Secret is too long that it causes an 
unnecessary line break. If this happens, generate a new Shared Secret. 

http://help.sap.com/businessobject/product_guides/boexir31/en/xi3-1_bip_admin_en.pdf
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Single Sign-On 
The Single Sign On (SSO) add‐on to Maconomy allows users to use an external authentication provider 
when logging into Maconomy. The list of supported identity providers includes Microsoft Active Directory 
and Microsoft Azure as well as other OpenID Connect (OIDC)-capable authentication providers, such as 
OneLogin and Okta. With SSO enabled, the Maconomy Clients will either log in automatically, or show a 
vendor-specific login screen when started. 

SSO can be set up in two ways: name matching or name mapping. With name matching, a check is 
performed to see if the user’s network username matches the login name of an existing user in 
Maconomy. If the login name exists, the user is logged in automatically. With name mapping, the user’s 
network username and domain are checked against the configured network usernames and domain 
entries in the Maconomy database. If a user with a matching network username and domain exists in 
Maconomy, the user is logged in automatically. 

If an error occurs (for example, if the domain is invalid or if the users are blocked or does not exist), the 
user is directed to the standard Maconomy login screen, where they must enter their Maconomy 
username and password. 

Configuration 
The Maconomy server must also be configured to use SSO. This is done in MConfig, on the OSGi 
product configuration screen for the Maconomy application you want to configure. In the Domain login 
method dropdown, select the login method relevant for your scenario: 

 Kerberos account login: SSO against Microsoft Active Directory where you directly specify the 
account credentials for the Service Principal Name (SPN) 

 Kerberos keytab file: SSO against Microsoft Active Directory using a Java keytab file to store 
the account credentials for the SPN 

 Azure OpenID: SSO using an OIDC application defined in Microsoft Azure 
 Generic OIDC: SSO using a different OIDC authentication provider 
 OneLogin and Okta: Supported OIDC authentication providers 

After this, you are presented with the method-specific settings that must be configured for each login 
method. 

Add‐On Number 
To use SSO, the installation must be updated with an installation number and add‐on set number 79. 

Background Task Administrator User 
The Background Task Administrator user is a default user added in Access Control » Users workspace, 
designed specifically to manage and perform background tasks effectively. This user has full access 
across the system, restricted only by specific employee field permissions and access level. The 
Maconomy Password Block checkbox is selected for this user, and you cannot log in to the web client 
as a Background Task Administrator user. Additionally, this user is excluded from the Maconomy users 
license count. 
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Blocked and Expired Accounts 
A blocked user account is one that is either outside its validity period (expired or not yet activated) or has 
been manually blocked by an administrator through the User Blocked checkbox. When the User 
Blocked checkbox is selected, the user is prohibited from logging in or reconnecting to Maconomy, 
whether through SSO login or Maconomy Password. Note that administrator accounts cannot be blocked, 
and users do not have the ability to block themselves. 

Handling Login Attempts with Incorrect Password 
When users enter an incorrect password three times consecutively, their accounts are temporarily 
blocked from performing password logins. This temporary block uses an exponential growth algorithm to 
determine the duration of the block. 

The Maconomy Password Blocked field is used to completely prevent login attempts using the 
Maconomy password. When the password is blocked, all related functionalities, such as changing the 
password and resetting it with 'Forgot my password,' are also blocked. This does not affect login methods 
that do not involve the Maconomy password, such as Active Directory Domain Login, Open ID Connect 
(OIDC), and Privileged Login method used by the Background Task framework. 

The generic error message for failed login attempts includes the possibility of temporary blocking due to 
multiple failed login attempts. 

You can use the Maconomy Password Blocked field to enforce SSO authentication, and the new User 
Blocked field to completely block a user, regardless of the authentication method. 

Single Sign-On with Kerberos 
The Single Sign-On (SSO) add‐on to Maconomy allows users to use their local domain credentials to log 
into Maconomy. If the user is running the Maconomy client on a domain-joined computer, the login can 
normally be performed automatically; otherwise, the user will be prompted to enter the network username 
and password that is associated with the user’s Maconomy account. 

System Overview 
This implementation of SSO is based on the Kerberos security protocol. 

“Kerberos is a distributed authentication service that allows a process (a client) running on behalf of a 
principal (a user) to prove its identity to a verifier (an application server, or just server) without sending 
data across the network that might allow an attacker or the verifier to subsequently impersonate the 
principal. Kerberos optionally provides integrity and confidentiality for data sent between the client 
and server.”1 

Kerberos was developed by the Massachusetts Institute of Technology (MIT). Maconomy uses the Java 
GSS-API (Generic Security Services API) to decode and consume Kerberos tickets produced by any 
compatible Kerberos‐based authentication provider. This includes Microsoft Active Directory for the PC 

 
1 B. Clifford Neuman,Theodore Ts’o: “Kerberos: An Authentication Service for Computer Networks.” See for example 
http://www.isi.edu/gost/publications/kerberos‐neuman‐tso.html 

Warning: The default Background Task Administrator will overwrite any customer user with the same 
name. If a customer does not want to use the default Background Task Administrator user, the 
customer must create a new Admin user with a different name to manage background tasks. 
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and Mac platforms supported by Maconomy. The Workspace Client on Microsoft Windows also supports 
the native Windows SSPI library for a more seamless SSO experience. 

Kerberos works by providing principals (users or services) with: 

 Tickets that principals can use to identify themselves to other principals 

 Secret cryptographic keys for secure communication with other principals. 

A ticket is a sequence of a few hundred bytes. Kerberos provides for mutual authentication and secure 
communication between principals on an open network by manufacturing secret keys for any requestor 
and providing a mechanism for these secret keys to be safely sent through the network. 

As mentioned previously, Maconomy implements the Kerberos functionality through a device called the 
GSS‐API. The following diagram illustrates Maconomy’s Kerberos implementation. 

 
The initial communication (1 in the preceding diagram) from the Maconomy client to the Maconomy server 
is established through a sequence of communications between the GSS-API, Kerberos, the operating 
system (or Microsoft Active Directory or similar), and the Maconomy server. Through a system of tickets 
and encrypted security keys, Kerberos verifies that the Maconomy client is indeed the user that it claims 
to be, and that it is safe for the Maconomy server to establish communication with the client. After this 
initial handshake, the server and client can communicate using Maconomy’s network transport protocols 
without involving Kerberos (2 in the preceding diagram). 

Setup Instructions 
For a Maconomy client to be verified by Kerberos, a Maconomy service must be registered as a Kerberos 
service. This means that a specific network user account should be assigned to Maconomy (for example, 
the maconomy user) and a Maconomy service should be registered to this account (making it a service 
account). For Maconomy to authenticate users, it must be logged in to this account. The login information 
is configured in the SSO configuration in MConfig, either directly or through a Java keystore file. 

In addition, clients that connect to the server must know the name of the service and have information 
about the Kerberos realm (domain) that they want to log in to. This is also configured in the SSO 
configuration in MConfig. In the Domain login method field, select Kerberos account login or 
Kerberos keytab file. 

If you select Kerberos account login, the following fields display: 
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If you select Kerberos keytab file, instead of the two Kerberos Account fields you will see: 

 
 SSO method: namemapping or namematch. See the description in the Single Sign-On section 

above. 

 Kerberos Realm: This is the name of the realm (domain) under which the Maconomy service has 
been registered. For example: 
example.com 

 Kerberos KDC: This is the network name or IP address of the Kerberos KDC (Key Distribution 
Center). 

 Kerberos SPN: This is the name of the service Maconomy that has been registered as the 
authenticator. For example: 
Maconomy/test.example.com 

 Additional realms: For multi-realm authentication to work, this property must be set to contain a 
list of all the realms from which SSO should be possible, along with either the network name or 
the IP address of the associated KDC. If all SSO users reside on the same realm as the 
Maconomy service, this property does not have to be defined. 

In a multi-realm setup, all the realms (domains) must be configured with a direct two-way trust 
relationship to the primary realm (the one that hosts the Maconomy service). It must be possible 
for the clients to “jump” directly from the local realm to the primary realm using the local Ticket 
Granting Ticket. 

For an Active Directory domain forest, a two-way trust is automatically established between each 
domain and its parent domain, but for other installations it can be necessary to establish the 
necessary trust relationship explicitly. See the documentation for the Kerberos installation that 
you are using for additional information. 

 Kerberos Account Username: This is the account name of the service account associated with 
the Kerberos SPN. 

 Kerberos Account Password: This is the password for the service account. 

 Kerberos KeyTab file: This is a Java keytab file containing the encrypted password for the 
service account. See the documentation for the Java ktab tool for details: 

https://docs.oracle.com/javase/8/docs/technotes/tools/windows/ktab.html 

Browser Setup 
Maconomy web clients use the SPNEGO protocol to perform Kerberos SSO. The SPNEGO protocol will 
try to negotiate an authentication context between the server and the browser which satisfies the security 

https://docs.oracle.com/javase/8/docs/technotes/tools/windows/ktab.html
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requirements of both sides. Usually this works seamlessly, but in some scenarios the browser might be 
unable or unwilling to fulfill the security requirements of the server. In such cases, you can try to follow the 
steps below to manually set up your browser to perform Kerberos-based SPNEGO SSO. 

Browser Setup for Internet Explorer, Edge, and Chrome 
For Internet Explorer (IE), Microsoft Edge, and Google Chrome, you may need to add the Maconomy 
webserver address to the Local intranet zone, as Windows might not permit Kerberos-based SPNEGO 
SSO for untrusted websites. 

 

Browser Setup for Firefox on Windows and Mac OS X 
For Firefox, you may need to set the network.negotiate-auth.trusted-uris property in the about:config 
page of FireFox. 

To set the network.negotiate-auth.trusted-uris property: 
1. Open the about:config page, and accept the warning that displays. 

2. Use the Search field to find the network.negotiate-auth.trusted-uris property.  

3. Double-click network.negotiate-auth.trusted-uris. 

4. In the editor window that displays, enter a comma-separated list of http:// URLs, and click OK to 
accept the changes. 

5. Close the about:config page. 

Macintosh Setup 
The Maconomy Workspace Client can run with Kerberos SSO on Macintosh computers that run OS X 
10.4 (Tiger).  

 

Single Sign-On with OneLogin 
The third-party vendor OneLogin is supported by Maconomy. It offers a cloud-based identity and access 
management system that works across all Maconomy user interfaces, for both cloud and on-premises 
deployments. 

To set up OneLogin, you must: 
 Configure OneLogin 

 Configure Maconomy 

Attention: More details on using SPNEGO SSO in Internet Explorer are available in the “Client 
Side—Internet Explorer” section of the following Microsoft article: 

https://msdn.microsoft.com/en-us/library/ms995329.aspx 

Attention: For more information about setting up Kerberos SSO on a Macintosh, see 
http://web.mit.edu/macdev/KfM/Common/Documentation/preferences-osx.html. 

https://msdn.microsoft.com/en-us/library/ms995329.aspx
http://web.mit.edu/macdev/KfM/Common/Documentation/preferences-osx.html
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Setup Instructions 
This login module is disabled by default. Once enabled, OneLogin is deployed across all interfaces. 

To configure the Maconomy generic OIDC login module with OneLogin as the authentication provider, 
perform the following procedures. 

Sign Up for a OneLogin Account 
If your company does not already have a OneLogin account, go to https://www.onelogin.com/ for 
information on free trials, package pricing, and support documentation. 

Configure OneLogin 

Create a OneLogin OIDC Application 

To create a OneLogin OIDC application: 
1. Log in to your OneLogin account (<account-name>.onelogin.com).  

2. Click Administration to access your administration dashboard (<account-
name>.onelogin.com/admin). 

3. Click APPS » ADD APP. 

4. Search for OIDC, and select OpenID Connect (OIDC). 
5. If this is your first OIDC app, leave all values at default. 

6. Click Save. 

7. Click the SSO tab. 

8. Copy your Client ID and Client Secret into a text document. 

9. From the Token Endpoint dropdown list, select POST. 

10. Click Save. 

Configure a Client Redirect URI 

To configure a Client Redirect URI: 
1. Go to the OIDC app page. 

2. Click Configuration. 

3. In the Redirect URIs field, enter the URI of the page that will receive the OIDC access token.  

It can take up to five minutes before you can use the new redirect URI.  

https://www.onelogin.com/
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Configure Maconomy 

To enable the OIDC login module and link OneLogin users to Maconomy users:  
1. In MConfig, go to the OSGi Products window. 

2. In the Domain login method field, select Generic OIDC. 

Once you select this option, the following fields display: 

 
 

 
3. Fill out these fields.  

Except for Extra Parameters, all fields are mandatory. 

 SSO method: Select one of two options: namematch or namemapping.  

 OIDC Metadata URL: Enter the following value: https://{account-
name}.onelogin.com/oidc/2/.well-known/openid-configuration. 

Note:  
 http:// URIs are only permitted for localhost for test purposes. If you need to test 

OneLogin on a Maconomy installation hosted on a different machine, you must 
configure a TLS proxy for it. 

 Do not end specified redirect URIs with a forward slash (/). 

  If you disable the external browser option, use the following URI instead: 
https://<webserver-host-and-root-path>/blank or http://<webserver-host-and-
root-path>/blank. 

Note: MConfig automatically populates some of the fields with default values. Edit these if 
needed.  
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 Default Redirect URL: Select one of two options: http://localhost/ or http://127.0.0.1/ 
(recommended).  

 Extra Parameters: Skip this field. You do not need to specify any parameters for OneLogin.  

 Client ID: Specify your OIDC client ID.  

 Client Secret: Specify your OIDC client secret.  

 Port range: Specify a port range.  

 
 Accept the default values provided for the rest of the fields. 

 
4. Click OK to save your changes. 

5. In the succeeding dialog boxes that display, click OK or Next (whichever applies) to install your 
changes.  

6. In the Workspace Client, go to the workspace that exposes the User Role Information container 
(for example, the Users workspace). 

7. Link OneLogin users to Maconomy users.  

This depends on the value you selected for the SSO method field in the OSGi Products window 
of MConfig. 

 If you specified namematch, make sure the names of your OneLogin users and the names of 
your Maconomy users match. 

 If you specified namemapping, enter the user principal name (UPN) or email address 
components of your OneLogin users (‘user@domain’) as Network Username and Domain 
Name in Maconomy. 

Single Sign-On with Okta 
Okta is an OIDC authentication provider. It offers a cloud-based identity and access management system 
that works across all Maconomy user interfaces, for both cloud and on-premises deployments. 

To set up Okta, you must: 
 Configure Okta 

Note: You also need to add the ports in the port range to the OneLogin setup page as 
follows: 

http://localhost:<port1>/... 

http://localhost:<port2>/... 

… 

http://localhost:<portN>/.. 

Note: Customers on Enterprise Cloud who want to activate OneLogin will need to send this 
information to Deltek Cloud Operations via a support case.  

http://localhost/
http://127.0.0.1/
http://localhost:%3Cport1%3E
http://localhost:%3cport2%3e/
http://localhost:%3Cportn%3E
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 Configure Maconomy 

Setup Instructions 
This login module is disabled by default. Once enabled, Okta deploys across all interfaces. 

To configure the Maconomy generic OIDC login module with Okta as the authentication provider, perform 
the following procedures. 

Sign Up for an Okta Account 
If your company does not already have an Okta account, go to https://www.okta.com for information on 
free trials, package pricing, and support documentation. 

Configure Okta 

Create an Okta OIDC Application 

To create an Okta OIDC application: 
1. Log in to your Okta account ({account-name}.okta.com). 

2. Click Applications in your developer console (https://{account-name}.okta.com/dev/console). 

3. Click Add Application, select Web, and click Next. 
4. Enter the host and port of the Maconomy system in the Base URIs field. 

5. Enter the redirect URIs for each of your client interfaces (WSC, web client, Touch).  

For the WSC, this is: https://{host}:{port}/blank 

6. Ensure Allowed grant type is set to Authorization code. 

7. Click Create. 

Configure a Client Redirect URI 

To configure a Client Redirect URI: 
1. Go to the OIDC app page. 

2. Click Configuration. 

3. In the Redirect URIs field, enter the URI of the page that will receive the OIDC access token.  

It can take up to five minutes before you can use the new redirect URI.  

 

Note:  
 http:// URIs are only permitted for localhost for test purposes. If you need to test 

Okta on a Maconomy installation hosted on a different machine, you have to 
configure a TLS proxy for it. 

 Do not end specified redirect URIs with a forward slash (/). 
 If you disable the external browser option, use the following URI instead: 

https://{host-name}:{port}/blank or http://localhost:{port}/blank. 

https://www.okta.com/
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Configure Maconomy 

To enable the OIDC login module and link Okta users to Maconomy users:  
1. In MConfig, go to the OSGi Products window. 

2. In the Domain login method field, select Generic OIDC. 

After you select this option, the following fields display: 

 
 

 
3. Fill out these mandatory fields.  

 SSO method: Select one of two options: namematch or namemapping.  

 OIDC Metadata URL: Enter the following value: https://{account-name}.okta.com/.well-
known/openid-configuration. 

 Scope: If needed, update the value to openid, email. 
 Default Redirect URL: Select one of two options: http://localhost/ or http://127.0.0.1/ 

(recommended). 

 Extra Parameters: Set the parameters nonce,state. The OIDC login module in the Coupling 
Service assigns them a unique ID and UUID, respectively.   

 Client ID: Specify your OIDC client ID.  

 Client Secret: Specify your OIDC client secret.  

 Port range: Specify a port range.  

Note: MConfig automatically fills out some of the fields with default values. Edit these if 
needed.  

http://localhost/
http://127.0.0.1/
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 Accept the default values provided for the rest of the fields. 

 
4. Click OK to save your changes. 

5. In the succeeding dialog boxes that display, click OK or Next (whichever applies) to install your 
changes.  

6. In the Workspace Client, go to the workspace that exposes the User Role Information container 
(for example, the Users workspace). 

7. Link Okta users to Maconomy users.  

This depends on the value you selected for the SSO method field in the OSGi Products window 
of MConfig. 

 If you specified namematch, make sure the names of your Okta users and the names of your 
Maconomy users match. 

 If you specified namemapping, enter the user principal name (UPN) or email address 
components of your OneLogin users (user@domain) as Network Username and Domain 
Name in Maconomy. 

Generic Support for Third-Party SSO Vendors Using OAuth 
2.0 OIDC 
Maconomy offers the capability for you to integrate with other third-party SSO vendor solutions that use 
the OAuth 2.0 OIDC protocol.  

Note that there are no plans to support vendors using the older OAuth 2.0 protocol, except when an SSO 
vendor implements OAuth 2.0 as a compatible subset of their OIDC offering. In such cases, Maconomy 
may be able to consume OAuth 2.0 Bearer tokens issued by the SSO vendor, in addition to the 
authorization code credentials issued by the OIDC protocol.  

 

Note: You also need to add the ports in the port range to the Okta setup page as follows: 

http://localhost:<port1>... 

http://localhost:<port2>... 

… 

http://localhost:<portN>.. 

Note: Customers on Enterprise Cloud who want to activate Okta will need to send this 
information to Deltek Cloud Operations via a support case.  

Attention: For more information on this, see the section on OAuth 2.0 Bearer tokens further down. 

http://localhost:%3Cport1%3E
http://localhost:%3cport2%3e/
http://localhost:%3Cportn%3E
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Limitations 
At present, this generic login support is only applicable to the Workspace Client and the web client. It 
does not include Touch, whose user interface requires tailoring to each authentication provider. It also 
does not include Enterprise Cloud, which only supports the Azure, OneLogin, and Okta authentification 
providers.  

 

Setup Instructions 

Configure Maconomy 

To enable the OIDC login module:  
1. In MConfig, go to the OSGi Products window. 

2. In the Domain login method field, select Generic OIDC. 

After you select this option, the following fields display: 

 
 

 
3. Fill out the following fields.  

 

Note: While this generic login solution has been successfully tested with multiple third-party SSO 
vendors, there are no guarantees that other vendors out of the vast array that exist will not have 
additional requirements that are not supported at present.  

Note: MConfig automatically fills out some of the fields with default values. Edit these if 
needed.  

Note: Except for Extra Parameters, all fields are mandatory. 
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 SSO method:Select one of two options: namematch or namemapping. 

 OIDC Metadata URL: Specify the metadata URL from which you want to obtain the OIDC 
provider configuration.   

 User Identity: Enter the prioritized list of JSON Web Token (JWT) claims from which the 
OIDC login module will extract the user identity. Suggested values are: 

 preferred_username,name (if you specified namematch as the SSO method) 

 upn,email (if you specified namemapping as the SSO method) 
 Scope: Enter a comma-separated list of scope values to which the OIDC login module will 

request access.  

 Interactive Prompt: Enter the OIDC prompt value to use when initiating an interactive login. 
You can combine any of the standard OIDC 1.0 prompts. 

 Default Redirect URL: Select the default redirect URL to use for native clients (for example, 
the Workspace Client). Choose one of two options: http://localhost/ or http://127.0.0.1/ 
(recommended). 

 Extra Parameters: Fill out this field if needed. 

For example, you could specify a list of key=value assignments for inclusion in the 
authorization request. If you specify the nonce and state parameter keys without a value, the 
OIDC login module in the Coupling Service assigns them a unique ID and UUID, respectively. 

If you want to generate such IDs for other parameter keys, set the relevant key’s value to $id 
or $uuid. If a key starts with a plus sign, the OIDC login module appends the ID value to the 
existing value for the key. If a key starts with a minus sign, the OIDC login module removes 
the key from the authorization request. 

 
 Client ID: Specify your OIDC client ID. 

 Client Secret: Specify your OIDC client secret. 

 Port range: Specify a port range.  

4. Click OK to save your changes. 

5. In the succeeding dialog boxes that display, click OK or Next (whichever applies) to install your 
changes.  

OAuth 2.0 Bearer Tokens 
The OIDC protocol is designed to provide end-users with a flexible and integrated authentication 
experience. It is generally not suited for other authentication scenarios, such as scripted logins and 
integrations, where the security requirements might instead involve application access tokens, or even 
certificate-based authentication to entirely avoid having to store clear text credentials. 

For such use cases, the basic OAuth 2.0 protocol still serves a purpose. If the external SSO vendor offers 
an authentication endpoint through which a client can obtain an OAuth 2.0 Bearer token, the Maconomy 
RESTful API accepts this token when submitted in a Bearer Authorization header and passes it to the 
Maconomy OIDC login module for validation. If the token is a well-formed and signed JSON Web Token 
(JWT), the login module inspects the JWT for one of the user claims configured in the User Identity field 
in the Generic OIDC configuration. If a matching user claim is found, the login module looks for a 
Maconomy user with a matching Login Name or Network Username and Domain. 

Attention: For more information about which parameter values you should include, refer 
to the OAuth 2.0 OIDC documentation of the authentication provider. 

http://localhost/
http://127.0.0.1/
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Note: It might be necessary to edit the User Identity field in the Generic OIDC configuration to 
include the user claim that contains the caller’s identity in the OAuth 2.0 Bearer Token. 
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Set Up Passwords 
Maconomy systems are often installed with one customer only in an installation. A customer may have 
multiple companies in the same Maconomy instance, all adding up to a consolidated group statement. 
This is supported by Maconomy, using the multi-company features. 

To ensure a secure system for custom implementation, MConfig auto-generates a password for the 
Administrator user and displays that at the end of the installation process. The initial password is 
composed of six random characters. 

Password Requirements 
Maconomy enforces password length over complexity. Note that no specific combination of characters is 
required. 

Following are new password guidelines.  

Password may contain: 
 Up to 30 characters 

 ASCII characters (a..z) (A..Z) and digits (0..9)  

 Special characters: ? * # / _ [ ] { } + - : . ~ 

Password may not contain: 
 More than 30 characters 

 Blank spaces  

 Empty password  

 A username  

 National characters, such as the Danish æ, ø, and å 

 

Reset Password 
The Workspace Client features an integrated password reset process through which a user can reset a 
forgotten password without having to contact the local Maconomy administrator. 

Before You Begin 
The password reset process is based on temporary authentication tokens sent to the user via email. 
Before you begin, ensure that a valid email address is specified for each user on the Employees pane. 

Set Up Password Reset 
To enable the password reset functionality in the Workspace Client for employees, administrators must 
complete the following steps to configure the system appropriately. 

To enable password reset: 
1. Select the Enable Reset Password field on the OSGi products page in MConfig. 

Note: There is currently no minimum password length. 
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2. Configure the MailPortAndServer system parameter in the Maconomy application with the 
SMTP server name and port number to use for sending emails. 

3. Ensure that all relevant users have valid email addresses specified in the E-mail field, located 
under Contact Information on their Employee card. 

Use Password Reset 

To use the password reset process: 
1. Click the Forgot password? link in the Workspace Client login window. 

2. Enter your Maconomy username. 

A temporary authentication token is generated and sent via email to the email address specified 
on your Employees card. The Workspace Client then prompts you to enter the token you received 
via email. 

3. Enter the token at the prompt.  

If the token is valid, a Reset Password dialog box displays. 

4. Enter and verify a new password.  

After a new valid password is entered and confirmed, you are automatically logged into the 
Workspace Client. 
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Two-Factor Authentication (2FA) 
It is a Deltek-wide initiative to implement Two-Factor Authentication (2FA) in all Maconomy interfaces. 
Using 2FA reduces identity and access management risks for users. The Maconomy 2FA system 
provides an additional layer of authentication on top of the existing authentication mechanisms in order to 
decrease the risk of unauthorized access in the case where a user’s credentials have been compromised. 

The system is based on the standard Time-Based One-Time Password algorithm (TOTP) and is 
compatible with a range of smart device apps designed for this purpose, including but not limited to Duo 
Mobile, Google Authenticator, and Microsoft Authenticator. Push-based authentication is currently not 
supported. 

 

Maconomy 2FA Implementation 
This section provides basic details on how a Maconomy user uses two-factor authentication to access 
Maconomy. The details and steps of the process vary slightly depending on the authenticator tool and the 
operating system you use. However, the main steps and interaction points are consistent across apps. 

Some popular authentication apps include:  

 Duo Mobile 

 Google Authenticator 

 Microsoft Authenticator 

Process Summary 
The first time you log in to Maconomy, you are asked to enroll a smart device app in the 2FA system by 
scanning a QR code. After the code has been scanned, the app is able to generate one-time passwords 
which consist of six digits and are valid for a limited period, typically 30 seconds. A one-time password 
must be provided by the user whenever the user’s primary login credentials are required by the system. 
This works to prove that the user is in possession of the device on which the app is installed. 

2FA Process Diagram 
The following diagram represents the enrollment, login, and code generation processes. 

Warning: The web client and Touch do not support the combination of Maconomy 2FA and Azure. 
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2FA Enrollment and Reconfiguration 
The Maconomy 2FA login module allows users to reconfigure their 2FA device.  

To allow enrollment and reconfiguration: 
1. Ensure the following are enabled in MConfig’s OSGi product configuration: 

 2FA account reset: Enabled with the Allow users to reconfigured their 2FA device option.  

 Reset password: Select Enable “Reset password” checkbox to enable.  

If enabled, the Maconomy 2FA login module supplies a temporary access token to allow users to 
reconfigure their 2FA device. The token is sent by email to the email address stored in the user’s 
employee information. For added security in Maconomy 2.5.3 forward, users are also required to supply 
an access token sent by email to enroll their 2FA device for the first time. 
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To disable this feature: 
If you want to disable this security measure which requires users to supply an access token when they 
initially enroll their 2FA device, manually update the Maconomy 2FA login module parameter 
accountResetToEnroll to false. 

 

2FA Bypass Token 
From a usability standpoint, it is not desirable to force the user to go through the Two-Factor 
Authentication process on every login. Once a user has proven ownership of a device by performing a 
successful 2FA login, it is not unreasonable to treat the device itself as a trusted second factor. 

A device is trusted if it is in possession of a valid 2FA Bypass Token. This token is only returned to the 
device after a successful login involving Two-Factor Authentication has been completed. This token can 
then preemptively be included in subsequent login requests as a way to bypass any 2FA requirements for 
the user. 

The 2FA Bypass Token is only valid for a specific Maconomy 2FA account, and for a server configured 
bypass period. When a valid 2FA Bypass Token is received by the server, it returns an updated token 
with an extended bypass period. 

By default, 2FA Bypass Tokens are enabled for the Maconomy 2FA login module with a bypass period of 
30 days. Bypass tokens are currently supported for the web client and Touch but not for the Workspace 
Client. 

Authentication Keys 
To provide fine-grained control over the behavior of the Maconomy TOTP login module, Deltek introduced 
the concept of authentication keys. These keys are set by the other Maconomy-related login modules or 
by the login framework itself. 

An authentication key is an assertion that a specific condition was met during the login process. For 
example, the CloudMFA key indicates that a Cloud-based login with Multi-Factor Authentication (MFA) 
was performed, while the WebLogin key is set if the login process was started from the Maconomy web 
interface (REST API). 

By including some of these authentication keys in the skipIf option list, you can control the circumstances 
under which 2FA should be skipped. The full list of supported authentication keys is shown in the 
following table. 

Authentication Key Description 

Maconomy2FA The login included Maconomy 2FA, or validation of a 2FA-bypass token 

CloudLogin A cloud login was performed 

CloudMFA A cloud login including MFA was performed 

DomainSSO A domain single sign-on was performed 

Warning: When accountResetToEnroll is enabled, only users with a valid email address in their 
employee information can enroll in 2FA and gain access to Maconomy. Users without an email 
address are disqualified from 2FA and must either use a login method which is skipped by the 2FA 
login module, or be assigned a 0 (zero) 2FA account, as described in the section 2FA Administration 
and Management below. 
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Authentication Key Description 

PasswordLogin A conventional password-login was performed 

ReconnectLogin A reconnect to an existing (but expired) login session was performed 

WebLogin A web interface (REST API) login was performed 

WSCLogin A Workspace Client login was performed 

By default, 2FA is skipped for CloudMFA, DomainSSO, and ReconnectLogin. 

TOTP Configuration 
The core configuration of the TOTP authentication scheme is done in the Coupling Service configuration 
file settings.ini (configuration/settings/settings.ini): 
server.auth.totp { 

  issuer = issuer-name 

  window-size = window-size 

  algorithm = algorithm 

  digits = digits 

  time-step = time-step 

} 

Setting Default Value Description 

issuer-name Deltek Maconomy The issuer name shown on the 2FA devices. 

window-size 2 The number of time-step windows to accept one-time 
passwords from. 2 means the current window + the 
previous window.  

algorithm SHA-1 The hashing algorithm to use. Changing this value from 
the default (SHA-1) might not be supported by all 2FA 
devices. 

digits 6 The number of digits in the one-time password. 
Changing this from the default (6) might not be 
supported by all 2FA devices. 

time-step 30 The duration (in seconds) of each time-step window. 
Changing this from the default (30) might not be 
supported by all 2FA devices. 

2FA Administration and Management Capabilities 
When a user completes the Maconomy 2FA setup process, a 2FA key is generated for the user. This key 
encodes both a TOTP key and a timestamp tracking the last time a one-time password was successfully 
validated for this account. 
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The 2FA key is stored in the Maconomy Key Store, which is introduced as safe storage for sensitive 
authentication-related information associated with each Maconomy user. The keys are stored in the key 
store with the Maconomy2FA key type.  

As an administrator, you can manage and interact with the Maconomy Key Store via several command-
line options. 

Key Store Interaction Examples 
The following examples show how to interact with the Maconomy Key Store using the Maconomy Server 
command-line option --keystore which was introduced along with the Maconomy Key Store itself. In 
these examples, MaconomyServer.app is used as a placeholder for the MaconomyServer executable or 
symbolic link with the application name included (-i<app-name>) while shortname is a placeholder for 
the database shortname of the Maconomy application. 

View all stored Maconomy 2FA key store entries: 
$ MaconomyServer.app -Sshortname --keystore:type=Maconomy2FA 

Create/update a Maconomy 2FA account. This is primarily useful if a user should always be exempt from 
2FA which can be achieved by creating a 2FA account with key value ‘0’ (zero): 
$ MaconomyServer.app -Sshortname --keystore:type=Maconomy2FA:user=username:key=0:set 

Delete a user’s Maconomy 2FA account. When a 2FA account is deleted the 2FA setup process will be 
re-run the next time the user logs in: 
$ MaconomyServer.app -Sshortname --keystore:type=Maconomy2FA:user=username:remove 

 

MConfig Support for Maconomy 2FA 

Setup 
Maconomy 2FA can be enabled in MConfig during the installation of Maconomy. You can choose whether 
or not users should be allowed to reconfigure their 2FA device in the event that it is lost or stolen. The 
reconfiguration process is based on the same email-token authentication scheme which can be enabled 
to allow users to reset their Maconomy password. 

Advanced Setup 
The Maconomy 2FA login process is configured via the login module MaconomyTOTPLoginModule in the 
Coupling Service security configuration file (configuration/maconomy.security.config):  
org.eclipse.equinox.security.auth.module.ExtensionLoginModule required 

  extensionId="com.maconomy.lib.coupling.MaconomyTOTPLoginModule" 

    QRCodeWindowHeight="window-height" 

    QRCodeWindowWidth="window-width" 

    allowAccountReset="allow-account-reset" 

    skipIf="auth-key-list" 

    ; 

Warning: The remove command deletes all keystore entries matching the entered criteria without 
asking for confirmation. Always run the command without remove first to ensure the command only 
matches the desired key store entries. 
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Setting Default Value Description 

QRCodeWindowHeight 340 The suggested height (in pixels) of the 
window frame displaying the QR code to 
the user. 

QRCodeWindowWidth 340 The suggested width (in pixels) of the 
window frame displaying the QR code to 
the user.  

allowAccountReset true (if Reset 
password is enabled) 

Whether or not users should be allowed to 
reconfigure their 2FA device. Valid values 
are true and false. 

accountResetToEnroll true (if Reset 
password is enabled) 

Whether or not users must provide an 
access token to enroll a 2FA device, like 
when they reconfigure their 2FA device. 

skipIf CloudMFA, 
DomainSSO, 
ReconnectLogin 

A list with the authentication keys which will 
cause 2FA to be skipped for a login 
session.  

allowBypass true Whether or not 2FA Bypass Tokens are 
enabled. Valid values are b”and false. 

bypassPeriod 30d (30 days) The validity period of the bypass tokens, 
with time unit included. Valid time unit 
values are b’(days), h (hours), m (minutes), 
and s (seconds). 
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Access Control 

Access Control View Templates 
Only two Access Control view templates are currently available: the union template and the noemptykey 
template. but, there are plans to expand the template framework with the addition of more templates and 
Oracle support. Due to database-specific optimizations, templates must be different for each database. 
Only the Microsoft SQL Server database is supported. 

The union template is a rewrite of original Maconomy access control views. It replaces subselects with 
union operators since it is less costly to perform a union on the SQL server. In Oracle, this is not the case, 
thus the need for database-specific templates. The union template is a dynamically generated template 
and can be applied to all views matching a specific signature in the RelationAccessDefinitions file (located 
in the Maconomy application directory). Depending on how access control is set up on any given 
Maconomy system, MConfig generates a list of views that can use the union template. 

The noemptykey template, on the other hand, can be applied only to specific tables where business logic 
ensures that key values for a table are never empty. Therefore, the list of allowed views is static. 

When to Use… 
The best-performing setup is a combination of the following: 

 Applying the noemptykey template to the acjobentry view 

 Applying the union template to all other views (that can utilize this template) 

This may vary depending on how the data is distributed in a given database. Be aware that applying the 
union view can have a negative effect on performance for the Administrator user (or for any user with 
equal or similar access rights), as illustrated by the test results for the ACJobentry table in the Findings 
section. If this issue occurs, use the noemptykey template on the table (if applicable), or revert to the 
stock view for that table. 

Findings 
This section illustrates performance differences between the views for two tables that, in most Maconomy 
installations, contain the largest number of records. Test results are shown for the following: 

 ACFINANCEENTRY: A table containing 16 million entries 

 ACJOBENTRY: A table containing five million entries 

The three test types used are the following: 

 Wsc (Multiple): This test involves opening the corresponding job or finance entry list in a 
workspace and measuring the time it takes to populate the first page. 

 Direct Fresh: This test is a cold (that is, not cached) run against the database with the same 
query that is used in the Workspace Client to populate the table. 

 Direct Multiple Runs: This test involves executing the same query as in Direct Fresh, but multiple 
times. The goal is to check if caching has an impact on performance. 

Time is measured in seconds. “0s” means that the query is executed in less than a second. Actual 
execution time in milliseconds is no longer displayed because, to the Client user, the time difference is no 
longer distinguishable. 

The rows in bold font indicate the best template to use for each view in the test database. 
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ACFINANCEENTRY 

Template  Wsc (Multiple) Direct Fresh Direct Multiple Runs 

User with limited access 

default 46s 106s 45s 

noemptykey 45s 106s 45s 

union 9s 9s 9s 

Administrator user 

default 1s 1s 1s 

noemptykey 1s 1s 1s 

union 1s 1s 1s 

ACJOBENTRY 

Template Wsc (Multiple) Direct Fresh Direct Multiple Runs  

User with limited access 

default 36s 40s 35s 

noemptykey 1s 0s 0s 

union 1s 1s 1s 

Administrator user 

default 1s 0s 0s 

noemptykey 1s 0s 0s 

union 180+s 180+s 180+s 

Setup 
As of MConfig version 8.6, Access Control view templates can be controlled from a View management 
window that can be accessed through the application shortname window in MConfig. 

The following figure dispays the application shortname window. 



Access Control 

System Admin Guide 86 

 

 



Access Control 

System Admin Guide 87 

 

The following figure displays the View management window. 

 
The View management window allows you to select which template to apply to specific views. Note that 
the templates do not support all views. If you select a template, the window displays the views that are 
supported for that template. Since all view changes are completely reversible, and the updated views 
function in the same way as the original views, faster performance should be your only consideration 
when applying a template to a supported view. 

If you make any changes to access control in the Maconomy system (specifically, to the 
RelationAccessDefinitions.txt file), you need to reapply the Access Control view templates through 
MConfig to ensure the validity of the selected configuration. 

Access the View Management Window 

To access the View management window: 
1. Start MConfig. 

2. Double-click an application from the list box to open the application window. 

3. Double-click the shortname to open the shortname window. 

4. In the shortname window, click View management. 

Reapply the AC View Templates  

To reapply the AC view templates: 
1. In the View management window, select the Reinstall all views checkbox. 

2. Click OK. 

3. If the views are reinstalled with no errors, apply the desired view template configuration. 
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Changing Access Principles 
To provide you with the possibility of making special adjustments to the access control system, a special 
set of programs has been designed to help you with the technical details. 

Customer-Specific Access Principle File 
When upgrading to new Maconomy versions, the RelationDefinitions and RelationAccessDefinitions files 
are overwritten with Maconomy’s standard access principles. To ensure that previous manual 
adjustments to the access control system are kept, you can create a file that comprises exceptions to the 
standard principles. 

The name and location of this file is optional, but it is a good idea to place the file in the same folder as 
the original file that is supplied with Maconomy and to use the following format for its name: 
RelationAccessDefinitions.<CompanyName> 

where <CompanyName> is the name of your company. 

In this file, you can specify the access principles for the relations that should not use the standard 
principles. Thus, it is the access principles in this file that will be used for the relations in question. The file 
must be a standard text file. When this specific access principle file is ready, the changes can be 
implemented as described in the “Update of Access Principles” section later in this document. 

The following sections contain examples of how to adjust the access principles using a specific access 
principles file. 

Example 1 
Consider the access principle for the Creditor relation. Here the standard principle is 
DirectAccessControl, which means that the value of the AccessLevelName field for the individual 
vendor determines which user groups have access to the vendor in question. 

You may want to change this principle so that all users have free access to all vendors. The access 
principle should therefore be changed from DirectAccessControl to NoAcccessControl. 
In the specific access principle file, you should specify the following line: 
Creditor : NoAccessControl ; 

Note the semicolon (;) which indicates the end of the principle. 

The adjustment can then be implemented as described in “Update of Access Principles” Section. 

Example 2 
Now look at the access principle for the relation JobHeader. Here the standard access principle is 
DirectAccessControl, which means that the value of the AccessLevelName field for the individual job 
determines which user groups have access to the job in question. 

You may want to change this so that the principle also specifies that the customer must have access to 
the customer indicated on the job header and saved in the CustomerNumber field. The access principle 
should therefore be changed from DirectAccessControl to an expression that also includes the indirect 
access principle for the customer who is assigned to the job. 

In the specific access principle file, you should specify the following line: 
JobHeader : DirectAccessControl 

and IndirectAccessControl (Customer, CustomerNumber) ; 

Note the semicolon (;) which indicates the end of the principle. 
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The adjustment can then be implemented as described in “Update of Access Principles” Section. 

Update of Access Principles 
Access principles are updated in three steps: 

1. Generate new view definitions 

2. Delete existing views 

3. Create views 

It is essential that no users are logged in to the system during an update. 

Generate New Views 
To generate new views, the current folder must be set to the following: 
<MaconomyHome>\MaconomyDir\Database 

Now enter the following: 
OracleViewGenerator-Kernel US -Administrator Administrator 

-CheckOnly 

-UseDD 

-MaconomyFolder Folder "<DestinationFolder>" "RelationAccessDefinitions" 
"RelationAccessDefinitions.<CompanyName>" 

where "<DestinationFolder>" is the destination folder of the generated sql files. Use "." for the current 
folder. 

For Maconomy version 6.0 and earlier, enter: 
OracleViewGenerator –Kernel US –Administrator Administrator -AllWindows “All Windows” 
–CheckOnly “<DestinationFolder>” “RelationDefinitions” “RelationAccessdefinitions” 
“RelationAccessDefinitions<Customer>”. 

Note that all parameters must be specified on the same line. In the above example, the parameters are 
entered on separate lines for the sake of clarity. The -CheckOnly parameter must be left out when 
generating a view, but it must be included to validate if all access principles are OK. 

The folder path specified in the -MaconomyFolder option is the full path of the folder that contains your 
current MaconomyDir (placed in the MaconomyHomes folder). 

In all cases, you should use an OracleViewGenerator version 2.4 or later because of corrections in the 
views that are generated. 

Delete Existing Views 
The following two commands are used: 
DeleteDHViews <shortname> <password> [MSQL] Delete3PStuff <shortname> <password> 
[MSQL] 

For Maconomy version 6.0 and earlier, enter: 
OracleViewGenerator -Kernel US -Administrator Administrator 

-AllWindows "All Windows" -CheckOnly "<DestinationFolder>" "RelationDefinitions" 
"RelationAccessDefinitions" "RelationAccessDefinitions.<Customer>". 
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Create Views 
You can use one of the following commands—the first is for Oracle-based servers and the second is for 
SQL Server-based servers: 
StartOracleSQL <shortname> <password> DHViewMake.sql StartSQLServer1 <shortname> 
<password> DHISQLViewMake.sql 

MaconomyServer[MSQL].exe -iMaconomyServer.<Application> -f -3 

-S<shortname> 

Recreate3PStuff <shortname> <password> [MSQL] 
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Install and Set Up Fonts 
This section describes the use of fonts in Maconomy andent is divided into six sections. The first four 
sections are relevant for MPL 2, and the last two are relevant for MPL 4. 

 Administration and installation of Type 1 fonts, including how you can make Maconomy aware of 
the installed fonts. 

 The Maconomy PDF printer driver, PrintToPDF.exe, including how you can convert Maconomy 
print files into properly formatted PDF files. 

 Using Type 1 fonts with MPL and MDL. 

 Example: Installing a font in Maconomy. 

 Administration and installation of fonts in MPL 4. 

 Example: Installing a font in MPL 4. 

Please note that most Type 1 fonts are covered by copyright. Owning the right to use a font does not 
automatically give you the right to use the font with PrintToPDF because this will embed the font in the 
PDF file that is created (PrintToPDF does not support font‐subsetting). Some vendors impose restrictions 
on the use of fonts for electronic viewing. It is the responsibility of the Maconomy user to ensure that the 
use of a given font is permitted. 

 

Font Administration and Installation 
A limited number of license‐free fonts are available by default. The available fonts are: 

 Helvetica 

 Times Roman 

 Courier 

 Symbol 

 ZapfDingbats 

If you need any fonts other than this standard set, they must be installed on the server. To install a Type 1 
(PostScript®) font on the server, perform the following procedures. 

To prepare to install a Type 1 font on the server: 
1. Purchase the font (for example, Garamond), and install it on the server. 

As a result of the installation, the files 91aramond.pfm and 91aramond.pfb are created. 

2. Make Maconomy aware of the .pfm and .pfb files. 

3. Assign Maconomy font names to the Type 1 font. 

The actual procedure for font installation varies, depending on the operating system of the 
Maconomy server. The following steps apply to a Maconomy server that is running supported 
versions of Microsoft Windows. 

To install a Type 1 font on the server: 
1. Log in as Administrator. 

Note: Google Noto Fonts are also available. 
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2. Click the Fonts icon in the Control Panel. 

3. In the Fonts window, select Install New Font in the File menu and choose the drive and folder in 
which your new font was placed. 

4. Click Select All. 
5. Make sure that the Copy fonts to Fonts folder checkbox is selected. 

6. Click OK. 

7. In the progress dialog box, click Yes for all messages. 

For Unix servers, please refer to the documentation of the version of Unix that you are running. 

For Maconomy to use the fonts successfully, all that you need are the *.pfm and *.pfb files. The .pfm files 
contain a description of the metrics (that is, size measurements) of the current font. The .pfb files contain 
a bitmap rendering of the current font. 

Make Maconomy Aware of the Font 
To make a font known to Maconomy, first place the .pfm and .pfb files in the Maconomy font directory 
and create a mapping from the Type 1 font name to the Maconomy file names. Then create another 
mapping from Maconomy font names to Type 1 font names, as illustrated in the following figure, using 
the Garamond font as an example. 

 

The Default Font Directory 
Maconomy by default looks for fonts in this subfolder: /Maconomy/FontSupport/fonts/ 

Maconomy can be set up to look elsewhere for fonts. 

 
To make fontname available to the Maconomy server, place the font description files (usually called 
fontname.pfm and fontname.pfb) in this folder. 

The Font Map File 
For Maconomy to know which files to open for the font descriptions, you must create a mapping from the 
Type 1 font name fontname to the font description file names, typically fontname.pfm and fontname.pfb. 
This is done in the file fontmap.lst, which can be found in the  /FontSupport folder located in the 
Maconomy server folder. 

For MPL 4, this is done in the file FontFileMap.lst, which can also be found in the /FontSupport folder 
located in the Maconomy server folder. 

 

Attention: For more information, refer to the “Creating Your Own Font Folder” section. 

Attention: For more information, refer to the “Font Administration and Installation in MPL 4” section. 
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You must create an entry at the end of the file containing the font name and the two filenames. The entry 
consists of one line, where the names are separated by <tab>, and the filenames are enclosed by sets of 
parentheses. A comment line can be inserted by prefixing it with #. For example: 
# Font Name PFM File PFB File 

Garamond (Garamond.pfm) (Garamond.pfb) 

This entry specifies that the font with Type 1 name Garamond is defined using the files Garamond.pfm 
and Garamond.pfb, both located in the /FontSupport/fonts/ folder or in a custom font folder. 

Create Your Own Font Folder 
By default, the location of font files is relative to the  /FontSupport/fonts folder, but you can specify 
another location for font files in the file fontmap.lst (in the /FontSupport folder in the Maconomy server 
folder). 

Two lines must exist in the file fontmap.lst if you want to specify a different font folder. The first line 
specifies prefixes in the font location. If the font location contains any of these prefixes, the font location 
will be regarded as absolute (that is, not relative to /FontSupport/fonts). 

The second line specifies the actual location in which Maconomy should look for the .pfm and .pfb files, 
respectively. 

For example: 
$Abs_Path_Prefix (\) (.) (C:) (D:) 

$Font_Directories (C:\psfonts\pfm) (C:\psfonts\pfb) 

This tells Maconomy to look for fonts in C:\psfonts\pfm and C:\psfonts\pfb. The specification 
C:\psfonts\fonts begins with C:, which was specified in the $Abs_Path_Prefix line, and is therefore 
considered an absolute path. 

The location of .pfm and .pfb files need not be the same. However , for MPL 4, the location of the files 
must be the same. 

 
The items are listed on the same line, separated by <tab>. You can specify a maximum of ten items on a 
line. 

Assume that you want to place font descriptions in a folder called C:\pdffonts\, and you want the .pfm 
files in a subfolder called pfm and the .pfb files in another subfolder called pfb. Then the path 
specification section of the file should look like the following: 
$Abs_Path_Prefix (\) (.) (C:) (D:) 

$Font_Directories (C:\pdffonts\pfm) (C:\pdffonts\pfb) 

Note that the folder specification must not be followed by a folder separator character, such as \ or /. 

These two lines that specify font folders and absolute prefixes must be specified before the font map 
specifications. 

Using the preceding definition, you can specify a font map (see “The Font Map File”) like this: 
Marlett (marlett.pfm) (marlett.pfb) 

Garamond (C:\test\Garamond.pfm)(C:\test\Garamond.pfb) 

Maconomy first checks if the Marlett font is a built‐in font. Then it checks if Marlett is in the default 
FontSupport\fonts folder in the Maconomy server installation, and finally in the path specified by the 
$Font_Directories directive. 

Attention: For more information, refer to the “Font Administration and Installation in MPL 4” section. 
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For Garamond, Maconomy performs the same three checks as for the Marlett font. If the font is not found, 
it searches the specified path (C:\test). The fact that the filenames start with C:\ (which is specified in the 
$Abs_Path_Prefix line) indicates that these are filenames with an absolute path. 

Specify Maconomy Font Names for Type 1 Fonts 
Performing the steps described in the “Making Maconomy Aware of the Font” section makes fonts known 
to the Maconomy system by their Type 1 font names. However, when you create or compile MPL print 
layouts, names other than the Type 1 font names are used for the fonts in the MPL specification. 

For example, installing the Type 1 font Times actually installs four fonts with distinct Type 1 font names: 
Times‐Roman, Times‐Bold, Times‐Italic, and Times‐BoldItalic. The MPL specification uses a different 
concept. Here, there is only one font called Times, to which attributes such as bold and italic can then 
be applied (underline is handled differently and is not part of the font). Furthermore, you might want to be 
able to refer to this font both as Times and as Times New Roman. 

To create this mapping between Maconomy font names and Type 1 font names, you need to edit the file 
FontAttributeMap.lst, which is found in the /FontSupport folder in the Maconomy server folder. The 
entries for Times‐Roman as discussed previously are the following: 
Times-Roman Times 

Times-Roman Times New Roman 

Times-Bold Times, BOLD 

Times-Bold Times New Roman, BOLD 

Times-Italic Times, ITALIC 

Times-Italic Times New Roman, ITALIC Times-BoldItalic Times, BOLDITALIC 

Times-BoldItalic Times New Roman, BOLDITALIC 

Each line contains two texts separated by <tab>. The first text is the Type 1 font name, and the second is 
the Maconomy font name. The Maconomy font name can be suffixed with: 
, BOLD 

, ITALIC 

, BOLDITALIC 

The suffixes must be written exactly in this way, including the space after the comma. No other font-
modifying attributes can be specified. 

The first line maps the Maconomy font name Times (without any attributes) to the Type 1 font name 
Times‐Roman. The second line in effect creates an alias to the MPL Times font by specifying that the 
Type 1 font Times is also called Times New Roman in MPL. The third line maps the same Maconomy 
font name (Times), but with the bold+ attribute set, thus mapping the font + attribute combination to the 
Type 1 font Times‐Bold. 

The Times font is already defined in the FontAttributeMap.lst file, but similar lines must be added when 
new fonts are installed on the system. 

Please note that neither the MPL 2 nor the MDL compiler checks for the existence of fonts. Hence, the 
following is a valid statement in MDL and MPL 2: 
"Hello":fontname="thisisnofont" 

Therefore, it is important to be careful when specifying font names, as typos such as 
"Hello":fontname="Helvetica" or similar will go unnoticed by the compiler.  

 
Attention: For more information, refer to the “Fonts in MPL 2 and MDL” section. 



Install and Set Up Fonts 

System Admin Guide 95 

 

Move MPL into Coupling Service 

Moving MPL into Coupling Service 
Phase 1 moving MPL into Coupling Service supports large printings which had previously run out of 
memory. 

The MPL print engine in Maconomy is ported to run inside the Coupling Service, instead of as an 
embedded Java process inside each MaconomyServer intance. 

This reduces the average memory footprint of the MaconomyServer processes while also making it 
possible to produce larger prints without running into memory limitations. 

The embedded MPL engine is still available in the 2.5 release stream to support various command line 
operations, such as the '-U*P' arguments as well as MScript and import invocations, which require print 
functionality. In future releases, the embedded print engine will be removed entirely, and these operations 
will either be ported to the Coupling Service, or they will be desupported. The '-U*P' arguments as well as 
the '-x' argument for stand-alone script execution are supported by the Coupling Service as of 2.5.1. 

QR Code Centre Image Support 
MPL supports QR Code Centre Image Support to fulfill statutory e-invoicing requirement.  

You can overlay images at the center of such QR codes without compromising the QR code’s readability. 
A QR code scanner/app is now able to scan such a QR code successfully even though part of the QR 
code area is overlaid by an image.   

For example, the following code: 
<barcode {"Hello world"} 

    QRCODE  

    height=46mm 

    qrOverlayImage={"qrcode\image.png"} 

will overlay the qrcode\image.png from the Maconomy’s document archive at the center of the QR code. 

Technically, overlaying images over QR codes is possible because QR codes implement error correction, 
which means that a QR code can still be read by a scanner even though part of it is damaged or covered 
by an image. The QR code specification lists the following error correction levels and their corresponding 
theoretical recovery rates (the percent of the coding words that can be missing without affecting the QR 
code's readability): 

 L: 7% 

 M: 15% 

 Q: 25& 

 L: 30% 

In practice, for the QR codes to scan correctly, the overlay should take up less than that theoretical limit. 
It is up to the MPL layout developer to choose the right error correction level and overlay image size 
depending on the use case. The chosen values should be tested extensively in practice.  

These two properties can be set using the following <barcode> attributes: 

 qrErrorCorrection: The requested error correction level. Valid values are: L (lowest), M, Q, and 
H (highest). 

The default values are 
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 L without an overlay image 

 M with an overlay image 

 qrOverlayAreaRatio: The ratio of the overall QR code picture's area (including the QR code’s 
silent zone) that the overlay picture should take up. Valid values are from 0.0 to 1.0. The default 
value for error correction level M is 0.05. 

Apart from these two attributes, you can also set the requested overlay image quality with the 
qrOverlayQuality attribute. Since the overlay image is drawn over the QR code image, the QR code 
image must be scaled up to have enough pixels to draw the overlay image over without losing quality. 

 qrOverlayQuality: the requested quality level. The valid values are: L (lowest), M, Q, and H 
(highest). Level H indicates that the overlay image should be drawn with original quality and the 
QR code image should be scaled up accordingly (up to 2000 x 2000 pixels max). The higher the 
quality level, the more RAM memory the QR code image will consume when generating a PDF 
and the bigger the resulting PDF size will be. Deltek recommends that you use the lowest 
possible value that renders a satisfying quality. 

The default value is Q. 

The following examples shows how to set all the above-described attributes: 
 <barcode {"Hello world"} 

    QRCODE  

    height=46mm 

    width=46mm  

    qrOverlayImage={"qrcode\swiss_flag.png"} 

    qrErrorCorrection=M 

    qrOverlayAreaRatio=0.025 

    qrOverlayQuality=L> 

PrintToPDF Initialization File 
Some of the Maconomy PDF and MPL 2 compiler functionality can be modified by changing the 
parameters of the PrintToPDF.i file which can be found in the /IniFiles folder in the Maconomy folder. 
Please note that the MPL 2 compiler also makes use of this file, but the MPL 4 compiler does not. 

The valid parameters are summarized in the following tables. Parameters are set by stating 
parametername=value. 

Parameter Description Default Value 

FONATTRIBUTEMAPDIR Path to the folder where 
FontAttributeMap.lst is 
found. 

FontSupport in 
Maconomy folder 

CPDFFONTMAPDIR Path to the folder where 
FontMap.lst is found. 

FontSupport in 
Maconomy folder. 

COMPRESSION Compression (1=on/0=off). 1 

LOGLEVEL Logging (1=on/0=off). 0 

MACTOWINDOWSCORRECTION Do not change this. 18 
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Parameter Description Default Value 

ISLANDTEXTMODIFICATIONHORIZONTAL Do not change this. 4 

ISLANDTEXTMODIFICATIONVERTICAL Do not change this. 4 

UNDERLININGCORRECTION Do not change this. 2 

SUBSTITUTIONFONT If a font cannot be found, 
use this font instead. 

Times-Roman 

FONTWIDTHSCALFACTOR Multiply calculated text 
widths with this factor when 
formatting MPL layouts. 

1 

The following is a description of the PrintToPDF.i parameters. 

 FONTATTRIBUTEMAPDIR and CPDFFONTMSAPDIR: By setting these parameters, you can 
change the folder path to the location of the FontAttributeMap.lst and fontmap.lst files, 
respectively. Please note that no path delimiter (/ or \) should be specified at the end of the path 
name. There is rarely any need to change any of these parameters. 

 COMPRESSION: This parameter indicates whether or not the printer driver PrintToPDF should 
generate compressed (smaller) PDFs. 

 LOGLEVEL: This parameter indicates whether or not the printer driver PrintToPDF should 
generate a log file while running. The log file can be used for debugging purposes. 

 MACWINDOWSCORRECTION, ISLANDTEXTMODIFICATIONHORIZONTAL, 
ISLANDTEXTMODIFICATIONVERTICAL, and UNDERLININGCORRECTION: These 
parameters are constants used by PrintToPDF to adjust the prints. This adjustment is necessary 
due to deviations between Macintosh and Windows formats. Do not change these; they are 
carefully balanced. 

 SUBSTITUTIONFONT: This parameter specifies the Type 1 name of the font that should be used 
if the specified font cannot be found, both when printing using PrintToPDF and when calculating 
text widths in the MPL 2 compiler. The MPL 4 compiler does not use the notion of substitution 
fonts. 

 FONTWIDTHSCALEFACTOR: This parameter is only used by the MPL 2 compiler. When 
calculating the width of a text in a given font, the result is multiplied by this factor. This parameter 
is a work-around to a problem concerning Windows and Macintosh fonts: Windows (True Type) 
and Type 1 fonts are very similar, whereas Macintosh fonts are often wider. Since the calculation 
of the width of texts is performed using Type 1 fonts, the consequence is that texts may be cut off 
when printing from a Macintosh computer. A FONTWIDTHSCALEFACTOR of approximately 1.2 
(perhaps less, depending on the fonts used) seems to remedy this problem. Note, however, that 
this creates extra spacing when printing from Windows; hence, this workaround should only be 
used when necessary (that is, when there is a need to print from a Macintosh computer). 

PDF Printing 
The PDF printer driver is called PrintToPDF.exe and is located in the bin folder of the Maconomy server 
folder on Windows. The following information is valid as of version 1.19 of PrintToPDF.exe. 

The syntax for calling the PDF printer driver is as follows: 
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PrintToPDF.exe [-d] [-c <filename>+] [-l] [-p<papersize>] [- n<filename>+] [-s] [-h] 
[-v] 

Note that there should be no space between flag and argument (for example, between -n and the 
filename). The parameters have the following meanings: 

 -n: Input filename. The name of the output file is generated by Maconomy. If the print file is called 
name, the output file will be called name.pdf and will be placed in the same folder as the input 
file name. This parameter is mandatory. 

 -c: PrintToPDF can concatenate multiple print files into one output file, which is written to stdout. 
In this way, a list of print files can be changed to one print file. For example, assuming that you 
want to create one PDF file from the following two print files PRINT00001 and PRINT00002, you 
can enter one of the following: 

 Printtopdf –c PRINT00001 PRINT00002 | printtopdf –s -nFULLPRINT 

In this way, the concatenated file is piped back to PrintToPDF, which then generates the file 
FULLPRINT.PDF, which contains both print files. No temporary file is created. 

 Printtopdf –c PRINT00001 PRINT00002 > FULLPRINT 

Printtopdf –nFULLPRINT 

Using this method, the two files are first concatenated into a temporary file FULLPRINT. 
PrintToPDF is then invoked again to create the FULLPRINT.PDF file. 

Please note that instead of creating a PDF file, the concatenated print file can be sent to another 
printer driver (for example, the hpgl printer driver). 

 -s: Read input from stdin. If this parameter is specified, the -n parameter is only used to find the 
output filename (but -n must be specified). 

 -d: Debug mode. Print debug messages while running, only used for debugging purposes. 

 -l: Landscape. Generate the PDF file in landscape mode. 

 -p: Paper size. Specified as an HP PCL identification for paper size: 

 1=Executive 

 2=Letter 

 3=Legal 

 26=A4 

 27=A3 

 -v: Version information. This displays the date and number of the current version of PrintToPDF. 

 -h: Help. This displays a summary of available features in PrintToPDF. 

A call to PrintToPDF typically only consists of the -n and -p parameters. For example: 
PrintToPDF.exe –p26 –nMyPrint 

This call would generate an A4-sized document in the file MyPrint.pdf, ready to open with Acrobat 
Reader. Please note that PrintToPDF embeds all fonts in the PDF file. 
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Fonts in MPL 2 and MDL 
There are several considerations to take into account when working with fonts other than the standard set 
(also known as Base 14 fonts)2. The following sections describe the things that you should be aware of 
when working with different forms of Maconomy layouts. 

MPL 
The MPL 2 compiler uses the font description files of the Type 1 fonts installed on the server for 
calculating the width of texts on a print layout. This information is then used during formatting to ensure 
that there is room for all texts, while not wasting space. 

When the MPL 2 layout is printed from the client, the fonts installed on the client computer are used. If a 
font referenced in the layout does not exist on the client, the substitution font is used. This may cause 
texts to be cut off if the font metrics of the substitution font are greater than the font on the server which 
was originally referenced. 

If the font specified in the MPL 2 layout does not exist on the server when the layout is compiled, the font 
metrics of the substitution font are used. When this happens, no error message is given. The reason that 
MPL 2 allows you to create layouts with reference to non‐existing fonts is that you may not want to add 
the font to the server for reasons of the cost or work involved in installing the font. If you know in advance 
that you are referencing a font that does not exist on the server, you should manually supply sufficient 
room for the text in your layout, using the width attribute. For example: 
"Barcode text":fontname="OCR-B":width=10cm 

An example of this may be a layout for use in the warehouse, which contains a reference to a bar code 
font such as OCR-B. The layout is only used on one machine, where the OCR-B font is installed, and will 
thus print correctly from that computer only. 

However, this can be a source of error in the layouts. If, for example, you meant to reference a font called 
Marlett that is properly installed on the server, but you inadvertently typed “Martlett,” the MPL 2 compiler 
will use the substitution font for calculating the text widths, thus not using the correct Marlett font metrics. 

Windows clients contain a built‐in substitution of the following two fonts: 
Font: Substituted By: 

Helvetica Arial 

New Century Schlbk NewCenturySchlbk 

However, these substitutions can be changed, and more can be added, by changing the maconomy.ini 
file in the Maconomy folder. By adding a section called FontSubstitutes to the file, you can control the 
font of the print layouts by setting “Original Font Name”=“Substitute Font Name.” For example: 
... 

[FontSubstitutes] Helvetica=Helvetica BarCodeFont=OCR-B 

... 

The preceding settings specify that if the MPL layout specifies Helvetica, Helvetica should in fact be used. 
If the MPL layout specifies that a barcode font should be used (the name not being known at the time of 
writing the layout), this particular Windows client should substitute this non‐existing font with the proper 
OCR‐B font. 

On Macintosh clients, the fonts referenced in the MPL layout are substituted with Macintosh fonts using 
the substitution table embedded in the Macintosh client. Since Macintosh fonts are often slightly wider 
than the corresponding Windows fonts, the setting FONTWIDTHSCALEFACTOR in the PrintToPDF.i file 
can be used to force the MPL compiler to add extra space to the length of the texts in the layout, thus 

 
2 The standard Type 1 fonts known to the system are Helvetica, Times‐Roman, Courier, Symbol and ZapfDingbats. 
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ensuring that texts are not cut off when printed from a Macintosh computer. A factor of 1.2 is often 
suitable. However, this setting should only be used if there are in fact Macintosh computers printing from 
Maconomy. 

To change the font substitution in the Macintosh client, you need to edit the dialog handler string list 
resource #7001 using the ResEdit utility. This resource contains strings in sets of four: 

 Internal font name: The name from the MPL layout (for example, Laudatio). 

 External font name: The name of the Macintosh font that substitutes the internal font name (for 
example, Geneva). 

 Displacement: Enter 0 for off or 1 for on. 

 Use fractional widths: Enter 0 for off or 1 for on for more accurate spacing. 

In the preceding example, whenever the Laudatio font is referenced in an MPL layout, it will be 
substituted by the Macintosh Geneva font. 

When printing using the Maconomy client for the Java platform, the settings in the PrintToPDF.I file are 
used for generating the PDF file for an MPL 2 printout. MPL 4 does not make use of the PrintToPDF.I file 
and does not use the notion of substitution fonts. 

MDL 
The problem of truncated text does not apply to MDL because dialog box layouts are not formatted until 
the dialog box is displayed. As opposed to MPL, which uses text widths that are calculated using the fonts 
that are installed on the server when the layout was compiled, MDL uses the fonts that are installed on 
the client machine when calculating the width of texts. 

On Macintosh clients, the fonts referenced in the MDL layout are substituted with the Macintosh system 
fonts as set up on the client computer. 

In the Maconomy client for the Java platform, all fonts are displayed using Arial. 

Example of Font Installation 

Example 1 of Font Installation 
Assume that you want to install the font Poppl‐Laudatio. The font is defined in two files called 
Pyrg____.pfb and Pyrg____.pfm. Firstly, place these two files in the fonts folder (on a Windows server, 
this is typically C:\MaconomyNT\FontSupport\fonts). 

Secondly, create a mapping between the font name and the font files by creating an entry in the 
fontmap.lst file (typically C:\MaconomyNT\FontSupport\fontmap.lston Windows). Enter this line: 
PopplLaudatio (Pyrg .pfm) (Pyrg .pfb) 

Thirdly, create a mapping from the Maconomy font name to the Type 1 font name. This entry is created in 
the file FontAttributeMap.lst file (typically C:\MaconomyNT\FontSupport\FontAttributeMap.lst on 
Windows). Enter this line: 
PopplLaudatio PopplLaudatio 

This concludes the installation of the font. Note the following: 

 With the preceding installation, a boldface version of Poppl-Lautdatio is not known to the MPL 2 
compiler. This implies that the following: 
"text":fontname="PopplLaudatio":bold+ 
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will be written as Times, BOLD (as this is the default substitution font). We do not have a bold 
version, but we might want to use the non-bold version of Poppl-Laudatio, even when bold+ is 
specified. In that case, you should add the following lines to the FontAttributeMap.lst file: 
PopplLaudatioPopplLaudatio, BOLD PopplLaudatioPopplLaudatio, ITALIC 
PopplLaudatioPopplLaudatio, BOLDITALIC 

 We chose to give the font its proper name, but both the Type 1 font name and the Maconomy font 
name are free to choose. We could, for example, call the font MyHeadlineFont in the 
FontAttributeMap.lst file. 

Example 2 of Font Installation 
Assume that you want to install the font Frutiger. The font is defined in two files called FTR____.pfb and 
FTR____.pfm. Firstly, place these two files in the fonts folder (on a Windows server, this is typically 
C:\Maconomy\FontSupport\fonts). 

Secondly, create a mapping between the font name and the font files by creating an entry in the 
fontmap.lst file (typically C:\Maconomy\FontSupport\fontmap.lst on Windows). Enter this line: 
Frutiger (FTR _.pfm) (FTR .pfb) 

Thirdly, create a mapping from the Maconomy font name to the Type 1 font name. This entry is created in 
the FontAttributeMap.lst file (typically C:\Maconomy\FontSupport\FontAttributeMap.lst on Windows). 
Enter this line: 
Frutiger Frutiger 55 Roman 

This concludes the installation of the font. Note the following: 

 With the preceding installation, a boldface version of Frutiger is not known to the MPL 2 compiler. 
This implies that the following: 
"text":fontname="Frutiger":bold+ 

will be written as Times, BOLD (because Times is the default substitution font). To use bold or 
any other font style, specify the bold version of the Type 1 font. To do this, add the following lines 
to the FontAttributeMap.lst file: 
Frutiger-Bold Frutiger 55 Light, BOLD Frutiger-Italic Frutiger 55 Roman, ITALIC 
Frutiger-Black Frutiger 55 Roman, BOLD 

and so on. 

 We chose to give the font its proper name, but both the Type 1 font name and the Maconomy font 
name are free to choose. We could, for example, call the font MyHeadlineFont in the 
FontAttributeMap.lst file. 

Font Administration and Installation in MPL 4 
In addition to Type 1 (PostScript) fonts and a limited number of license‐free fonts, MPL 4 also allows the 
use of TTF (TrueType) and AFM (Adobe) fonts. 

Making MPL 4 Aware of the Font 
In MPL 4, two mappings need to be created: one mapping between the actual font name and the font 
filename (for fonts other than Base14 fonts) and another mapping between the actual font name and the 
Maconomy font name. 
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The Font Search Path 
MPL 4 determines the location of the font files using the MACONOMY_FONTHOME environment 
variable in the MaconomyServer ini (.I) file. If the MACONOMY_FONTHOME environment variable is not 
explicitly set, the default font file location is assumed to be the /FontSupport/Fonts folder. 

Several font search paths can be specified separated by a semicolon, for example: 
MACONOMY_FONTHOME=D:\maconomy\FontSupport\fonts;C:\WINDOWS\Fonts;C:\m yfonts 

Thus, MPL 4 can use font files placed in the three folders mentioned previously. To create a mapping 
between the actual font name and the font file name, please see ʺThe FontFileMap Fileʺ section. For 
Base 14 fonts, the MACONOMY_FONTHOME environment variable is not used. 

The FontFileMap File 
For the MPL 4 compiler and runtime to know which files to open for the font descriptions, a mapping from 
the actual font name to the font file name must be created. This is done in the FontFileMap.lst file, which 
can be found in the /FontSupport folder located in the Maconomy server folder. 

An entry that contains the actual font name and the font file name can be created at the end of the file. 
The entry consists of a line with the actual font name and the font file name separated by <tab>. A 
comment line can be inserted by prefixing it with #. 

Font Name Font File Name 

HelveticaUni HelveticaWorld-Regular.ttf 

Garamond Garamond.pfm 

The first entry specifies that the TTF font Helvetical Unicode is defined using the file HelveticaWorld-
Regular.ttf. Similarly, the second entry specifies that the Type1 font Garamond is defined using the file 
Garamond.pfm. 

For Type1 fonts, MPL 4 (unlike MPL 2) requires that both .pfm and .pfb files be present in the same 
directory; therefore, only the .pfm file name needs to be present as part of the entry in the FontFileMap.lst 
file as seen in the preceding example. 

If a font other than a Base 14 font is used in a MPL 4 layout without a corresponding mapping between 
the actual font name and the font file name in the FontFileMap.lst file or the font file cannot be found for 
some reason, a runtime error will be thrown by MPL 4. For Base 14 fonts, the FontFileMap.lst file is not 
used. 

Specifying Maconomy Font Names in MPL 4 
In MPL 4, the mapping between actual font names and Maconomy font names is created in a manner 
similar to MPL 2 by using the FontAttributeMap.lst file (found in the /FontSupport folder in the Maconomy 
server folder). If a Maconomy font name is used in a MPL 4 layout without a corresponding mapping 
between the actual font name and the Maconomy font name in the FontAttributeMap.lst file, the Helvetica 
font is used by default. 

Defining Default Font in MPL4 
In MPL4, a default font can be configured in a custom version of the Maconomy.ini file. It can either be a 
single font or a comma separated list of fonts. When a list of fonts is used, the MPL 4 engine selects the 
appropriate font for each character in the printout, such as the first font in the list to support the character. 
[MPLConfig] 
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DefaultFont=HelveticaUni 

#or 

DefaultFont= HelveticaUni, JhengHei, Leelawade 

 
The MaconomyServer -UP command has the following shape: 
MaconomyServer.<APP_NAME>.cmd -S<shortname> -UEP 

For example: 
MaconomyServer.w_20_0.cmd -Sw200 –UP 

Similarly, in order to recompile all the custom print layouts after the default font setting has been changed, 
use the MaconomyServer -UEP command to first export the custom print layouts and the 
MaconomyServer -UIP command to import them back. 

For example: 
MaconomyServer.w_20_0.cmd -Sw200 –UEP 

MaconomyServer.w_20_0.cmd -Sw200 –UIP 

Defining Last Resort Font in MPL4 
In MPL 4, you can define a Last Resort Font to use for rendering characters that are not supported by any 
of the configured fonts (either default fonts or the current value of the MPL’s fontname attribute). The Last 
Resort Font should render appropriate “missing character” glyphs for any unsupported characters.  

Maconomy pre-packages the official Unicode Last Resort font 
(https://unicode.org/policies/lastresortfont_eula.html) into the TPU, under 
\FontSupport\fonts\LastResort.ttf. The Unicode Last Resort font covers the entire world and renders an 
appropriate missing character glyph for any Unicode language family. For example, the Unicode Last 
Resort font renders the following glyph when encountering a Simplified Chinese character, but there is no 
font supporting Simplified Chinese (which is part of the CJK language family) configured for Maconomy. 

 
To configure the Last Resort Font, edit the following section of your custom Maconomy.ini file to point to 
the chosen font. 
[MPLConfig] 

LastResortFont=LastResort 

In addition, make sure that the \FontSupport\FontFileMap.lst file contains the name of the font followed by 
a tab character, and then followed by the name of the LastResort font file in the \FontSupport\fonts 
directory, for example: 
LastResort LastResort.ttf 

The \FontSupport\FontAttributeMap.lst must contain the tab separated name of the font. For example: 
LastResort LastResort 

Note: It is important to recompile all standard and custom layouts after changing the default font. To 
recompile the standard layouts, use the MaconomyServer -UP command. Please refer to the 
“Application Server” section for a detailed description of MaconomyServer commands and the -UP 
option in particular. 

https://unicode.org/policies/lastresortfont_eula.html
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Example of Font Installation in MPL 4 

Example 1 of Font Installation in MPL 4 
Assume that you want to install the basic version of the Helvetica Unicode True Type font. The font is 
defined in a file called HelveticalWorld-Regular.ttf. 

1. Place the two files in a folder of your choice (for example, C:\Maconomy\FontSupport\Fonts). 

2. Specify that MPL 4 should search for the font files in the preceding folder by adding the following 
entry to the MaconomyServer.I file: 
MACONOMY_FONTHOME = C:\Maconomy\FontSupport\Fonts 

Additional folders to search for font files should be separated by a semicolon (;). 
3. Create a mapping between the actual font name and the font file name by creating an entry in the 

FontFileMap.lst file. Enter the following line: 
HelveticaUni HelveticaWorld-Regular.ttf 

4. Create a mapping between the actual font name and the Maconomy font name by creating an 
entry in the FontAttributeMap.lst file. Enter the following line: 
HelveticaUni HelveticaUni 

5. In addition, configure HelveticaUni as the default font in a custom version of Maconomy.ini like 
this: 
[MPLConfig] 

DefaultFont=HelveticaUni 

6. Recompile all Standard and Custom print layouts by running the following Maconomy Server 
commands: 

 -UP: For example, MaconomyServer.w_20_0.cmd -Sw200 –UP 

 -UEP: For example, MaconomyServer.w_20_0.cmd -Sw200 –UEP 

 -UIP:For example, MaconomyServer.w_20_0.cmd -Sw200 –UIP 

If the actual bold, italic, or bold‐italic versions of the Hevetical Unicode font are available and intended to 
be used, steps 1, 3, and 4 in the preceding procedure should be repeated with the corresponding font 
files. 

For example, to use bold, italic, and bold‐italic fonts, place the corresponding font files in the font folder 
and then add the following lines to the FontFileMap.lst file: 
HelveticaUni-Bold HelveticaWorld-Regular.ttf 

HelveticaUni-Italic HelveticaWorld-Regular.ttf 

HelveticaUni-BoldItalic HelveticaWorld-Regular.ttf 

And add the following lines to the FontAttributeMap.lst file: 
HelveticaUni-Bold HelveticaUni, BOLD 

HelveticaUni-Italic HelveticaUni, ITALIC 

HelveticaUni-BoldItalic HelveticaUni, BOLDITALIC 

Then configure HelveticaUni as the default font in a custom version of Maconomy.ini like this: 
[MPLConfig] 

DefaultFont=HelveticaUni 
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Example 2 of Font Installation in MPL 4 
Assume that you want to install the basic version of the Garmond Type1 font. The font is defined in the 
file Garmond.pfm and Garmond.pfb. 

1. Place the file in a folder of your choice (for example, C:\Windows\Fonts). 

2. Specify that MPL 4 should search for the font files in the preceding folder by adding the following 
entry to the MaconomyServer.I file: 
MACONOMY_FONTHOME = C:\Windows\Fonts 

Additional folders to search for font files should be separated by a semicolon (;). 
3. Create a mapping between the actual font name and the font file name by creating an entry in the 

FontFileMap.lst file. Enter the following line: 
Garmond Garmond.pfm 

4. Create a mapping between the actual font name and the Maconomy font name by creating an 
entry in the FontAttributeMap.lst file. Enter the following line: 
Garmond Garmond 

This concludes the installation of the basic Garmond font. 

If the bold, italic, or bold-italic versions of the Garmond font are available and intended to be used, steps 
1, 3, and 4 in the preceding procedure should be repeated with the corresponding font files. 

For example, to use bold, italic, and bold-italic fonts, place the corresponding font files in the font folder 
and then add the following lines to the FontFileMap.lst file: 
Garmond Bold GarmondB.pfm 

Garmond Italic GarmondI.pfm 

Garmond Bold Italic GarmondZ.pfm 

And add the following lines to the FontAttributeMap.lst file: 
Garmond Bold Garmond, BOLD 

Garmond Italic Garmond, ITALIC 

Garmond Bold Italic Garmond, BOLDITALIC 

Then configure Georgia as the default font in a custom version of Maconomy.ini like this: 
[MPLConfig] 

DefaultFont=Georgia 

Remember to recompile all the standard and custom print layouts after setting the default font to the new 
value. 

Troubleshooting 
If you experience problems when installing and using a new font, even after following this guide, you can 
check the following list. This list contains the questions which come up most often, or the steps that are 
most often overlooked. 

The list is in no particular order. 

 MPL 2 supports PostScript fonts also known as Type1 fonts but does not support TrueType (.ttf) 
or other font types. A PostScript font consists of a set of two files: one with the file type .pfm and 
one with the file type .pfb. MPL 4 supports TrueType (.ttf), OpenType (.otf), and Adobe Font 
Metric (.afm) fonts in addition to PostScript fonts. 
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 Do you refer to the fonts correctly in MPL? When referring to fonts in MPL, remember that font 
names are case-sensitive; the font “Arial” is not used if it is referred to as “arial” in an MPL layout. 

 Are you using the correct font specification files? MPL 2 uses the fontmap.lst file for mapping the 
actual font name to the .pfm and .pfb font file names and the FontAttributeMap.lst file for mapping 
the actual font name to the Maconomy font name. MPL 4 uses the FontFileMap.lst file for 
mapping the actual font name to the font file name and the FontAttributeMap.lst for mapping the 
actual font name to the Maconomy font name. These three files mentioned previously can be 
found in the /FontSupport folder of the Maconomy server folder. 

 Are you using spaces or tabs in the font specification files? You must use tabs to separate the 
information columns in the fontmap.lst and FontAttributeMap.lst files for MPL 2 and in the 
FontFileMap.lst and FontAttributeMap.lst files for MPL 4. 

 Are you expecting a boldface or italic font, but getting the plain font? If you specify, for example, 
bold+ in an MPL layout, the font must support a boldface variant. This variant must be referenced 
in the FontAttributeMap.lst file, listing the PostScript variant on the left side and the MPL 
reference on the right. 

 When using PrintToPDF, an error message says that the font is not found. For instance: 
“ClibPDF: Font not found: OCRB-Alternate >> substituting Times-Roman.” 

This usually means that PrintToPDF could not find the font that is referenced in the MPL layout 
being printed. (It could also mean that the font that it found is not a correct font, but that is quite 
unusual.) By default, PrintToPDF looks for fonts in the current directory first, then in 
/usr/local/font/pfm and /usr/local/font/pfb (Unix only), and finally in the folders specified for the 
font in the fontmap.lst file. 

 Have you set the MACONOMY_FONTHOME environment variable in the MaconomyServer.I file 
for MPL 4? 

MPL 4 uses the MACONOMY_FONTHOME environment variable to search for font files. Multiple 
folders separated by a semicolon can be specified. If this environment variable is not set, 
/FontSupport/fonts is assumed to be default location of the font files. This environment variable is 
not used for Base 14 fonts. 

 Do you get the Helvetica font in the pdf instead of the font used in the MPL 4 layout? 

This indicates a missing mapping between the actual font name and the Maconomy font name in 
the FontAttributeMap.lst file and, in such a case, Helvetica is used as the default font. Note that 
MPL 4 does not support the notion of substitution fonts used by MPL 2. 

 Do you get a runtime error when using a font other than a Base 14 font in MPL 4? 

This may be due to a missing mapping between the actual font name and the font file name in the 
FontFileMap.lst file, or because the folder in which the font file is placed is not specified in the 
MACONOMY_FONTHOME environment variable, or because the font file could not be found for 
some reason. 

Google Noto Fonts 
Google’s font family, called Noto, supports all languages with a similar style. Maconomy includes four 
Google Noto fonts, and Google customers can obtain additional fonts for broader language needs. 

From Google: Noto has multiple styles and weights, and it is freely available to all. The 
comprehensive set of fonts and tools used in our development is available in our GitHub repositories. 

 
Attention: To see more information, click https://www.google.com/get/noto/. 

https://github.com/googlei18n?query=noto
https://www.google.com/get/noto/
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Note: Noto is a trademark of Google Inc. Noto fonts are open source. All Noto fonts are published 
under the SIL Open Font License, Version 1.1. Language data and some sample texts are from the 
Unicode CLDR project. 

http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&id=OFL
http://cldr.unicode.org/
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Printing Right-to-Left Languages 
Maconomy supports the entry and display of data in right-to-left languages, and the Maconomy Print 
Language (MPL) supports the correct printing of such text. Specifically, companies can: 

 Configure Maconomy to print data in right-to-left languages in an otherwise left-to-right language 
print. For example, you can print Arabic customer names within an English-language print.  

 Customize MPL layouts so that static content on a print is in a right-to-left language as well. For 
example, you can create a custom invoice entirely in Arabic. 

For most use cases, the DefaultTextDirection configuration setting, editable in the MaconomyCustom.ini 
server config file, should be set to LTR (left-to-right bi-directional printing). Suppose English is an 
example left-to-right language and Arabic is an example right-to-left language. Setting 
DefaultTextDirection to LTR will cover the correct printing of English-only language text, Arabic-only 
language text, and instances where Arabic appears within English text.  

For specific instances where text is predominantly Arabic but contains some English phrases, read further 
to understand options to support this.  

The following sections provide a conceptual overview of bi-directional printing and setup instructions for 
enabling this functionality. These setup instructions should apply for most companies and their users. 

Bi-Directional Printing 
The textdirection MPL style attribute supports the one-directional left-to-right mode of printing, as well as 
the bi-directional modes of printing which are both capable of printing right-to-left languages correctly. 

The succeeding paragraphs use English as the left-to-right language, and Arabic as the right-to-left 
language. The concepts discussed should apply to all left-to-right and right-to-left languages, respectively.  

The textdirection attribute can assume any of the following values: 

 NOBIDI: The one-directional (or non-bi-directional) default that is equivalent to how MPL used to 
work prior to the introduction of bi-directional printing. Text is always printed left to right 
independently of the language used. 

 RTL: Uses bi-directional reordering with left-to-right preferential run direction. With this algorithm, 
the text is divided into English and Arabic blocks. Characters comprising Arabic blocks are always 
printed right to left. Moreover, the blocks themselves are printed in the right-to-left order. This 
setting is ideal for embedding English within Arabic text, where all text reads right to left apart 
from English words which read left to right.  

 LTR: Uses bi-directional reordering with right-to-left preferential run direction. With this algorithm, 
the text is also divided into English and Arabic blocks. Characters comprising Arabic blocks are 
always printed right to left. Moreover, the blocks themselves are printed in the left-to-right order. 
This setting is ideal for embedding Arabic within English text, where all text reads left to right 
apart from Arabic words which read right to left.  

To better understand these settings, consider the following sample sentences: 

 Is the share price going to raise this year? 

 العام؟ ھذا سیرتفع السھم  سعر  ھل  [English translation of the above] 

 Employee عالیھھ will be promoted. [English: Employee Aaliyah will be promoted.] 

 مربح DELTEK رائعة [English: Company DELTEK is profitable] 

The following screenshot shows how these sentences will be printed in MPL using the three settings.  
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Note that when using LTR, sentences 1, 2, and 3 are printed correctly, but 4 is incorrect. On the other 
hand, when using RTL sentences 2 and 4 are correct and 1 and 3 are incorrect. NOBIDI is not suitable for 
printing Arabic at all, as it prints everything left to right. 

In conclusion, when using Arabic words in the English context, the LTR text direction is appropriate. For 
embedding English words in the Arabic context, RTL is a better fit. 

Setting Text Direction 
You can use the DefaultTextDirection attribute to specify the system-wide Maconomy setting. To do this, 
update the /MaconomyDir/Definitions/MaconomyCustom.ini server config file. 

For example:  
[MPLConfig] 

DefaultTextDirection=LTR  

Setup Instructions 
For purposes of backward compatibility, bi-directional printing is disabled by default.  

Once enabled, this functionality works for both the Workspace and web clients. 

 

Note: If you are a customer on Maconomy Cloud who needs to use this functionality, file a support 
case with Deltek Cloud Operations. 
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To enable this feature:  
1. Make sure you have installed the right fonts to render your right-to-left language (if applicable). 

 
2. Configure text direction for your entire system: 

By default, the system-wide text direction is set to NOBIDI. 
a. In the /MaconomyDir/Definitions/MaconomyCustom.ini file, specify a new value for 

DefaultTextDirection.  

For example: 
[MPLConfig] 

DefaultTextDirection=LTR 

b. Recompile all standard and custom print layouts.  

 To recompile the standard layouts, use the MaconomyServer –UP command. 

 To recompile your custom print layouts, use the MaconomyServer –UVP command. 

 
For example: 
MaconomyServer.w_21_0.cmd-Sw210 –UP 

MaconomyServer.w_21_0.cmd-Sw210 –UVP 

Attention: For more information, refer to the “Font Administration and Installation in MPL 4” 
section. 

Attention: For detailed descriptions of the MaconomyServer commands and the –UP/–UVP 
options, refer to the “Maconomy Server Executable Options” section. 
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Install and Upgrade 

Automated Hotfix (CU) Installation 
An installer specialized for Cumulative Update (CU) installations simplifies the process of installing CUs. 
The CU installer, which is a hardcoded MConfig installer applying the same underlying functionality as 
MConfig, handles APUs, TPUs, web client PUs, and standard SPUs. 

 

To use the CU installer: 
1. Manually move the relevant PUs to the packing units folder on the machine.  

All relevant PUs are automatically installed by the installer.  

2. Ensure that all the PUs are in the packing units folder.  

This means that if a CU includes both an APU and a TPU, you cannot choose to install the TPU 
only. In this example, you must include both the APU and TPU.  

3. In the CU Installer folder, right-click the Install[version].exe installer, and click Run as 
Administrator.  
The Maconomy Configurator screen displays, prompting you to select the needed installation 
tasks. The installer scans the list of applications on the server and finds which applications the 
CU is relevant.  

4. On the Maconomy Configurator screen, select the applications for which the CU should be 
installed, and click OK. 

 
In the screenshot example above, the CU can be installed on the applications w_20_0.ora-mcs 
and w_20_0.remote-msql. The CU could have been applied to w_20_0.msql-mcs-2, as well, if the 
web client PU had been present. 

Note: Each CU installer is built for a specific CU and can be used only for that particular CU. For 
example, a CU installer for Maconomy 2.5.1 CU 5 can be used only for installing 2.5.1 CU 5, not 
others such as 2.5.1 CU 4. 
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5. Select the applications to install, and click OK.  

6. Enter the database system password (as you do when using MConfig).  

The MConfig Scripting Console runs automatically. 

7. If the application uses remote database servers or remote web servers, start the wiserver 
program on the remote machines, and click OK. 

The installer installs the CU on the selected application(s) and then closes down. 
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Windows Installation 
Deltek Best Practice 
Windows Installation 
From DSM, download the latest Maconomy Workspace Client installation package. 

Update Sites 
Using the ZIP packages enables you to use Update Sites, ensuring that new versions of the Client, 
translations, and branding (if required) are automatically downloaded and installed on User’s 
machines whenever they are available. All updates to the WSC released via new major or minor 
versions, maintenance releases, or cumulative updates can then be automatically installed via 
Update Sites rather than manually.  

If you upgrade to a new version of Maconomy without enabling full Update Sites functionality, you 
must uninstall the previous version prior to installing a new WSC. 

 

 

Deltek Best Practice 
Macintosh Installation 

 From DSM, download the latest Maconomy Workspace Client installation package. 

 Install the Workspace Client on the user’s desktop or in the user’s Home folder in order to 
allow read/write access. This ensures that the WSC automatically updates in all scenarios. 

 

Prepopulate IP Address and Port Number 
When installing the Workspace Client, you can prepopulate the IP address and Port number in the .ini file 
so that the end-user does not need to enter them at first login. Update Sites overwrites the .ini file when 
the Client is updated. If you would like to prepopulate IP addresses and Port numbers for end users and 

Warning: MSI Installer is NOT Recommended Method 

Workspace Clients installed using the MSI installer cannot use Update Sites and are not 
automatically updated for all upgrades. Since Update Sites require write access to the directory 
where the Client is installed, Workspace Client upgrades where the embedded Java is changed 
only update automatically if installed using the ZIP packages.  

If the WSC is installed using this method, Deltek cannot guarantee that Update Sites will support 
a new version of the WSC, and this may require that a completely new installation is made for 
each user. 

Warning: Do NOT Install in Global Applications Folder 

Installing in the Global Applications folder only allows read-only access to the WSC, which 
prevents automatic updates and is likely to require that updates to the WSC will require a new 
installation. 
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would like this to be maintained post-upgrade, you must implement a .cmd wrapper to launch the WSC, 
such as:  
Maconomy.exe -a <hostname> -p <portnumber>  

Windows Uninstall 

To uninstall the Workspace Client on a Windows computer: 
1. Start the Windows Control Panel. 

2. Select Uninstall a Program or go to Programs and Features » Uninstall or change a 
program, depending on the version of Windows that you are using. 

3. Select the Deltek Maconomy Workspace Client. 

The Windows uninstaller removes the Workspace Client. 

Macintosh Installation and Uninstall 

To uninstall the Workspace Client on a Macintosh computer: 
1. Locate the .DMG file. 

2. Click the .DMG file and drag the package into the preferred location. 

The Macintosh uninstaller provides prompts for the steps that are required. 

3. Follow the steps and respond appropriately. 

The Macintosh installer removes the Workspace Client. 

Update Sites 
Use Update Sites to update/install additional features for the Maconomy 2.1.5 (and newer) Workspace 
Client.  

Automatic updates of the Workspace Client are possible in most installations, but some versions of the 
Workspace Client may contain components that cannot be updated and that may require re-installation of 
the Workspace Client. Some customers may also have restrictions on their computers (such as terminal 
servers) that may prevent automatic updates to succeed, and thereby require re-installation. Windows 
access rights management may also prevent automatic updates to be successful if the Workspace Client 
was originally installed using the MSI installer. Therefore, Deltek recommends that installations of the 
Workspace Client on Windows platforms be performed using the ZIP packages. 

The update/install is performed by the Workspace Client using the p2 provisioning platform, which 
requires the installable/updated units to be packaged as Update Sites and made available on a web 
server. If new Workspace Client features do not prevent automatic updates, Update Sites for Maconomy 
2.1.5 (and newer) Workspace Clients are distributed with the Coupling Service and installed with the 
Coupling Service using MConfig. 

The process of the install/update mechanism can be described as the following: 

 The update repositories are created using the Build Updatesite tool and delivered as independent 
packages –repo.tar files. 

 The Update Sites are installed with the Coupling Service and deployed on a web server using 
MConfig. 
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 With Update Sites installed on the web server, the Workspace Client will be able to connect to the 
Coupling Service and acquire the location of Update Sites on the web server, resolve necessary 
dependencies, and download updates/installs from the specified location. 

This section describes how to set up Update Sites for the Coupling Service using MConfig. 

Before You Begin 
Review these notes about Update Sites: 

 Update sites can be used to update: 

 New versions of the Workspace Client, which come based on a Maconomy update as a CU, 
MU, or new version,  

 Dictionaries, for which customers implement changes 

 Branding, for which customers implement changes 

 Updates of the WSC are typically of equal size as new versions of all plugins that are included in 
the update. However, updates to new versions may also include changes reserved only to new 
versions, which may make them slightly larger. 

 Update Sites can impact customer networks, including information that updates are at present 
passive until users actively attempt to open the WSC following a new change. Maconomy comes 
with the ability to configure a script to push updates more efficiently to users on the network 
whenever possible, even if they do not actively open the WSC. 

 For branding and dictionaries, no update is made unless changes to the timestamp are made. 
Therefore, if no branding changes are made, this does not add to the size of the update. 

Building Update Sites 
A Documentation package (Maconomy Help) is delivered as an Update Site. The package is created 
using the Build Updatesite tool and packed in <package_name><timestamp>-repo.tar file. The 
following are the most important elements in the folder structure of the Update Site package: 

 /artifacts.jar: This is the generated artifact repository index file for the Update Site. 

 /content.jar: This is the generated metadata repository index file for the Update Site. 

 /plugins: This folder contains the plugins that compose the Update Site and is downloaded during 
the update. 

 /features: This folder contains the features that compose the Update Site and is downloaded 
during the update. 

The Build Updatesite tool can be run with Ant if the input plugins and features to be exported into Update 
Site. The output of the tool is a generated Updated Site packaged in the 
<package_name><timestamp>-repo.tar file. 

Installing Update Sites with MConfig 
After the Update Site package is created, it is ready to be installed and deployed with MConfig. MConfig 
is intended to unpack the Update Site -repo.tar package and deploy it on the web server. In addition, 
MConfig writes the location of the deployed Update Site into the updatesite.ini file on the Coupling 
Service. 

The following are detailed instructions on how to install Update Sites with MConfig: 
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 Update Sites for the Workspace Client should be deployed on a web server. Web servers can be 
set up as usual from the Web Products screen. 

 On the OSGi products screen, a selection list displays available web servers for use with the 
Workspace Client update sites. To deploy Update Sites on a specific web server, select it from 
the list 

 Additional packages to be installed should be placed in the PUs folder. Available packages to be 
deployed can be selected on the OSGi Products screen. Packages should be valid P2 
repositories placed in a .tar archive named like MyPackage-repo.tar. 

 

Additional Step When Using IIS Web Server 
Some of the Update Site files that must be downloaded by the client have no naming extension. If Update 
Site is set up on a web server that runs on IIS, these files are by default inaccessible. 

To enable access, configure the IIS site to allow Extension “.*” with MIME as the type of 
“applications/octet-stream.” Set this up in IIS manager, on the “MIME types” configuration panel 
specifically for the Maconomy/Update Site path on the web site under consideration. 

Updating the Maconomy Workspace Client 
When Update Sites are successfully installed with the Coupling Service and deployed on the web server 
using MConfig, they are ready for the Maconomy Workspace Client. The update process can be 
described as follows: 

 The Update Sites are deployed on the web server and are ready to be downloaded. 

 The Coupling Service knows about the location of the Update Sites from which they can be 
downloaded. 

 The Workspace Client starts up and connects to the Coupling Service during the initial login 
process. 

 The Coupling Service notifies the Workspace Clients about available updates/installs and 
provides the location for Update Sites. 

 The Workspace Client checks and resolves possible updates/installs and downloads them from 
the specified location. 

 If new updates/installs were downloaded, the Workspace Client restarts so that the new changes 
take effect. 

 If no updates were found, the Workspace Client starts up normally. 
By default, the Workspace Client displays a warning message to inform you when an update is available. 
To disable this and allow the system to automatically update the system, you can edit the CS settings.ini 
file. 

To do so, edit the following property in the CS settings.ini file: 
client.p2.showInstallAndUpdateWarning = <boolean> 

The default value is true. Change it to false to remove the warning message. 

Attention: For more details, refer to “How to Install the Coupling Service with MConfig” Section. 
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Silent Updates 
You can run a command to enable Maconomy to push updates whenever possible, instead of when users 
actively open the WSC. 

In Windows, open the command prompt and run the following command: 
Maconomy.exe --silentInstallAndUpdate -a <host> -p <port> 

You can also run this command in MAC OSX. Open the Terminal and run the following command: 
Maconomy.app/Contents/MacOS/Maconomy --silentInstallAndUpdate -a <host> -p <port> 

Solutions 
As part of a Maconomy release, two solutions—PSO and CPA—are released as sub-releases. These two 
solutions can be installed on top of the core Maconomy by using Mconfig. 

The two solutions are packaged in solutions files that are targeted for a specific Maconomy release. 

Extensions 
A Maconomy release contains some product extensions. Some are built into the core Maconomy systems 
and are seen as standard functionality, such as “export to Excel”, whereas other extensions are installed 
as separate functionality, such as “Credit Control.” The standard product extension should by default 
always be installed using Mconfig. In special customer solutions, it may be decided not to install the 
standard extensions, and default selections in Mconfig may need to be changed when installing 
packages. 

Export to Excel Row Summary 
The Export to Excel action enables you to include a count of the number of rows included in the 
generated file. 

Administrators must configure this option prior to use. The following parameters are added to export-to-
Excel action ExportDataSet: 

 RowId (boolean): If enabled, a row-id (number starting from 1) is added as the first column for all 
rows in the export. The color-format of the row-id column is identically to the header-color-code. 

 RowCount (boolean): If enabled, a count (number) of all data-rows is added as the last line in 
the export (for example, Row Count: 1001). 

The system checks that the number of rows does not exceed 1048576, which is the maximum number of 
rows supported by Excel (including header and tail-info/row count).  

 
Note: If the number of lines exceeds this number, the export is truncated. 
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Set Up Maconomy 

Background Task Setup  

 

User Masking Setup 
To enable user, employee, and company masking, you must set the value of the Allow User Masking for 
Company system parameter. 

To enable masking: 
1. Navigate to Setup » System Setup » Parameters and Numbers » System Parameters tab. 

2. In the Show field, select All Parameters. 

The table displays the list of all system parameters. 

3. In the Description column, scroll to Allow User Masking for Company and double-click to open 
the System Parameter tab for that parameter. 

4. On the System Parameter tab, select Allow User Masking for Company in the System 
Parameter island.  

The default value is false (not selected). 

5. Optional: Enter any appropriate remarks in the Remarks field.  

6. Enter or search for a company number in the Company No. column in the Company Specific 
Values subtab. 

This column is validated; the company number must exist. 

7. Select the Allow User Masking for Company column to enable masking for this company.  

The default value is false (not selected). 

8. Optional: Enter any appropriate remarks in the Remark 1 – 3 columns. 

Repeat this process to enter the company numbers for all the companies for which you want to enable 
masking. 

Attention: For details, refer to the Deltek Maconomy Background Task Guide. 
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Long Text Support 
Originally introduced in version 2.1.1, the Long Text functionality allows you to add a text extension to 
timesheet lines so that end users can enter descriptions longer than the 255-character limit. Maconomy 
also displays the long text field during invoice editing and before printing of the final invoice. End users 
can edit the description before printing the final invoice.  

After a timesheet is approved, Maconomy transfers the long text references to the job entries. On the job 
entry, the long text is read-only. This means any workspaces that display job entries can display the 
corresponding non-editable long text. If a job is transferred or reallocated, the text reference is transferred 
to the new job entry.  

Beginning with version 2.4.4, this functionality is available in the Workspace Client, web client, and 
Touch. In the Workspace Client, the Texts single dialog box workspace displays all long texts used in the 
system, with the following information provided for each: 

 Reference instance key 

 Read-only status 

 Whether or not the long text is in use 

 

Setup Instructions 
To allow long text entry, enable the Enable Long Text Emulation in Workspaces system parameter. 
Enabling this parameter activates the layouts that contain the long text field. 

By default, this parameter is disabled. 

 

Containers for Long Text Support 
Workspaces that use long text are based on containers that have namespace = "MaconomyLongText". 
The following table lists these containers and the names of the applicable fields' long text equivalent. 

Container Field/s 

MaconomyLongText:InvoiceEditing InvoicePrintoutLine.LongText (adjacent to existing 
InvoicePrintoutLine.Text) 

MaconomyLongText:QuoteEditing QuotationPrintoutLine.LongText (adjacent to 
existing QuotationPrintoutLine.Text) 

MaconomyLongText:QuoteRevisions QuotationPrintoutLine.LongText (adjacent to 
existing QuotationPrintoutLine.Text) 

Note: These fields are not available by default in the standard layout, but are available in the PSO 
and CPA Solution layouts. 

Warning: If you enable/disable the system parameter after deploying the system to users, your 
standard layouts will stop displaying existing descriptions. As a temporary solution, you can use 
custom layouts for viewing these descriptions. 

This limitation applies to all clients. 
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Container Field/s 

MaconomyLongText:Requisitions RequisitionLine.LongLineText (adjacent to 
existing RequisitionLine.LineText) 

MaconomyLongText:RequestsForQuote RequestForQuoteLine.LongLineText (adjacent to 
existing RequestForQuoteLine.LineText) 

MaconomyLongText:PurchaseOrders PurchaseOrderLine.LongLineText (adjacent to 
existing PurchaseOrderLine.LineText) 

MaconomyLongText:InvoiceAllocation VendorInvoiceJournal.EntryText 

MaconomyLongText:InvoiceReallocation  

(up to and including Maconomy 20 only) 

VendorInvoiceJournal.EntryText 

MaconomyLongText:ShowJobInvoice InvoicePrintoutLine.LongText (adjacent to existing 
InvoicePrintoutLine.Text) 

MaconomyLongText:ShowJobCreditMemo InvoicePrintoutLine.LongText (adjacent to existing 
InvoicePrintoutLine.Text) 

MaconomyLongText:JobInvoiceCrediting InvoicePrintoutLine.LongText (adjacent to existing 
InvoicePrintoutLine.Text) 

There are also Workspace Client containers that include the LongDescriptionDay1-7 and 
LongDescriptionWeek long text fields as an extension to the normal fields used in pane layouts. The 
following table lists these containers and the names of the applicable long text fields. 

Container Field/s 

MaconomyLongText:TimeRegistrationDetails  TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 
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Container Field/s 

MaconomyLongText:TimeRegistrationDetails
DayDescription 

 TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

MaconomyLongText:TimeRegistrationDetails
WeekDescription 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:TimeSheetLines  TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:TimeSheetLinesDayDes
cription 

 TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 
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Container Field/s 
 TimeSheetLine.LongDescriptionDay5 (adjacent 

to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

MaconomyLongText:TimeSheetLinesWeekDe
scription 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:DailyTimeSheetLines  DailyTimeSheetLine.LongDescriptionDay 
(adjacent to existing 
DailyTimeSheetLine.DescriptionDay) 

 DailyTimeSheetLine.LongDescriptionWeek 
(adjacent to existing 
DailyTimeSheetLine.EntryText) 

MaconomyLongText:DailyTimeSheetLinesDa
yDescription 

 DailyTimeSheetLine.LongDescriptionDay 
(adjacent to existing 
DailyTimeSheetLine.DescriptionDay) 

MaconomyLongText:DailyTimeSheetLinesWe
ekDescription 

 DailyTimeSheetLine.LongDescriptionWeek 
(adjacent to existing 
DailyTimeSheetLine.EntryText) 

MaconomyLongText:TimeRegistration  TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:TimeRegistrationDayDes
cription 

 TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 
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Container Field/s 
 TimeSheetLine.LongDescriptionDay2 (adjacent 

to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

MaconomyLongText:TimeRegistrationWeekD
escription 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:ApprovalTimeSheets  TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:ApprovalTimeSheetsDay
Description 

 TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 
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Container Field/s 
 TimeSheetLine.LongDescriptionDay6 (adjacent 

to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

MaconomyLongText:ApprovalTimeSheetsWe
ekDescription 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:ApproveTimeSheetLines  TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:ApproveTimeSheetLines
DayDescription 

 TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

MaconomyLongText:ApproveTimeSheetLines
WeekDescription 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 
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Container Field/s 

MaconomyLongText:TimeSheets  TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:TimeSheetsDayDescripti
on 

 TimeSheetLine.LongDescriptionDay1 (adjacent 
to existing TimeSheetLine.DescriptionDay1) 

 TimeSheetLine.LongDescriptionDay2 (adjacent 
to existing TimeSheetLine.DescriptionDay2) 

 TimeSheetLine.LongDescriptionDay3 (adjacent 
to existing TimeSheetLine.DescriptionDay3) 

 TimeSheetLine.LongDescriptionDay4 (adjacent 
to existing TimeSheetLine.DescriptionDay4) 

 TimeSheetLine.LongDescriptionDay5 (adjacent 
to existing TimeSheetLine.DescriptionDay5) 

 TimeSheetLine.LongDescriptionDay6 (adjacent 
to existing TimeSheetLine.DescriptionDay6) 

 TimeSheetLine.LongDescriptionDay7 (adjacent 
to existing TimeSheetLine.DescriptionDay7) 

MaconomyLongText:TimeSheetsWeekDescri
ption 

 TimeSheetLine.LongDescriptionWeek (adjacent 
to existing TimeSheetLine.EntryText) 

MaconomyLongText:DailyTimeRegistration  DailyTimeSheetLine.LongDescriptionDay 
(adjacent to existing 
DailyTimeSheetLine.DescriptionDay) 

 DailyTimeSheetLine.LongDescriptionWeek 
(adjacent to existing 
DailyTimeSheetLine.EntryText) 
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Container Field/s 

MaconomyLongText:DailyTimeRegistrationDa
yDescription 

 DailyTimeSheetLine.LongDescriptionDay 
(adjacent to existing 
DailyTimeSheetLine.DescriptionDay) 

MaconomyLongText:DailyTimeRegistrationW
eekDescription 

 DailyTimeSheetLine.LongDescriptionWeek 
(adjacent to existing 
DailyTimeSheetLine.EntryText) 

MaconomyLongText:DailyTimeSheets  DailyTimeSheetLine.LongDescriptionDay 
(adjacent to existing 
DailyTimeSheetLine.DescriptionDay) 

 DailyTimeSheetLine.LongDescriptionWeek 
(adjacent to existing 
DailyTimeSheetLine.EntryText) 

MaconomyLongText:DailyTimeSheetsDayDes
cription 

 DailyTimeSheetLine.LongDescriptionDay 
(adjacent to existing 
DailyTimeSheetLine.DescriptionDay) 

MaconomyLongText:DailyTimeSheetsWeekD
escription 

 DailyTimeSheetLine.LongDescriptionWeek 
(adjacent to existing 
DailyTimeSheetLine.EntryText) 

MaconomyLongText:JobDailyTimeRegistratio
n 

 DailyTimeSheetLine.LongDescriptionDay 
(adjacent to existing 
DailyTimeSheetLine.DescriptionDay) 

 DailyTimeSheetLine.LongDescriptionWeek 
(adjacent to existing 
DailyTimeSheetLine.EntryText) 

MaconomyLongText:JobDailyTimeRegistratio
nDayDescription 

 DailyTimeSheetLine.LongDescriptionDay 
(adjacent to existing 
DailyTimeSheetLine.DescriptionDay) 

MaconomyLongText:JobDailyTimeRegistratio
nWeekDescription 

 DailyTimeSheetLine.LongDescriptionWeek 
(adjacent to existing 
DailyTimeSheetLine.EntryText) 

The containers postfixed ...DayDescription or ...WeekDescription only add said long text fields. These 
containers support only one long text (instead of several) and perform better than the general container. 

Long Text in Invoice Editing 
To display long text during invoice editing: 

 The invoice layout rule should specify that invoices must print one line per registration. 

 The Registration Specification – Field 1 detail must be either the 
DailyDescriptionTextHeaderInstanceKey field or the EntryTextTextHeaderInstanceKey field. 
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Printing Considerations 

Using Long Text in Invoice Prints 
To use the long text daily descriptions from time sheet lines in invoice prints, select One Entry per Day in 
the Allocation Method field in the System Information Workspace.  

Splitting Long Text in Prints 
For the workspaces that correspond to the containers listed above, the long text is stored as a series of 
records in the database. When printed, these records display as continuous long text. 

However, as the print area is limited, the chunks of text stored in each record must not exceed the space 
available in the corresponding print. To know where to split a long text, the system needs to determine 
the following:  

 What is the name of the font used for printing?  

 What is the font-size used?  

 Is the font boldfaced, italicized, and/or underlined? 

 What is the width available for printing (measured in points)? A point corresponds to 1/72 of an 
inch. 

The configuration of these properties are stored in dedicated option lists in the database. To look up the 
properties for a specific area, use any of the following option lists:  

 config:longtext:Invoice: Used for Invoice Editing  

 config:longtext:Quote: Used for Quote Editing and Quote Revisions  

 config:longtext:Requisition: Used for Requisitions 

 config:longtext:RequestForQuote: Used for Request for Quotes 

 config:longtext:PurchaseOrder: Used for Purchase Orders 

 config:longtext:InvoiceAllocation: Used for Invoice Allocation and Invoice Reallocation 

For each of these option lists, you can use the Name field for the property name and the Description 
field for the corresponding value. 

You can specify the following properties:  

 fontName: The name of the font 

 fontSize: The size of the font (in points) 

 fontBoldface: True or False. True if the font is boldfaced. 

 fontItalic: True or False. True if the font is italicized. 

 fontUnderline: True or False. True if the font is underlined. 

 Width: A number indicating the available printing width (in points) 

Note: Even with long text enabled, users cannot enter descriptions exceeding 255 characters in 
header-type Description fields on all invoice lines. These lines have specific printing restrictions which 
make them unable to accommodate long text. 

This exception applies to all clients. 
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 Indentation: A number indicating a possible indentation. For example, if width = 200 and 
indentation = 10, the available space is calculated as 200 – 10 = 190. 

If you do not define any of these properties, the system uses default values for them. These default 
values roughly correspond to the factory settings of Maconomy prints.  

Company-Specific Settings 

In addition, you can opt for company-specific settings to address instances when one company uses 
layouts different from another company within a multi-company setup. To indicate settings specific to a 
company, create an option list with the "config"-option-list names listed above and with ".company" 
appended to each name, followed by the value of the company number. 

For example, if you need an option list that indicates the invoice settings for a company assigned 
company number “1,” use the following format:  

config:longtext:Invoice.company1  

If you do not define any company-specific options lists, the system uses the general (non-company-
specific) option list. 

Usually, when a company-specific option list is specified, only that list is taken into account. Any property 
not specified for that list will instead use the default (factory-setting) value.  

However, you can specify that the remaining values should instead be taken from the general (non-
company-specific) option list. You do that by specifying a line in the option list with name = "addendum" 
and the corresponding description as true. This points Maconomy to the company-specific list as an 
addendum to the general list, rather than as a stand-alone list.   

Line-Specific Properties 

For some prints, the properties may differ for each specific line within the print. For example, in the 
standard invoice print, the indentation differs depending on the specified indentation level on the line. 
Second, the font differs depending on the value of the property header. Finally, the print settings might be 
different in invoices and credit memos. To accommodate such needs, you can further refine the 
properties. If you postfix certain specifications to a property, you can override general properties 
depending on the specific line that is printed. 

For example, if you need to set different values for the indentation property of some instances of the 
Indentation Level field, postfix a given property with .indentLevel0 for indentation level 0, .indentLevel1 
for indentation level 1, and so on. 

That is, if you set the value for indentation.indentLevel2 as 10, and set the value for 
indentation.indentLevel3 as 20, lines with an indentation level of 2 are indented by 10 points, and lines 
with an indentation level of 3 are indented by 20 points.  

You can specify properties that relate to whether or not a line is a header. When you do this, make sure 
you take the indentation level of the line into account. The postfix properties for header lines are .header 
for header lines and .noHeader for non-header lines. 

Hence, if you want to declare that headers at indentation level 1 are boldfaced, specify the 
fontBoldface.header.indentLevel1 property, and give it the value true.  

Finally, you can refine the values for invoices and credit memos. When you do this, take the 
header/noHeader into account as well as the indentation level. The postfixes for invoices and credit 
memos are .invoice and .creditMemo, respectively.  

To specify a width of 230 points for credit memos and 200 points for invoices, specify the width as 200 
and then specify all relevant width combinations of the width property for credit memos as:  

"width.creditMemo.header.indentLevel0" (200) 
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"width.creditMemo.header.indentLevel1" (200)  

"width.creditMemo.header.indentLevel2" (200)  

"width.creditMemo.header.indentLevel3" (200)  

"width.creditMemo.header.indentLevel4" (200)  

"width.creditMemo.header.indentLevel5" (200)  

"width.creditMemo.header.indentLevel6" (200)  

"width.creditMemo.header.indentLevel7" (200)  

"width.creditMemo.noHeader.indentLevel0" (200)  

"width.creditMemo.noHeader.indentLevel1" (200)  

"width.creditMemo.noHeader.indentLevel2" (200)  

"width.creditMemo.noHeader.indentLevel3" (200)  

"width.creditMemo.noHeader.indentLevel4" (200)  

"width.creditMemo.noHeader.indentLevel5" (200)  

"width.creditMemo.noHeader.indentLevel6" (200)  

"width.creditMemo.noHeader.indentLevel7" (200)  

Maconomy prioritizes and uses the most specific property. That is, it looks for and examines the 
properties in the following order: 

1. Properties that contain invoice/creditMemo, header/noHeader, and indentLevelN. 

2. If no property fits the first criterion: Properties that contain invoice/creditMemo and 
indentLevelN. 

3. If no property fits the first and second criteria: Properties that contain indentlevelN. 

4. If no property fits the first, second, and third criteria: Pure property. 

A similar but less complex way of having different properties based on the line-type is also available in the 
three purchase-related areas: Requisitions, Requests for Quotes, and Purchase Orders.  

Although these three areas can have properties of their own, you would usually want to keep them 
completely identical. This relates to the fact that you can create a Request for Quote based on a 
Requisition, and create a Purchase Order from a Request for Quote. You can even create a Purchase 
Order directly from a Requisition.  

For these purchase areas, you can postfix a specific property based on the type of line. If fixed asset-
related lines use a different font than job/cost-related lines, you can take that into account. The possible 
postfixes are:  

 .fixedAsset for fixed-asset related lines 

 .inventory for inventory-related lines 

 .jobCost for job-cost-related lines 

 .g/l for G/L-related lines  

 .subcontractor for sub-contractor-related lines 

To display and print sub-contractor-related lines in italics, specify the fontItalic.subcontractor property 
and give it the value true. 
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Debugging 
The Texts single dialog box workspace (Single Dialogs » Set-Up » Note » Texts) lists all long texts in 
the system. This is useful for debugging purposes. 
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Advanced Logging Setup 
This section contains setup information and examples for Advanced Logging.  

 

Configuration File 
The relations and fields to be monitored are specified in a text file on the server. This file is encrypted to 
prevent unauthorized changes (tampering) by users. The encryption is performed by Maconomy A/S on 
request. 

 Location: The configuration file is called UpdateLog.cnf and is placed in the Definitions folder on 
the Maconomy server. 

 Content: Two optional keywords can be added to the beginning of the file: NoLogOnCreate and 
LogOnDelete. The order of the keywords is insignificant. 

 NoLogOnCreate: If this keyword is specified, log entries are not made when a record of the 
types specified later in the file is created, only when it is changed. 

 LogOnDelete: If this keyword is specified, Maconomy logs the deletion of a field in one of the 
included relations by registering the value that was deleted as a change to a blank value. If 
not specified, Maconomy simply records the fact that it was deleted (but does not include the 
deleted value). 

In addition, enter the names of the relations that you want to log when they are updated. Each line must 
end with a semicolon. You can modify the relation selection in several ways: 

 You can add lists of fields that you want to exclude from the log (for example, ChangedBy, which 
is included in the log anyway). This is done using the keyword Exclude. 

 If you only want to log changes to a few fields in a relation, you can add lists of fields that you 
specifically want to add to the log. This is done using the keyword LogOnly. 

 You can specify a custom key for the relation. It is not always interesting to use the database 
specified key. For instance, in the relation DialogGroupMember, the database key is GroupTitle, 
LineNumber, but it would be more interesting in the subsequent use of the Analyzer report to be 
able to use GroupTitle, WindowTitle as key. This is done using the keyword Key. 

 You can specify that you only want to log an entry if one or more specific fields are changed. For 
instance, you may only want to log changes to a vendor if the vendor’s bank account number is 
changed. This is done using the keyword IfChanged. 

BNF Syntax 
The formal syntax for the specification of relations and fields can be expressed as follows in Backus Naur 
Form (BNF): 
<UpdateLog> ::= [NoLogOnCreate;][LogOnDelete;]<RelationDefinition> 

{; <RelationDefinition>} 

<RelationDefinition> ::= <RelationName> 

(   Key 

<FieldList>) ( IfChanged 

<FieldList>) ( Exclude 

Attention: For conceptual information, refer to the Advanced Logging section. 
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<FieldList>) 

(   LogOnly 

<FieldList>) 

<FieldList> ::= (<FieldName> {; <FieldName>}) 

Example 
The following configuration file example sets up Maconomy to log changes in the following way: 

 No log entries are added when an object is created, only when changed. 

 When a logged field is deleted, the deleted value is logged as a change to <blank>. 

 In the Customer Information Card window (and related windows), changes to the Credit Max., 
Segment, and Customer Payment Mode fields are logged. 

 In the Vendor Information Card (and related windows), System Information, Company 
Information, Users, Access Information, and Access Levels windows, all changes are logged with 
the exception of the Changed On, Changed By, and Version No. fields. 

 In addition, all changes to the following windows are logged: Groups (with a custom key), Access 
Level Lines (table part of Access Levels), and User Access Levels. 

The file would look like the following example: 

NoLogOnCreate;  

LogOnDelete;  

Customer LogOnly(CreditMax, Segment, CustomerPaymentMode); 

Creditor Exclude(ChangedDate, ChangedBy, Versionnumber); 

SystemInformation Exclude(ChangedDate, ChangedBy, Versionnumber); 

CompanyInformation Exclude(ChangedDate, ChangedBy, Versionnumber); 

User Exclude(ChangedDate, ChangedBy, Versionnumber); 

DialogGroupMember Key(GroupTitle, WindowTitle); 

AccessInformation Exclude(ChangedDate, ChangedBy, Versionnumber); 

UserDialogGroup;  

AccessLevelHeader Exclude(ChangedDate, ChangedBy, Versionnumber); 

AccessLevelLine;  

UserAccessLevel;  

Notes 

What Is Logged 
 Data: A log entry is stored in two relations in the Maconomy database: UpdatingLog and 

UpdatingLogLine. The former contains the name of the relation, the window in which the change 
was made, and the key of the item that was changed. The latter contains information about which 
fields in the relation were changed. 

 The following data is logged in the UpdatingLog relation: 

 The name of the user who changed data 
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 An update log number 

 The date of the change 

 The time of the change 

 The name of the relation that was changed 

 The name of the window in which the relation was changed 

 The key (possibly composite key) of the changed data 

 The following data is logged in the UpdatingLogLine relation: 

 The name of the user who changed data 

 An update log number 

 An update log entry number 

 The name of the field that was changed 

 The content of the field before the change 

 The content of the field after the change (possibly blank, if LogOnDelete is specified) 

The first three items in the preceding list constitute the key reference to the UpdatingLog 
relation. 

A log entry might look like the following at the record level: 

UpdatingLog 

NameOfUse
r 

Updating 
LogNumbe
r 

TheDat
e 

TheTim
e 

RelationNa
me 

WindowNam
e 

KeyFiel
d Name1 

KeyValue
1 

..

. 

Arod 
Hasufel 

1 040219 10:23 Customer PaymentIn
f 
ormation 

Custome
r 
Number 

31003100  

And at the field level: 

UpdatingLogLine 

NameOfUser Updating 
LogNumber 

LineNumber FieldName CorrectedFrom CorrectedTo 

Arod 
Hasufel 

1 1 CreditLimit 20,00 40,000 

The Analyzer report Update Log is built on these two relations. 

Query Log 
The Maconomy Query Log is used for registering which users query the Maconomy database and what 
information they see, print, or export. 

The Maconomy database is considered to be queried in the following cases: 

 When viewing information in a dialog box 

 When using the Find window 

 When printing using parameter dialog boxes 

 When printing using Print This in the File menu 
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 When printing using an action in the Action menu 

 When exporting data from dialog boxes, including Find windows 

 When exporting data using an action (for example, Create Payment File) 

 When exporting data using add-on programs 

 When running SQL (RGL) reports 

However, internal transactional lookups are not considered a query. For example, when Maconomy 
checks for the existence of a customer in the General Journal, no log entry is made. 

Setup 

Configuration File 
The relations and fields to be monitored are specified in a text file on the server. The file is encrypted to 
prevent unauthorized changes (tampering) by users. The encryption is performed by Maconomy A/S on 
request. 

 Location: The configuration file is called RequestLog.cnf and is placed in the Definitions folder on 
the Maconomy server. 

 Content: In the file, enter the names of the relations that you want to log when they are queried. 
Each line must end with a semicolon. You can modify the relation selection to add a specific key 
to the log. 

 Input File Encoding: This field is in the parameter dialog boxes for auto-generated import 
programs. The encoding can be specified either in this field or on the first line in the import file. 
Valid encodings can be found here: http://demo.icu-project.org/icu-bin/convexp 

 Specifying in the import file must be done with a comment line (a leading tab) such as: 
DefaultInputCharSet=iso-8859-5 

 Only some encodings, such as ansi, iso-8859-15, and utf-8, can be specified in the file. UCS-
2/UTF-16 cannot be specified in the file. All supported encodings can be specified in the 
parameter dialog box field. 

 BNF syntax: The formal syntax for the specification of relations and fields can be expressed as 
follows (in Backus Naur Form): 
<QueryLog> ::= <RelationDefinition>{; <RelationDefinition>} 

<RelationDefinition> ::= <RelationName> ( Key<FieldList>) 
<FieldList> ::= (<FieldName> {; <FieldName>}) 

 Example: The following example sets up Maconomy to log all queries in the Customer 
Information Card (and related windows), Vendor Information Card (and related windows), and the 
Job Budgets (and related windows) windows. 
Customer; 

Creditor; 

JobBudget; 

http://demo.icu-project.org/icu-bin/convexp
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Notes 

What Is Logged 
 Data: A log entry is stored in the Maconomy database relation QueryLog. This relation contains 

the name of the relation, the window in which the query was made, and the key of the item that 
was queried. 

 The following data is logged in the QueryLog relation: 

 The name of the user who queried the data 

 The date of the query 

 The time of the query 

 The name of the relation that was queried 

 The name of the window from which the relation was queried 

 The key (possibly composite key) of the queried data 

A log entry might look like the following: 

QueryLog 

NameOfUser TheDate TheTime RelationName WindowName KeyFieldName1 KeyValue1 ... 

Arod 
Hasufel 

040219 10:23 Customer PaymentInformation CustomerNumber 31003100  

The Analyzer report Query Log is built on the QueryLog relation. 

Query Types 

Logging in Various Circumstances  
The following describes what triggers a log entry in the database in various situations in Maconomy. This 
description assumes that logging is set up for the relations that are described in the examples. 

 Dialog Boxes: In a dialog box, for example, the Customer Information Card, a log entry is made 
every time an information card is shown to the user. This means when you open the window, 
browse to another information card, or select a customer from a Find window. 

Redrawing the window is not regarded as a new query. 

If you open two windows to the same relation (for example, the Customer Information Card and 
the Payment Information window), and the windows are linked (Automatic Find is turned on in the 
Maconomy client), two entries are made every time you browse any of the windows. 

 Find Windows: All entry keys displayed  in the Find window are logged. The log only registers the 
records that are actually displayed. If tyou only see the first 30 records in the Find window, only 
30 records are logged, even though the search criteria actually resulted in hundreds of records. 

 Printing from Parameter Dialog Box: When printing, all selections that are to be printed (based on 
printable items in the current print layout) are logged. 

 Printing using Print This: This works as when printing from a parameter dialog. In addition, the 
record from which Print This was selected is also recorded. This record is transferred from the 
dialog box (not retrieved from the database). 
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 Printing using Actions: Printouts that are invoked from the Action menu, such as Print Invoice in 
the Sales Orders window, are run (and therefore logged) in the same way as printouts that are 
selected using Print This. 

 Exporting Data from Dialog Boxes or Find Windows: In all dialog boxes where a relation is 
associated with the card part, you can export records from the associated relation (either by 
selecting Export from the File menu or selecting Export Result in the Find pane). The exported 
records are logged in the same way as if they had been displayed in a Find window or in a dialog 
box. 

 Exporting Data using Actions: In a number of Maconomy dialog boxes, you can export data using 
an action from the Action menu (for example, Create Payment File in the Payment Files window). 
In this kind of query, you enter selection criteria while the export file is open, and some of the 
exported data is filtered to the file. It is impossible for the query log to tell which data is actually 
exported to the file, as this is part of the logic of the particular Maconomy window, so all of the 
data from the associated relations is registered in the query log. 

 Exporting Data using Add-On Programs: This corresponds to selecting an action in the Action 
menu. 

 Running SQL Reports: This corresponds to exporting data using add-on programs. 

 

Note: You can use bind variables whenever it makes sense, such as for filter queries and 
notification queries. 
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Synchronous Notification Setup 

 

To set up Synchronous Notifications: 
1. In MNSL, locate the asynchronous notification code, and delete the query definition (line 

highlighted in yellow) below.  
<?xml version="1.0" encoding="UTF-8"?> 

<MNSL xmlns="http://www.deltek.com/ns/mnsl" version="0.2"> 
  <Notifications name="ApprovePurchaseOrderLine" title="Approve Purchase Order 
Line"> 

    <Query entity="NotificationUniverses::Basics::ApprovePurchaseOrderLine"> 

      <Restriction condition="ApprovalLine.Approver = userEmployeeNumber() and 
userEmployeeNumber() != ''"/> 

    </Query> 

 

    <Link workspace="ApprovePurchaseOrderLines"> 

      <Description template="^1 ^2 - ^3 ^4 ^5" 
arguments="PurchaseOrderHeader.PurchaseOrderNumber PurchaseOrderHeader.Name1 
PurchaseOrderLine.LineText 
PurchaseOrderLine.PriceCurrency  PurchaseOrderHeader.Currency"/> 

 

      <Waypoint pane="PurchaseOrderLinesFilter"> 

        <Restriction title="Purchase Order Lines for Approval"> 

          <Match queryField="PurchaseOrderLine.InstanceKey" 
field="InstanceKey"/> 

        </Restriction> 

      </Waypoint> 

 

      <Target pane="PurchaseOrdersCard"> 

        <Restriction title="Approvals"> 

          <Match queryField="PurchaseOrderLine.InstanceKey" 
field="InstanceKey"/> 

        </Restriction> 

      </Target> 

    </Link> 

  </Notifications> 

</MNSL> 

2. . In the Notifications workspace, select the Synchronous Notification checkbox to change the 
notification setup in Maconomy.  

3. Specify arguments, waypoint keys, and target keys in the field reference section (the green 
portions in the mnsl-specification).  
<?xml version="1.0" encoding="UTF-8"?> 

<MNSL xmlns="http://www.deltek.com/ns/mnsl" version="0.2"> 
  <Notifications name="ApprovePurchaseOrderLine" title="Approve Purchase Order 
Line"> 

Note: The steps below are valid only for 2.5.1. 

http://www.deltek.com/ns/mnsl
http://www.deltek.com/ns/mnsl
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    <Link workspace="ApprovePurchaseOrderLines"> 

      <Description template="^1 ^2 - ^3 ^4 ^5" 
arguments="PurchaseOrderHeader.PurchaseOrderNumber PurchaseOrderHeader.Name1 
PurchaseOrderLine.LineText 
PurchaseOrderLine.PriceCurrency  PurchaseOrderHeader.Currency"/> 

 

      <Waypoint pane="PurchaseOrderLinesFilter"> 

        <Restriction title="Purchase Order Lines for Approval"> 

          <Match queryField="PurchaseOrderLine.InstanceKey" 
field="InstanceKey"/> 

        </Restriction> 

      </Waypoint> 

 

      <Target pane="PurchaseOrdersCard"> 

        <Restriction title="Approvals"> 

          <Match queryField="PurchaseOrderLine.InstanceKey" 
field="InstanceKey"/> 

        </Restriction> 

      </Target> 

    </Link> 

  </Notifications> 

</MNSL> 

4. Go to Approval Hierarchies » Approval Hierarchy Rules.  

5. Link the approval task to the notification type. 
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Security Service File Check 
In Maconomy, it is possible to check if a file to be uploaded or downloaded can be accepted. One or more 
of the following predefined file check functions can be enabled. 

 

File Check Using an External Command 
You can add one or more external commands to check a file for security. It is not mandatory to define 
either an allowlist or a blocklist. 

Note that in the instructions below, the first command must have the value 1, and the following 
commands must be consecutive. If a number is missing, then the following commands are skipped. 

To file check using an external command: 
1. Open the settings.ini file and add the following line: 

security.filecheck.external.<n>.command = <command with "{}" for file> 

2. To define which exit codes are accepted, add the following line (default value is 0): 
security.filecheck.external.<n>.exitcodes = <comma-separated list of exit 
codes> 

3. To define an allowlist, add the following line: 
security.filecheck.external.<n>.allowlist = <path to the allowlist file> 

 
4. To define a blocklist, add the following line: 

security.filecheck.external.<n>.blocklist = <path to the blocklist file>  

 
5. Review the files.  

When creating one of the files, it can be helpful to temporarily add this to the logback.xml file in 
the CouplingService\configuration\settings folder: 
  <logger 
name="com.maconomy.coupling.service.security.McFileCheckUsingExternalCommand" 
additivity="false"> 

    <level value="DEBUG" /> 

    <appender-ref ref="FILE" /> 

  </logger> 

Note: File check using Simple Magic is no longer supported. This produces an error in the Coupling 
Service log if this capability was previously enabled. 

Note: The allowlist contains the output that is accepted. Each line in the file contains an 
output text. If the output from the command does not contain one of these texts, then the file 
is not accepted. Default is not to use an allowlist. 

Note: The blocklist contains the output that is not accepted. Each line in the file contains an 
output text. If the output from the command contains one of these texts, then the file is not 
accepted. Default is not to use a blocklist. 
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and then try to upload files to be accepted (allowlist) or not accepted (blocklist). After, check the 
maconomy.log file in the CouplingService\log\coupling folder and update the relevant file. 

Examples using External Commands 
# Checks exit code == 0 and then white/black list 

security.filecheck.external.1.command = C:\cygwin64\bin\file.exe -b "{}" 

security.filecheck.external.1.allowlist = ./security-filecheck-external-allowlist-
default.txt 

security.filecheck.external.1.blocklist = <file2> 

 

# Checks exit code == 0 

security.filecheck.external.2.command = /path/to/anti/virus/checker "{}" --check 

 

# Checks exit code == 42 or 43 

security.filecheck.external.3.command = /strange/tool "{}" 

security.filecheck.external.3.exitcodes = 42,43 

 

# This one will be skipped because the previous command used n=3: 

security.filecheck.external.5.command = /will/not/run "{}" 
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Ask Dela 
Ask Dela is an innovative, OpenAI-powered digital assistant that transforms how you interact with the vast 
amount of data in your Maconomy system. As you engage with Ask Dela, you can request more detailed 
information, follow up on your initial queries, and receive comprehensive responses. 

Configure Ask Dela 

 
Maconomy On-Premises Customers: Dela utilizes the OpenAI GPT models available through Microsoft 
Azure services. To access these AI capabilities within Maconomy, you must have a separate agreement 
with Microsoft. This agreement will include a license key that must be obtained and integrated into the 
Maconomy configuration. 

 

To configure Dela for Maconomy: 
1. Open the extension.ini file in the Coupling Service configuration/settings folder. 

2. At the end of the file, add the following information: 
property.dela-provider = azure   

url.dela-endpoint = <your Azure OpenAI endpoint>  

property.dela-key = <your Azure OpenAI api-key>  

property.dela-model = <your GPT model name> 

3. Restart the Coupling Service. 

Enable Ask Dela 
Enable Ask Dela for interactive conversations about Maconomy data. 

To enable Ask Dela: 
1. Go to Setup » System Setup » System Parameters. 

2. Use the search filter and/or the Search field at the top on the workspace to select the Enable 
Digital Assistant system parameter. 

3. Select the Enable Digital Assistant checkbox. 

4. Click Save. 

After enabling Ask Dela at the system level, you must enable it for each user that requires access to the 
digital assistant.  

Set Up User Role Access for Ask Dela 
System administrators can specify a security role’s access to Ask Dela. 

Note: If you have a customized CouplingConfiguration.mcsl.xml file, you must add the Enable Digital 
Assistant system parameter and the Enable Digital Assistant user action to utilize Ask Dela. 

Note: Although you can use different GPT models, the functionality in Ask Dela has been tested 
thoroughly only on the GPT-4o model. 
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Prerequisite: You must first enable Ask Dela in Maconomy.  

To grant access to Ask Dela: 
1. Go to Access Control » Users » Actions. 

2. Use the search filter and/or the Search field at the top of the workspace to select a user. 

3. On the Permitted Misc. Actions card, select Enable Digital Assistant. 
4. Click Save. 

Set Up Super User Access to Access All Threads 
Use these steps to provide a super user with access to view all user conversations with Ask Dela. This 
can be useful when debugging Ask Dela. Threads created by other users can be viewed in the Threads 
reference workspace. Access to view all threads should be granted with caution. 

Prerequisites: This procedure assumes that you have enabled Ask Dela and granted user role access to 
the digital assistant. 

To grant access to see all threads: 
1. Click Access Control » Users » Actions. 

2. Use the search filter and/or the Search field at the top of the workspace to select a user. 

3. On the Permitted Misc. Actions card, select See All Digital Assistant Threads. 

4. Click Save. 

Dela Access to Maconomy Dialogs 
To utilize Dela in Maconomy, the user must have access to the following Maconomy dialogs : 

 Threads  

 Prompts  

These dialogs are automatically added to the Required System Level Windows group. 

Dela retrieves information about records from the following Maconomy dialogs: 

 ContactCompanys 

 ContactPersons 

 CustomerCard 

 ShowEmployees 

 JobInvoiceOverview 

 JobOverview 

 Opportunities 

 API_PurchaseOrderLines 

 TimeSheets 

 TimeRegistrationDetails 

 VendorCard 
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 ShowVendorInvoices 

 ShowInvoiceAllocationLines 

The current version of Dela utilizes information only from the filter list of the aforementioned dialogs. 

 

Dela FAQs 
This topic provides answers for the most frequently asked questions about Dela. 

Is Dela available for on-prem customers? How do we enable/disable Dela? 
Yes, Dela is available to all Maconomy on-prem customers but each on-prem customer must obtain a 
license key to enable Ask Dela. 

Is Dela enabled for Cloud Customers? How do we enable/disable Dela? 
Yes, Dela is available to all Maconomy Cloud customers. A Maconomy Administrator can enable or 
disable Dela for each Maconomy system. 

Is there any additional connectivity that has to be set for AI to be available? 
For web client and Cloud customers, Dela is available immediately. On-premises customers must obtain 
their own license with Microsoft to provide a product key for their Azure Chat GPT offering. 

Can we choose who has access to Dela? 
Yes, you can utilize user actions to enable Dela for specific users. Dela inherits user organization and 
security permissions, so users can only ask Dela questions related to the information they already have 
access to. 

Is there a training on the AI functionality within Maconomy? 
A pre-recorded training on the Dela capabilities is forthcoming.  

Do I get Dela with my Maconomy License? 
Yes, Dela is included with the Maconomy License. On-premises customers need to have a license with 
Azure Chat GPT. 

Will Dela restrict the information it reveals based on what employees have access to? 
Yes, Dela adheres to the same data permissions that the Maconomy user is subject to based on their 
settings in the Maconomy system they are working in. For example, if I do not have access to salary 
information based on my Maconomy permissions, Dela will not provide me with that information. 

Are there any performance issues with users using Dela? 
We do not expect any performance issues outside of regular usage. 

 

Note: To receive answers from Dela about the records listed above, users must have the appropriate 
access to the corresponding Maconomy dialogs. Without the necessary permissions, Dela is unable 
to provide the requested information.  
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SYSTEM MAINTENANCE and REGULAR USE 
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Scheduled Background Tasks 

 
Attention: For details, refer to the Deltek Maconomy Background Task Guide. 
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Increase Allowed Number of Named Users 
If you need to increase (or decrease) the number of licensed Maconomy users, you can now make the 
update yourself from within the Workspace Client, as opposed to having this performed as a chargeable 
activity by one of Deltek’s technical consultants, requiring a restart of the system (which is no longer 
needed). 

Contact your account manager so they can process your requested user extension order. Once that 
process is complete, they will provide you with a license key which is required for the following procedure. 

 

To update your company’s allowed number of named users:  
1. Go to Setup » System Setup workspace » Installation Details section » Installation 

Information tab » Version island. 

2. In the Named Users Code field, enter the license key provided by your account manager. 

Sample code: 

150--a32c675c-f5d7b068-0741a962-93367c4c 

3. Click Save, or press ENTER. 

Maconomy immediately applies the update. 

Note: This procedure can only be performed by one of your system administrators, or any user who 
has access to the System Setup workspace. 
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User Masking 
The user, employee, and company masking feature enables you to mask personal information that is 
related to former employees. This feature deletes some relevant records according to your specifications 
and masks relevant fields in other records. 

Usernames and employee names are stored in multiple places in Maconomy, such as contact person 
information, vendor information, user-specific selection criteria, setup and transaction data, documents, 
and various logs. 

When you enable masking, only the user and/or employee information is masked, even when you use the 
company masking functionality. When you use the company masking functionality, the user and 
employee information that is associated with the specified company is masked. 

This feature performs the following activities to mask personal information: 

 Changes the username to the value that you specify as the masking value. Updates all 
occurrences of the username to the masked value. Deletes the user if it exists. 

 Changes the name of the corresponding employee (including revisions), contact person, and 
vendor to the masked name and updates all occurrences of the original employee name to the 
masked name. Retains the employee record, but with all personal information masked. 

 Clears all the personal information for the employee, contact person, vendor, and many other 
relevant fields. 

 Clears any personal information in the logs of field changes to the user, employee, employee 
revisions, contact person, and vendor who are associated with the user. 

 
If you have the correct access privileges, you can: 

 Mask information for one or more users and/or employees. 

 Mask all user and employee information for one or more companies. 

Masking-related workspaces and options are not displayed to users who do not have the correct access 
privileges. 

User Masking Workflow 
The high-level workflow for using masking is as follows: 

1. In the System Setup workspace, set the value of the Allow User Masking for Company system 
parameter to enable masking. 

2. In the Masking workspace, on the User Masking tab, enter the user and employee masks to be 
used and select the usernames and/or employee numbers whose information is to be masked.  

Note: The masking feature does not affect documents that may have been attached in Maconomy or 
other data that could hold employee names. 

For example, if you set up a G/L dimension named Entity that contains account manager information, 
and you need to mask the personal information for a former employee who is listed as an account 
manager (in the Entity dimension), and you have enabled the logging of changes to the Entity 
dimension, the personal information in the Entity dimension for the former employee is not masked. 
In addition, when you make a change in the Entity dimension, the original employee name appears in 
the log of changes. 
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3. In the Masking workspace, on the Company Masking tab, enter the user and employee masks 

to be used and select the company whose user and/or employee information is to be masked.  

 
4. Run the masking routine via the appropriate action button. 

When the masking routine finishes, it displays a log file that contains a list of all the major 
instructions that were executed. You can save the log file to a location of your choice. This is 
helpful if you need to retain proof that you performed the masking. 

5. Examine the log file to check for any errors. 

You can remove these log files manually if no problems occurred. 

 

User Masking Procedures  

Mask Users 
To perform user/employee masking, ensure that the following conditions are met: 

 At least one of the columns User Name and Employee No. must contain a value. 

 The values in those columns must be unique. 

 The current user cannot be included in the list of users to mask. 

 The user named Administrator cannot be included in the list of users to mask. 

To mask a username: 
1. Navigate to Human Resources » Masking » User Masking tab. 

2. In the User mask field in the Set default values island, enter the string to use as the mask. 

The masking routine replaces all selected usernames with this string. You can enter any string 
with a maximum length of 50 characters. 

3. In the Employee mask field in the Set default values island, enter the string to use as a mask. 

The masking routine replaces all employee names that have the selected numbers with this 
string. You can enter any string with a maximum length of 50 characters. 

4. Enter or search for a username in the User Name column in the User Masking subtab. 

You can enter any string; the value in this field is not validated. This enables you to locate and 
mask information for usernames that have already been removed from Maconomy, but that still 
exist in various locations, such as change logs and database tables. 

5. Enter or search for an employee number in the Employee No. field in the User Masking subtab. 

The value in this field is validated; the employee number must exist in Maconomy. 

Attention: For more information, refer to “Mask Users” section. 

Attention: For more information, refer to “Mask Companies” section. 

Tip: If a log file indicates that there were problems in the masking operations, send the log 
file to Deltek Customer Care. 
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6. Click the Perform User and Employee Masking button. 

A warning dialog box prompts you to confirm that you want to run the masking routine. If you do 
not click OK or Cancel, the action is automatically canceled. 

 
7. Click OK in the warning dialog box to run the masking routine. 

 
The masking routine can take up to an hour or longer to complete, depending on the speed and the size 
of your database. A progress bar indicates how processing is going. 

When the masking routine finishes, it displays a log file. You can save this log file. 

If the masking routine encounters any errors, a message warns you that there are exceptions in the log 
file. If you receive this message, send the log file to Deltek Customer Care. 

Mask Companies 
To perform user/employee masking for a selected company (or companies), ensure that the following 
conditions are met: 

 The Company No. column must contain a valid company number that exists in Maconomy. 

 The value in the Company No. column must be unique. 

 You can perform masking only for companies for which the Allow User Masking for Company 
system parameter is selected.  

 The current user cannot be included in the list of users to mask. 

 The user named Administrator cannot be included in the list of users to mask. 

To mask user and/or employee information that is associated with the specified company or 
companies: 

1. Navigate to Human Resources » Masking » Company Masking. 

2. In the User mask field in the Set default values island, enter the string to use as the mask. 

The masking routine replaces all selected usernames with this string. You can enter any string 
with a maximum length of 50 characters. 

3. In the Employee mask field in the Set default values island, enter the string to use as a mask. 

The masking routine replaces all employee names that have the selected numbers with this 
string. You can enter any string with a maximum length of 50 characters. 

4. Enter or search for a company number in the Company No. field in the Company Masking 
subtab. 

Note: You can enter just a username, just an employee number, or both username and 
employee number. 

Warning: Masking actions are not reversible. Be sure that you want to run the masking 
routine with the values that you have specified before you click OK. 

Warning: After you click OK, do not interrupt the execution of the masking routine. 
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The company number must exist in Maconomy, and masking must be enabled for this company 
via the Allow User Masking for Company system parameter.  

2. Click the Perform User and Employee Masking button. 

A warning dialog box prompts you to confirm that you want to run the masking routine. If you do 
not click OK or Cancel, the action is automatically canceled. 

 
3. Click OK in the warning dialog box to run the masking routine. 

 
The masking routine can take up to an hour or longer to complete, depending on the speed and the size 
of your database. A progress bar indicates how processing is going. 

When the masking routine finishes, it displays a log file. You can save this log file. 

If the masking routine encounters any errors, a message warns you that there are exceptions in the log 
file. If you receive this message, send the log file to Deltek Customer Care. 

Warning: Masking actions are not reversible. Be sure that you want to run the masking 
routine with the values that you have specified before you click OK. 

Warning: After you click OK, do not interrupt the execution of the masking routine. 
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General Server Maintenance 
A Maconomy system can be customized by just changing the configuration (for example, how security is 
configured, which protocol is used between Workspace client and Server, and so on). 

This section describes the routines that are necessary for maintaining a Maconomy server, including 
backing up and restoring a Maconomy installation. The control routines must be performed to check that 
the Maconomy installation is in good shape. The routines are grouped by the schedule by which they 
should be performed. Some must be performed daily, others weekly, still others monthly, and finally, 
some should be performed every six months. 

This document is intended for system and database administrators, and to perform these tasks, 
knowledge at that level is required. 

Note that all commands in this document should be performed as the local user Maconomy. You should 
not use root (on UNIX) or Administrator (on Windows), unless you are completely confident with the 
commands that you are performing. 

In this document, it is assumed that the temporary area assigned to Maconomy is <UserHome>tmp (for 
example, D:\maconomy\Tmp on Windows). Consult your server installation documentation for the precise 
assignment of temporary directories. 
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Running an Index Script 
The database index handling process includes support for index scripts. While this can be used for a 
multitude of purposes, the main benefits are validating, creating, migrating, and maintaining indices in the 
Maconomy database. 

An index script is a list of commands. The script language supports a single kind of variable: a list of index 
descriptions. These index-lists can be read from files, from the Maconomy database, or from the DbDesc 
and index-lists written to files or dumped as SQL.  

Index script format: 

 All commands are case-insensitive. 

 All index-list variables are case sensitive. 

 Two slashes are used for comments. 

 Double quotes are used for filenames and print text. 

To run an index script: 
1. Create and read all files from \Maconomy\tmp. 

2. Run an index-script as a MaconomyServer command line command, in the following format: 
MaconomyServer.exe -iMaconomyServer.<application> -S<shortname>  

--IndexScriptFile "\Tmp\IndexScrpt.txt" 

Example: 
MaconomyServer.exe -iMaconomyServer.w_21_0.sp102 -Smarco  

--IndexScriptFile "\Tmp\IndexScrpt.txt" 

 

Index Script Parameters 
Occasionally, it is more practical to use parameters for index scripts. You can specify these parameters at 
the end of the command line, and these will replace file parameter placeholders in the script. File 
parameter placeholders follow the following format: ${1} for the first parameter, ${2} for the second, and 
so on. 

Example: 

If you specify the following parameter: 
MaconomyServer.exe -iMaconomyServer.<application> -S<shortname>  

--IndexScriptFile "\Tmp\IndexScrpt.txt" OldDB.json ListOld.txt 

it replaces the following script: 
ReadIndexFromJson jsonIndex ${1} 

WriteIndexToText jsonIndex ${2} 

When you run the index script, the IndexHandler reads the json-file OldDB.json and converts its contents 
into a more readable format before copying everything into the ListOld.txt file. 

Note: If you are not a power user, you will likely find what you need in the examples at the end of this 
section. Skip the description of the ”Script commands” section and go straight to the “Script 
Examples” section. 
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Script Commands 
This section contains a list of the current index script commands. 

Print 
Print simply outputs the content of a quoted string to standard output.  

Index-list variables cannot be used with print-only text. 

Use Print to track progress. 

Example: 
Print "Script completed"   // Outputs status text to the console 

ReadIndexFromDatabase 
This command accesses the shortname and builds an index-list containing all indices in the database. 

Note this list also contains uniqueness constraints since these are in fact also indices, but annotated in 
the index-list as such. That information can later be used to generate correct DDL for creating and 
removing such index/constraints.  

Example: 
// Read all index from database  

ReadIndexFromDatabase dbIndex   // Save in an index-list named 'dbIndex' 

ReadIndexFromDbDesc 
This command works as the command above, but instead of reading indices from the database, it reads 
from the DbDesc. This contains (almost) all indices on the system, but not uniqueness constraints or 
instancekey constraints. 

Example: 
Print "Read all index from DbDesc "  

ReadIndexFromDbDesc dbDescIndex // Save in an index-list named 'dbDescIndex' 

FindIndexFromCreConstraint 
This command generates an index-list of all uniqueness constraints. Since there is nowhere to read this 
information, the list is generated with an algorithm similar to what the server uses to generate uniqueness 
constraints using information from the DbDesc.  

Example: 
print "Generate creconstraint index"    // Generate uniqueness constraints 

FindIndexFromCreConstraint tmp          // And save in an index-list named 'tmp' 

Note that there is a server setting in Maconomy.ini/MaconomyCustom.ini to guide how deferred 
constraints are handled on SQL Server that lacks support for that. 

 DeferredConstraintsOnSqlServer=Ignore 

This setting disregards these indices and does not read them (default behavior if not specified). 

 DeferredConstraintsOnSqlServer=Unique 

This setting reads the index as a normal unique constraint.  
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 DeferredConstraintsOnSqlServer= Error 

This setting works the same as Ignore. Deferred constraints are normal in the DbDesc and do 
not generate an error. 

FindIndexFromInstanceKeyConstraint 
This command generates an index-list of all instance key constraints. Since there is nowhere to read this 
information, the list is generated with a similar algorithm to that which the server uses to generate 
instance key constraints using information from the DbDesc.  

Example: 
print "Generate Instance Key Constraint"  // Similar to the way the server do it.  

FindIndexFromInstanceKeyConstraint tmp2   // And save in an index-list named 'tmp2' 

ReadIndexFromDbDescAll 
This command combines the three previous commands: ReadIndexFromDbDesc, 
FindIndexFromCreConstraint, and FindIndexFromInstanceKeyConstraint. It generates the three index-
lists and combines them into a single list that is the sum of the three.  

Example: 
print "Build index-list from DbDesc-index and constraint"  

ReadIndexFromDbDescAll dbDescIndex  // And save in an index-list named ' dbDescIndex' 

 

WriteIndexToText 
The Json file format used in the commands above are human-readable, but imperfect for a condensed 
overview of the involved index. An alternative is to write out an index-list variable to a text file. This format 
is preferable for a quick overview of an index-list and the attributes of the involved index. 

Example: 
Print "Save TestJason as a text file for easy reading" 

 

// Take the index-list 'TestJason' and save as a text file  

// to \Maconomy\tmp\TestJason.txt 

 

WriteIndexToText TestJason TestJason.txt 

This is an example of the generated output: 
Relation DEV_PROGRESSSNAPSHOT has the following index :  

  Index IKDEV_PROGRESSSNAPSHOT, Non-clustered, Unique, Table constraint: INSTANCEKEY - 
Asc;  

Relation MACONOMY_USERS has the following index :  

  Index MACONOMYUSERSINDEX2, Non-clustered: SESSIONID - Asc; ROLEINSTANCEKEY - Asc; 

Note: For more information, refer to the description of the DeferredConstraintsOnSqlServer setting in 
the FindIndexFromCreConstraint section. 



Running an Index Script 

System Admin Guide 155 

 

WriteIndexToJson  
This saves an index-list to a Json file. The format of this file is not a part of this document. This is a 
method of saving an index list for later reference. 

Example: 
Print "Save found duplicates as a json file" 

 

// Take the index-list 'duplicates' and save as a  

// .json file to \Maconomy\tmp\FoundDups.json 

 

WriteIndexToJson duplicates FoundDups.json  

This is an example of a start of an index-list Json-file: 
{ 

  "Version" : "1.2", 

  "Relations" : 

  [ 

    { 

      "Relation" : "ABSENCEBOOKINGDETAIL", 

      "Index" : "ABSENCEBOOKINGDE02", 

      "Type" : "Non-clustered", 

      "Unique" : "No", 

      "TableConstraint" : "No", 

      "InitiallyDeferred" : "No", 

      "Columns" : 

      [ 

        { 

          "Name": "EMPLOYEENUMBER", 

          "Sorting": "ASC", 

          "Included": "No" 

        },  

        { 

          "Name": "ABSENCETYPE", 

          "Sorting": "ASC", 

          "Included": "No" 

        },  

        { 

          "Name": "PERIODSTART", 

          "Sorting": "ASC", 

          "Included": "No" 

        } 

      ] 

    }, 

    {    { 

      "Relation" : "ACTIVITY", 

      "Index" : "UQACTIVITY", 

      "Type" : "Non-clustered", 
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      "Unique" : "Yes", 

      "TableConstraint" : "Yes", 

      "ConstraintImplementationIndex" : "ACTIVITY01", 

      "InitiallyDeferred" : "No", 

      "Columns" : 

      [ 

        { 

          "Name": "ACTIVITYNUMBER", 

          "Sorting": "ASC", 

          "Included": "No" 

        } 

      ] 

    }, 

ReadIndexFromJson 
This is the reverse of the above command; it reads a Json file with an index-list definition and saves it to 
an index-list structure. 

Example: 
Print "Read index from a json file"             

 

// Read an index structure from a Jason-file named "TestJason.json" in \Maconomy\tmp 

// And then store it in an index-list named 'jsonIndex' 

 

ReadIndexFromJson jsonIndex TestJason.json      

 
 DeferredConstraintsOnSqlServer=Ignore 

This setting disregards these index commands and does not read them (default behavior if not 
specified). 

 DeferredConstraintsOnSqlServer=Unique 

This setting reads the index as a normal unique constraint.  
 DeferredConstraintsOnSqlServer= Error 

This setting creates an error if a deferred constraint is read from a json-file. 

AddIndex 
Use this to add to add two index-lists together.  

 

Note: There is a server setting in Maconomy.ini/MaconomyCustom.ini describing how deferred 
constraints are handled on SQL Server that lacks support for that. 

Note: It is possible that both index-lists contain an index with the same name and possibly different 
definitions. In that case, the index from the first list is overwritten with the index definition from the 
second. For example, in the example below, if both index-list contain an index on ACCOUNT named 
TEST, the definition from the index-list named ‘Tmp’ is used.  
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Example:  
Print "And add all the index in Tmp to those in dbDescIndex" 

 

// This function adds two index-lists together (based on name only)  

// and saves the result in the first (dbDescIndex) 

 

AddIndex dbDescIndex Tmp                     

FilterIndex 
Use this command to run through an index-list and extract all indices to a new list with that quality.  

This is the complete list of qualities to filter on: 

 Clustered 

 Notclustered 

 FunctionBased 

 NotFunctionBased 

 Unique 

 NotUnique 

 Constraint 

 NotConstraint 

 Deferred 

 NotDeferred 

 Standard 

 NotStandard 
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Example:  

 

CopyIndex 
Use this command to make a copy of an index-list.  

Example:  
Print “Assign the index-list dbDescIndex to the new index-list variable AlsoDbIndex " 

CopyIndex AlsoDbIndex dbDescIndex 

RemoveIndexFromList  
This command deletes all indices named in the index-list given in the second argument from the index-list 
in the first argument. Therefore, this is a kind of subtraction function.  

 
Example: 
Print "Remove index used in hint from the 'Duplicates' list" 

Print "Later we don't want to drop those"     

   

RemoveIndexFromList Duplicates IndexFromHints 

CompareIndex 
This command compares two index-lists and, as a result, creates three new index-lists. One includes the 
index that was added, and one includes a list of the indices that were missing, and both are from the 
perspective of the first argument index-list. Finally, an index-list containing all indices that were present in 
both the argument index-lists, but differ in definition. For example, both lists have an index called 
TestIndex, but spanning different sets of columns. Alternatively, only one may have a unique index. 

Example: 
print "Compare DbDesc to database"   

Print "Filter out in sub-sets based on type" 

 

// Read all index from database  

ReadIndexFromDatabase dbIndex   // Save in an index-list named 'dbIndex' 

 

// Filter out in these sublist:  

// UniqueIndex, ClusteredIndex, FunctionBasedIndex, NonDefConstraint 

 

 

FilterIndex dbIndex UniqueIndex Unique // UniqueIndex: a list of unique index in DB  

FilterIndex dbIndex ClusteredIndex Clustered // ClusteredIndex: a list of clustered index  

FilterIndex dbIndex FunctionBasedIndex FunctionBased // FunctionBasedIndex. a list of FB Index 

FilterIndex dbIndex NonDefConstraint NotDeferred  // NonDefConstraint: a list of constraints  

                                                  // that are not initially deferred  

Note: This removal is based on the index name only,not on the detailed definition of the index 
(columns, and so on). 
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// Compare two index-lists and create 3 new based on the result. 

// These contains the added, missing and changed index.  

// From the perspective of the first index-list. 

 

CompareIndex Database InstallReference missingIndex addedIndex changedIndex         

ValidateIndex 
This command compares two index-lists and as a result create a new index-lists. The new index list will 
be all the index and constraints from the second list, that not could be found covered in the first list. The 
name is not important here. One use could be to validate that all standard index are somehow 
implemented in the database. This is how the --ValidateIndexes and –ValidateConstraints server options 
are implemented. 

Example: 
print "Compare DbDesc to database"   

 

// Compare two index-lists and create 3 new based on the result. 

// These contains the added, missing and changed index.  

// From the perspective of the first index-list. 

 

ValidateIndex Database stdIndex missingIndex 

MarkAsStandard 
Some indices are considered standard. These are preferable to non-standard indices if you are looking 
for duplicates to drop (see FindIndexDuplicates), everything else being equal between the indices under 
consideration. 

This command can mark all indices in an index-list as standard.  

Standard status can be applied to jso-files and read from json-files. 

Run the command as follows: 
Print "Mark index read from json as standard" 

 

MarkAsStandard standardIndexNew  // All standard index is marked as such  

When you eliminate duplicates (see FindIndexDuplicates), standard indices will not be chosen as a 
duplicate (everything else being equal between the indices under consideration). 

Example: 
Print "Now mark all as standard" 

 

MarkAsStandard jsonIndex 

FindIndexDuplicates 
Many databases contain duplicate index definitions, which means that the same selection, sorting, and 
order of columns are contained in several indices. This provides no benefit and has a performance impact 
when updating the table and should therefore be avoided. This command can identify a duplicate index in 
an index-list, and decide on the index to keep, using the following rules: 
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 Keep clustered over non-clustered 

 Keep unique index over non-unique 

 Keep table constraints over indices 

 Keep a superset of columns (keep an index on column a, b, and c over an index on a and b) 

 Keep “normal” columns over included columns (SQL Server) 

 As a tie braker: Keep index marked as Standard over the non-standard index. See 
MarkAsStandard. 

 As a tiebreaker: If one index is a standard index and the other one is not, keep the standard 
index. 

Example: 
Print "Finding all duplicates in the index-list DatabaseList" 

 

// Find all duplicates in the index-list 'DatabaseList'  

// and save the findings to a new structure called 'duplicates' 

 

FindIndexDuplicates DatabaseList duplicates  

RenameInstanceKeyConstraints 
From Maconomy 2.4 to 2.5, the naming scheme for instance key constraints changed.  

 In 2.4 and older versions, an instance key constraint would have the name INSTANCEKEYnnn, 
where nnn is a 3-digit internal number of the underlying table.  

For example, INSTANCEKEY408 is the instance key constraint for the ACTIVITYREFERENCE 
table. 

 In 2.5 and later versions, an instance key constraint would have the name IK followed by the 
name of the underlying table.  

For example: IKACTIVITYREFERENCE is the instance key constraint for the 
ACTIVITYREFERENCE table. 

The RenameInstanceKeyConstraints command takes a list of indices and constraints, and renames all 
old-style named instance key constraints according to the new scheme. At the same time, it creates an 
SQL script for updating the names of the instance key constraints in the database according to the new 
naming scheme. The script matches the database in use. 

Example: 
print "Change all instance key constraints to new naming" 

 

// Renames old-style instance key constraints if any 

RenameInstanceKeyConstraints OriginalDatabaseIndex "renameInstanceKeyConstraints.sql"  

WriteIndexAsDropStatements 
In the end, you will likely need to convert index-lists to SQL, and the following commands are examples of 
that. WriteIndexAsDropStatements generates a file of drop statements based on an index-list (for 
example, a list of duplicates generated by the FindIndexDuplicates command). All files are generated in 
the \maconomy\tmp folder. 

Example: 



Running an Index Script 

System Admin Guide 161 

 

print "Write all duplicates as DROP statements" 

 

// Take the index-list 'duplicates' and create DROP statements  

// and write them to \Maconomy\tmp\DropDuplicates.sql 

 

WriteIndexAsDropStatements duplicates "DropDuplicates.sql" MACINDEX 

That last parameter is a tablespace parameter and is only used for Oracle. For Oracle, you might need to 
drop and recreate constraints using the argument index to be dropped. When creating the constraints 
again, you need a tablespace. An argument of DEFAULT creates the constraint without a tablespace 
parameter, and it is created in the default tablespace. 

For SQL Server all table names, field names and index/constraint names are in square brackets. 

WriteIndexAsDisableStatements 
This command creates a SQL file in \Maconomy\tmp, which disables all indices in the argument index-list. 

Example: 
print "Write all duplicates as Disable statements" 

 

// Take the index-list 'duplicates' and create DROP statements  

// and write them to \Maconomy\tmp\DropDuplicates.sql 

 

WriteIndexAsDisableStatements duplicates "DisableDuplicates.sql"  

For SQL Server all table names, field names and index/constraint names are in square brackets. 

WriteIndexAsCreateStatements 
This command creates a SQL file in \Maconomy\tmp with CREATE-statements for all indices in the 
argument index-list. You need to specify a tablespace (Oracle) or filegroup (SQL Server) for the create 
statements to use, or use the keyword DEFAULT to specify that no tablespace should be included in the 
CREATE-statement. 

Example: 
print "Write all index in the index-list 'Tmp' as CREATE statements" 

 

// Create all index in the default tablespace 

WriteIndexAsCreateStatements Tmp "CreateIndex.sql" DEFAULT   

For SQL Server all table names, field names and index/constraint names are in square brackets. 

WriteNormalizeConstraintsAsSql 
In Oracle, unlike SQL Server, a constraint will not create its own index to implement the constraint, but 
instead depends on an existing index if at all possible (even a non-unique one). This command creates a 
script that follows this process: 

1. Drops all constraints depending on “external” index. 

2. Drops the constraints. 

3. Creates all the above constraints again. 

4. Create all the above indices again. 
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In extreme cases, it might be necessary to run the process (create the script,un the script) multiple times.  

The last parameter is the tablespace for the index/constraints to be created in or the word DEFAULT for 
them to be created in the default tablespace. 

This command creates an empty script file on SQL Server. 

Example: 
Print "Create a script that makes no Oracle constraint depend on an ‘external’ index" 

 

// Read all index / constraints in the database 

ReadIndexFromDatabase allDbIndex 

// Create a script for normalizing 

// Create all recreated index in a tablespace called MacIndex 

WriteNormalizeConstraintsAsSql allDbIndex "Normalize.sql" MacIndex   

ParseExpandScript 
When running expand scripts tables make change name or be rebuilt. Previously, the standard procedure 
was to drop all indices, upgrade by running expand scripts, and then rebuild all indices. However, 
rebuilding all indices is time-consuming. Now, you can script an alternative: Parsing an expand script to 
find all the indices that must be dropped and creating a script for that purpose. All other indices can be 
kept, and later in the process, you can recreate the dropped index. 

 Table rename: The index is dropped and then recreated to use the new table name  

 Field rename: Likewise 

 Field type change: No issue - index does not know about type 

 Field removed: Impacted index are dropped 

 Table is rebuild during expand: Index is dropped and recreated 

 Table is expanded or unchanged: Index is kept without change 

Example: 
Print "Prepare for upgrade" 

 

// Read the Expand script expand.w200sv0-w210sv2.sql  

// and create an index-list for indexes to be dropped now  

// and also an index-list for index to be created later 

ParseExpandScript dbDatabase expand.w200sv0-w210sv2.sql toBeDroppedNow 
toBeCreatedLater  

FindAllHintIndex 
When planning to drop an index (for example, a duplicate index), it is important to determine if it is used in 
a hint. This command searches through SQL Server hint definitions (Oracle is not supported) and builds 
an index-list of indexes used in hints. Since an index mentioned in a hint does not contain any details 
about the index, the FindAllHintIndex command needs an argument index- list that defines the hints—
typically created by reading the index from the database using ReadIndexFromDatabase. An error is 
reported if an index is mentioned in a hint but not defined in the argument index structure. 

Example: 
Print "Find all index in Hints files" 
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// First build an index-list of all index in the database 

ReadIndexFromDatabase dbDatabase // Save in an index-list named 'dbDatabase' 

 

// Then read the hints files and find all index there.  

// If an index is not defined in the first argument: report error 

// Store the found indexes from hints in 'IndexFromHints' 

FindAllHintIndex dbDatabase IndexFromHints   

FindRenamedIndex 
This command, which takes an index list and compares it with another, is uncommon but could be 
needed. The command finds an index from the first list that cannot be found in the second, but does exist 
with a complete identical definition, but with another name, are considered to be renamed. The command 
then generates a SQL script for renaming these files. 

Example: 
Print "Find renamed index in database" 

 

// First build an index-list of all index in the database 

ReadIndexFromDatabase dbDatabase // Save in an index-list named 'dbDatabase' 

 

// Compare index in 'dbDatabase' with index in 'newVersion' 

// Identify renamed index and store them in a new index-list 'renamed' 

// Also create a SQL script for renaming the index in 'dbDatabase': 'Renamed.sql' 

FindRenamedIndex dbDatabase newVersion renamed Renamed.sql 

Command Line Options 

ValidateConstraints 
You do not need to create an index script to validate that all the vital uniqueness constraints are present. 
All you need to do is run a server as follows:  
\Maconomy\bin\MaconomyServer.<Application>.cmd -S<shortname> --ValidateConstraints 

Or optionally: 
\Maconomy\bin\MaconomyServer.<Application>.cmd -S<shortname> --ValidateConstraints 
<SQL Server filegroup or Oracle tablespace for missing constraints>  

Example: 
\Maconomy\bin\MaconomyServer.w_22_0.sp100.cmd -Sm22p0 --ValidateConstraints 

If everything is fine, the command returns 0 to the environment and displays the following report: 
Constraint check successful. No constraints are missing. 

If constraints are missing, the command displays the following report: 
Constraint check failed. 

Create missing constraints by running <file> 

Example: 
Constraint check failed. 
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Create missing constraints by running 
C:\maconomy\Tmp/CreateMissingConstraints.m22p0.sql. 

If the missing constrains must be created in a specific Oracle tablespace or SQL Server file group, you 
can specify this on the command line as follows: 
\Maconomy\bin\MaconomyServer.w_22_0.sp100.cmd -Sm22p0 –ValidateConstraints MacIndex 

Where MacIndex is an example of a tablespace or file group name. 

ValidateIndexes 
Like constraints, if you want to validate all standard indexes (and constraints) are present, there is no 
need to create an index script. Present can mean covered by a custom index. 

Run a server like this: 
\Maconomy\bin\MaconomyServer.<Application>.cmd -S<shortname> --ValidateIndexes 

Or optionally: 
\Maconomy\bin\MaconomyServer.<Application>.cmd -S<shortname> -- ValidateIndexes <SQL 
Server filegroup or Oracle tablespace for missing index> 

Example: 
\Maconomy\bin\MaconomyServer.w_22_0.sp100.cmd -Sm22p0 --ValidateIndexes 

If everything is fine, the command returns 0 to the environment and displays the following report: 
Index check successful. No indexes or constraints are missing. 

If indexes are missing, the command displays the following report: 
Index check failed. 

Create missing indexes and constraints by running <file> 

Example: 
Index check failed. 

Create missing indexes and constraints by running 
C:\maconomy\Tmp/CreateMissingConstraints.m22p0.sql. 

If the missing indexes must be created in a specific Oracle tablespace or SQL Server file group, you can 
specify this on the command line as follows: 
\Maconomy\bin\MaconomyServer.w_22_0.sp100.cmd -Sm22p0 –ValidateConstraints MacIndex 

Where MacIndex is an example of a tablespace or file group name. 

Script Examples 

Example 1: Eliminate Duplicate Index 
Use the script below to eliminate indices in the database, but keep those used in hints. 
// Eliminate Duplicates in database 

 

print "Read index from database" // Print status to stdout 

readIndexFromDatabase dbDatabase // Read all index from database and save in a index-
structure and name it 'dbDatabase' 

 

print "Write all index in text format to  dbDatabase.txt" 
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WriteIndexToText dbDatabase dbDatabase.txt 

 

print "finding duplicates" 

FindIndexDuplicates dbDatabase duplicates // Find all duplicates in the index-
structure 'dbIndex1' and save the finding to a new structure called duplicates 

 

print "Drop duplicates as text" 

WriteIndexToText duplicates "Duplicates.txt" // Take the index-structure 
'duplicates' and create DROP statements and write them to 
\Maconomy\tmp\DropDuplicates.sql 

 

print "Find all index in Hints files" 

FindAllHintIndex dbDatabase IndexFromHints  // Read the hints file and find all 
index there. If not in the DB report error 

 

print "Write list of index index in hints files to \Maconomy\tmp\IndexFromHints.txt" 

WriteIndexToText IndexFromHints IndexFromHints.txt  

 

print "Remove index used in hint from the duplicates list: we don't want to drop 
those"       

RemoveIndexFromList duplicates IndexFromHints 

 

print "Write the final list of index to drop to \Maconomy\tmp\DuplicatesWoHints.txt" 

WriteIndexToText duplicates DuplicatesWoHints.txt  

 

print "Also dump the final list of index to drop as Json to 
\Maconomy\tmp\DuplicatesWoHints.json" 

WriteIndexToJson duplicates DuplicatesWoHints.json  

 

print "And finally create drop-statements for  index to drop to 
\Maconomy\tmp\DropDuplicatesWoHints.Sql" 

WriteIndexAsDropStatements duplicates DropDuplicatesWoHints.Sql  

Review and run the script DropDuplicatesWoHints.Sql to remove all duplicate indices NOT used in a 
SQL Server hints file. 

Example 2: Create and Use an Index Reference File 
After upgrading and tuning a system, a consultant takes a snapshot of the current index. 
// Take a snaphot 

 

print "Read index from database" 

// Read index from database and save in an index-structure and name it 'dbIndex1' 

readIndexFromDatabase dbIndex 

 

print "Save it as a json file" 

WriteIndexToJson dbIndex "dbIndex-june-2020.json" 

 

print "Also save found index as a text file for easy reading" 

WriteIndexToText dbIndex dbIndex-june-2020.txt  
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Four months later, the consultant comes back because there are a number of issues with the system. 

The consultant decides to check if the index is as he left it. 
// Take a new snaphot and compare with june index 

 

print "Read index from database" 

// Read index from database and save in an index-structure and name it 'dbIndex1' 

readIndexFromDatabase dbIndex  

 

print "Save it as a json file" 

WriteIndexToJson dbIndex1 dbIndex-october-2020.json 

 

print "Also save found index as a text file for easy reading" 

WriteIndexToText dbIndex1 dbIndex-october-2020.txt  

 

print "Read index from june database "  

ReadIndexFromJson jsonIndexJune "dbIndex-june-2020.json" 

 

print "Compare database index to june index"  

CompareIndex dbIndex dbIndex2 addedIndex  missingIndex changedIndex 

 

print "Save addedIndex as a text file for easy reading" 

WriteIndexToText addedIndex addedIndex.txt // Take the index-structure 
'addedIndex' and save as a text fileto \Maconomy\tmp\addedIndex.txt 

 

print "Save missingIndex as a text file for easy reading" 

WriteIndexToText missingIndex missingIndex.txt // Take the index-structure 
'missingIndex' and save as a text fileto \Maconomy\tmp\missingIndex.txt 

 

print "Save changedIndex as a text file for easy reading" 

WriteIndexToText changedIndex changedIndex.txt // Take the index-structure 
'changedIndex' and save as a text fileto \Maconomy\tmp\changedIndex.txt 

 

print "Save addedIndex also as a json file for easy reading and possibly diffing" 

WriteIndexToJson addedIndex addedIndex2.json // Take the index-structure 
'addedIndex' and save as a text fileto \Maconomy\tmp\addedIndex.txt 

Example 3: Compare Index from Database with Standard  
Run this script to compare the index from the database with a standard index to… 

The standard index for an APU is defined in this file:  

MaconomyDir\Database\StandardIndexesAndConstraints.json. 

But for the below script to work, it must be copied to \Maconomy\tmp. 

Then run this script: 
// Compare database index to APU standard  

// First copy file from MaconomyDir\Database\StandardIndexesAndConstraints.json 

// to \Maconomy\Tmp 
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// Read the standard index for the installed APU  

// from \Maconomy\Tmp\StandardIndexesAndConstraints.json 

print "Read Std index from from APU" 

ReadIndexFromJson apuIndex "StandardIndexesAndConstraints.json" 

 

print "Read index from database" // Print status to stdout 

readIndexFromDatabase dbDatabase // Save all index from Db in 'dbDatabase' 

 

print "Compare APU to database"  // Comapare dbDatabase and apuIndex 

CompareIndex apuIndex dbDatabase AddedIndex  MissingIndex ChangedIndex 

 

print "Dump create script for missing index to \Maconomy\tmp\CreateMissingIndex.sql" 

WriteIndexAsCreateStatements MissingIndex "CreateMissingIndex.sql" default  

 

print "Also write missing to readable \Maconomy\tmp\MissingIndex.txt" 

WriteIndexToText MissingIndex MissingIndex.txt 

 

print "Dump drop script for added index to \Maconomy\tmp\DropAddedIndex.sql" 

WriteIndexAsDropStatements AddedIndex "DropAddedIndex.sql"  

 

print "Also write missing index to readable \Maconomy\tmp\AddedIndex.txt" 

WriteIndexToText AddedIndex AddedIndex.txt  

 

print "Finally write changed index to readable \Maconomy\tmp\ChangedIndex.txt" 

print "Please inspect ChangedIndex.txt and consider if theese changes are desirable" 

WriteIndexToText ChangedIndex ChangedIndex.txt  

Review the changes from standard in addedIndex.txt. It always contains indices for the Maconomy_Users 
table and this is acceptable. If any additional indices are found and considered undesirable, drop SQL 
can be found in DropAddedIndex.sql. 

Review missing indices listed in missingIndex.txt. Be especially aware of any removed constraints 
(starting with IK or UQ). Consider creating missing index using SQL in CreateMissingIndex.sql. 

Finally, review any changed index in the file changedIndex.txt. Consider the following:  

 Why these changes, if any?  

 Should standard be restored? 
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Checklists 

Regular Routines — Daily 
In this section, you will find the list of checks that should be performed regularly. Performing these checks 
according to the schedule cannot completely ensure the absence of problems but following the guidelines 
below will allow you to catch most issues before they become real problems. 

Check the Backup 
A check of the backup should be performed every day, whether it is performed by Maconomyʹs backup 
script or by a third‐party tool. 

Check the Maconomy backup log to ensure that the backup has run properly. Errors should be reported 
to the Maconomy Customer Support Service. 

The backup log is stored in: 

 Unix 

/usr/Maconomy/backup 

To check for errors, look in the bottom of the BackupGeneral.log. If there are any errors, check 
the Backup.<date>.log. 

 Windows 

See the installation documentation for the backup log location. 

Check the BackupLog.txt file for errors; the latest entry is at the bottom of the file. 

Also remember to change the backup tapes. 

Check that the Daemons are Running 
As described in the “System Overview” section of this manual, Maconomy uses daemons to handle 
requests from the clients and clean up closed connections. The daemons run on the Maconomy server. 

To check the daemon status: 
 Unix 

Use ps –ef | grep Daemon. 

This will display a list of all processes that have “Daemon” in their names. 

The daemon also has a temporary file. Check that it has been refreshed recently. 
ls –l /tmp/zDaemon* 

Examples: 
maconomy 6 % ps -ef | grep Daemon 

maconomy 23800 22372  0  27 okt     - 11:28 bin/Daemon.r -s30 

maconomy 17584    1  0  28 okt     - 6:06 

/data02/app/maconomy/bin/WebDaemon.nm.4105 

This output displays both the Maconomy daemon (Daemon.r) and a webdaemon. You can check 
the number of webdaemons and their port numbers in the server installation documentation. 
maconomy 9 % ls -l /tmp/zDaemon* 
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-rw-r--r-- 1 maconomy maconomy 0 02 dec 11:57 

/tmp/zDaemon.tmp 

The time stamp of the file is important. It should have been modified within approximately the last 
15 minutes. 

 Windows 

In Windows, the Daemons run as services and can be checked in the server’s Services 
management console window. The services in question are: 
MaconomyDaemon WebDaemon.<shortname>.<port> 

Check the Temporary Area for Old Files 
Normally, the Maconomy application will clean up its old files from the temporary area assigned to it. 
However, this is not the case if the application or the batch job terminates unexpectedly. 

The file DaemonConfig in the \IniFiles directory specifies which files will be deleted automatically by the 
Maconomy daemon. The file contains several lines of the following format: 
<Folder>\<Wildcard> <No.Hours> 

For example, the file can contain the following lines (Windows): 
%MaconomyTmpDir%\PRINT* 6 

%MaconomyTmpDir%\ERROR* 24 

%MaconomyTmpDir%\MSL* 6 

According to that setup, files in the Maconomy temporary directory which begin with PRINT or ERROR, 
respectively, will be deleted by the MaconomyDaemon after 6 and 24 hours, respectively. For UNIX, only 
the folder separator is different. Exchange the 
\ with a /. 

Files of the type defined below, which are older than 24 hours, can and should be removed. If you are in 
doubt, you can ask Maconomy A/S if you can delete a file. 

You may find the following file types in the temporary area: 

 Debug files from the Maconomy Daemon (for example, DdbugDOCAFhIAAA). Only Maconomy 
should set the daemon up to run with debugging and you only do it if necessary. Therefore, you 
should not expect to see files of this type. 

 Error files from the clients (for example, ERRORZIAFhIAAC). These files are created for each 
client and for each job. They will be deleted when a job has finished unless it terminated 
abnormally. The contents of these files will correspond with an entry in the PPU_DebugStr file. 

 Batch job files (for example, JOBBIKAFhIAAB or JOBBIKAFhIAAB.cmd). These are executable 
files created for each batch job. Unless the job is terminated abnormally, the files will be removed 
automatically; otherwise, they can be used for localizing the error that caused the termination of 
the job. 

 Debug files from the Maconomy server process belonging to a batch job such as a print file (for 
example, JdbugBIKAFhIAAB). Unless there is a reason for Maconomy to be running with debug 
switched on, there should not be any files of this type. 

 Debug files belonging to a client such as a print file (for example, OdbugZIAFhIAAf). Unless there 
is a reason for Maconomy to be running with debug switched on, there should not be any files of 
this type. 

 ASCII representations of a printout (for example, PRINTZIAFhIKAf). These files are either sent to 
the client or printed directly from the server. 
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 Batch job parameter files (for example, PRMBIKAFhIAAB). These files contain the parameters for 
the batch jobs and will be deleted when the job has finished successfully. The suffix will match a 
JOB* file. 

 Debug files from the Maconomy server process belonging to a report (for example, 
RdbugZIAFhIKAf). Unless there is a reason for Maconomy to be running with debug switched on, 
there should not be any files of this type. 

 Files created in connection with installation or upgrade of Maconomy. For example: 

 ConvertAnalyzerFiles.<AppName>.<shortname>.txt 

 CreateAnalyzerViews.<shortname>.txt 

 LayError_<shortname>.txt 

Files of these types concern the installation, upgrade, and validation of Analyzer files and print 
layouts. 

 Other files may exist, depending on the server and which server features are used. 

If you notice such files, there may be a configuration error in your system, which you should 
investigate. At any rate, the files can also be deleted if they are, for example, a few days old. 

To check the temporary area: 
 Unix 

cd /tmp ls –l 

 To order it by date and time: 
ls -l -t | more 

 To remove the files use: 
rm <filename> 

DO NOT use wildcards such as * or ? in the filename when deleting. 

 In some cases, the /tmp directory can get so full that you are not able to do a directory listing, 
and hence not able to view and delete the files. 

 Windows 

Use Explorer and order the files by clicking on the Modified tab for the folder. 

Check the Maconomy Error Log 
Every time something unexpected happens with the Maconomy application, an entry is appended to the 
log file. The log file will be created if it does not yet exist. On Unix, it is called PPU_DebugStr, and on 
Windows it is PPU_DebugStr.txt. It is located in Maconomy’s temporary area. 

It may be a good idea to rename the file when it reaches about 1 MB in size. A good naming method is to 
add the date to the end of the file (but before any extension). 

The file is an ordinary text file and can be opened with any text editor. The following is an example of the 
error log: 
--------------------------------------------------- 

PPU_DebugStr called at Wed Nov 19 09:54:11 2003 

 

Message: 

DoReceive: recv failed; errno=73 ( connection to client lost) 
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Program name: macoracle.r.w_8_0 Version string: 32.02.0.49 

Process Id: 21128 

User name: Administrator Address, local: 172.16.2.15:4484 

Address, remote: 172.16.100.117:1090 Client type: Windows 

Ini file prefix: macoracle.r.w_8_0 

The entry shows the date, username, address of the client, and an error message that 
describes the problem. 

Error Types 
Here are some of the most common error types. Note that information about program name, version, 
address, and so on has been removed from the examples. 
-------------------------------------------------------- 

PPU_DebugStr called at Wed Feb 27 15:02:03 2002 

 

Message: 

Debug message received from client: Maconomy client version: */T US 3.2.2-32 

 

AllbaseCom Received ErrorCode 150010 

This error means that a file could not be found. The error is most often seen on Unix after a 
failure during backup where the folder FontSupport is temporarily renamed. 
-------------------------------------------------------- 

PPU_DebugStr called at Thu Nov 21 13:52:51 2002 

 

Message: 

ORA-01034: ORACLE not available 

This error indicates that Oracle is not running or that the client is unable to find Oracle. Other than from 
Oracle being down, this error can be caused by network problems or by the client connecting with the 
wrong data. 
-------------------------------------------------------- 

PPU_DebugStr called at Thu Nov 21 13:52:51 2002 

 

Message: 

ORA-1652: unable to extend temp segment by 19762 in tablespace MACINDEX 

If an error is caused by the database, the error message will be transferred to PPU_DebugStr with a 
description of the error. In this specific case, the area in the database reserved for indices has run full and 
needs to be extended. This is a job for a Database administrator. Maconomy Corp. can help with 
extending the tablespace. This error can also happen for other tablespaces. 
-------------------------------------------------------- 

PPU_DebugStr called at Tue Sep 03 19:46:33 2002 

 

Message: 

Server timeout. 240 minutes passed without activity 

This error happens after 240 minutes of inactivity, where the server closes the connection. The time‐out 
can be changed. This error can be ignored. 
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-------------------------------------------------------- 

PPU_DebugStr called at Thu Sep 05 11:36:53 2002 Message: 

ORA-02091: transaction has been rolledback;ORA-00001: unique constraint 
(TEST71.UQ0448) has been violated 

From version 7.0 of the Maconomy application, Maconomy uses constraints in the database to enforce 
uniqueness on the key fields of the database. In this case, there has been a violation. Unless this error 
occurs frequently, it can be ignored. 

Check for Free Disk Space 
The file systems in Unix and the hard disks in Windows should not be allowed to run full. This may affect 
the execution of processes, such as printouts and server processes. Especially the drives/file systems 
where the database’s data files, archive files, and the Maconomy temporary area are placed should be 
closely monitored. 

 
 Unix 

Use the command: 
df -k 

The result may differ a bit depending on the Unix version, but it will display the results in 1 KB 
blocks. 

Example: 
maconomy 1 % df -k    

Filesystem 1024-blocks Free  %Used Iused %Iused Mounted on 

/dev/hd4 503808 422548 17% 1331 1% / 

/dev/hd2 602112 120660 80% 19130 13% /usr 

/dev/hd9var 102400 75000 27% 232 1% /var 

/dev/hd3 258048 163916 37% 678 2% /tmp 

/dev/hd1 8192 7888 4% 22 2% /home 

/dev/lv00 5013504  2952036 42% 1219 1% /data01 

/dev/lv01 12058624  718028 95% 26234 1% /data02 

 Windows 

To check the disk status on Windows, use Explorer. Click My Computer and ensure that it shows 
the results “detailed.” 

Attention: For more information on how to change the time-out option, refer to “Options and 
Parameters” in “Maconomy Server Options and Parameters.”  

Warning: DO NOT move the data files of the database to get more free space unless you are a 
database administrator. If you just move them, it will most likely damage the file in such a way that the 
latest backup must be reinstalled. 
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Regular Routines — Weekly 
The routines described in this section should be performed weekly. 

Check for Free Space in the Oracle Database 
To ensure that the database is in working order, you can run the CheckOracle program. It will print a list 
of information for each tablespace in the database. If a tablespace is close to full, it should be extended. 
Usually, the following tablespaces need to be extended: MACONOMY, MACINDEX, and on rare 
occasions also SYSTEM. MACROLLBACK will most often look full, but as long as your reports and 
updates of the system run without problems, there is no need to worry. 

CheckOracle is a small Maconomy program (used from a command line) and it is stored in the 
Maconomy /bin folder. 

 Unix 

Example: /data02/app/maconomy/bin 

 Windows 

Example: D:\maconomyNT\bin 

The results are similar, except for the path to the data files. To run the program, change your location to 
the /bin folder, and type (exchange manager for the password for your system user): 
CheckOracle system/manager 

The result may look like this: 
CheckOracle version 4.1. Copyright PPU Maconomy 1997-2002. 

---------------------------------------------------------- 

Checking tablespace allocation: 

-- TABLESPACE TOTAL FREE LARGEST USED % FREE RM 

-- --------------- ----------- ---------- -------- ----------- ------ 

-- 

-- SYSTEM 122683392 507904 327680 122175488 .4 AX 

-- MACROLLBACK 2097152000 180215808 1064960 1916936192 8.6 

 

 

** 

-- MACONOMY 2298478592 1245978624 4186112 1052499968 54.2 AX 

-- MACTMP 524288000 498720768 1064960 25567232 95.1 AX 
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-- MACINDEX 1918894080 1161723904 1048576 757170176 60.5 AX 

-- OEM_REPOSITORY 5242880 5234688 5234688 8192 99.8 AX 

Checking init parameters: 

--------------------------------------------------------------------- 

--- 

Done. 

Check the amount of free space against the total size of the tablespace. As long as there is more than 
20% free space, there is no need to take further action (free space in percentage is shown in the second 
column from the right). 

Since version 8, Oracle has been able to auto-extend its data files up to a given maximum size, which is 
set during the creation of the data file. Maconomy normally creates data files with a maximum extent of 2 
GB. This may cause some confusion, so if CheckOracle reveals that a tablespace may be close to full, a 
second check should be made. 

To check the maximum size of the tablespace: 
1. Log in to the system as as the Maconomy user. 

2. Start sqlplus. 

3. Run the following check: 
select sum(bytes), sum(maxbytes), tablespace_name from sys.dba_data_files 

group by tablespace_name; 

This check will show you the maximum size of the tablespace, and how much it is actually using at the 
moment. 

Example 
maconomy 11 % sqlplus system/manager 

 

SQL*Plus: Release 8.1.6.0.0 - Production on Thu Dec 4 15:48:12 2003 

(c) Copyright 1999 Oracle Corporation. All rights reserved. 

 

Connected to: 

Oracle8i Release 8.1.6.0.0 - Production JServer Release 8.1.6.0.0 - Production 

 

SQL> select sum(bytes), sum(maxbytes), tablespace_name from sys.dba_data_files group 
by tablespace_name; 

 

SUM(BYTES) SUM(MAXBYTES) TABLESPACE_NAME 

---------- ------------- ------------------------------ 

1918894080 4194304000 MACINDEX 

2298478592 4194304000 MACONOMY 

2097152000 0  MACROLLBACK 

524288000  786432000 MACTMP 

5242880  83886080 OEM_REPOSITORY 

123731968  2097152000 SYSTEM 

 

6 rows selected. 
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In this case, there is plenty of free space for the tablespaces to grow, with MACROLLBACK as the 
exception. 

Check the Oracle Trace Files 
Oracle writes errors to trace files, which should be checked weekly. To find the files, please check your 
server installation documentation to see where the oraclebase is located. 

In that folder you will find the following path to Oracle’s log files: 

<oraclebase>/admin/<SID name>/log 

For example, if <oraclebase> is /data02/app/oracle, and <SID name> is macora, the path will be: 

/data02/app/oracle/admin/macora/log 

Entering maconomy 30 % ls -l may yield the following result: 
-rw-r--r-- 1 oracle dba 1480142 04 dec 08:37 alert_macora.log 

-rw-r----- 1 oracle dba 524 20 aug 10:11arc0_10516_macora.trc 

-rw-r----- 1 oracle dba 524 23 sep 08:00 arc0_10530_macora.trc 

-rw-r----- 1 oracle dba 524 03 nov 08:00 arc0_11790_macora.trc 

In this case, there are three trace files and the database log file. Trace files should be checked by a 
Database administrator or by one of Maconomy’s technical consultants. 

Check the Operating System Error Log File 
By checking the error log of the operating system, you can catch many errors before they become 
problems.  

Check the Date of Export Files 
If you are using the Maconomy backup script as described in the “Backup and Restore Guidelines” 
section of this manual, check the date in the Maconomy export file folder (typically \MaconomyNT\Backup 
on Windows). The date of the export files should be current; otherwise, something has gone wrong. 

Run Cleaning Tape at the Tape Station 
If a tape station is installed locally, a cleaning tape should be run once a week (for instance to avoid the 
error seen above). See also the bi‐annual routine of cleaning the tape station. 

You should also ensure that you can read what has been written on a random tape from last week’s 
backup, and you should also remember to follow the guidelines from the manufacturer of the tape about 
the lifetime of the tapes. 

Regular Routines — Monthly 
The routines described in this section should be performed monthly. 

Reinstall Random Files from the Backup Tape 
This check should be performed if you take a backup of more files than the databases data files and the 
database dumps generated by the Maconomy backup script. 
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To control the quality of the backup, the system administrator should reinstall some files from the backup 
tape. The restored files should be compared with the original ones. This check naturally only makes 
sense if there has been no change to the file since the backup was taken. 

If you are using tar on Unix to write to the tape, like the Maconomy backup script does, please note that 
tar uses absolute paths and will overwrite the original file. So, before performing a restore, make a copy of 
the files you are trying to restore. 

Several programs can be used on the different platforms supported. On Windows, CSDIFF can be used.  

If the files are identical, the command diff will return no comments. It can be used for both binary and 
text files. 

If there are no differences, you can delete the original file: 
rm Schema.cc.sql.orig 

The tar command will return this output when a file exists (for other backup programs, please refer to the 
manual or online help): 
tar x /data02/app/maconomy/w_8_0/MaconomyDir/Database/Schema.cc.sql 

As an alternative, all Maconomy installations contain a small command line program, which on all 
platforms is called binsum. You can call it twice (once for each file) and compare the checksums. If the 
checksums are identical, so are the files. 

Example: 
maconomy 18 % binsum Schema.cc.sql 

Checksum: 52508 Size: 802 KB Schema.cc.sql 

 

maconomy 19 % binsum Schema.cc.sql.orig 

Checksum: 52508 Size: 802 KB Schema.cc.sql.orig 

Check that Backup Tapes can be Read on Another Server 
It is important to ensure that the backup can be read with another machine and with another tape drive in 
case the original server is destroyed or stolen. This check can be done by completely restoring the 
system to the hard disk. Alternatively, restore some of the files and then read the complete contents of the 
tape. 

Again please note that tar uses absolute paths, and it will overwrite any existing files. 

Deposit Complete Backup in Safe Place 
Every month, you should deposit a complete backup in a fireproof safe deposit box or in the bank. 

Import a Dump from the Backup to a Test Company 
To ensure that the test data is up to date, a copy of the live data should be installed each month. If you 
are running some tests, this check can be postponed. 

You should only do this if you are the database administrator. You will use Maconomy’s internal tools 
since the syntax is mostly the same on all platforms. 

The following default syntax is used: 
<version>, <data_source>, <data_target>, <filename> 

There are four steps to this: 
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 Empty the target company. 

 Export the data from the source company. 

 Import the data into the target company. 

 Verify that you can log in to the target company. 

Empty the Target Company 
Before an import can be made, the target company must be emptied for data (truncated). This is done by 
using the -ZT parameter: 
MaconomyServer.<version> -S<data_target> -ZT 

For example: MaconomyServer.w_8_0 -Snmtest -ZT 

The output looks like this (note that the server version and database type may vary): 
MACONOMY SERVER for ORACLE81 vers. 32.01.0.320148 compiled Sep 30 2003 10:23:13 

: Import/Export. 

 

Truncating ABSENCECALENDARLINE Done. Truncating ACCESSCODELOG Done. 

Truncating ACCESSINFORMATION Done. 

Ending with 
Truncating WORKFLOWITEM Done. TOTALS: 

613 relations truncated. 

Export the Data from the Source Company 
Exporting data from the data source is done by using the -E parameter. This should not be done while 
there are users on the system: 
MaconomyServer.<version> -S<data_source> -E<filename>.dbd 

For example: MaconomyServer.w_8_0 -Snm -Enm.dbd 

The output looks like this (note that the server version and database type may vary): 
MACONOMY SERVER for ORACLE81 vers. 32.01.0.320148 compiled Sep 30 2003 10:23:13 

: Import/Export. 

 

Database application version: Maconomy W 8.0 

Exporting ABSENCECALENDARLINE . Records exported: 0 

Exporting ACCESSCODELOG . Records exported: 0 

Exporting ACCESSINFORMATION . Records exported: 1 

Exporting ACCESSLEVELHEADER . Records exported: 0 

Exporting ACCESSLEVELLINE . Records exported: 0 

Exporting ACCOUNT . Records exported: 0 

Exporting ACCOUNTBALANCE . Records exported: 0 

Exporting ACCOUNTREFERENCE . Records exported: 42 

...  

Ending with 
Exporting WORKFLOWITEM . Records exported: 0 
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TOTALS:      

  613 relations exported. 

  31130 records exported. 

Import the Data into the Target Company 
Import the data into the data target by using the -I parameter:  
MaconomyServer.<version> -S<data_target> -I<filename>.dbd  

For example: MaconomyServer.w_8_0 -Snmtest -Inm.dbd 

The output looks like this (note that the server version and database type may vary): 
MACONOMY SERVER for ORACLE81 vers. 32.01.0.320148 compiled Sep 30 2003 10:23:13 

: Import/Export. 

 

Database application version: Maconomy W 8.0 

Importing ABSENCECALENDARLINE . Records imported 0 

Importing ACCESSCODELOG . Records imported 0 

Importing ACCESSINFORMATION . Records imported 1 

Importing ACCESSLEVELHEADER . Records imported 0 

Importing ACCESSLEVELLINE . Records imported 0 

Importing ACCOUNT . Records imported 0 

Importing ACCOUNTBALANCE . Records imported 0 

Importing ACCOUNTREFERENCE . Records imported 42 

...      

Ending with 
Importing WORKFLOWITEM . Records imported 0 

 

TOTALS:      

  613 relations imported. 

  31130 records imported. 

Check that you have imported as many tables and records in the target as you exported from the source. 

Verify that You Can Log in to the Target Company 
If you have forgotten to truncate the data in the target company before the import, you will not be able to 
log in to the system. 

Regular Routines — Biannually 
Every six months, you should perform the following routines. 

Make a Complete System Restore 
Restore a complete backup, log in to the restored system, and see if the integrity of the system is intact. 
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Clean the Tape Station 
If the tape station is placed in a local server machine, you should open the server box and clean it inside 
twice a year (or quarterly). This is important for reliable tape backups.  

 

Replace Backup Tapes 
Every six months, or at least every year, you should replace your backup tapes to ensure reliable tape 
backups. 

Maintenance Checklist 
The following list is a brief checklist of things to remember.  

 
 Check the backup. 

 Check that the Daemons are running. 

 Check the temporary area for old files. 

 Check the Maconomy error log. 

 Error types 

 Check for free disk space. 

 Check for free space in the Oracle database. 

 Check the Oracle trace files. 

 Check the operating system error log file. 

 Check the date of export files. 

 Run cleaning tape at the tape station. 

 Reinstall random files from the backup tape. 

 Check that backup tapes can be read on another server. 

 Deposit complete backup in safe place. 

 Import a dump from the backup to a test company. 

 Empty the target company. 

 Export the data from the source company. 

 Import the data into the target company. 

 Verify that you can log in to the target company. 

 Make complete system restore. 

 Clean the tape station. 

Attention: For further instructions, please refer to the manual supplied by the manufacturer of the 
tape station. 

Tip: Print a copy of this list and hang it on the wall. 
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 Replace backup tapes. 
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Common Maconomy Server Tasks  
This section describes some tasks which are commonly performed on a Maconomy server. 

Shutting Down the Server (Windows) 
If you want to shut down the server, and you want to be completely sure that the server is shut down fast, 
follow this procedure: 

1. Log on locally as the Maconomy user. 

2. Stop the MaconomyDaemon service by typing net stop MaconomyDaemon in a command 
prompt or by using the Services window. 

3. Shut down all processes called MaconomyServer.exe. 

4. Stop the OracleService<SID> service by typing net stop OracleService<SID> in a command 
prompt or by using the Services window. 

5. Shut down the server. 

Who Is Logged in to the Maconomy System? 
To find out who is logged in to a given Maconomy system: 

1. Log in locally as the Maconomy user. 

2. Open a command prompt. 

3. Run the MaconomyServer process associated with the Maconomy system.  

 On Linux there is a symbolic link to the server executable in the /data/maconomy/bin folder 
that includes the system name.  

 On Windows the -i option must be used to identify the system configuration to use. 

In addition the -S option must be used to specify which database shortname to connect to. The --
users option can then be used to list the current user session for the system.  

Examples: 
MaconomyServer.exe -i<system-name> -S<shortname> --users 

macoracle.<system-name> -S<shortname> --users 

In the table listing, you can see the username and the client type being used as well as creation time and 
last-access time of the user session. 

Change the Password for the Maconomy User (Windows) 
If you want to change the password for the Maconomy user, you can do so by logging on as the local 
system administrator. However, note the following: 

 All services installed with Maconomy run as the Maconomy user, so it is also necessary to 
change the password for these services. In some cases, some of the Oracle services may also 
run on the Maconomy user account, and the password should also be changed here. The 
Maconomy services include: 

 MaconomyDaemon 

 WebDaemon.<shortname>.<port> 
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 MscriptDaemon<portal id> 

 The Maconomy backup runs as an at job. Normally, all at jobs are set up to run as the Maconomy 
user in Scheduled tasks under Advanced options. If other Maconomy jobs are running, these 
should also be checked. 

 On the day following a password change, you should check that the backup has run correctly, 
and that all Maconomy related services are running. 

Server Debug Output 

 
Debug output for the Maconomy Server can be activated globally with the -d option in the server 
initialization file (MaconomyServer.<appl_ID>.I). 

This activates a default set of test masks in the Maconomy server processes, and each process writes 
debug output to a process-specific log file in the \Tmp folder of the Maconomy installation. 

The option only applies to server processes started after the option is set, so you must restart the 
Coupling Service to activate debug output for all server processes. 

As of Maconomy 2.3 GA, you can also activate debug output from the Coupling Service for the already-
running server processes owned by that Coupling Service.  

Output from Server Debug Logging  
By default, output from server debug logging is sent to the log file, maconomy-debug.log, which is located 
in the Coupling Service log folder. Each request to the 1.x MaconomyServer produces a multi-line log 
entry with all debug output related to the request. If the request produces additional files with debug 
output, then the contents of each file are included as its own multi-line log entry.  

Combined with the move of the debug configuration settings to the settings/logging.ini file, the process of 
enabling and collecting server debug logs is now completed entirely through the Coupling Service. If the 
Coupling Service is configured with integration to OpenTelemetry, the debug log output is also available 
to third-party tools consuming log events through the OpenTelemetry Collector Service. 

Activate Server Debug Output 
In this mode, the Maconomy server processes write debug output to user-specific log files in the \Log 
folder of the Maconomy installation. 

To activate server debug output: 
1. Open the logging.ini configuration file of the Coupling Service.  

2. Locate the server.debug.enabled setting. 

3. Remove the comment marker from the setting. 

4. Set the setting to true.  
server.debug.enabled = true 

The debug output is immediately enabled for all subsequent server operations. 

Warning: Activating debug output can negatively affect server performance. 
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Reduce the Performance Penalty of Debug Output 
To reduce the number of log files and the number of users affected by the performance penalty of debug 
output, collect only debug output for specific users. 

The filter condition for matching individual users is similar to the user-principal filter option in the MPM 
settings. 

To filter debug output: 
1. Open the logging.ini configuration file of the Coupling Service. 

2. Locate the server.debug.filters setting. 

3. Remove the comment marker from the setting. 

4. Write a string expression that matches the users to collect debug output for: 
server.debug.filters.principal-name = <string-expr> 

Use this syntax of a string expression: 
string-expr: [contain(s)|match(es)] [regex] <pattern>  

 

To disable debug output: 
1. Open the logging.ini configuration file of the Coupling Service.  

2. Locate the server.debug.enabled setting. 

3. Add a comment marker in front of the setting or set the setting to false.  
server.debug.enabled = false 

 

Database Surveillance 
The data of a Maconomy system is placed in a database. The data of different Maconomy companies are 
placed in separate DB‐user accounts in the same database instance. An important part of keeping a 
Maconomy system functional is to monitor the database. 

 

Tablespaces 
All objects (tables, indexes, and so on) in an Oracle database are stored in tablespaces. The data in each 
tablespace is stored physically in one or more data files. 

Maconomy uses the following six tablespaces. 

Note: The logical combinators and, or, and not can also be used. 

Attention: For more details, refer to “Maconomy Server Frequently Asked Questions” section. 

Attention: For information about supported databases, please see the “Database and OS 
Requirements” section in this manual. Currently, this document only describes Oracle. 
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Tablespace Description 

Maconomy Used as the default tablespace. All Maconomy 
data and indexes are stored in this tablespace. 

MacTmp Used as the temporary tablespace. A 
temporary tablespace holds temporary 
segments, which are created automatically and 
used during SQL execution. 

MacRollback Holds the rollback segments used during SQL 
execution. 

MacIndex Holds the indexes for all the relations/tables of 
the database. 

System Holds system information for the instance and 
is not described further in this document. 

Oem_Repository Holds system information for the instance and 
is not described further in this document. 

 
As more data is entered in the Maconomy system, a tablespace can become full. When this happens, it 
must be extended; otherwise, Maconomy will stop functioning.  

 
 

Data Files 
The data in the Oracle database is stored in a number of files that are usually placed in a directory named 
\Oradata inside the Oracle Home. Oracle Home is usually a directory named \Oracle at the root of a drive. 
A typical example of the path to the directory where the data files are placed is: 

 Win NT/Win2K: C:\Oracle\Oradata\ORCL8 

 Unix: /data/oradata/orcl8 

If more than one physical disk exists in the system, the data files may be placed elsewhere. Use 
CheckOracle (see the following information) to locate the data files. 

CheckOracle 
Use the CheckOracle utility to check the condition of the Maconomy database. 

Warning: When the database that Maconomy uses is first created, each of these tablespaces 
consists of one file. These files must never, under any circumstances, be deleted. 

Attention: For information about extending a tablespace, refer to the “Extending an Oracle 
Tablespace” Section.  
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To run CheckOracle: 
1. Open a command prompt/shell. 

2. Run the CheckOracle system/manager command. 

If you are running Windows, and the command is not recognized, change to the 
<MaconomyHome>\bin directory before running the command. The output of the command 
should be similar to the following: 
D:\maconomy\bin>checkoracle system/manager 

CheckOracle version 4.2. Copyright PPU Maconomy 1997-2004. 

-- TABLESPACE TOTAL FREE LARGEST USED % FREE RM 

-- ------------- ---------- ---------- ---------- ---------- ------ 

-----------  

-- SYSTEM 327155712 573440 573440 326582272 

.175280449 AX D 

-- MACROLLBACK 463470592 1048576 1048576 462422016 

.226244344 AX D 

-- MACONOMY 4196401152 640811008 560922624 3555590144 

15.2704898 AX D 

-- MACTMP    0 

-- MACINDEX 6287261696 1903820800 889978880 4383440896 

30.2806037 AX D 

---- ---- 

- 

Checking init parameters: 

- 

.. 

.. !!! WARNING: DATABASE STATISTICS IS POOR. PLEASE IGNORE TUNING COMMENTS 

Done. 

This displays the following information about the various tablespaces in the database. 

Column Description 

TABLESPACE The name of the tablespace. 

TOTAL The total allocated size of the current tablespace, i.e. the sum of the columns 
FREE and USED, in bytes. 

FREE The size of the available portion of the current tablespace, in bytes. 

LARGEST The size of the largest object in the current tablespace, in bytes. 

USED The size of the used (unavailable) portion of the current tablespace, in bytes. 

% FREE The amount of free space in the current tablespace, as a percentage. 

RM Any remark to the current tablespace. 
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Use the information to determine if one or more of the tablespaces is running full and if you have to add 
an additional data file to the tablespace in question. When the upper file size limit (2000 MB) is reached, a 
new file must be manually added to the tablespace.  

 

More Details 
If you run CheckOracle with the -a option (for example, CheckOracle system/manager -a), more details 
are added to the report. Two new sections, Retrieving details and Data files in database, are added 
after the tablespace output. 

The information in the Retrieving details section can be useful for optimizing the Oracle database. 

The information in the Data files in database section is used to find out which data, control and redo‐log 
files exist in the database. At the bottom of the new output section, you will find information similar to the 
following (depending on platform): 

 Windows 
.. Data files in database 

.. Datafiles 

.. C:\ORACLE\ORADATA\ORCL\SYSTEM01.DBF 

.. C:\ORACLE\ORADATA\ORCL\MACROLLBACK.DBF 

.. C:\ORACLE\ORADATA\ORCL\MACDATA01.DBF 

.. C:\ORACLE\ORADATA\ORCL\MACTMP01.DBF 

.. C:\ORACLE\ORADATA\ORCL\MACINDEX01.DBF 

.. C:\ORACLE\ORADATA\ORCL\OEMREP01.DBF 

.. Controlfiles 

.. C:\ORACLE\ORADATA\ORCL\CONTROL01.CTL 

.. C:\ORACLE\ORADATA\ORCL\CONTROL02.CTL 

.. C:\ORACLE\ORADATA\ORCL\CONTROL03.CTL 

.. Logfiles 

.. C:\ORACLE\ORADATA\ORCL\REDO1_1.LOG 

.. C:\ORACLE\ORADATA\ORCL\REDO1_2.LOG 

.. C:\ORACLE\ORADATA\ORCL\REDO1_3.LOG 

.. 

 UNIX 
.. Data files in database 

.. Datafiles 

.. /data/oradata/orcl8/system01.dbf 

.. /data/oradata/orcl8/MacRollback.dbf 

.. /data/oradata/orcl8/MacData01.dbf 

.. /data/oradata/orcl8/MacTmp01.dbf 

.. Datafiles 

.. /data/oradata/orcl8/MacIndex01.dbf 

.. /data/oradata/orcl8/oemrep01.dbf 

.. Controlfiles 

.. /data/oradata/orcl8/Control01.ctl 

Attention: For information about extending the tablespace, refer to the “Extending an Oracle 
Tablespace” section. 
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.. /data/oradata/orcl8/Control02.ctl 

.. /data/oradata/orcl8/Control03.ctl 

.. Logfiles 

.. /data/oradata/orcl8/redo1_1.log 

.. /data/oradata/orcl8/redo1_2.log 

.. 

This list displays the following five data files: one data file for the system tablespace, one data file for the 
Maconomy temporary tablespace, two data files for the Maconomy rollback tablespace, and one data file 
for the Maconomy data tablespace. Additionally, the list displays the locations of the Oracle Control file 
and the Oracle Redo‐log files. 

Please note that all these files must be included in an Oracle file system backup. 

Autoextend Option 
Since version 8, Oracle has had the option to auto‐extend the tablespaces as they are running full. If 
auto‐extend is turned on, the only valuable information from CheckOracle is to see if an additional data 
file must be added to the tablespace in question. 

However, the Oracle autoextend option in its current implementation has some drawbacks. First, Oracle 
auto‐extends the tablespace in increments of 1 MB. This is a very small amount, especially if you are 
dealing with large databases (for example, larger than 10 GB), where you would want to increase the 
tablespace by 2 GB at a time. The consequence of these increments being so small is that a large 
number of data files are created, and that the amount in the % FREE column often displays a very small 
amount, frequently around 0.5%. 

Advocates for the autoextend option say that the option reduces the need for database service. But in the 
end, it is up to you, the database administrator, to decide whether you want to turn the option on or not. 

Extending an Oracle Tablespace 
If a tablespace is running full, you need to extend it. On Windows, this is done using the Oracle Database 
Administrator program (svrmgrl). 

The examples below extend the tablespace named Maconomy. Assume that the data files are placed in 
the directory C:\Oracle\Oradata\ORCL8, and the data file to add is named MacData02.dbf. Do the 
following: 

1. Open a command prompt/shell. 

2. Launch svrmgrl. 

3. Type the following commands:  

 Windows: 
connect system/manager alter tablespace Maconomy 

add datafile 'C:\Oracle\Oradata\ORCL8\MacData02.dbf' size 100 M; 

exit  

 UNIX (only the path notation is different): 
connect system/manager alter tablespace Maconomy 

add datafile '/data/oradata/orcl8/MacData02.dbf' size 100 M; 

exit 

This will add a new data file with a size of 100 MB to the tablespace Maconomy. 
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As Oracle may be initially set up to auto‐extend the data files when needed, you only have to observe that 
the used space in tablespace Maconomy is lower than 4000 MB. When the used space is close to 4000 
MB, an additional file must be added, and so on. 

 
You should follow these naming conventions when adding data files to tablespaces: 

 Files added to tablespace Maconomy are named MacData<SeqNo>.dbf. 

 Files added to tablespace MacTmp are named MacTmp<SeqNo>.dbf. 

 Files added to tablespace MacRollback are named MacRoll<SeqNo>.dbf. 

 Files added to tablespace MacIndex are named MacIndex<SeqNo>.dbf. 

 Files added to tablespace System are named System<SeqNo>.dbf. 

In all five cases, <SeqNo> is a sequence number starting from 2 and uses two digits. For example, when 
adding a data file to the Maconomy tablespace for the first time, the file should be named 
MacData02.dbf. 

Prior to adding data files, you should use CheckOracle with the -a parameter to obtain a list of the names 
of the existing data files.  

 

Operating System Surveillance 
To keep the Maconomy server in shape, you must carefully monitor your operating system.  

 

What to Watch 
Check disk space regularly. If you are running out of disk space, check the Maconomy \Tmp directory for 
files which can be cleared.  

 

Note: If you add a data file to a tablespace, it cannot be removed again without deleting the entire 
tablespace. Furthermore, it is difficult to rename or move a data file. Consequently, you must be sure 
that you add the file to the correct tablespace, that the file is placed in the correct location, and that 
the file is given the correct name. Also, check for sufficient disk space before adding a datafile! 

Attention: For information about using CheckOracle, refer to the “Check Oracle” section. 

Attention: For information about supported operating system versions, refer to the “Database and 
OS Requirements” section in this manual. 

Attention: For more information, refer to the “Check for Free Disk Space” and “Check the Temporary 
Area for Old Files” Sections. 
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Advanced Logging 
Maconomy contains a suite of data security features. One feature is the logging system, which is 
designed to comply with various legal requirements. 

From a security point of view, two areas are especially interesting to monitor: 

 Which users change data in the system, what do they change, and from what? 

 What data do users view, print, export, and search for in the system? There may be legal 
requirements to monitor, such as who changes the credit maximum of a customer or who extends 
a credit grace period. 

Maconomy has a powerful method of keeping track of any updates and queries in the system. This is 
described in the following sections. 

General Functionality 
The kind of information to be logged is specified in a configuration file in which the system administrator 
can define the exact relations and fields on which logging should be performed. To find the names of 
relations and fields in the database, please consult Database Description in the Reference Manual for the 
current version of Maconomy. 

By logging only the data changes that require monitoring, storage space can be limited, and response 
times optimized. After the relevant logging rules have been set up, all the monitored changes and queries 
are stored in relations in the Maconomy database. 

The log information is viewed by means of the Maconomy Analyzer, using either the Update Log Analyzer 
Report or the Query Log Analyzer Report. 

The following diagram demonstrates the flow of information through Maconomy when a user changes a 
relation that is monitored by the Update Log functionality: 
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Update Log 
The Maconomy Update Log is used for registering changes made in various relations in the Maconomy 
database. Maconomy does not log the entire relation when something is changed. Maconomy only logs 
those fields that are changed. 

An entry is made in the log for a selected relation when a user makes a direct change to the relation. 
However, transaction updates performed by Maconomy are not logged. For example, if all fields in the 
Customer relation are monitored, Maconomy records an entry in the log if a user changes the customer’s 
credit maximum in the Payment Information window. But if a sales order is approved and billed, and the 
customer’s balance is thus increased, no log entry is made. 

When deleting an entry, Maconomy can log either the fact that the entry was deleted or the value that was 
deleted. The method of logging deletions depends on the keyword LogOnDelete. 
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MDoc/Data Dictionary 
MDoc is a tool for generating a set of hyperlinked HTML files that offers a database description for each 
field and action within Maconomy. Information for each field/action includes: (database) name, type, (user 
interface) title of field, and other information.  

How to Generate MDoc 
To generate MDoc: 

1. In the bin folder of the TPU, click the MDumper program to generate the files on any Maconomy 
installation from the application server.  

2. Create an output folder in any location where you have write access. 

 
3. Use the following command to generate files using MDoc: 

MDumper  -MaconomyDir  <application home>  -DumpMDoc  <output folder> 

where  

<application home> is the application home for the targeted application  

and  

<output folder> is the folder where the generated MDoc files are placed. 

 

How to Use MDoc 
After you generate MDoc, use the tool to look up database items and view descriptions.  

To use MDoc: 
1. Run the tool to generate a zip file. 

2. In the output folder you created, extract the contents of the zip file.  

3. Double-click the MDoc folder.  

4. Double-click the html folder. 

5. Double-click index.html to open the MDoc start page in your default browser. 

6. Select a database item from the menu to view its description. 

Note: Be sure to create the Output folder prior to running the command below. 

Note: Instructions are maintained in the System Administrator Guide documentation suite. 
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Data Import Packages 
The Data Import Package process in Maconomy streamlines the import process. This is especially helpful 
at the beginning of a project, where a customer is new to Maconomy and wants to move large amounts of 
data from their old system to Maconomy (including employees, projects, historical information, and so on).  

Previously, importing was done through MConfig, or dialog box by dialog box. The new process 
introduces the concept of Data Import Packages, which enables you to specify which files to include in a 
package, and transfer numerous import components at once. Additionally, you can validate the package 
prior to import to flag and correct any errors prior to import. Finally, you can save the packages in different 
formats for future use. A new Data Import Workspace provides a centralized place in the Workspace 
Client to create, validate, and import data packages.  

This section includes: 

 Workflow  

 Concepts 

 Procedures 

 Setup 

 Troubleshooting 

 Field Descriptions  

Data Import Packages Workflow 
This section describes the workflow for using data import packages and the related workspace. 
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Data Import Package Concepts  

Data Import Package 
A Data Import Package is a collection of import files you put together in a specific order to create a single 
package to transfer data to Maconomy. This is particularly helpful as an efficient means to transfer legacy 
data to Maconomy. For example, a company may have subsidiary companies or branches all over the 
world. Data Import Packages provides a process to create initial packages and then replicate the 
packages to move data from all their legacy systems to the Maconomy system.  

Additionally, a data import package contains metadata, such as checksums, which are a small size data 
derived from the import files which allow you to verify the integrity of the package and track it across 
different systems.  

You can create data import packages in Workspace Client, and then save and download the package 
from one Maconomy system and load it into another Maconomy system. As part of this process, master 
data as well as transactional data is created when you execute the import of the data import package. 
You can quickly create, update, or delete multiple records in different tables without navigating specific 
records. Moreover, the import files dictate how the data should be changed, acting as a trace of what has 
been imported into a given system. Additionally, the import files can be prepared by one user and 

1 • Create Import Data Package

2 • Validate Packages

3 • Correct Errors

4 • Simulate Import

5 • Import Packages

6 • Verify Imported Data

7 • Save and Load Packages

8 • Purge Package
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delivered to another user who can then import them. Lastly, import files can be prepared once and then 
imported into multiple different systems allowing to you to maintain consistency between systems. 

Use the Data Import Packages workspace to maintain the import data and automate the actual importing 
of the data files. 

 

Create Packages 
You can create import data packages for one-time use or create them and use them in the future as 
template import packages, which is helpful if you are importing data from many different branches and will 
always include the sample import programs.  

Creating a package requires these main steps:  

 Set up the package information. Set up the package with a unique name for easy identification 
and a short description that will be helpful to you and others viewing the package. Also, since 
import data is usually sensitive, you can also set up access control.  

 
 Use the New Data Import Package action to create the package. You must first create the 

package before you can attach the import files. 

 Complete the table lines for the new package. Data import package lines represent import data 
that must be imported as well as the order in which they must be imported. The table lines define 
this order.  

 Use the Attach File action to select files to import and attach them to the new package. Create 
the package lines in the order in which you want to import them.  

For example: 

If you want to import new vendors to your Maconomy system, begin by specifying an Import Program. 
The import program refers to the dialog box or container that manages the import data in the given import 
file. In this case, choose the Import Vendors container.   

Next, add the files in the order you want to import them to account for data dependencies. A typical order 
may be customer, job, and so on. Finally, import the file after you have already imported vendors since 
vendor invoices depend on vendors. 

Option Lists 
Two fields, Option List and Selected Value, support option lists in Data Import Packages and function as 
they do elsewhere in Maconomy.   

 Option List: Lists all the options that are defined in Maconomy and allows you to select one of 
them.  

 Selected Value: After selecting the option list, use the Selected Value field to select one of the 
values that are defined in the chosen option list. All the option lists and the corresponding values 
can be seen in the Option Lists dialog box. 

Note: Color Coding  

Colors of both text and highlight have meaning. Refer to the Legend in Data Import Packages » 
Data subtab » Sliding Panel » Legend for details. 

Note: Both the Name and Description fields are editable. 
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One difference when you use the fields in data import packages is that when you save a package to file, 
the specified option list and the selected value are also saved to that file. This means that when you load 
the saved package on another system, it is loaded with the same option list values.  

If an option list does not exist on a system where the package is being loaded, these rules apply: 

 If package is being loaded on another system, but the specified Option List does not exist on 
that system, then both the Option List and Selected Value values are reset (set to empty value) 
before loading it. 

 If Option List does exist, but Selected Value does not exist, then only Selected Value is reset 
before loading it. 

In both cases, you receive a warning so that you can opt to continue with the load or stop. 

Validate Packages  
The Data Import Packages process allows you to validate packages so that you can find and resolve 
errors prior to import. Validating is much faster than importing, so in a short span of time, you can 
troubleshoot any issues in preparation for the more time-consuming import. Validation can help to reveal 
obvious mistakes in the import file, such as using string value where integer/amount/real was expected, 
referencing non-existing popups, or referencing non-existing columns. Validate the files that you have 
attached to see if they are correct or if you have any errors. 

 
While you validate, you can continue working with the lines that have not been marked for validation or 
create new package lines. The data import package lines that have been validated will have a validation 
log attached to them. To view the validation log, click the View Validation Log action either directly on 
the line or in the sliding panel.  

If the validation log contains errors, you can edit the import file by modifying the original file stored locally 
on your computer. Or, you can download the attached import file to your local computer, edit it, save it 
locally, re-attach the corrected file to the package line, and re-run the validation.  

 

Hierarchy of Validation Example 
You may wish to validate in a number of systems prior to the full import. Deltek recommends a hierarchy 
of validation, moving to the next system when everything has passed at each stage, though the 
complexity of your environment will likely determine the levels of validation. For example, a small 
customer may have only a Test System and a Production System, whereas a larger customer may have a 
Test System, Pre-Production System, Development System, and Production System.  

Best Practice: While it is not mandatory to perform validation before executing the import of a line, it is 
recommended as best practice. For example, you may discover that an import failed and needs to be 

Note: Validation does NOT find business logic errors or foreign key errors (such as specifying a 
negative billing price for an employee, using blocked activity, referencing non existing dimension, and 
so on). 

To perform a more in-depth validation and find errors described above, use the Simulate Import 
action. 

Note: Overwriting Files 

The existing import file is overwritten with the new file, meaning that the original import file is 
permanently replaced. If you need revision control or history tracing, store your files in a 
source code repository, such as Git repository. 
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repeated because on line 5671 there was a format error that could have been easily discovered by 
running a format validation. 

If a more in-depth validation of the package is required, use the Simulate Import action instead of or in 
addition to the validation.  

Simulate Import 
Use the Simulate Import action instead of or in addition to the validation. This action performs an actual 
import of the file; however, it will not save any changes in the system when simulation completes. 
Simulating an import can help uncover errors that could not be found by simple format validation. 

The Simulate Import action performs validation of only the current package line.  

 

Import Packages 
Use the Import action to import selected lines on the data import package. It imports the lines in the order 
they are defined in the subtab by moving sequentially through the line list.  

 
If the import fails, then the whole data import package execution terminates, and you must investigate the 
attached import log, which lists the reasons why the import failed.  

For example: 

Line 1  Completed 

Line 2  Failed 

Line 3 

Since the import of Line 2 failed, the whole execution stops, so Line 3 is not picked up for import. This is 
because Line 3 might depend on Line 2, and if Line 2 failed then there is a high chance that Line 3 will 
also fail. 

Similar to the validation flow, you can either edit the original file stored on your computer locally or 
download the currently attached import file, correct it, re-attach it to the line, and restart the import. The 
import resumes from the next line that was not imported. 

When a data import package line is successfully imported, you can no longer change it or any line above 
it. Instead of changing the imported package line, you can create a new one, listing all the changes you 
want to perform and then import that line. 

Files import sequentially, in the order the package lines are defined in the subtab. If you are confident that 
you have independent import data files, you can create multiple data import packages and run them in 
parallel. This might be useful when importing data for different companies in the system. Blocking is less 
likely to occur when resources like system numbers are not shared. 

Best Practice: Deltek recommends that import users have a good understanding of Maconomy before 
trying to import multiple packages at the same time. While importing multiple packages at the same time 
uses parallelism and thus makes importing faster, if different packages block each other, this efficiency 
will not be achieved. 

Note: This action does not update the validation status nor the validation log on the line. However, it 
does produce a validation log at the end, which is available for investigation. 

Note: It is not possible to make any changes to the lines that are marked for importing while the 
import is in progress. 
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Additionally, when importing a package, Deltek recommends that you configure email notifications. 
Notifications can quickly inform you of a failed import, so you can react more quickly. 

Save and Load Packages  
Use the Data Import Package workspace when import data needs to go through different test phases. For 
example, you can first import data to a test system and then import it on a pre-production system before 
importing it in the production system. 

To do so, first create the data import package on your test system. When you are done creating, 
validating, and importing the package, use the Save Package to File action to save it from your test 
system. This package can then be loaded into the pre-production system using the Load Package from 
File action. Since this package is already validated and imported on the test system, there is a high 
chance that it can also be successfully imported on the pre-production system.  

For example, you may go through these four systems/phases while making necessary adjustments to the 
import files along the way: 

 Phase 1: Create a new Package on Development system. Validate, import, and save it to file. 

 Phase 2: Load package file from Development system to Test system. Validate, make changes, 
import, and save it to file. 

 Phase 3: Load package file from Test system to Pre-Production system. Validate, make 
changes, import, and save it to file. 

 Phase 4: Load package file from Pre-Production system to Production system. Validate, make 
changes, import, and possibly purge. 

Save as Template 
Sometimes you might want to re-use the package structure for a new data import package. To do so, 
save the data import package in Skeleton Package Content format. This saves the underlying structure 
that defines the import programs and the order in which they should be imported. This saved structure 
can then be loaded into the new data import package. Instead of creating the import files manually, you 
have the option to load the package from an existing file package template instead.  

Purge Package 
The Purge Package action removes all the import data (import files and associated log files) from the 
system that are associated with this data import package. It does not automatically delete the data import 
package itself, however. Besides saving the package in Skeleton Package Content format, you are no 
longer able to make any changes to it. Note that after purging, the checksum information, as well as the 
import file names, sizes, and other information remain on the data import package for tracking purposes. 

Best Practice: The data import packages often contain sensitive data about users and employees. After 
the package has been successfully imported, it is best practice to run the Purge Package action.  

Purge after you have imported into your production system, and then purge from all the environments 
where you imported previously (such as Test and Development). Purge from each environment manually 
or schedule a background task to purge imported packages.  

Excel Data File Support 
Maconomy supports Excel format for direct upload to both Data Import Packages and Standard Import 
Programs. No configuration is needed, and this feature works for files with extension .xlsx. 
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This capability includes: 

 Works for all stand-alone Import programs and for Data Import Packages. 

 Excel files are supported (transformed to CSV-files internally). File must have extension .xslx. 

 All features of CSV import-files are supported in Excel import-files 

 All import keywords (such as #KEEP and #EMPTY) are supported as cell values. 

 Only the first Excel sheet is imported. Further sheets are ignored. 

 Each row in the Excel sheet is translated to a line in the CSV file. 

 Each cell in the Excel sheet is translated to a value (the content between two tabs) in the CSV file 

 Excel hidden lines in an Excel sheet are NOT imported but are considered comments. 

 Excel hidden columns are NOT imported but are considered comments. 

 Support for comment rows (rows which are not imported): Leave the first (visible) cell of a row 
empty. 

 Formatting (colors, fonts, borders and more) is supported but does not have any semantics 
during import. 

 Excel booleans are supported and will be converted to Maconomy booleans 

 Numbers (int, real, amount) can be entered in Excel format or as Excel text. 

 Date and time fields can be entered in Excel format and will be converted to Maconomy format for 
date and time. 

 If a String field cell contains data which Excel interprets as a Date, a Time, or a Date and Time, 
such Strings will also be converted to Maconomy representations of the same date and/or time. 
This is due to the Excel limitations. To prevent this, add a ping ( ' ) in front of the date/time to 
force Excel to interpret it as a text (and not a date/time). 

Data Import Packages Procedures  

Create Data Import Package 
You can create new data import packages via two methods: 

 From scratch: Use for first instance or if no current data import package exists. 

 From import file: Use when you have a package with many lines and you know which import 
programs you want to include in the package, and in what order. Additionally, you can choose to 
bulk attach import files to any number of package lines as you create the package. 

Prerequisite: Before you begin, you must extract data from your old system and build import files to 
import to Maconomy. This step is out of scope of this section. These instructions pertain only to creating a 
new data import package, and not creating the data.   

Create Package from Scratch 

To create a new data import package from scratch:  
1. In the Workspace Client, go to Setup » Data Import Packages. 

2. Click . 
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3. Complete the following fields on the wizard: 

 Name: Enter a name that is representative of the new Data Import Package (for example, 
London Office Vendor Invoices). This name must be unique per package. However, it can be 
changed after creation. 

 Description: Enter a brief description of the package that will be meaningful to you and 
others.  

 Access Level: Set the access level as needed.  

 Deletable: Select this checkbox to indicate that the package can be deleted after creation. 
 Email To: Enter the email address(es) which must receive notification of import package 

progress.  

 Email On: Select Validation Finished to send an email regarding validation to notify you if 
the validation is successful or not. Select Import Finished to send an email regarding the full 
import to notify you if the import is successful or not. You can select both options if needed.  

4. Add package lines in the Data subtab.  

5. Validate (or simulate validation) prior to import.  

Create Package from an Import File 

To create a package from a master import file: 
1. Manually create a Data Import Package import file.  

This import file can only contain these line types: 

 Format: Must contain the ImportProgram field 

 Create: With or without specifying the keyword create 

 Comment  
2. If you want to bulk attach the import files during creation, include the AttachImportFileName field 

in the import file.  

Example import file for the Import Data Package: 
DATAIMPORTPACKAGELINE:FORMAT IMPORTPROGRAM Responsible EmailTo 
 AttachImportFileName 

DATAIMPORTPACKAGELINE ImportSystemparameter User1 uone@company.com
 sysparametersstart.txt 

DATAIMPORTPACKAGELINE ImportJobParameters User2 utwo@company.com
 jobparametersdata.txt 

DATAIMPORTPACKAGELINE ImportExchangeRates User3 uthr@company.com
 exchangeratetables.txt 

DATAIMPORTPACKAGELINE:FORMAT IMPORTPROGRAM 

DATAIMPORTPACKAGELINE:create ImportJobParSelectionRules 

3. In Workspace Client, go to Setup » Data Import Packages.  

4. Click .  

5. Complete the following fields on the wizard: 

 Name :Enter a name that is representative of the new Data Import Package (for example, 
London Office Vendor Invoices). This name must be unique per package. However, it can be 
changed after creation. 
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 Description: Enter a brief description of the package that will be meaningful to you and 
others.  

 Access Level: Set the access level as needed.  

 Deletable: Select this checkbox to indicate that the package can be deleted after creation. 
 Email To: Enter the email address(es) which must receive notification of import package 

progress.  

 Email On: Select Validation Finished to send an email regarding validation to notify you if 
the validation is successful or not. Select Import Finished to send an email regarding the full 
import to notify you if the import is successful or not. You can select both options if needed.  

 Select the Import Package Lines checkbox. 

 
6. Click Next.  

Another wizard displays, where you can choose to attach files in a bulk action during the package 
creation. 

7. Select Attach Import Files to Package Lines and click Create.  

8. Select Import Package Lines, and click Next >.  

9. In the File Chooser, browse to and select the master import file created in step 1.  

10. If you opted to attach import files to the package lines, you are prompted with another File 
Chooser that you can use to select any number of files to attach, including zip files containing the 
import files you want to attach. 

If the import file is contained in a zip file, it is extracted and attached.  

The package is created with the package lines from the master import file. If you attach import 
files to package lines during creation, all package lines which have a file name specified in the 
AttachImportFileName field will get the file with that name attached as import file, if such a file is 
found among the files selected (or inside a zip file that was selected) in the File Chooser. 

For example, if you have an import file exchangeratetables.txt to attach to the package line with 
the import program ImportExchangeRateTables, then you put the value 
exchangeratetables.txt in the AttachImportFileName field on the line with the import program 
ImportExchangeRateTables. When you later select files to attach in the file chooser, you either 
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select the file exchangeratetables.txt directly, or you select a zip file that contains the file 
exchangeratetables.txt. In both cases, the file is attached to the package line.  

11. After the package is created, use the File Chooser that displays to save the log file to a folder you 
specify, and click Save. 

The log file contains a summary of the import and details of the bulk attachment operation.  

Load an Existing Data Import Package 

To load an existing Data import package from an .mip file: 
1. Go to Setup » Data Import Packages » Data Import Package tab. 

2. Click . 

3. Select which load package format to use, such as Full Package Content to include all the 
original lines and files.  

4. If needed, complete the additional fields: 

 Set Access Level: Add the access level needed for this import package file, if any. Use this 
field to override the access level in the import package you are trying to load or assign one if 
there is none on the package that is being loaded. 

 Load Email To Information from Package: Select this if you need to include the same 
email notification information. Clear the option if this information is not relevant to this 
company. 

 Clear Import As if user not present in system: Select this field to clear a user and allow 
yourself to load the import package.  

For example, a user specified on the Test system may not exist on the Pre-Production 
system, which would generate an error. To avoid this situation, either create the user on the 
Pre-Production system before loading or select this field. 

 Deletable: Select this checkbox to indicate that this import package can be deleted after its 
creation. If Deletable is not selected, the package can still be purged, but not deleted. 

5. Click Load.  

6. On the dialog box that displays, select the .mip file and click Open.  

Add Package Lines to a Data Import Package 
After a package is created or loaded, package lines can be added in the Data subtab. Add lines in three 
ways: 

 Load lines manually 

 Load lines from an existing package 

 Load lines from a Master Data Import Package Import file 

When addinglines by loading them from an existing package or an import file, they are placed after the 
last current line in the table, in the order they appear in the package or import file. 
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Add Lines Manually 

To add lines manually 
1. In Workspace Client, go to Setup » Data Import Packages » Data.  

2. Add table lines with: 

 Import Program: Select the Window Name of the existing Maconomy import program to 
include in this import (for example, Import Vendors).  

Add lines and select import programs to include in this import package as needed, taking 
care to add them in the order you wish to import them.  

For example, import Employees prior to Time Sheets, as Time Sheets has a dependency on 
Employees.  

 Attach Import File: Click in the field on each line to open a dialog box containing text files 
from the Import Program selected above, and select the related text file.  

For example, for the ImportEmployees Import Program line, select Employees.txt.  

 Import File: This field automatically populates with the txt file selected by the Attach Import 
File action for this line.  

Load Lines from an Existing Package 

To load lines from an existing package: 
1. In Workspace Client, go to Setup » Data Import Packages » Data. 

2. Select Load Lines. 

3. Select Load From Existing Package, and click Next. 
4. Select the Package Format to load, and click Load. 

5. In the File Chooser that displays, select the *.mip file to load lines from. 

Load Lines from a Data Package Import File 

To load lines from a data import package import file:  
1. In Workspace Client, go to Setup » Data Import Packages » Data.  

2. Select Load Lines. 

3. Select Load from Import File as the method to load package lines, and click Next.  
4. Select whether or not to attach import files to the lines as they are created.  

5. Click Create.  

6. In  File chooser will appear, select a master import files to import from.  

7. If you chose to bulk attach import files to the lines, you will immediately be prompted with another 
File chooser where you can select any number of files to attach. 

8. When prompted, save the log file that is generated to a location of your choice. 



Data Import Packages 

System Admin Guide 203 

 

Bulk Attach Import Files to Package Lines 
The bulk attachment action is available by itself in the table part of the workspace. If you have specified 
the name of the import file to attach on one or more package lines, you can use the Bulk Attach Import 
Files action to attach the files to those lines.  

To bulk attach import files to package lines: 
1. Go to Data Import Packages » Data subtab.  

2. Specify the name of an import file to attach on one or more package lines in the 
AttachImportFileName field.  

3. Click Bulk Attach Import Files to attach the files to those lines. 

4. Use the File Chooser that displays to select any number of files to attach 

5. When prompted, save the log file that is generated to a location of your choice. 

Validate Packages 

To validate the import lines: 
1. Go to Data Import Packages » Data subtab.  

2. Select the lines to validate.  

 To select lines one-by-one, select the Marked for Validation column for the line. 

 To select multiple lines at once, click the Mark/Unmark dropdown list, and select one of the 
following:  

 Mark All to select all lines 

 Mark to Here to select lines prior to the current line 

 Mark from Here to select lines after the current line 

 

3. Click . 

The activity and status lines automatically populate for all lines under validatation. Note also that 
the color updates to reflect the status. See the Legend for details.  

4. Review Validation Status: 

 Status of Passed (green font) is validated and ready for import. 

 Status of Failed (red font) has errors as must be corrected prior to validation or import.  
5. Identify and correct any errors in Failed lines.  

When all lines are in Passed status, the package is ready to import.  

Simulate Import 

To simulate the import: 
1. Go to Data Import Packages » Data subtab. 

Note: Selected lines display in bold font. 
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2. Select a line in the table with an import file attached to it. 

3. Expand the sliding panel on the right and click the Advanced tab. 

4. Click Simulate Import. 
After the simulation is complete, a text file displays a list of errors. 

Import Packages 

To import data package files: 
1. Go to Setup » Data Import Packages » Data Import Package tab.  

2. In the Mode island under Validation, click Switch to Import. 
The mode switches to Import. Import actions appear as does a Marked for Import column on the 
Data subtab. 

3. Select the lines to import.  

 To select lines one-by-one select the Marked for Import column for the line. 

 To select multiple lines at once, click the Mark/Unmark dropdown list, and select one of the 
following:  

 Mark All to select all lines 

 Mark to Here to select lines prior to the current line 

 Mark from Here to select lines after the current line 

 

4. Click . 

5. Complete the following fields on the wizard: 

 Import As (Default): The user specified in this field will be used for importing those package 
lines where an Import As user is not specified. 

 Import All Lines Using Default User: Select this field to import all lines as the user specified 
in the Import As (Default) field regardless of whether there is a user specified in the Import 
As field on the package line or not. 

 
Additionally, the Import All Lines Using Default User functionality overrides if there is a 
user specified in the Import As field in the subtab or if a user is specified as a default 
background task user.  

 Due Date: You can schedule a validation/import date in the future. For example, you may 
want the import to start on 14 September, which is a Saturday when there are no users on 
the system.  

 Due Time: You can schedule a validation/import time for the date chosen above. For 
example, you can set the import starting on Saturday to begin at 8 a.m. 

Note: Selected lines display in blue bold font. 

Note: If there is no user specified, then the default background task user is used if there is 
no user specified in the Import As field on the package line AND there is no user specified 
in the Import As (Default) field on the package. 
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6. Click Import Package.  

The activity and status lines automatically populate for all lines to import. Note also that the color 
updates to reflect the status. See the Legend for details. 

7. If any lines fail, correct the errors; otherwise, the Status for the data import package updates to 
indicate Imported.  

8. If you intend to use this package again, you can use the Save Package to File action to create 
an import package template.  

Correct Errors 
Maconomy stops the import at the point of a failed line, due to line dependencies. Failed lines are 
indicated by red font, red highlight, and the Validation Status of Failed. To resolve errors, review the 
Validation Log or Import Log, depending on the mode you are in.  

To correct errors: 
1. Go to Setup » Data Import Packages » Data Import Package tab.  

2. In the Validation Log or Import Log (depending on which mode you are in), click View for the 
Failed line.  

A text log file opens, flagging the error lines.  

3. Identify the errors and investigate as needed.  

4. On your local drive, open the related text file, and make the necessary corrections.  

5. Save the file.  

6. Reattach the file to the import line by clicking the Attach Import File field on each line to select 
the related text file.  

The Import File field automatically populates with the txt file selected by the Attach Import File 
action for this line.  

7. Proceed with the Import or Validation.  

 

Purge Packages 
This action deletes all the import files related to this package, as well as any validation and import logs, 
and locks the package from further use.  

To purge an import package: 
1. Go to Setup » Data Import Packages » Data Import Package tab. 

2. Select the package in the filter List of Data Import Packages.  

3. In the Data Import Package tab, click . 

The Mode updates to Purged, and the fields become locked.  

Note: The logs are retained for future reference if needed, though they are now labeled “Outdated.” 
They are overwritten with a new log when you re-validate the line. 
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Alternatively, you can delete the package if the Deletable checkbox is selected in the Advanced assistant 
on the tab.  

1. If you have proper permission (via Make Packages Deletable), go to the Advanced assistant on 
the tab and ensure the Deletable field is selected.  

2. Click Delete.  

Create an Import Template File 
If this is an import setup that you will have to run again at numerous company sites, you can save the 
Maconomy Import Package File to a single file for reuse. This action archives all the files in the package 
into a single file.  

 

To create an import template package file:  
1. Go to Setup » Data Import Packages » Data Import Package tab.  

2. Click . 

3. In the dialog box that displays, save the file in one of the following formats: 

 Full Package Content: Select this format to include all the information that is included in the 
import package, including all the information in the Data Import Package tab and Data 
subtab.  

 Template Package Content: Select this format to reuse format lines in the import file, which 
define the columns to specify in the import file and load without loading the actual data. This 
allows you to reuse the template file without reusing the data itself. It includes Import Files 
(.txt files) but the text files contain no data. 

 Skeleton Package Content: Select this format to reuse only the structure of the files. This 
setup contains no import files, and only includes the lines that define the import programs to 
use as well as the structure to use. With this format, users can attach their own import files. 

4. Click .  

5. On the dialog box that displays, confirm or update the name of the package.  

6. Click Save to save on your local drive.  

Setup Instructions 

To enable this feature: 
1. Go to System Setup » Parameters and Numbers » System Parameters.  

2. Double-click the Use Internal Names in Import Dialogs parameter (see description below).  

3. On the System Parameter subtab, select the Use Internal Names in Import Dialogs checkbox.  

4. Click Save. 

Note: The Remarks field remains editable after purging so that you can add any notes or 
details as needed. 

Note: Template files have the extension .mip (Maconomy Import Package). 
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Install/Upgrade Considerations 
The Use Internal Names in Import Dialogs system parameter is enabled after the upgrade, so the 
Internal Names field is also selected in all the import dialog boxes.  

System Parameter for Import Programs 
The Use Internal Names in Import Dialogs system parameter enables Maconomy to automatically 
include internal names in import criteria as a default setting when you open any import dialog box. This 
system parameter is enabled by default, but it can be disabled in the System Setup. 

 
Attention: For solutions to common issues, refer to Data Imports Packages Troubleshooting. 
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Standard Import Programs Overview 

 
This section describes the use of import programs for Maconomy 2.0+. This section describes the central 
concepts involved in the import process and explains the possibilities offered by import programs. In 
addition, this section sets up a number of examples for the practical use of import programs. The concept 
definitions and examples are described on a general level.  

Please note that the functionality described in this section only applies to those Maconomy import 
programs that are generated according to the Standard Import Format. Maconomy’s product range also 
includes several import programs with functionality that is not covered in this section.  

How to Read This Section 
This section consists of two parts. The first part describes the standard functionality of Maconomy import 
programs, including technical details, data allowed in an import file, and a list of concepts related to data 
import. The first part thus acts as a technical handbook describing the exact functionality and explaining 
how import programs interpret different information. 

The second part is a guide to creating your own import files for different purposes and to using the tools 
available in the import programs in practice. The second part describes the workflow of setting up an 
import file and contains step by step lists which you can follow when setting up your import file. 

After you have read this section, you can apply the general functionality described to any Maconomy 
standard import program.  

Getting Started 
This section briefly describes how to get started working with import programs. More detailed 
explanations are given in subsequent sections.  

Specific import file manuals consist of lists of line types available in the program. Each line type includes 
a list of available fields. 

To work with a specific import program, you must: 

 Activate Help. This action produces a file that lists the available line types. 
 Activate printformat. This action produces the fields for the corresponding line types. 
 Create the import data file. Data files consist of lines with a command followed by data. 

Activate Help 
Select the Help field to produce a list of the line types available in the program. When you activate Help, 
no import is made. Instead, Maconomy creates a file with the line types available in the specified 
program. The line type names in the help file are the external or internal names, depending on whether or 
not you selected the Internal Names field (as described later in this document). The file is automatically 
placed in your home folder, and the name of the import program is used as the file name, with a .txt 
extension.  

Note: While the Standard Import Programs continue to function as always, new Data Import 
Packages functionality streamlines the import process. 



Standard Import Programs Overview 

System Admin Guide 209 

 

 

To activate Help: 
1. Select Menu » Programs, and then select the appropriate import program.  

The import program window displays. 

 
2. Select the Internal Names checkbox, or leave it blank to use external names. 

3. Select the Help checkbox, and click Start. 
This creates a file in your home folder (for example, C:\Users\<UserName>). 

Activate PrintFormat 
Activate PrintFormat to produce a list of available fields for the corresponding line types. When a 
printformat line is processed during import, Maconomy creates a line in the log file with the names of 
corresponding fields. For example, if you import general journals, creating a line with the line type 
JOURNAL:PRINTFORMAT, the log file displays a line with the fields that are available for lines of the type 
JOURNAL:FORMAT. 

 

To activate PrintFormat: 
1. Open the help file as described in the preceding section.  

2. Remove all lines except those including the word PRINTFORMAT (for example, 
Journal:PRINTFORMAT) and save in a new file. 

3. Select Menu » Programs, and then select the appropriate import program.  

The import program window displays. 

4. In the Input File field, enter the name and folder of the file for which you want to print format.  

If you leave the field blank, you can select an input file after clicking Start. 
5. Enter the path to an Output File.  

Note: For more information about the use of each line type, see the “Line Types” section in this 
manual and the description of the individual line types in the program-specific manual. 

Note: A PrintFormat line is a line that only results in a line in the log file. No data in Maconomy is 
affected by a PrintFormat line, and the line only consists of the line type field. Any other information 
on the line is ignored. 
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If you leave the field blank, the log file is placed in your home folder. The name will be that of the 
import program with the date appended. 

6. Select the Internal Names checkbox, or leave it blank to use external names. 

7. Click Start. 

Create Data File 
Import data files are tab-separated files consisting of lines with a command (line type) in the first field. For 
some commands, additional data is provided in the fields that follow the command. The file used to print 
format lines in the preceding section is an import file with PrintFormat commands. 

A typical import file could look like this: 

 
The first two format lines identify which fields are used for importing. This sample shows SALES 
ORDERS and ORDER LINE, respectively. Next, data is provided for a sales order and several order lines 
according to the format specified in the FORMAT lines. 

Save the import data file and import it using the same steps as in the previous section. 

Reference Section 

General Information on Standard Maconomy Import Programs 
The functionality of Maconomy import programs follows a standard guideline, meaning that the programs 
used for importing different types of information generally work in a similar way. The import programs all 
offer standard functionality, which is explained in the “Standard Line Types” Section. Standard 
functionality is defined as functionality that performs similar actions and is used in a similar way, 
regardless of the program. For example, all standard import programs (with a few exceptions) can delete 
entries, and the method for deleting entries is the same for all import programs.  

 
In addition to the standard functionality, some import programs offer a number of functions specific to the 
program in question. For example, the Import Orders program allows the approval of sales orders, which 
is a function that is only relevant when working with sales orders. The functions that are specific to each 
program are described in the manual for the program in question. However, before reading about both the 
general functionality and the program-specific functionality, it is important that you understand the 
concepts defined in the “Central Concepts in Import Programs” section because the remaining sections in 
this manual contain several references to these concepts. 

Using the Program 
This section describes how import programs are used. 

Attention: For a definition of the concept of entries, refer to the “Central Concepts in Import 
Programs” section. 
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Running Import Programs Manually 
You start the import program by selecting the Programs… option in the Menu menu, and then selecting 
the appropriate import program. When you select the import program, Maconomy displays a window like 
the one in the following figure, where you can select the import file to use and specify a name and folder 
for the log file that is created as a result of the import. The log file contains information about the results of 
the import as well as any errors that occur in the import file. 

 
In the Input File field, you can enter the name and folder of the import file on the server. You should 
always specify the full path of the file, including the name of the folder in which the file is located. If you 
did not select Print on Server in the File menu, if you do not enter a file name, or if the specified file does 
not exist on the server, Maconomy displays a dialog box where you can select the appropriate file. In the 
Logging field, you can enter the name and folder for the log file. If you do not provide a value for this 
field, Maconomy places the log file in the Maconomy folder, using the name of the import program 
followed by today’s date as the file name. 

Start the import by clicking Start. The dialog box remains open. If the import fails (for example, as a result 
of importing a pop-up value that does not exist in Maconomy), you only need to edit the import file and 
click Start to make another attempt. 

In several Maconomy’s import programs, the window also contains the Internal Names, Progress Bar, 
Logging, Echo, and Help fields. The functionalities of these fields are described in the following sections. 

Internal Names 
This checkbox determines whether the import file should contain internal or external field and line type 
names. Select this checkbox if the import file contains internal names, or leave this checkbox blank if the 
import file contains external names.  

The internal names are the names that the fields and actions have in Maconomy’s relations, meaning that 
they do not change from one version to another. When you use internal names, the field names on format 
lines should be the internal names from the field lists, and line type names should be those specified as 
internal in the list of available line types.  

 

Progress Bar 
Select this checkbox to specify whether or not Maconomy is to display a window during the import. This 
window displays the number of lines imported, the number of errors encountered, and so on. 

Attention: For more information about the concept of format lines, refer to the “Format Lines” section 
The concept of line types is described in the "Line Types" Section. 
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Logging 
Select this checkbox to specify whether or not Maconomy is to continue processing the lines in the import 
file after encountering an error. If you select this checkbox, any errors in the import file are reported in the 
log file, and Maconomy continues processing the import file to see if there are other errors. If you do not 
select this checkbox, Maconomy stops the import when the first error occurs, and the error message is 
shown on the screen.  

When an error is encountered, none of the information that was read since the last save point found in the 
import file is imported. Therefore, if you want to use the save point functionality, you should select this 
checkbox; otherwise, the import will stop when it encounters an error. Because one of the purposes of 
using save points is to import all of the correct sections of the import file and to have all erroneous 
sections written to the log file, you should select checkbox to ensure that the import continues after 
encountering errors. 

Echo 
Select this checkbox to specify whether or the log file is to show what information was created and 
changed as a result of the current import. If you select this checkbox, each imported data line results in a 
line in the log file, showing the information that was imported to the fields in the format. 

Help 
If you select this checkbox, no import is performed. Instead, Maconomy creates a file with the line type 
names that are available in the program in question. The line type names in the help file are the external 
or internal names, depending on if you selected the Internal Names field. The file is automatically placed 
in the Maconomy folder, and the name of the import program is used as the file name. The file gets the 
extension ".txt."  

 

Running Imports from Command Lines 
You can run the import program by calling it from a command line in a Unix or Windows NT system. 
When doing so, the import processes as normal, but you must specify the name and location of the 
import file to be used. You can also specify values for all the fields in the import dialog box described in 
the “Running Import Programs Manually” section. To type command lines, you must have of command-
line syntax and the structure of your Maconomy installation. Understanding the following description 
therefore also requires basic knowledge in these areas. 

When running import programs from command lines, you must first log in as the Maconomy user. The 
import program must be located on the server. This means that on Unix systems, the file must be 
transferred through binary copy from the installation CD; whereas on Windows NT systems, it can simply 
be copied from the installation CD to the server. 

Command lines that execute import programs are similar on Unix and Windows NT systems. The syntax 
for a command line to run an import program is as follows, where the information in brackets represents 
certain specific information that depends on your Maconomy installation: 
[Maconomy Server Program] -S[Shortname] -x[Import Program] 

The [Maconomy Server Program] is the location and name of the Maconomy server program. The -S 
indicates that a shortname is specified next, and the [Shortname] contains the shortname of the 
Maconomy database on which the import should be run. The -x tells the Maconomy server to execute the 

Attention: For more information about the use of each line type, refer to the “Line Types” section in 
this manual and the description of the individual line types in the program-specific manual. 
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program that is specified next. The [Import Program] is the location and file name of the import program. 
The path and file name should be specified in quotes.  

You can leave out the -S[Shortname] on the command line. If you do so, Maconomy prompts you for the 
shortname when the command line is executed. If you do not know the location of the Maconomy server 
program and the shortname, consult your Maconomy system administrator. The following is an example 
of a command line, in Unix and Windows NT respectively, which executes an import program for expense 
sheets in version 5.0. 

 Unix 
macoracle.r.us_5_0 -Sus501 -x"Import ExpSheets 5.0.prm" 

 Windows NT 
maconomyserver -imaconomyserver.us_5_0 -Sus501 -x"Import ExpSheets 5.0.prm" 

This command activates the Maconomy server program and tells it to execute the Import ExpSheets 
5.0.prm program on the database whose shortname is us501. Because no path is specified for the import 
program, Maconomy assumes that the program is located in the current folder. 

When the command line is executed (and, if you did not include it in the command line, you have 
specified a short name), Maconomy prompts you for any parameters to be changed in this import. The 
parameters correspond to the fields in the import dialog box shown when the import program is activated 
manually, as described in the “Running Import Programs Manually” section. The parameters and their use 
are listed in the “Parameters” section because this section only describes how to specify the parameters. 

In the prompt, you can specify the name of a parameter and press RETURN. You are then prompted for a 
parameter value. 

You can also enter $ for a complete list of the available parameters and their current settings. 

The following example shows a prompt for parameter values and the specification of a parameter name 
and value. In this case, the parameter is INFILENAME, which is a parameter used to identify the location 
and name of the import file to be used. 
Variable to change ($ to list all, <return> to continue, $$ to 
exit)INFILENAMEVARINFILENAMEVAR : STRING = 

, newvalue :Impfile.data 

The first line is the prompt that is issued by the system. The second line is the parameter name specified 
by the user. On the third line, the first part is the prompt, and the text emphasized in bold is the parameter 
value (file name) specified by the user. 

When you have specified all the appropriate parameter values, press RETURN when prompted for a new 
parameter, and the import is performed. 

Parameters 
When you run import programs from command lines, the fields in the import dialog box are referred to as 
parameters to which you assign a value for each import. 

Parameters are specified through parameter names and parameter values. The parameter name 
indicates the parameter for which you want to specify a value, and the parameter value indicates the 
value to be applied to the parameter in question. For example, the parameter name could be 
InFileNameVar, and the parameter value could be \Imports\Import Expense Sheets.txt. In this case, 
the parameter name indicates that the import file is now going to be specified, while the parameter value 
is the actual location and name of the import file. This corresponds to entering a file name in the Inputfile 
field in the import dialog box when running an import manually. 

Each parameter has a default value that is used if no other parameter value is specified. 
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The following table contains the names of the parameters that can be used, and what they are used for. 
The table also indicates which values are allowed, and what the default value of each parameter is. 

Parameter Name Functionality Default Value 

InFileNameVar Corresponds to the Inputfile field in the import 
dialog box, as described in “Running Import 
Programs Manually.”  

Specify the name and location of the import file. It 
is mandatory to specify an input file. If you run the 
import from a command line, and you do not 
specify an input file (or if the specified input file 
does not exist), you are prompted for an input file. 

Blank 

OutFileNameVar Corresponds to the Output Data File field in the 
import dialog box, as described in "Running 
Import Programs Manually.”  

Specify the name and location of where to place 
the log file. 

Blank 

UseInternalNamesVar Corresponds to the Internal Names field in the 
import dialog box, as described in "Running 
Import Programs Manually." 

The value 1 corresponds to the Internal Names 
field being selected in the import dialog box. The 
value 0 corresponds to the field not being selected 
in the import dialog box. 

0 (false) 

UseProgressBarVar Corresponds to the Progress Bar field in the 
import dialog box, as described in "Running 
Import Programs Manually"  

The value 1 corresponds to the Progress field 
being selected in the import dialog box. The value 
0 corresponds to the field not being selected in the 
import dialog box. 

1 (true) 

LoggingVar Corresponds to the Logging field in the import 
dialog box, as described in "Running Import 
Programs Manually."  

The value 1 corresponds to the Logging field 
being selected in the import dialog box. The value 
0 corresponds to the field not being selected in the 
import dialog box. 

1 (true) 

EchoVar Corresponds to the Echo field in the import dialog 
box, as described in "Running Import Programs 
Manually."  

The value 1 corresponds to the Echo field being 
selected in the import dialog box. The value 0 

0 (false) 
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Parameter Name Functionality Default Value 
corresponds to the field not being selected in the 
import dialog box. 

PrintHelpVar Corresponds to the Help field in the import dialog 
box, as described in "Running Import Programs 
Manually."  

The value 1 corresponds to the Help field being 
selected in the import dialog box. The value 0 
corresponds to the field not being selected in the 
import dialog box. 

0 (false) 

BatchRunVar With this parameter, you can specify whether or 
Maconomy should issue a message when the 
import is complete. Set this parameter to 1 if a 
script should perform additional commands after 
the import because the script will otherwise be 
halted until you click the OK button in the 
message box. 

0 (false) 

APIInFileNameVar This is a special parameter type. In addition to 
corresponding to the Inputfile field in the import 
dialog box, as described in "Running Import 
Programs Manually," the use of this parameter 
indicates given values for the other parameters 
that can be used. 

When you have specified this parameter name, 
the other parameters for the program are 
automatically assigned the following values: 

 UseInternalNamesVar: true 
UseProgressBarVar:= false 

 LoggingVar: false 

 EchoVar: true BatchRunVar: true 

As the parameter value for this parameter, specify 
the name and location of the import file. It is 
mandatory to specify an input file. 

When you have used this parameter, you cannot 
use the OutFileNameVar parameter. Instead, you 
must use the APIOutFile-NameVar parameter to 
specify a log file location. 

Blank 

APIOutFileNameVar This parameter type is only allowed when the 
input file name was specified using the 
APIInFileName parameter. In those cases, you 
must use this parameter to specify a location and 
name for the log file. 

Blank 
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Using Parameter Files in Command Lines 

Instead of specifying the relevant parameters one by one as described in the “Running Imports from 
Command Lines” section, you can create a parameter file that includes all of the parameters to be used. 
A parameter file is simply a text file with the specification of parameters and values to be used in an 
import. When you use a parameter file, you do not need to manually specify anything after the command 
line is run. This allows you to run imports in batches where a standard set of parameter values are used 
in a completely automatic procedure. 

The syntax used for identifying a parameter file corresponds to the one used when specifying the 
parameters manually, one by one, but you add the location and name of the parameter file as an attribute 
to the file name of the import program. Thus, the command line should look as follows: 
[Maconomy Server Program] -S[Shortname] -x[Import Program] 

   <[Parameter File] 

Note that a < must be specified before the path to the parameter file. The following is an example of a 
command line that executes an import program for expense sheets, using the parameter values specified 
in the Import.parms file. 
macoracle.r.us_5_0 -Sus501 -x"Import ExpSheets 5.0.prm" 

  <"Import.parms" 

The parameter file must also comply with a number of syntax rules that are described in the following. 

If the command line does not include the shortname, the parameter file must begin with a line with the 
shortname. However, if the shortname is included in the command line, only the following information 
should be included in the parameter file. 

For each parameter for which you want to specify a value, create a separate line on which you specify the 
name of the parameter followed by a = and the value to be assigned. After the last parameter, insert a 
blank line to indicate that no more parameters are to be specified, and the import should continue. 

The following is an example of the lines in a parameter file. It is assumed that the shortname was 
specified on the command line: 
InFileNameVar= "ExpenseSheets.data"  

OutFileNameVar="ExpenseSheets.log"  

BatchRun=1 

<Blank line> 

Central Concepts in Import Programs 
This section contains the definitions forseveral concepts used in this manual. Since this manual contains 
references to these concepts, and it is important that you understand the concepts before you read the 
rest of the manual. 

Import File 
The import file is the file that contains the information to be imported. Each import requires the input from 
one import file. The import file must be a standard tab-separated text file. The recommended way of 
working with an import file is by using a spreadsheet because a spreadsheet program provides an 
effective overview of the lines and fields in the file. A spreadsheet also offers a number of editing tools 
that make it easier to change and move information in the file. However, you should be aware of the auto-
correct features of certain spreadsheet programs because some information may be auto-corrected ( for 
example, vital spaces between figures and %-characters are removed) resulting in an error. After you 
have completed the import file, save it as a tab-separated text file. 
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Depending on whether you are importing data from a Macintosh client or a Windows client, the following 
rules apply to the file format of the import file: 

If the import is performed from a Macintosh client, the import file must be a standard tab-separated file in 
the Macintosh extended ASCII characters. The entries are separated by cr (carriage return). The ASCII 
values for cr and tab are 13 and 9, respectively. 

If the import is performed from a Windows client, the import file must be a standard tab-separated file in 
Windows characters. Line shift in a Windows text file is represented by cr (carriage return) and nl (new 
line), which have the ASCII values 13 and 10, respectively. The ASCII value for tab is 9. 

Import Lines 
An import line is simply a line in an import file. In a spreadsheet, an import line corresponds to a row. 

Entries 
An entry is a record in a relation in Maconomy’s database. For example, a job shown in the Jobs 
workspace is an entry in the Jobs relation in Maconomy’s database. A tab in a workspace in Maconomy 
shows one entry at a time while the subtab of the workspace shows an entry on each line. The following 
is an example of data in the customer relation in Maconomy. The header row contains the names of the 
fields that make up the relation, and each of the remaining rows represents an entry in the relation. 

Customer No. Name 1 Name 2 … Changed by 

10995 Hugo Rune 324 Ealing Road  Administrator 

10997  Colin Danbury 110 Johnson Avenue  Administrator 

10998 Legalease 28-33 Cato Street  Administrator 

Line Types 
Each import line is of a certain type. You specify the line type in the first field (column A) of each import 
line. The line type specifies the contents of the import line. For example, the line type can specify that the 
line in question contains information to create/update an entry, or that the line should perform a given 
action from the Action menu in Maconomy. 

Line types 

 
Although the line types that are available in each program vary, several the line types work in a similar 
way, meaning that the functionality of the line types is the same, but the lines affect different types of 
entry. For example, all standard import programs (with very few exceptions) contain a line type for 
deleting entries. These line types work in exactly the same way, but they are named differently according 
to the type of entry to be deleted. For example, ITEM:DELETE is available in the Import Items program, 
and SALES ORDERS:DELETE is available in the Import Orders program. Line types whose functionality 
is common to all programs are called standard line types. The general functionality of each standard line 
type is described in detail in the “Standard Line Types” section, and each program-specific manual 
contains a list of the line types that are available in the program in question. You can thus check the 
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available line types in the manual for any import program and read about their functionality in the 
“Standard Line Types” section ofthis manual. 

Each line type pertains to a given relation in the Maconomy database, meaning that the information that is 
imported is not necessarily limited to one Maconomy window. For example, in the Import Purchase 
Orders program, you can use the line type PURCHASEORDERLINE, which specifies that the import line 
contains information to be imported to the Maconomy PurchaseOrderLine relation. This relation contains 
information about both the number ordered on a purchase order line and the number received. Therefore, 
data on lines of this type can be related to both the subtab of the Purchase Orders workspace and the 
Item Receipt workspace. 

Keys and Key Fields 
A key field is a field that is part of the key to a given entry in Maconomy’s database. A key consists of one 
or several key fields whose combined values identify a given entry in Maconomy’s database. No two keys 
in a database relation can be identical. Therefore, when you need to identify a given entry, such as an 
item or an order, you do it by specifying the key. For example, the key to a sales order is the order 
number, and no two sales orders can have the same number. If you want to update a sales order using 
an import program, you therefore identify the order to be updated by specifying the order number of the 
order in question. 

Of course, when an entry is created, it must be assigned key values to make it unique. This is sometimes 
done manually or sometimes automatically by Maconomy, depending on the setup of your system and 
the workspace into which information is being imported. For example, when you create a requisition, you 
can only specify the requisition number manually if the Manual Requisition Numbers system parameter 
is selected. If this parameter is not selected, you must let Maconomy assign a number to new requisitions. 
You let Maconomy assign a value to a field by entering #KEEP in the field in question.  

 
The key fields are specific to each Maconomy database relation. Please refer to MDoc for information 
about key fields for each relation. Some relations have several alternative sets of key fields. In that case, 
the available sets of key fields are listed in the help for the import program. To select a set different from 
the primary key, use a KEYFIELDS line from the help. 

Keys in Table Parts 
The key in relations that represent lines in the subtab of a given workspace (for example, order lines or 
inventory change lines) consists of the key to the tab to which the line is assigned as well as a line 
number that represents the location of the line in the subtab. In a few cases, the line number is not part of 
the key. Instead, another type of value is used in the key. For example, the key to a line in the subtab of 
the Item Information Card workspace consists of an item number and a warehouse because a given 
warehouse can only be represented on one line for each item. 

States 
Imported data is processed in the same way as manually entered data. As in Maconomy, there are two 
states for data entry: Creating and Updating. Creating is the state of an entry being created, meaning that 
certain fields can/must be completed while others are closed for data entry. 

In Maconomy, an entry is in the Creating state from the time when you create an entry by using the Index 
menu, š+N/CTRL+N or activating a new subtab line, until you press ENTER. 

Updating is the state that an entry has after being created. In Maconomy, an entry is in the Updating state 
when you have pressed ENTER after creating an entry or when you are editing an existing entry. For 
example, in the Updating state of an item, you cannot change the item number nor several other fields. 

Attention: For more information about standard values, refer to the “The #KEEP Command” Section. 
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Each field can be either open or closed in each of the two states. Open means that a value can be 
entered while closed means that you cannot enter or change the value in the field. 

It is possible for a field to be closed in both states. For example, the fields in the User island are always 
closed. When you import information, Maconomy allows values in fields that are closed both in the 
Creating and Updating states. These fields are ignored during the import, but can be included in the 
format, thus allowing you to export data from Maconomy, edit the information, and reimport it without 
having to remove the columns containing closed fields. 

In the field lists from the format lines in the help output, the Open column displays the states in which the 
individual fields are open. Open in the Creating state is marked with a C while open in the Updating state 
is marked with a U. Open in both states is marked with a checkmark, Ð while the column shows a ÷ for 
the fields that are closed in both the Creating and Updating states. In most cases, you can also find out if 
a field is open or closed in each state by creating an entry in the window in question and observing which 
fields are open before and after you press ENTER. 

Mandatory Fields 
In the states where a field is open, the field can be either mandatory or optional. Refer to MDoc for 
information on which fields are mandatory and whether the field is open for input when creating and/or 
changing records. Mandatory when open means that if a field is, for example, mandatory but only open in 
the Creating state, the rules for data in mandatory fields only apply when entries are created, while the 
contents of the field are ignored in the Updating state where the field is closed. The rules for data in 
mandatory fields are as follows: 

 Mandatory means that fields of the types String, Date, Time, and Popup cannot be blank while 
Integer, Real, and Amount fields cannot be zero. Thus, the import file must not contain these 
values in mandatory fields. Fields that are mandatory and open in the Creating state must be 
included in the format when creating entries. In the Updating state, mandatory fields that are not 
included in the format keep their existing values. 

 Mandatory does not always mean that you must manually enter a value. In some cases, you can 
let Maconomy assign the standard value or keep the existing value by specifying the value 
#KEEP in the field in question. Whether a value must be entered manually or not depends on the 
exact functionality of the window into which you are importing information. It is therefore not 
possible to define a set of rules that apply to all mandatory fields. However, as a rule, you can 
avoid many problems by always including mandatory fields in the format and always completing 
these fields. 

Standard Import Functionality 
This section describes the features available in import programs, and how to use them. 

Information Processing 
This section describes how information is processed by the import program. Part of the standard 
functionality of import programs is the fact that all information that is imported is treated as if it were 
entered manually in a Maconomy window. This means, for example, that the type of information (dates, 
text, amounts, and so on) in a given field that is imported must comply with the type of information 
allowed in the corresponding field in Maconomy.  

In addition, the rules regarding valid data in Maconomy also apply to import programs, meaning that any 
pop-up values, customers, or items specified in an imported field must exist in Maconomy. In some cases, 
a given field may only contain a value if several conditions are met. For example, in the General Journal 
workspace, you can only enter a value in the Vendor Inv. No. field if the GRP field contains the value P, 
and you have stated a vendor number. This type of condition also applies to imported data. It is therefore 
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important to know the exact functionality of the window or windows into which you are importing 
information before you set up your import file. 

 

Data Commitment to Database and Errors During Import 
When you import information, the entire import is performed as one database transaction. Consequently, 
an error in any single line, such as a pop-up value that is not recognized by Maconomy, means that none 
of the information in the import file is imported. If the import contains errors, you can find the error 
messages in the log file created by the import program. 

However, most import programs allow you to insert “save points” in the import file. Each time a save point 
is reached without encountering errors, Maconomy writes the information imported since the last save 
point to the database. If errors are encountered between two save points (or between the beginning of the 
file and the first save point or the last save point and the end of the file), the information in that section is 
rolled back (cancelled), meaning that the data in that section is not imported. Instead, all the import lines 
between the two points are written to the log file. After the import is completed, all data in successfully 
imported sections thus has been saved in the database, while the log file contains all the erroneous 
sections, allowing you to copy those sections to a new import file, correct the data that caused the errors, 
and run a new import with the corrected lines. Please note that this functionality requires that the Logging 
field is selected in the import dialog box (see the description of the Logging field) because the import is 
otherwise stopped the first time that an error is encountered. Hhowever, data saved by means of save 
points before the error is encountered is, of course, saved in the database. 

To insert a save point, create a line at the relevant point in the import file and enter Save Data in the first 
field if external names are used in the import or Commit if internal names are used. 

The following figure provides an example. 

 
Inserting frequent save points increases the performance of the import program because the program 
does not have to manage a large amount of data at a time. In addition, time is saved because correct 
import data does not have to be reimported due to errors that occur later in the import file. 

Save points should only be inserted after whole sections of related import data (for example, after all of 
the lines that pertain to a given sales order), not after each line. Consider a case where you want to run 
an import that creates several sales orders, each of which contains a number of order lines. If you place a 
save point after each line and an error occurs on one of the lines with order line information, the 
erroneous line is written to the log file while the remaining information is successfully written to the 
database. However, the line that is written to the log file now stands out of context, and you may be 
unable to tell which order the line belongs to. 

It should be noted that using save points slightly increases the risk of database deadlock because the 
relations that are used in the import are unlocked each time date is committed. This makes it possible for 

Attention: For more information about the exact functionality of Maconomy fields and windows, refer 
to the Maconomy Reference Manual. 
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other import programs that run at the same time to lock those relations, thus preventing the import from 
continuing. 

As mentioned, this functionality is available in most standard import programs from Maconomy. To find 
out if the functionality is available in a given program, use the Help field in the import program dialog box, 
and see if the help file contains a line with the text Save Data or Commit, depending on your choice of 
external or internal names. 

Field Types 
This section contains a description of the values allowed in the different types of fields in the import file. 
Each field is of a certain type that defines the values that are allowed in the field in question. For example, 
some fields can contain text while others can only contain figures. In your import file, it is therefore 
important that the contents of each field are in compliance with the field type of the field in question. See 
MDoc for information on the type of each field. The field types are described in the following table. 

Type Example Description 

String Leather Couch This field type is used for text strings. The field can 
contain a maximum of 255 characters, and both letters, 
figures, and special characters can be used. 

Integer 999 This field type can only contain figures. No decimals 
are allowed. A blank value that is imported results in 
the number 0. 

Real 999,999 This field type can only contain figures. The field type 
allows decimals, and the comma is used as the 
separator (for example, 372,1).  

The maximum number of decimals that is allowed is 
the same as the chosen number of decimals in the 
Preferences workspace (in the Edit menu) in 
Maconomy. If you import a real figure that has fewer 
decimals than what is set up in the Preferences 
workspace (or none at all), Maconomy adds the 
remaining decimals automatically. A blank value that is 
imported results in the number 0,00 (and the relevant 
number of decimals). 

Amount  99,99 This field type is used for amounts. The comma is used 
as the separator between the main monetary unit and 
the secondary monetary unit. A maximum of two 
decimals is allowed (for example, 125,00). A blank 
value that is imported results in the amount of 0,00. 

Date 07.01.02 This field type is used for dates.It follows the format 
day, month, year with a dot used as the separator 
between each (for example, 07.01.99). A blank value 
that is imported results in a blank field in Maconomy. 

Time 13:45:00 This field type is used for time. The colon is used as 
the separator (for example, 13:45:00). No blanks are 
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Type Example Description 
allowed before or after the value. A blank value that is 
imported results in a blank field in Maconomy. 

Checkbox 1 This field type represents checkboxes in Maconomy. 
The values allowed are 0 and 1. 0 stands for an 
unselected checkbox while 1 stands for a selected 
checkbox. A blank value that is imported results in an 
unselected checkbox. 

Popup sssss This field type is used for options in pop-up fields. You 
specify a pop-up value by the name of the option, and 
the option must already exist in Maconomy. A blank 
value that is imported means that no option is selected 
in the pop-up field. Note that a blank value is only 
allowed if the pop-up field can be left blank in 
Maconomy. 

Standard Line Types 
This section describes the standard line types in Maconomy import programs. Because the standard line 
types function in a similar way in all import programs, the standard line types are described on a general 
level. Several import programs allow you to choose between the use of internal or external names. The 
internal names are the names that are used in Maconomy’s relations while the external names 
correspond to the field headers and action names in the Maconomy windows. In the program-specific 
manuals for the programs where this feature is available, the list of available line types shows both the 
external and internal names of each line type. All lines in the import file should thus contain either the 
internal or external names of both fields and line types in accordance with the choice made when the 
import is started. 

Standard line types can be divided into five groups: format lines, data lines, action lines, format return 
lines, and comment lines. The line types within each group are described in the following section. Note 
that some of the line type names contain the term <OBJECT>. The object is the type of information to 
which the line type pertains. When you set up your import file, replace the term <OBJECT> with the name 
of the relation that the line concerns. For example, when importing items, replace the line type 
<OBJECT>:FORMAT with ITEM:FORMAT. The objects that can be handled vary from program to 
program. Some programs can even handle several objects. For instance, Import Orders can handle the 
objects SALES ORDERS and ORDER LINE. 

Format Lines 
Line type name: <OBJECT>:FORMAT 

Examples: ITEM:FORMAT, ORDER LINE:FORMAT, JOURNAL:FORMAT 

On a format line, you can specify the names of the fields to which you want to import data that pertains to 
the object that is specified in the name of the format line type. The order of the field names specified on a 
format line also determines the order in which data should be entered on subsequent data lines that 
pertain to the object in question. A format line does not result in the creation/update of any entries, nor 
does it perform any actions. 

The following example shows an import file for the import of orders. 
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 Row 1: Format line for the object SALES ORDERS. 

 Rows 4 and 8: Lines with object SALES ORDERS must comply with the nearest preceding line of 
the type SALES ORDERS:FORMAT. 

In the Import Orders import program, you can import data for two objects: SALES ORDERS and ORDER 
LINE. Therefore, you must set up a format for each object, specifying the fields to which you want to 
import data. In the preceding example, the SALES ORDERS:FORMAT line type in line 1 specifies that 
whenever the SALES ORDERS object is used on subsequent lines, column B should contain an order 
number, column C should contain an order type, column D should contain a customer number, and so on. 
The ORDER LINE:FORMAT line type on line 2 specifies the order of fields for the ORDER LINE object in 
the same way. 

On lines 4 and 8, you can see from the line type names that the lines pertain to the SALES ORDERS 
object. The data on these lines therefore must be presented in the order that is specified by the format for 
the SALES ORDERS object (that is, line 1). Similarly, lines 5-7 pertain to the ORDER LINE object, and 
therefore must comply with the format on line 2. 

The field names available are specific to each object, and the format line types available are specific to 
each import program.  

 
The field names on format lines must match the names in the field list with regards to spelling, spaces, 
punctuation, and so on; otherwise, the import will fail. 

Several import programs allow you to choose between the use of internal or external names. The internal 
names are the names that are used in Maconomy’s relations while the external names correspond to the 
field headers in the Maconomy windows. In the program-specific manuals for the programs where this 
feature is available, the field lists show both the external and internal names of each field. All format lines 
in the import file should thus contain either internal or external field names in accordance with the choice 
made when the import is started. 

When you set up your import file, you must specify a format line before you can specify any data and 
action lines; otherwise, the import program cannot tell which column pertains to which field. 

A format line applies until another format line for the same object occurs in the import file. 

The format for a given object does not need to include all the available fields. If you leave fields out of the 
format, the fields that are not specified on the format line are treated as if they contained the command 
#KEEP on all subsequent lines with that object. The effects of the command #KEEP are described in the 
“The #KEEP Command” section Note that on data lines for a given object, you need not enter information 
in all of the fields in the format. For example, in preceding figure, the Extra Text 1 field (column F) has 
been left blank on lines 6 and 7.  

Attention: For information about how to print the available format lines and the field supported by 
each object, refer to the “Getting Started” section. 
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Data Lines 
Line type name: <OBJECT>, <OBJECT>:CREATE, <OBJECT>:CHANGE 

Examples: ITEM, ORDER LINE, JOURNAL, ITEM:CREATE, ITEM:CHANGE 

A data line contains the data values to be imported to the fields specified in the nearest format for the 
object in question. Thus, a data line can result in the creation and/or update of an entry in Maconomy’s 
database. There are three different forms of data lines. By using different forms of data lines, you can 
specify whether the information on the individual line should result in the creation of an entry, the update 
of an existing entry, or if Maconomy should determine whether an entry is to be created or updated, 
based on the values in the key fields of the line. However, in some programs, you can only let Maconomy 
determine whether an entry should be created or an existing one should be updated. 

The value in each field on a data line must comply with the data that is allowed in the field type of the field 
in question. For example, the Pick field in the previous example is of the type Integer, meaning that no 
letters are allowed in this field. You can find the field type of each field in the field lists in the program-
specific manuals, while the exact meaning of each field type is described in the “Standard Import 
Functionality” section of this guide. 

The concept of key fields is explained in the “Central Concepts in Import Programs” Section. 

The following describes the three forms of data lines: 

 Data lines for creating entries 

Line type names: <OBJECT>:CREATE 

Examples: ITEM:CREATE, INVOICELINE:CREATE 

In most import programs, you can specify that a data line should result in the creation of an entry 
in the database. The line type name of such a line consists of the name of the object for which the 
line contains data, followed by a colon and the text CREATE. 

When such a line type is used, an entry is created in Maconomy with the data specified on the 
line. However, only fields that are open in the Creating state are imported because any values in 
other fields are ignored. This corresponds to selecting New <OBJECT> in the Index menu in 
Maconomy, entering information in the fields that are open for data entry, and pressing ENTER. 

When you use this form of data line type, you ensure that existing entries are not updated by 
mistake. If Maconomy’s database already contains an entry with the key values specified on the 
data line, the import fails. 

 Data lines for updating existing entries 

Line type names: <OBJECT>:CHANGE 

Examples: ITEM:CHANGE, INVOICELINE:CHANGE 

In most import programs, you can specify that a data line should result in the update of an 
existing entry in the database. The line type name of such a line consists of the name of the 
object for which the line contains data, followed by a colon and the text CHANGE. 

When such a line type is used, the specified entry is updated with the data that is specified on the 
line. However, only fields that are open in the Updating state are imported because any values in 

Attention: For more information about the effects of leaving a field blank, refer to the “Leaving Fields 
Blank” Section. 
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other fields are ignored. This corresponds to browsing to a given existing entry, changing some 
information, and pressing ENTER. 

When you use this form of data line type, you ensure that no new, undesired entries are created 
by mistake. The entry to be updated is identified from the values in the key fields on the data line 
in question. If Maconomy’s database does not contain an entry with the key values specified on 
the data line, the import fails. 

 Automatic data lines 

Line type names: <OBJECT>  

Examples: ITEM,INVOICELINE 

In some cases, you want to let Maconomy determine whether an entry should be created or an 
existing entry should be updated. For this purpose, you can use automatic data lines. The line 
type name of a data line consists of the name of the object for which the line contains data. When 
the import is run, Maconomy checks if the database already contains an entry with the key values 
specified in the key fields on the data line. 

If the database already contains an entry with the key values on the data line, Maconomy updates 
the entry in question with the information on the line, just as if you had used the line type 
<OBJECT>:CHANGE. 

If no such entry exists in the database, Maconomy creates the entry with the information on the 
line, and Maconomy processes the line as if you imported the same line twice, namely first with 
the line type <OBJECT>:CREATE and then with the line type <OBJECT>:CHANGE. Although 
some mandatory fields are only open in the Updating state, they must also contain a value when 
you create entries using automatic data lines. This is because, as mentioned, the entry in 
question is first created and then updated. Therefore, if you are creating entries with fields that 
are mandatory and open in the Updating state, you must enter an explicit value or the #KEEP 
command in these fields; otherwise, Maconomy first creates the entry without problems, but 
afterwards attempts to update the mandatory fields with the value blank, resulting in an error. 

The following example shows an import file for the import of users. 

 
There are four data lines in this example: lines 4-7. Lines 4, 5, and 6 contain the object USER, 
meaning that the information should be entered in the order specified in the format for the USER 
object (that is, line 1). Therefore, column B contains a username, column C contains a starting 
date for the user’s validity, and so on. The information on line 7 pertains to the USER DIALOG 
GROUP object, meaning that the information should be entered in the order specified in the 
format for the USER DIALOG GROUP object (that is, line 2).  

 
On line 4, the line type is USER:CREATE. As a result, Maconomy checks that the user who is 
specified on the line does not already exist in Maconomy. Next, the new user is created. 
Maconomy only imports values from the fields open in the Creation state, ignoring any other 
information. If a user with the specified name already exists in Maconomy, the import will fail. 

Attention: For more information about the command #KEEP, refer to “The #KEEP Command 
Section. 
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On line 5, the line type is USER:CHANGE. As a result, Maconomy checks that the user specified 
on the line has, in fact, already been created in Maconomy. Next, the user in question is updated. 
Maconomy only imports values from the fields that are open in the Updating state, ignoring any 
other information. If no users with the specified name exist in Maconomy, the import fails. 

On line 6, the line type is USER. As neither :CREATE nor :CHANGE has been specified, this 
means that Maconomy checks whether the import should trigger the creation of a user or update 
an existing user. Maconomy uses the value in the key field (in this case the username) to 
determine if the user exists. If the user exists, the user information is updated with the information 
on the line. If the user does not exist, the information on the line is imported to a new Maconomy 
user. In this process, Maconomy first imports the fields that are open in the Creating state, and 
then updates the new user with the fields that are open in the Updating state. 

Action Lines 
Line type name: <OBJECT>:ACTION 

Examples: ITEM:DELETE, SALES ORDERS:APPROVE ORDER, SALES ORDERS:PRINT INVOICE 

An action line performs an action that corresponds to the one that is performed when you select the 
action from the Index or Action menu in a given window in Maconomy. You must specify the entry on 
which the action is to be performed, such as the order to be approved, the item to be deleted, and so on. 
You specify the entry by entering the key of the entry in question. For example, the key to a specific order 
is the order number. When you specify the SALES ORDERS:APPROVE ORDER line type and enter the 
relevant order number in the Order Number field, the import program performs the Approve Order 
action on the order in question, just as if you had selected the action from the Action menu while the order 
was shown in the Sales Orders workspace.  

 
Action lines must comply with the nearest preceding format for the object in question. This means that the 
values in the key fields must be specified in the correct columns as defined in the format for that object. 
On action lines, any information in addition to the values in the key fields is ignored. You therefore only 
need to enter the relevant values in the key fields and leave any remaining fields blank on the action line. 
Note that the remaining fields on the action line do not have to be blank. Each remaining field can contain 
a value as long as that value complies with the field type of the field in question. Returning to the example 
used in the illustration of format lines (shown in the following figure), you can see that the import file 
contains one action line, line 8. 

 
The SALES ORDERS:CALCULATE QUANTITY DISCOUNT line type indicates that the object is SALES 
ORDERS, and the action to be performed is the calculation of quantity discount. As mentioned, the key to 
an order is the order number. Therefore, the key to the order for which the discount is to be calculated 
should be specified in the order number column defined by the format for the SALES ORDERS object 
(that is, column B). 

Attention: For a description of the concept of keys and key fields, refer to the “Central Concepts in 
Import Programs Section. 
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Format Return Lines 
Line type name: <OBJECT>:PRINTFORMAT 

Examples: ITEM:PRINTFORMAT, ORDER LINE:PRINTFORMAT 

A format return line is a line that only results in a line in the log file. No data in Maconomy is affected by a 
format return line, and the line consists of only the line type field, meaning that the line only contains a 
value in column A. Any other information on the line is ignored. When a format line is processed during 
import, Maconomy creates a line in the log file that contains the names of the fields that are included in 
the nearest preceding format line that pertains to the object in question. This means that if, for example, 
you are importing general journals, and you create a line with the JOURNAL:PRINTFORMAT line type, 
the log file will display a line with the fields included in the nearest preceding line of the 
JOURNAL:FORMAT type. If a format return line occurs before any format lines for the object in question 
have occurred in the import file (for example, because the format return line is the first line in the file), the 
line in the log file will display all of the fields that can be used on format lines for that object. 

Line 9 in the following example is a format return line. It contains only the line type name. 

 
The ORDER LINE:PRINTFORMAT line type name indicates that the object is ORDER LINE. Therefore, 
the log file will display a line with the names of the fields included in the nearest above line of the ORDER 
LINE:FORMAT type (that is, line 2). 

Several import programs allow you to choose between the use of internal or external names. In these 
programs, Maconomy prints either the internal or external names in accordance with the choice made 
when the import was started. 

Parameter Lines 
Line type name: <SPECIFICATION>PARAMETER SET:UPDATE 

Examples:  INVOICINGONACCOUNTPARAMETERSET:UPDATE, PARAMETER SET:UPDATE 

In some programs, you can use parameter lines. A parameter line is a line on which you can specify 
certain information that is not saved in the Maconomy database, but that is used in connection with 
actions that are performed in the import. An example of the use of parameter lines is the import of 
subscription orders where a parameter line allows you to enter information about the amounts to be 
invoiced on account when the next line of the SUBSCRIPTION ORDER:PRINT INVOICE ON ACCOUNT 
type is imported. Another example is the import of general journals where you can use a parameter line to 
specify if journals posted in the import should be printed. In connection with parameter lines, an action 
can either be an action that is performed through an action line or the creation/change of information by 
means of a data line. 

Information on a parameter line is specified in one or several fields, each of which has its own 
functionality. In the parameter set for invoicing subscriptions on account, you can, for example, specify in 
one field how much is to be invoiced for the subscriptions themselves while you specify in another field 
how much is to be invoiced for tax. 
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As mentioned, the information in these fields is not saved in the Maconomy database, and it therefore 
cannot be displayed in the Maconomy system after the import. The parameter information is only used in 
the current import. 

The value in each field on a parameter line applies until it is changed by importing another value in the 
same parameter field. This means that if, for example, in the import of general journals you specify on a 
parameter line that journals posted in the import should not be printed, this parameter setting will apply to 
all subsequent postings in the import until another parameter line occurs that contains another value in 
the same parameter field. 

Note, however, that some actions reset the parameters, making it necessary to specify a new parameter 
line with the relevant settings after each action line. 

Each field on a parameter line has a default value that applies until it is changed on a parameter line of 
the type in question. If no parameter lines are specified in the import file, the standard value applies 
throughout the entire import. 

Some parameter sets contain only one parameter field while others contain a number of fields. Therefore, 
you must always specify a format line for parameter sets before an actual parameter line can be 
imported, regardless of whether or not the parameter set consists of only one field. Format lines for 
parameter sets are specified in the same way as normal format lines. The name of each available 
parameter set format line in a program is shown in the program-specific manual, and the "Field Lists" 
section in the program-specific manual contains a list of the fields that are available in each parameter set 
format. The field lists also show the default value of each parameter field. 

Comment Lines 
A comment line contains no data, formats, or actions. A comment line is created by leaving the first field 
(column A) blank. You can use comment lines for headings and notes. Comment lines are ignored during 
the import. 

Lines 3 and 10 in the following example are comment lines, which is indicated by the fact that column A is 
blank. The text in column B on line 10 is just a note, and the line has no effect whatsoever on the import. 

 

The #KEEP Command 
The #KEEP command is a command that allows you to let Maconomy assign a non-explicit value to a 
field—that is, the existing value from an entry being updated, the value from a previously imported entry, 
or a standard value. In general, the #KEEP command means that the field is treated in the same way as 
when you enter information in a given window but do not touch the field in question. The #KEEP 
command is used by entering "#KEEP" in a given field. When a field contains the #KEEP command, 
Maconomy processes the field as described in the following, depending on whether you are creating or 
updating an entry: 

Using the #KEEP Command when Creating Entries 
The following table shows how Maconomy assigns values to fields that contain the #KEEP command 
when creating entries (regardless of whether the line type causing the creation is <OBJECT> or 
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<OBJECT>:CREATE). The "Field is maintained by Maconomy" column pertains to whether or not 
Maconomy automatically assigns a value to the field when creating an entry in the window in question. 
For example, Maconomy always assigns order numbers to new orders. The "Standard value applied" 
result means that Maconomy assigns a standard value to the field. The standard value can be many 
things, depending on the type of information contained in the field. In most cases, the standard value is a 
system number or information that is transferred from a standard entry, such as a standard item or a 
standard customer specified in the Company Information or System Information workspace. The standard 
value can also be a calculated value as in the case of prices on an order line.  

Field is a Key 
Field 

Field is Mandatory 
and Open in Create 

Field is Maintained 
by Maconomy 

Result 

Yes Yes Yes Not applicable. 

Yes Yes No  Error, as Maconomy 
expects an explicit value. 

Yes No Yes  Standard value applied. 

Yes No No Not applicable. 

No  Yes Yes Standard value applied. 

No Yes No  If a standard value can be 
found, it is used. Otherwise, 
an error occurs. 

No No No  Blank/zero value applied. 

No No Yes Standard value applied. 

Using #KEEP while Updating Existing Entries 
When updating existing entries, key fields can never contain the #KEEP command because the entry to 
be updated must be specified by the key. Entering #KEEP in a key field results in the creation of an entry 
when using automatic line types. 

All other fields with #KEEP, including mandatory fields, retain their current values. 

Note that in some cases, mandatory fields require you to enter an explicit value, and you therefore cannot 
use #KEEP. 

Using #KEEP to Use Information from Previous Entry 
When you import lines to the subtab of a workspace, you must specify (as part of the subtab line key) 
what tab (sales order, item, and so on) the line belongs to. Instead of entering an explicit value on the 
import line, you can use the #KEEP command to assign the key value from the tab that was most recently 
imported. This can sometimes be necessary because in some cases, you cannot know what the key to a 
given entry should be. For example, when importing orders and order lines, you may want to structure 
your import file so that the tab of the order is imported first, and subsequent lines contain information for 
the order lines of that order. In this case, it is not possible to tell what order number Maconomy will assign 
to the order because the order number is retrieved from the number series. Still, each order line must be 
assigned an order number so that Maconomy knows what order the line pertains to. 
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When you import key values for new subtab lines, the standard value is the value from the entry that was 
most recently imported to the tab. As in any other case, the standard value is obtained by specifying 
#KEEP in the field in question. In the preceding example, specifying #KEEP in the Order No. field on 
each order line in the import file means that the order line is assigned the same order number as the 
nearest preceding order (tab). 

You can also use the #KEEP command in the key fields on action lines to perform the action on the tab 
that was most recently imported. 

The following is an example of this functionality. 

 
In this example, the formats of both orders and order lines specify that column B must contain an order 
number that is part of the key in both types of entry. Line 4 contains information for the tab of the Sales 
Orders workspace, and the value #KEEP in column B on this line means that Maconomy is to assign the 
standard value to this field. The standard value for the Order No. field in the tab is a number from the 
number series. 

The value #KEEP in column B on lines 5 and 6 also means that the standard value is to be applied to 
these fields. Because the Order No. field is a key field in a subtab, the standard value for this field is the 
value from the corresponding field in the nearest preceding order. Consequently, the line is assigned to 
the order that was most recently imported. 

On line 7, the value #KEEP in the column B specifies that the Approve Order action is to be performed 
on the order that was most recently imported, the order on line 4. 

Leaving Fields Blank 
If the imported line triggers the creation of an entry, fields that are left blank are assigned the value zero 
or blank, depending on the field type. As described in “The #KEEP Command” section, entering #KEEP 
causes the field to be assigned the standard value. 

If the imported line updates an existing entry, fields that are included in the format but left blank are 
updated with the value zero or blank. However, the current value can be maintained by entering #KEEP 
in the imported field. 

Fields that are not included in the format are treated as if the field contained the #KEEP value on all lines, 
both when updating and when creating entries. 

The Difference Between Blank, Explicit Values, and #KEEP 
This section describes the difference between leaving a field blank, entering an explicit value, and 
entering #KEEP. 

When you leave a field blank, the value that is imported, regardless of whether you are updating or 
creating entries, is always a zero or a blank value, depending on the type of field. This means that if you 
are updating an existing entry, any value in the field is overwritten with a blank value. 

Explicit values, for example the item description "Leather Couch," are always imported as entered in the 
import file. When creating entries, this means that the new entry is assigned the specified value. When 
updating entries, an explicit value overwrites any existing value in that field for the entry in question. 



Standard Import Programs Overview 

System Admin Guide 231 

 

If you enter #KEEP, the value that is imported depends on whether you are updating or creating entries. If 
the import line in question updates an existing entry, #KEEP means that the value in the field is not to be 
changed in Maconomy’s database. If the import line creates an entry, the standard value depends on the 
type of entry and the setup of the system. Note that in some cases, the standard value is blank or zero. 

It is important to note that mandatory fields can never have the value zero or blank in the Maconomy 
database. Therefore, you must always enter an explicit value or #KEEP in fields that are mandatory, 
open, and included in the format. Note that in some cases, #KEEP is not valid either, and you must enter 
an explicit value. 

The following is an example of an import file for the import of sales orders. 

 
In this example, assume that all of the lines that are imported will result in the creation of entries. The 
Description field (Column D in the order line format) contains different values on each imported order 
line. On the first order line (line 5), the item description field contains a blank value. The value on the 
order line that is created in Maconomy will therefore also be blank, no matter what the normal item 
description for item 1241 is. The second order line in the import file contains an explicit value, meaning 
that the order line created in Maconomy as a result of this import line will be "Leather Couch," no matter 
what the normal description of item 1235 is. 

The third order line in this file contains the description #KEEP. This means that the standard value is to 
be used. The standard value for item descriptions on sales order lines is the description from the item 
information card, so the order line created in Maconomy will display the normal item description for item 
1236. 

Leaving Fields Out of the Format 
As mentioned in the “Line Types” section, leaving a field out of the format (that is, not including it on the 
format line) causes the import program to process that field as if it contained the value #KEEP on each 
line in the import file. In practice, leaving a field out of the format presents the following advantages: 

 When updating existing entries, you only need to include the key fields and the fields that you 
want to change. The remaining fields keep their existing values. This makes it easier to work with 
the import file because the number of columns can be reduced a lot. 

 When creating entries, you can leave out all of the fields to which you want Maconomy to assign 
standard values. 

 As described in the “Keys in Table Parts” section, the key to most subtab lines consists of the key 
to the tab and a line number that represents the line’s position in the tab. When you import new 
tab lines, you can usually omit the Line No. field from the format, and Maconomy will add each 
imported line to the bottom of the subtab. 

 The key to the tab can also be left out of the format for table lines. Maconomy will then assign 
each line to the tab that was most recently imported, meaning that the line is assigned to the 
nearest preceding line that represents a tab entry. An example of this functionality is described in 
the “Using #KEEP to Use Information from Previous Entry” section. 



Standard Import Programs Overview 

System Admin Guide 232 

 

Reading the Log File 
The results of each import attempt are reported in a log file that the import program generates. If there are 
errors, you can read the log file to find out what went wrong with the import file. You can use this 
information to correct the import file. 

You can encounter many different types of errors when trying to import information. However, this section 
does not list every type of error. Instead, this section focuses on ways to read the log file to weed out the 
major errors in the file. 

After you attempt to import a large file for the first time, the log of errors may be rather extensive. 
However, when you take a closer look at the actual errors, you will probably see that many of the errors 
are common to every line in the import file, or to certain line types. By finding out what caused these 
errors, you can correct the problem, reimport, and get a shorter error log that is easier to read. The 
following is a list of problems that can cause large numbers of errors in the log file. 

Note that in some import programs, you can choose whether or not logging should be activated. If logging 
is deactivated, Maconomy stops the import as soon as an error occurs, and the log file thus shows only 
one error. 

The Line Could Not be Imported 

When there is an error on a line, the error itself is shown in the log file, but sometimes, the log file also 
contains an additional line that reports that a line could not be imported. This error message disappears 
along with the actual error message after all problems on the line have been resolved. 

Unknown Line Type 

This type of error occurs if you misspell the line type name in the first field on the line. An error occurs for 
each line on which the line type name was misspelled. 

The Entry XX Does Not Exist 

This type of error is reported when you refer to an entry that does not exist in Maconomy. An error occurs 
for each line that refers to the invalid entry. 

In some cases, the error occurs if one import line contains errors and subsequent import lines contain 
references to that entry. Because the first line contains errors, it is not created in Maconomy, and any 
references to it are invalid. For example, if you are importing an order followed by a number of order lines 
and the order header contains errors, the order is never created, meaning that the references to this order 
on the subsequent order lines are invalid. After the errors in the tab are corrected, the subtab references 
become valid, and this error no longer occurs. 

Practical Usage of Import Programs 
This section consists of two parts. The first part describes how to use import programs in certain work 
procedures. The second part contains a list of hints and tips that can help you save time and trouble 
when you set up your import files. 

Import programs can be used as a tool in a number of different tasks. The most common purposes for 
using import programs are: 

 Changing existing information in your Maconomy system 

 Importing new information to Maconomy as a result of: 

 Converting paper-based information to entries in Maconomy 

 Changing data from another system to Maconomy 
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 Performing actions on several entries in the database  

This section describes how to create import files to perform these tasks. Note that the procedures that are 
described are merely suggestions. In your company, you may do things differently, or use import 
programs for different purposes. The following procedure descriptions should therefore only be 
considered as guidelines and tips for the considerations that you need to make in different situations. 

The Maconomy import programs are advanced tools. Therefore, it is very difficult to anticipate any 
possible error. As a result of this, an import procedure may take a few attempts where errors occur, and 
you need to find the cause of the errors. 

Changing Existing Information in Your Database 
When you must make general changes to existing data, such as payment terms in the customer 
information, you can in some cases save a lot of time by using import programs. 

The change can be made by following these steps: 

1. Export the relevant information from Maconomy. 

2. Rearrange the information to match the format of the import program. 

3. Make the necessary changes in the data. 

4. Perform the import. 

Export the Relevant Data 

When you want to change entries in Maconomy, the first step is to export the information from Maconomy 
to a tab-separated text file that you can edit and reimport. The export is created by using Maconomy’s 
standard export feature from the relevant Find window. 

In the Find window, start by setting up the correct search criteria, making sure that the search results only 
contain the entries that need to be changed. If you do not set up the right criteria, the search may include 
a lot of irrelevant entries that you will have to weed out from the exported file. After you have the right 
search results, use the Export table function from the File menu and select a folder for the exported data. 
If you use the Maconomy Windows client version 4.0 or newer, select the columns in the search windows 
and copy the entries to the clipboard instead because the Export table function is not available in that 
client version. 

Rearrange Information to Match the Import Format  

The exported information  must be changed to match the format used by the import program. You must 
add line types, and perhaps change the field names and change the contents of some fields, because the 
imported values in some cases are not in accordance with the field type rules that are used by import 
programs. 

First, open the exported file in a spreadsheet. If you use the Maconomy Windows client version 4.0 or 
newer and copied the columns in the search window instead of exporting the table, create a spreadsheet 
and paste the copied columns into the spreadsheet. 

Next, start by inserting a column to the left of column A so that the new column is the first column in the 
spreadsheet. You need this column to specify the line type of each line. The first line in the exported file 
contains the names of the fields in the file. This line can be turned into a format line by entering 
<OBJECT>:FORMAT in the new column that you just inserted. Of course, you need to replace the word 
<OBJECT> with the correct object name. For example, if you are working with items, the correct line type 
name is ITEM:FORMAT. You can find the valid format line names for each program in the manual that is 
specific to the program in question. 
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The next step is to change the column headers to match the field names in the manual. This step is not 
necessary for the programs that allow the use of internal names because the field names that are 
exported from Maconomy correspond to the internal names that are used by the import programs. It is 
very important that the names are entered exactly as in the manual. 

The order of the fields is of no importance, but you can change it so that the fields whose values you are 
changing are at the beginning of each line. That way, it can be easier to see which entries are being 
changed. 

After the column names and order have been changed, you need to make sure that the information in the 
file is presented in the way in which the import program reads it. For example, Maconomy exports the 
values TRUE and FALSE from integer fields if you use the Export table action. You need to change this 
to 1 and 0, using the replace function in the spreadsheet program. Maconomy also exports dates in 
another format than the one used in the import, and you must therefore change the slashes to dots in all 
date fields. 

Make the Necessary Changes in the Data 

Make the appropriate changes in the data—that is, the information that you want to change in the 
Maconomy database. When making the changes, be sure to observe the rules that apply to different field 
types. Save the file as a tab-separated text file. 

Run the Import 

Run the import and check out the results in the log file. The log file is placed in the Maconomy folder 
unless you specify otherwise in the dialog that appears before the import is performed. If there were 
errors in the import, read the log file carefully and find out what the problem was. To begin with, the log 
file can be very extensive, so the easiest way is to look for similar errors on different lines, eliminate one 
problem at a time, and then run the import again, each time getting a shorter log file. At this point, it is 
also a good idea to check the Maconomy reference manual for the exact functionality of the fields causing 
the errors. Keep doing this until the import is successful. 

Creating an Import File 
If you are starting up on a new Maconomy system with no information and you need to create a large 
number of entries in the database, the fastest way to create the entries is to import a file with all the 
information. The same procedure can be used any time that you need to create a large number of 
Maconomy entries based on paper-based transactions, such as time sheets that are submitted by 
employees or invoices that are received from vendors. 

The steps involved in this type of import process are as follows: 

1. Examine the functionality of the relevant window. 

2. Run a test import. 

3. Enter actual data and run the actual import. 

Examine the Functionality of the Relevant Window and the Import Program 
Before the import, you need to know what default information Maconomy will use when you create 
entries. For example, if you are importing customer information, check the standard customer so that you 
know what information will be transferred to the imported customers when you use the #Keep command 
or leave fields out of the format. In addition, the dimension values to be derived from imported customers 
should be decided upon. You should also consider the current setup and system parameters in 
Maconomy because this may affect the imported fields. For example, a system parameter can determine 
whether a value must be manually entered in a field or is maintained by Maconomy, as in the case of the 
requisition number in the Requisitions workspace. Another example is the import of items, where the 
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setup of the item groups determines whether the items that are imported have inventory control or not. 
Running these checks enables you to determine which new entries should have explicit values and which 
ones can use the default values. 

It is a good idea to enter an entry in Maconomy and export it. This allows you to see how the information 
is structured. However, the columns may need to be moved around, and the headers may need to be 
changed. In addition, dates and Boolean fields are exported using another format than the one used by 
the import programs. 

In short, you can avoid many problems by knowing the exact functionality of the window into which you 
are importing data. 

Run a Test Import 
It is a good idea to run a test import of one or two entries in a new spreadsheet or on the basis of the file 
that you exported in step 1. 

Start by deciding which fields you need to import. Create a format line that contains the names of the 
fields that you want to import. It is very important that the field names are spelled exactly as in the field list 
in the program-specific manual. If you can import several line types, for example, information for both the 
tab and subtab of a workspace, enter the format lines in the first lines of the import file. This is not 
compulsory, but it allows you to use the facilities for freezing panes in Excel. If you are working with 
frozen panes, you can always see the field names, no matter which line you are working on in the 
spreadsheet. 

Enter the relevant information for one or two entries and try to import the file. 

Check the log file that is placed in the Maconomy folder unless you specified another location. If the 
import was successful, start entering the relevant lines and conduct the import. 

If there were errors in the import, read the log file carefully to figure out what the problem was. When you 
have resolved the problem, document the problem and the solution because a similar problem may occur 
when you try to import the actual data. Try importing the file again after resolving the problem to see if the 
import is successful. 

Enter Actual Data and Run the Actual Import 
After the import of the test data is successful, enter the actual data and try the import. Because some of 
the information in the actual data will vary from your test import lines, you may encounter some errors. 
Check your notes to see if the problems are similar to those in the test data. 

To begin with, the log file can be very extensive, so the easiest way is to look for similar errors on different 
lines, eliminate one problem at a time, and then run the import again, each time getting a shorter log file. 
Concentrate on the first error in the log file because this error may be the cause of several subsequent 
errors. At this point, it is also a good idea to check the Maconomy reference manual for the exact 
functionality of the fields that caused the errors. Keep doing this until the import is successful. 

Importing Information Exported from Other Programs 
In many cases, you need to import information from other programs. For example, your carriers may 
deliver new price lists from time to time, or you are changing from another system to Maconomy. This 
process is in many ways similar to updating existing entries because you are working with a pregenerated 
file. However, in addition to the steps that you need to perform when updating existing information, you 
need to make some extra considerations. A number of these considerations are described in this section. 

In some cases, the import of data from other programs takes place on a regular basis such as once a 
month. If this is the case, it is a good idea to keep track of all the changes that you make in the import file. 
For example, if a pop-up option has a different name in the output file than in Maconomy, what was it 
changed from and what was it changed to? This way, you can set up a step-by-step list that describes the 



Standard Import Programs Overview 

System Admin Guide 236 

 

changes that are necessary to perform a smooth import. You can maybe even set up a macro that makes 
all the changes for you. 

In general, the process of importing information from other programs involves the following steps: 

1. Consider the conversion from external fields to Maconomy fields (for example, dimensions). 

2. Rearrange the information to match the format of the import program. 

3. Run the import. 

Consider the Conversion from External fields to Maconomy Fields 

The external program probably uses other field names and pop-up values than Maconomy uses. This, of 
course, must be considered. You need to analyze the information and set up algorithms for the 
conversion. After you have determined how dimension values, fields, and pop-up options should be 
converted, you can set up a macro that performs the necessary changes. This can be useful if you need 
to move data on a regular basis such as once a month. Remember that the setup of, for example, 
dimension derivation may cause the imported entries to be assigned different dimension values than 
stated in the import file. 

Rearrange the Information to Match Maconomy’s Fields 

The output format of different field types (date, Boolean, and so on) may not be the same as the input 
format required by the Maconomy import program. You therefore must make sure that the information in 
the file is presented in the way that the import program reads it. Check the field formats in the manual 
against the contents in the import file and make the necessary changes. You may also need to change 
the field names in the header and move columns around as explained in the previous description of 
updating existing entries with import programs. 

Run the Import 

Run the import and check out the results in the log file. The log file is placed in the Maconomy folder 
unless you have specified a different location. 

If there were errors in the import, read the log file carefully to figure out what the problem was.The log file 
can be very extensive, so the easiest way is to look for similar errors on different lines, eliminate one 
problem at a time, and then run the import again, each time getting a shorter log file. At this point, it is 
also a good idea to check the Maconomy reference manual for the exact functionality of the fields that 
caused the errors. Keep doing this until the import is successful. 

Actions on Several Entries in the Database 
You may want to perform an action on a number of entries. For example, you may want to delete entries 
in your database on a regular basis to remove any outdated and irrelevant information or as part of a 
larger work process. Similarly, you may want to approve orders in batches once a day. 

You can use the Maconomy import programs to perform actions on any number of entries in Maconomy’s 
database. However, the prerequisites that must be met for an action to be performed on a given entry 
also apply to import programs. For example, an item can only be deleted if the fields related to quantity in 
the item’s warehouses all have the value zero, if there have been no item changes in the last and the 
current years, and if no item discount agreements have been created for the current item. 

The procedure for performing actions on several entries is similar, regardless of the action taken. 

In general, the procedure for performing actions using an import program is as follows: 

1. Export the relevant entries. 

2. Edit the exported entries. 
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3. Run the import that performs the action. 

Export the Relevant Entries  

When you want to perform an action on a number of entries in Maconomy, the first step is to export the 
information from Maconomy to a tab-separated text file that contains the relevant entries. The export is 
performed as described in the “Exporting the Relevant Data” section. 

Edit the Exported Information 

The information that you exported must be changed to match the format that is used by the import 
program. You need to add line types, change the field names, and change the contents of some fields 
because the imported values in some cases are not in accordance with the field type rules that are used 
by import programs. 

First, open the exported file in a spreadsheet. If you use the Maconomy Windows client version 4.0 or 
newer and copied the columns in the search window instead of exporting the subtab, create a 
spreadsheet and paste the copied columns into the spreadsheet. 

Next, insert a column to the left of column A so that the new column is the first column in the spreadsheet. 
You need this column to specify the line type of each line. The first line in the exported file contains the 
names of the fields in the file. This line can be turned into a format line by entering <OBJECT>:FORMAT 
in the new column that you just inserted. Of course, you need to replace the word <OBJECT> with the 
correct object name. For example, if you are working with items, the correct line type name would be 
ITEM:FORMAT. You can find the valid format line names for a given program in the manual for the 
program in question. 

The next step is to remove all columns except for the ones that contain key fields because only the key is 
needed to identify each entry on which the action is to be performed. The key fields that are used in the 
program in question are shown in the program-specific manual. After the irrelevant columns have been 
deleted, you must change the column headers of the key fields to match the field names in the manual. 

It is very important that the names in the file are entered exactly as in the manual. 

After the column names have been changed, you must make sure that the information in the file is 
presented in the way that the import program reads it. For example, Maconomy exports dates in another 
format than the one used in the import, and you therefore need to change the slashes to dots in all date 
fields, if any date fields are part of the key. 

Finally, add the <OBJECT>:<ACTION> line type in column A on each line except for the one that already 
contains the format. Once again, substitute the relevant object name for <OBJECT>, <ACTION>. 

Save the file as a tab-separated text file. 

Run the Import 

Run the import and check out the results in the log file. The log file is placed in the Maconomy folder 
unless you have specified another location. 

If there were errors in the import, read the log file carefully to figure out what the problem was. The log file 
can be very extensive, so the easiest way is to look for similar errors on different lines, eliminate one 
problem at a time, and then run the import again, each time getting a shorter log file. At this point, it is 
also a good idea to check the Maconomy reference manual for the exact functionality of the window in 
question and any special rules about the deletion of entries. 

Checklist Before Import 
When working with import programs, you can avoid many problems by using the following checklist: 
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 Check the version. Make sure that the manual and import program match the version and patch 
number of your current Maconomy system. 

 Insert format lines. Make sure that the first line(s) in your import file are format lines that specify 
the fields to which you want to import information. 

 Check the spelling of field names. Make sure that all field names in the format lines are spelled 
exactly as in the field list in the program-specific manual. 

 Check data and field types. Make sure that the contents in each field comply with the values that 
are allowed as defined by the field type. 

 Check the values in mandatory fields. Make sure that all mandatory fields in the format contain a 
value. This is not always technically necessary, but you can avoid many problems by always 
entering values in mandatory fields. 

 Check for valid references. Make sure that all pop-up values and references to information cards 
in your import file are valid, meaning that the values to which you refer already exist in Maconomy 
and any spelling and punctuation is correct in these references. 

 Save as tab-separated file. Make sure to save as a tab-separated text file. 
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Integrations 
Integration with other systems is most often performed by the Deltek Services team for specific 
customers. For many years, integrations have been implemented using a Web Services interface, by 
writing MScript functions to handle the data exchange. 

Available from Maconomy 2.2 and onwards, a RESTapi will eventually replace the WebService and 
MScript While termination of support for WebServices and MScript has yet to be scheduled, Deltek 
recommends that new integrations should use the new RESTapi to be forward-compatible. 

Talent Management 
This section provides information on Talent Management in relation with Maconomy. 

Talent Management Integration Concepts 
This section details the integration between Talent Management and Maconomy. 

This integration enables Maconomy customers to use Talent Management to manage recruitment and 
other HR processes while utilizing Maconomy for their ERP solution. 

There is no requirement to be live on either Maconomy or Talent Management first. The flexible solution 
allows for existing customer of either system to integrate simultaneously.  

This section is divided into the following subsections: 

 Setup, which includes setup on both systems as well as the initial integration 

 Routine Steps, such as syncing employees 

 Field Descriptions 

Technical Considerations 
The integration between Maconomy and Talent Management communicates via HTTPS over port 443. 

If your instance of Maconomy is deployed on-premise, you must ensure that your on-premise application 
server has port 443 open to the internet so that it can properly communicate with the cloud-based Talent 
Management server. 

In addition, if your network security infrastructure employs any URL-based traffic filtering, you must 
configure that filter to allow all traffic from/to the URL used to access Talent Management. 

Workflow 

The bidirectional integration supports a single point data entry solution, where Maconomy sends 
employee update to the Talent Management user after the Talent Management user is imported to 
Maconomy. 

The integration supports the synchronization of Talent Management user and Maconomy employee data.  

This enables Human Resources users to use one system for updating data. Since Maconomy can 
capture more data on employees than Talent Management can, Maconomy stores the master data. 

https://home.deltek.com/sites/prst/Documentation/Public%20Folder/Maconomy%20Doc%20Editing/Current%20Working%20Documents/2.4.4/DeltekMaconomy244SystemAdminGuide_Restructure%20Dec%202018.docx#_Toc533062781
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Field Mapping 
The table in this section shows field mappings between the Talent Management user and the Maconomy 
employee. 

The general rule is that all fields below are copied from Talent Management to Maconomy when importing 
new hires. After that, all fields are copied from Maconomy to Talent Management when synchronizing the 
data. Refer to the Notes column for the exceptions. 

Country and State mapping procedures are detailed in the “Maconomy Setup in MConfig” section. 

Note: Refer to Fields NOT Included in Synchronization section for excluded fields. 

Talent Management 
Field 

Maps to Maconomy 
Field 

Notes 

User ID Talent Management 
User ID 

Entered upon employee creation. 

Employee ID Employee No. The employee ID in Talent Management is 
assigned to the Employee Number of 
Maconomy. 

First Name Formal First Name Only synchronized on import of new hires. 
Any later updates of this field are not 
synchronized. 

Middle Name Formal Middle Name Only synchronized on import of new hires. 
Any later updates of this field are not 
synchronized. 

Last Name Formal Last Name Only synchronized on import of new hires. 
Any later updates of this field are not 
synchronized. 

First Name Preferred First Name After initial creation, updates to this field are 
synchronized to Talent Management. 

Middle Name Preferred Middle 
Name 

After initial creation, updates to this field are 
synchronized to Talent Management.  

Last Name Preferred Last Name After initial creation, updates to this field are 
synchronized to Talent Management. 

SSN Soc. Security No. Always copied from Talent Management to 
Maconomy. Closed in Maconomy.  

A Talent Management user can have many 
Social Security Nos. (SSN), such as a number 
per country. In Maconomy, an employee can 
have only one SSN. Therefore, the number is 
derived by employee’s country. For example, 
if an employee is in country A, then the SSN 
of country A is retrieved from Talent 
Management and copied to the Maconomy 
employee. If the Talent Management user 
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Talent Management 
Field 

Maps to Maconomy 
Field 

Notes 

does not have an SSN of country A, then SSN 
is left empty in Maconomy. Whenever a 
country is updated in Maconomy, the SSN is 
updated to correspond with the updated 
country. 

E-mail Personal Email 
Address 

Upon importing new hires, E-mail is copied 
from Talent Management into the Maconomy 
Personal E-mail field. After this, the field 
cannot be empty. 

When updates are propagated from 
Maconomy employee to Talent Management 
user, E-mail is updated as follows: 

 If E-mail contains data, it is copied to 
the Talent Management user. 

 If E-mail is empty, the Personal E-
mail is copied to the Talent 
Management user. 

E-mail and Personal E-mail have validation 
against invalid addresses. 

E-mail E-mail See Notes on Email. 

Address One Name 2  

Address Two Name 3  

Address Three Name 4  

City Postal District  

Zip/Postal Code Zip Code  

Country Country/Name5 See the “Maconomy Setup in MConfig” 
section for details on mapping countries. 

ST/PR Country/Name5 See the “Maconomy Setup in MConfig” 
section for details on mapping countries. 

Primary Phone Phone Copied from Talent Management to 
Maconomy upon new hire import. After that, 
any data synchronization copies the phone 
number from Maconomy to Talent 
Management. Maconomy copies the phone 
number to the primary phone.  

If the primary phone does not exist, then 
Maconomy creates a primary phone in Talent 
Management. If a non-primary phone exists in 
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Talent Management 
Field 

Maps to Maconomy 
Field 

Notes 

Talent Management with the same number, 
then Maconomy sets this phone to primary. 

Deleting a phone number in Maconomy 
employee deletes the primary phone from 
Talent Management. 

Hire Date Date Employed This field is populated from Talent 
Management and copied to Maconomy. The 
field can be empty in Talent. The field can be 
empty in Maconomy but the empty value is 
not sent back to Talent. 

If updated in Maconomy, the value is sent 
back to Talent as "Original Date of Hire". 

Date of Birth Date of Birth This field is populated from Talent and copied 
to Maconomy. The field can be empty in 
Talent. The field can be empty in Maconomy 
but the empty value is not sent back to Talent. 

Job Title Position Always copied from Talent Management to 
Maconomy. Closed in Maconomy. 

Manager Supervisor, No. The manager user must be linked to a 
Maconomy employee to map this field. 

Termination Date Termination Date Always copied from Talent Management to 
Maconomy. Closed in Maconomy. 

Last Working Day Time Sheet End Date Always copied from Talent Management to 
Maconomy. Closed in Maconomy. 

Organization Unit  Company No. 

Entity dimension 
(executing 
department) 

The integration supports two ways of 
managing organizational affiliation: 

1. The Maconomy company number can 
be derived from the Company 
Number field on the onboarding form 
in Talent Management. Subsequent 
changes in Talent or in Maconomy 
are not synchronized. 

2. The Maconomy company number, 
and entity are derived from the Talent 
Management user, and applied to the 
Maconomy employee. Subsequent 
updates are completed in Maconomy, 
and are pushed to the Talent 
Management user. 

See more details below. 
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Talent Management 
Field 

Maps to Maconomy 
Field 

Notes 

Maconomy Company 
No. 

Company No. Never copied from Maconomy to Talent 
Management. 

Warning: User Org Level and Maconomy Company No. Fields Warning 
If the integration has been configured to use the company number from the onboarding form in Talent 
Management to derive the Maconomy company number, the company of the Maconomy employee 
obtains the company number from the onboarding form. 

If a company number has not been specified on the onboarding form, the Talent Management user is not 
created as an employee in Maconomy. 

The Company Number field is closed in Maconomy but can be opened in the layout to support HR 
updating this field in Maconomy. 

Changes you apply in Maconomy or in Talent Management are not synchronized. 

See the setup sections below to configure the integration to use the company number from the 
onboarding form. 

If the integration has been configured to utilize the Talent Management user to obtain the organizational 
unit, the Organizational Unit field is used to indicate the corresponding Maconomy company number, 
and department. 

The list of organizational units is pushed from Maconomy to Talent Management. 

When the employee is imported into Maconomy, the company number and executing department of the 
employee is derived from the Talent Management user. If there is no organizational unit specified, the 
Maconomy employee obtains the default company and executing department. 

Changes you apply to the Maconomy employee organizational affiliation, such as the company and 
executing department, are managed in Maconomy and pushed to Talent Management. 

See the “Reporting Structures” section to configure the integration to use the reporting structure in 
Maconomy to represent organizational hierarchy. 

Talent Management Steps 
This section provides procedures related to Talent Management. 

Talent Management Setup 
To enable the Maconomy integration from within Talent Management, you need to perform system setup. 

Before You Begin 

You need to contact Talent Management Support before you begin the Talent Management integration 
with Maconomy. 

Submit an RNT ticket to DTMCloud@deltek.com) to obtain the following: 

 User name and password to access middleware site 

 URL to middleware site 

 FTP site and related information 

 “Token” (password) to enable the integration 

mailto:DTMCloud@deltek.com
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 Prepare company setup 

o Create a top organizational level, which the organizational structure from Maconomy will 
be placed under.  

o Create a custom Maconomy Company Number field in user onboarding form if you will 
use this field in Talent Management to specify a Maconomy company. This field is 
referenced in the Maconomy setup. 

 Ensure the Country field is specified for the Talent Management user. 

Warning: When uploading users for the first time, ensure that the Country field is specified as 
Maconomy requires the Country when synchronizing with Talent Management. In addition, be careful not 
to change translations for the country name, as this field is used in searching IDs when creating or 
updating users. 

Talent Management Integration Setup 

To enable the integration from the Talent Management side, you must log in to a middleware support site, 
gain access to and complete an integration setup screen, and submit your information.  

To enable the Talent Management portion of the integration, complete the following steps: 
1. In your web browser, enter the middleware URL. It is in a format similar to the link below: 

https://clientname.hrsmart.com/tools. 

2. Log in with your user credentials. 

3. Click Special Integration » Maconomy Integration. 

4. On the integration setup screen, enter information in the following fields: 

 Client Name 
 Client Existing Token 
 Client URL 
 Client FTP Host 
 Client FTP Username 
 Client FTP Password 
 Client FTP Port 
 Client FTP Type 
 Client FTP Subdirectory 

5. In the Client Notification List field, enter the email addresses (comma separated) of users who 
should receive the reports that are generated each time the integration runs, including error 
reports. 

6. Click Deploy. 

The integration is now enabled on the Talent Management side. 

Maconomy Setup 
You must perform a specific setup in Maconomy to enable the integration with Talent Management. 

This includes the following:  

 Follow steps in Before You Begin 

 Maconomy setup in MConfig 
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 Set up country mapping and state mapping 

 Set up reporting structure 

 Set up employee creation using employee templates 

 Set up Talent Management integration 

Before You Begin 

You must perform specific tasks before you begin Talent Management integration setup in Maconomy. 

You must do the following: 

 Enable system parameter/s 

 Enable access control 

 Provide Talent Management custom Maconomy Company No. field name, if this field is used in 
Talent Management to specify a Maconomy company 

 Create skill level list, if applicable 

Additionally, to schedule automatic synchronization, you must also set up background integration: 

 Setup background integration to synchronize data 

Enable System Parameters 

Use these steps to enable Talent Management integration. 

To enable Talent Management integration and functionality with system parameters:  
1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Search for and enable the Use First/Middle/Last Name on Employees and Contact Persons 
and Use Both Formal and Preferred Names on Employees and Contact Persons 
parameters. 

Selecting these parameters enable the use of separate fields for employee and contact names.  

3. Search for and enable the Enable Deltek Talent Management Integration parameter.  

Selecting this parameter enables Talent Management in Workspace Client for the selected 
company.   

4. Search for and enable the Enable Deltek Talent Management Skills Integration parameter.  

Selecting this parameter enables Talent Management Skills Integration. However, you may opt to 
only enable the employee integration. 

5. Search for and enable the Block Employee Off-boarded in Deltek Talent Management 
parameter, if needed. 

If this parameter is selected and the user is off-boarded in Deltek Talent Management (such as if 
the user has left the company), then the linked employee is blocked in Maconomy.  

6. Search for and enable the Derive Template Employee on Creation parameter, if needed. 

When you enable this parameter, you can set up an employee template based on the company, 
or system information. 
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Add a Talent Management Custom Maconomy Company No. Field Name 

Use these steps to add a custom Maconomy company number field name. 

To add a custom Maconomy company number field name: 
1. On the onboarding form in Talent Management, copy the field name from the Company Number 

field. 

2. In the Workspace Client, go to Setup » Talent Management Setup » Administration. 

3. Paste the custom Talent Management company number field name on the Company No. Field 
Name field. 

Note: You can rename the custom field in Talent Management, which by default is “f_company_code_0”. 

Reporting Structures 

If you derive the Maconomy company number and entity from the User in Talent Management, you must 
set up a reporting structure in Maconomy of type Entity representing the hierarchy. 

This reporting structure must be specified in the Reporting Structure Name field in the Talent 
Management Setup workspace. 

The organizational structure is exported from Maconomy to Talent Management through the Export 
Organizational Structure action in the Talent Management Setup workspace. 

The Reporting Structures workspace allows you to create a hierarchical structure through its tree table 
functionality. 

Note: Not all fields on the Reporting Structures workspace are used for the Talent Management 
integration. For example, the Periodic field is a generic field for Reporting Structures but does not apply 
to an organizational structure. 

Set Up and Create Reporting Structures 

Use these steps to create an organizational reporting structure. 

To create the organizational structure: 
1. Go to Set-up » Reporting » Reporting Structures » Reporting Structure Lines. 

2. Create a new reporting structure with an Entity type. 

3. Add reporting structure lines to reflect the organizational structure that you want to export to 
Talent Management. 

4. In the Classification field, add company numbers as top organizational levels and assign each 
number only once. 
The bottom organization levels must be entity dimensions and have no label restrictions. These 
are not specific to a company, and you can use the entity dimensions multiple times. For 
example, you can add the same department name for companies 1 and 2. 
As for intermediate levels, you must enter free texts in the Description field and place these in 
the hierarchy using the Grouping or Indentation on the line. 

Set Up Employee Creation Using an Employee Template 

You can assign an existing employee to serve as an employee template to automatically fill in additional 
employee information for integrated Talent Management users. 

Set Up an Employee Template Using Company Information 
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Use these steps to set up an employee template containing company information. 

To set up an employee template using the company information: 
1. Go to Company Information » Company Information. 

2. Select a company from the filter list. 

3. On the Template card, select template from the Employee field. 

4. Click OK. 

Set Up and Employee Template Using System Information 

By default, Maconomy uses the company information based on the company set for the employee. 

If the company information is not available, the system information is used. 

To set up an employee template using the system information: 
1. Go to Setup » System Setup » System Information » Employees. 

2. Enter an employee number in the Template Employee field. 

3. Click OK. 

Add “DeltekTalentManagement” to Popup Field 

The popup type IntegrationType must have the value DeltekTalentManagement in order for Maconomy 
Skills integration to work with Deltek Talent Management. 

To add the value in the Workspace Client:  
1. Take one of the following actions: 

 Go to Single Dialogs » Set-Up » Set-Up » Popup Fields. 

 Go to Setup » System Setup » Parameters and Numbers » Popup Fields.  

2. Search for Integration Type and add the value DeltekTalentManagement. 

Create Skill Level List 

Use these steps to create a skill level list. 

To create a level list: 
1. Go to Human Resources » Employees » Setup » Level Lists. 

2. Click New Level List. 
3. On the Create Level List dialog box, do the following: 

• In the Name field, enter Talent Management. 
• In the Description field, enter Manually created. 

• From the Grading Method dropdown list, select Best Last. 
4. Click Create. 

5. Select the Talent Management level list. 

6. In the Levels panel, double-click and enter the exact same values from the level list in your 
Talent system. 
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Set Up Background Integration 

If you choose to schedule automatic synchronization, you must activate default background tasks. 

Note: If you use manual synchronization, skip this section and check “Talent Management Routine 
Steps” section. 

Activate Default Background Tasks 

Use these steps to activate default background tasks. 

To activate default background tasks: 
1. Go to Background Tasks » Setup » List of Schedule Rules. 

2. Locate the ImportDtmNewHires and SyncEmployeesWithDtmUsers default task generators. 

3. Setup a trigger time pattern and activate these generators: 

 ImportDtmNewHires generator creates tasks to import new hires from Talent 
Management. 

 SyncEmployeesWithDtmUsers generator creates tasks to synchronize Talent 
Management users with linked Maconomy employees. 

Attention: For more information about time patterns, refer to the Pattern syntax help. 

Import Skill Types and Skills 

You can import skill categories and skills from Talent Management to Maconomy. 

You must trigger each action to create background tasks and initiate synchronization. Skill types are 
required by skills. Skill types must be imported first from Talent Management before importing skills. 

To import skill types and skills: 
1. Go to Setup » Talent Management Setup » Administration. 

2. Activate each of the following actions to initiate synchronization: 

 Import Skill Types from Talent Management: Use this action to import skill types from 
Talent Management to Maconomy, and create a background task to add, update, or select a 
skill type as deleted when removed from Talent Management. 

 Import Skills from Talent Management: Use this action to import skills from DTM, and 
create a background task to add, update, or remove skills in Maconomy. You must use this 
action only after skill types have been imported from DTM. 

Note: Handling Skills in Maconomy 

Talent Management is the master of skills data and any skills information imported to Maconomy. The 
integration overwrites any changes directly made in Maconomy. 

 You cannot create, update, nor delete skills for employees linked to Talent Management. 

 You cannot update or delete skills (in Setup) imported from Talent Management. 

A user gets a notification when trying to change or delete a skill type linked to Talent Management skill 
categories. 

Skills and employees that are not linked to Talent Management can be amended in Maconomy. 

http://www.sauronsoftware.it/projects/cron4j/manual.php#p02
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Maconomy Setup in MConfig 

Maconomy requires a gateway URL and token to Talent Management. 

The URL and token are entered in MConfig.  

To enter the URL and token in MConfig: 
1. Select Application overview and go to the Deltek Talent Management integration tab. 

2. In the Gateway URL field, enter https://soadev-us.tm.deltek.com/gateway.php 

3. In the Token field, enter the authentication token, which is similar to the format below, while 
unique to each customer/system. 

123ASDF23ASDF5SDF23SDF56SDF 

Set Up Country and State Mapping 

The Maconomy employee uses Country and Name 5 fields for country and state mapping. 

A Talent Management Country ID must map to Country and/or Name 5 field.  

Once you create the country mapping, you can create the state mapping, if needed. Enter a Talent 
Management State ID and map to Country and/or Name 5 field. 

Country Mapping Concepts 

Maconomy has an open list of countries which you can add to at any time. 

For CPA and PSO solutions, this list may also contain the states of the countries. Talent Management 
has two lists: one for countries and the other for states. The states and the countries must be mapped to 
synchronize the Talent Management user with Maconomy employee. 

Maconomy Country Derivation 

Maconomy derives a country when synchronizing Talent Management users with Maconomy employees. 

As first derivation, it uses country mappings created in Maconomy.  

 By default it will use Country value if it is not empty and Name 5 value even if it is empty from 
country mapping (card). 

 If a state mapping also exists, then it will use Country value if it is not empty and Name 5 value if 
it is not empty from state mapping (table). 

If the mapping does not exist in Maconomy country mappings, then Maconomy will try to derive the 
mappings in this order: 

 Find a Maconomy country with the same country ISO code as a Talent Management country. 

 If the match is not found, find a Maconomy country with the same country name as a Talent 
Management country. 

If the match is not found the synchronization will fail, because the country is a mandatory field on 
Maconomy employee. 

Creation of Country Mappings 

The Maconomy employee uses two fields for the country and the state: Country and Name 5 fields. 

Note: When using these fields: 

https://soadev-us.tm.deltek.com/gateway.php
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 The Country field can represent a country or a state, and the Name 5 field can represent a 
country or a state. 

 You can create a mapping to specify which of these two fields to which you choose to map the 
Talent Management country and state. 

 The integration requires that the list of countries in Maconomy is the same as the list of countries 
in Talent Management. 

 The fields mapped from Talent Management to Maconomy are closed on employee. The only 
way to update them is through Talent Management.  

A Talent Management Country ID must be entered and must map to either Maconomy Country or 
Maconomy Name 5 or to both fields. Once the country mapping is created, the state mappings for this 
country can be created. A Deltek Talent Management state ID must be entered. It must map to either 
Maconomy Country or Maconomy Name 5 or to both fields.  

When you create a country mapping, Maconomy then imports related states automatically from Talent 
Management, loading all states for the current country. If the Talent Management country is mapped to a 
Maconomy Country, then Maconomy does not only create the state lines in the table, but it copies the 
Talent Management state name to Maconomy Name 5 field as the suggested mapping. 

Note: The fields mapped from Talent Management to Maconomy will be closed on employee. Thus the 
only way to update them will be in Talent Management. 

 

Set Up Country Mapping 

Use these steps to map countries between Talent Management and Maconomy. 

To map countries between Talent Management and Maconomy: 

1. Click Setup » Talent-Management Setup » Country Mappings to set up Talent Management 
countries. 

2. Click the Talent-Management Country tab. 

3. In the Talent Mgmt. Country field, select the country from Talent Management and map to 
Maconomy country. 

4. Click the Talent Management States tab. 

5. In the State Id., Talent Management field, select the identification code of the state from Talent 
Management and map to Maconomy state. 

Talent Management Routine Steps 
During routine synchronizations, you must perform the standard Talent Management to Maconomy 
synchronization, then identify and correct errors.  

Import New Hires 

You can manually import new hires from Talent Management to Maconomy, or schedule the import 
through background tasks. 

For each new hire (user, in Talent Management), an Employee is created in Maconomy, and data is 
copied to this Maconomy employee. The users are marked as exported in Talent Management. Every 
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Talent Management user will be updated with the linked Maconomy Employee ID number. The import 
derives information such as employee name, country, and company, listed in Field Mapping. 

Note: The “New Hires” import is one way, except in this initial instance where Maconomy populates the 
Talent Management user with the related Maconomy Employee ID. 

To manually import new hires:  
1. Go to Setup » Talent Management Setup » Administration. 

2. Click Import New Hires from Talent Management. 

Update Talent Management from Maconomy 

You can manually synchronize Maconomy employee data with already-linked Talent Management user or 
schedule the import through background tasks. 

Any changes to employees in Maconomy are copied to Talent Management and changes to users in 
Talent Management are copied to Maconomy employees. 

Note: The integration is bidirectional, but each field has only one direction updates. Most fields are 
always copied from Maconomy to Talent Management and other fields (very few) are always copied from 
Talent Management to Maconomy. The list of fields is fixed and the direction never changes. 

You can do this action for a single employee or for all employees. 

Update All Employees 

Use these steps to update all employees. 

To update all employees: 
1. Go to Setup » Talent Management Setup » Administration. 

2. Click the Sync All Empl. with Talent Management action. 

Update Single Employee 

Use these steps to update an employee. 

To update a single employee: 
1. Go to Human Resources » Employees » Employees. 

2. Click the Sync. with Talent Management action. 

Link Existing Maconomy Employee to Existing Talent Management User 

You can link an existing Maconomy employee to an existing Talent Management user. 

Enter a Talent Management User ID on the Maconomy employee. After, Maconomy updates Talent 
Management user with data from Maconomy employee and pulls data (such as the Social Security No., 
Position, and Termination Date) from the Talent Management user and updates the existing Maconomy 
employee accordingly. 

To link an existing Maconomy user with an existing Talent Management user: 
1. Go to Human Resources » Employees » Employees.  
2. In the Talent Management card, enter the user ID in the User ID field. 
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Sync All Employee Skills 

Use the Sync All Employees Skills with Talent Management action to retrieve all employees’ skills 
from DTM and synchronize them with Maconomy. 

You must trigger this action to create the background task and initiate synchronization. 

To synchronize all employees’ skills from DTM to Maconomy: 
1. Go to Setup » Talent Management Setup » Administration. 

2. Click Sync All Employees Skills with Talent Management.  
Note: The synchronization of employee skills is a separate function from the already existing 
Maconomy employee synchronization. The skills are not automatically synchronized when Maconomy 
pulls new hires from DTM nor when a single user is synchronized from DTM by Sync with Talent 
Management. 

Import Employee Skills 

You use the Import Empl. Skills from Talent Management action to retrieve the employee skills from 
DTM and synchronize them with Maconomy. 

You must trigger this action to create the background task and initiate synchronization. 

To import an employee’s skills from DTM to Maconomy: 
1. Go to Human Resources » Employees » Skills. 

2. Click the Import Empl. Skills from Talent Management action. 

Export Organizational Structure 

You use the Export Organizational Structure action to export the organizational structure from the 
reporting structure in Maconomy to Talent Management. 

To export the organizational structure from Maconomy to DTM: 
1. Go to Set-up » Talent Management Setup » Administration. 

2. Select an existing reporting structure from the Reporting Structure Name field. 
The selected structure must be an Entity type. 

3. Click Save Talent Management Integration Setup. 

4. Click Export Organizational Structure to create a background task that will export the 
organizational structure. 

5. View the exported organizational structure of the Talent Management user under the Position 
Information section. 

Remapping of Country and State 

Countries and states can be remapped as needed. If an existing country entry changes, then existing 
mappings should be updated. 

The remapping does not affect the employees instantly, as the remapped countries or states are updated 
on the employee when the employee is updated with the latest Talent Management user changes. 

Note: Notice that the mapping of the countries and states are not updated if a country or a state name is 
changed in Talent Management. A responsible user of Maconomy must update the country mappings in 
Maconomy to reflect the country and the state changes in Talent Management. 
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To remap countries and/or states: 
1. Go to Setup » Talent Management Setup » Talent Management Country. 

2. Select the actions to add, update, or delete a Talent Management Country and/or State as 
needed.  

3. Follow the steps in “Set Up Country and State Mapping” section to remap countries and states.  

Check Background Task Log 

Use these steps to check the background task log. 

To check the background task log: 
1. Go to Setup » Background Tasks » Status » List of Background Tasks. 

2. Double-click the background task. 

3. If the task’s Execution Result is “Failed,” open the Result Log to view the reason. 

Check Log Files 

The workflow of the integration is logged with Coupling Service logs. 

Logging for the Coupling Service is configured in the file logback.xml located in the folder: 

<Path to Maconomy installation>/CouplingService/configuration 

Talent Management Field Descriptions 
This section provides information on fields related to Talent Management. 

DTM Skill Category Mapping to Maconomy Skill Type 

Deltek Talent Management Maconomy Description 

skill_category_id String 1 The DTM skill category ID, 
prefixed with “DTM.” For 
example, when the 
skill_category_id is 5, the 
value is DTM 5. 

skill_category_name Name  

skill_category_last_modified String 2  

 Boolean 1 When skill category is 
deleted in DTM, this field is 
set to true in Maconomy. 
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DTM Skill Mapping to Maconomy Skill 

Deltek Talent Management Maconomy Description 

skill_id Skill Number The DTM skill ID, prefixed 
with “DTM.” For example, 
when the skill _id is 1, then 
the value is DTM 1. 

skill_name Skill Name  

skill_category_id Skill Type This is used to find the 
mapped skill type in 
Maconomy and assign it to 
the skill. 

 Level List The integration uses the 
“Talent Management” level 
list and this level list is 
created manually in 
Maconomy. 

DTM Skill Mapping to Maconomy Integration Line 

Deltek Talent Management Maconomy Description 

skill_id String 1  

skill_last_modified String 2  

DTM User Skill Mapping to Maconomy Employee Skill 

Deltek Talent Management Maconomy Description 

skill_id Skill Number Derived from  Maconomy skill. 

skill_category Skill Type Derived from  Maconomy skill. 

skill_name Skill Name Derived from  Maconomy skill. 

skill_level Level  

DTM User Skill Mapping to Maconomy Integration Line 

Deltek Talent Management Maconomy Description 

skill_id String 1  

skill_last_modified String 2  
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Deltek Talent Management Maconomy Description 

endorsed String 3  

skill_usage String 4  

skill_last_used String 5  

Fields NOT Included in Synchronization 

This section provides a list of Talent Management fields that are NOT included in the integration. 

Field Name 

user_phone 

user_eeoc_race 

user_eeoc_veteran 

user_eeoc_disabled 

user_eeoc_gender 

referral_source_id 

referral_source_name 

user_new_hire_exported 

manager_employee_id 

manager_firstname 

manager_lastname 

manager_email 

diversity_info 

user_location_code 

user_location_name 

requisition_id 

requisition_code 

requisition_job_code 

resume_id 
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Field Name 

candidate_id 

candidate_hire_date 

candidate_start_date 

offer_salary 

offer_salary_type 

offer_start_date 

user_status 

recruiter_id 

recruiter_employee_id 

recruiter_firstname 

recruiter_lastname 

recruiter_email 

hiring_manager_id 

hiring_manager_employee_id 

hiring_manager_firstname 

hiring_manager_lastname 

hiring_manager_email 

req_company_id 

req_company_code 

req_company_name 

req_division_code 

req_division_name 

req_division_id 

req_department_id 

req_department_code 
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Field Name 

req_department_name 

req_salary_grade 

req_location_code 

req_location_name 

dynamic_form_id 

req_exemption 

position _code 

position_salary 

position_location_code 

job_code 

job_location_code 

job_location_name 

job_type 

job_salary_grade 

user_login 

jobseeker_hire_type_id 

jobseeker_hire_type 

jobseeker_hiring_reason_id 

jobseeker_hiring_reason 

requisition_position_type 

requisition_job_type 

custom_fields 

taxable_entity_id 

taxable_entity_name 
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CRM 
The CRM integration enables Maconomy customers to use Deltek CRM to manage contacts and 
opportunities while using Maconomy for their ERP solution. 

This section provides conceptual information and step-by-step instructions related to the CRM integration 
with Maconomy. 

CRM Concepts 
This section details the integration between Deltek CRM and Maconomy. 

This integration enables Maconomy customers to use Deltek CRM to manage contacts and opportunities 
while utilizing Maconomy for their ERP solution. 

The following prerequisites are required: 

• Maconomy 2.6.1 

• Vantagepoint 3.0 

• Configurations in both Deltek CRM and Maconomy are completed. 

• Creation of user-defined fields and hubs are completed in Deltek CRM. 

 

Technical Considerations 
The integration between Maconomy and Deltek CRM communicates via HTTPS over port 443. 

If your instance of Deltek CRM and/or Maconomy is hosted in the Deltek cloud, you will not need to make 
any changes to your system to support the integration. However, if you have either Deltek CRM or 
Maconomy deployed on premises with the other product hosted in the Deltek cloud, you will need to 
ensure that your on-premise application server for either product has port 443 open to the internet so that 
it can properly communicate with the cloud-based application server. 

In addition, if your network security infrastructure is employing any sort of URL-based traffic filtering, you 
will need to ensure that you configure that filter to allow all traffic from/to the URL used to access the 
cloud-based product. 

If both Deltek CRM and Maconomy are deployed on premises, you will only need to ensure that port 443 
is open between both application servers via your internal network and that you are not filtering the URL 
used to access either application. 

Note: This document is updated to reflect the integration to Vantagepoint. 

Starting with Maconomy 2.5.1, the Vantagepoint SOAP API is deprecated in Vantagepoint version 
3.0, and the Deltek CRM Integration migrated to REST API. 

With the changes in the Vantagepoint API, companies can no longer be set to inactive in 
Vantagepoint CRM. Consequently, the functionality where a customer is deleted in Maconomy, and 
the corresponding company in Vantapoint CRM is set to inactive is removed. 

Integration now works with the new projects concept in Deltek CRM introduced with Vantagepoint. 
Prior to this release, Maconomy integrated to opportunities in Deltek CRM. 

This document continues to refer to opportunities to distinguish between Maconomy projects and 
Deltek CRM projects. 

https://home.deltek.com/sites/prst/Documentation/Public%20Folder/Maconomy%20Doc%20Editing/Current%20Working%20Documents/2.4.4/DeltekMaconomy244SystemAdminGuide_Restructure%20Dec%202018.docx#_Toc533062782
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Workflows 

Job Creation and Maintenance 

In Deltek CRM, the Maconomy tab on the Project and on the Firm contains information about the 
Maconomy integration. 

 
When a project is created in Deltek CRM, you can indicate on the project that Proposal and Fee Projects 
should be created in Maconomy. To do this, ensure that the fields for project creation are selected in 
Deltek CRM. A background task in Maconomy polls the Deltek CRM database for opportunities for which 
Proposal or Fee Projects must be created. Based on the output, a project is created in Maconomy, taking 
information from Deltek CRM about customer, company, project name, and so on, as well as basic project 
setup from a template job. 

You can indicate on a firm (customer) in Deltek CRM the creation of a Relationship Project in Maconomy. 

Fields on the projects in Maconomy are populated with basic information about the job type (Proposal, 
Fee, or Relationship), project name, project ID, and project status from Deltek CRM.  

When a project is created in Maconomy, basic information about Maconomy project number, name, and 
status flow back to Deltek CRM. 

When a project is created from a Deltek CRM project, some fields are closed on the Deltek CRM project 
and are modified only in Maconomy (for example, start date, end date, and project manager). 

A Deltek CRM project closed as Lost generates two notifications for the project manager in Maconomy 
that Proposal and Fee jobs can be closed. 

A Deltek CRM project closed as Won generates a notification for the project manager in Maconomy that 
the Deltek CRM project is won (indicating that the fee job can be submitted for final approval). 

Deltek CRM projects closed as won or lost will continue to be updated with Maconomy job information. 
Only the budget amount will remain unchanged. 

Customer Creation and Maintenance 

If a customer does not exist in the Maconomy database, a customer record is created in Maconomy 
(before job creation) based on the customer information in Deltek CRM. 

 
You can also manually initiate Maconomy customer creation from the company (customer) in Deltek 
CRM. It is a configuration option whether the Maconomy customer number is taken from a Maconomy 
number series or the Deltek CRM Company ID is used. 

Customers are created in Deltek CRM. Some customer information is available in both Deltek CRM and 
Maconomy (customer name and address) and are maintained only in Deltek CRM. Most other types of 
information only reside in one system and are updated in the relevant user interface. 

A link on the customer in Maconomy gives you easy access to the company in Deltek CRM. 

Note: When you run the integration, you must have edit access to the fields on the Maconomy tab in 
Projects and Firms. 

Note: When you run the integration, you must have edit access to the fields on the Maconomy tab in 
Projects and Firms. 
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Background Tasks 

The Background Task functionality in Maconomy polls the Deltek CRM database for information about 
opportunities, jobs, dimensions, companies, employees, and customers to synchronize databases. 

You can choose to run the synchronization manually or on a scheduled basis. 

Field Mapping 
The following tables show field mappings between Deltek CRM (for integrations using Vantagepoint) and 
Maconomy. 

 

Customer Creation 

The following information from the firm in Deltek CRM is used to create the customer in Maconomy. 

Deltek CRM Field Maconomy Field Notes 

 Customer No. 
(Customer.CustomerNumber) 

This comes from a Maconomy 
number series or is equal to the 
Deltek CRM company ID (depending 
on a system parameter in 
Maconomy). 

Company No./Company ID 
(CL.Client) 

Deltek CRM Customer ID 
(Customer.CRMCustomerID) 

This is the company/customer ID from 
Deltek CRM. 

Company Instance Key 
(CL.ClientID) 

Deltek CRM Customer Key 
(Customer.CRMCustomerKey) 

This is the company/customer 
instance key from Deltek CRM. 

Customer Name (CL.Name)  Name 1 (Customer.Name1)  

Primary Address 
(CLAddress.Address1)  

Name 2 (Customer.Name 2)  

Primary Address 
(CLAddress.Address2)  

Name 3 (Customer.Name 3)  

Primary Address 
(CLAddress.Address3)  

Name 4 (Customer.Name 4)  

City (CLAddress.City)  City (Customer.PostalDistrict)  

Zip (CLAddress.Zip)  Zip Code (Customer.ZipCode)  

State (CLAddress.State) Depending on setup (Country 
or Name5) 

Configuration option 

Country 
(CLAddress.Country) 

Depending on setup (Country 
or Name5) 

Configuration option 

Note: Fields integrating between Maconomy and Vantagepoint must be visible and unlocked for the 
role of the integration user. 
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Deltek CRM Field Maconomy Field Notes 

Phone (CLAddress.Phone) Phone (Customer.Telephone)  

Account Manager (UD 
employee number lookup: 
ClientCustomTabFields.cust
AccountManager) 

Account Manager 
(Customer.AccountManagerNu
mber) 

 

Custom Currency Code Currency  

Customer Creation 

The following information flows back to the CRM Firm. 

Deltek CRM Field Maconomy Field Notes 

Maconomy Customer No. 
(UD character: 
CustMaconomyCustomerN
umber) 

Customer No. 
(Customer.CustomerNumber) 

 

Customer Update 

The following information is maintained on the Firm in Deltek CRM after creation and flows back to 
Maconomy. 

Deltek CRM Field Maconomy Field Notes 

Name (CL.Name) Customer.CrmCustomerName  

ID (CL.Client) Customer.CrmCustomerId  

Address 1 
(CLAddress.Address1) 

Customer.Name2  

Address 2 
(CLAddress.Address2) 

Customer.Name3  

Address 3 
(CLAddress.Address3) 

Customer.Name4  

City (CLAddress.City) Customer.PostalDistrict  

ZIP (CLAddress.ZIP) Customer.ZIPCode  

Phone Customer.Telephone  

Fax Customer.Telefax  
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Deltek CRM Field Maconomy Field Notes 

Country 
(CLAddress.Country) 

Customer.Country (depends on 
country/state setup) 

 

State (CLAddress.State) Customer.Name5 (depends on 
country/state setup) 

 

Account Manager 
(ClientCustomTabFields.Cu
stAccountManager) 

Customer.AccountManager  

Fee and Proposal Job Creation 

This section provides information on field mapping. 

Deltek CRM Field Maconomy Field Notes 

 Job Number 
(JobHeader.JobNumber) 

From Maconomy number series 

Project Name 
(PR.LongName) + Job 
Template Name 

Job Name 
(JobHeader.JobName) 

Name of Fee/Proposal job 

 
Jobheader.CRMOpportunityKey  

Project Number 
(PR.WBS1) 

CRM Opportunity ID 
(Jobheader.CRMOpportunityID) 

 

Project Name 
(PR.LongName) 

CRM Opportunity Name 
(Jobheader.CRMOpportunityNa
me) 

 

 CRM Job Type 

(Jobheader.CRMJobType) 

Indicates job type. “Fee” if the job was 
created as a fee job and “Proposal” if 
the job was created as a proposal. 

Company No. (PR.ClientID) CRM Customer Key 
(CRMCustomerKeyVar) 

 

Organization (PR.Org) Company No. 
(JobHeader.CompanyNumber) 

 

Fee project: 

Project Currency 
(PR.ProjectCurrencyCode) 

Currency 
(JobHeader.Currency) 

The Fee Project will use the currency 
of the opportunity. 

The Proposal Project will use the 
currency of the company. 
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Deltek CRM Field Maconomy Field Notes 

Project Manager 
(PR.ProjMgr) 

Project Manager 
(JobHeader.ProjectManagerNu
mber) 

 

Start Date 

Fee job = Start Date 
(PR.EstStartDate) 

Proposal job = Start Date 
(PR.OpenDate) 

Start Date 
(JobHeader.StartingDate) 

Two different fields for Proposal and 
Fee jobs 

End Date 

End Date 
(PR.EstCompletionDate) 

Proposal Job = End Date 
(PR.EstStartDate) 

Expected Ending Date 
(JobHeader.ExpectedEndingDa
te) 

Two different fields for Proposal and 
Fee jobs 

Location Dimension 
(ProjectCustomTabFields.C
ustLocation) 

Location 
(JobHeader.LocationName) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Entity Dimension 
(ProjectCustomTabFields.C
ustEntity) 

Entity (JobHeader.EntityName) Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Project Dimension 
(ProjectCustomTabFields.C
ustProject) 

Project 
(JobHeader.ProjectName) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs. 

Purpose Dimension 
(ProjectCustomTabFields.C
ustPurpose) 

Purpose 
(JobHeader.PurposeName) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs. 

Specification 1 Dimension 
(ProjectCustomTabFields.C
ustSpecification1) 

Specification 1 
(JobHeader.Specification1Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs. 

Specification 2 Dimension 
(ProjectCustomTabFields.C
ustSpecification2) 

Specification 2 
(JobHeader.Specification2Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Specification 3 Dimension 
(ProjectCustomTabFields.C
ustSpecification3) 

Specification 3 
(JobHeader.Specification3Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Specification 4 Dimension 
(ProjectCustomTabFields.C
ustSpecification4) 

Specification 4 
(JobHeader.Specification4Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  
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Deltek CRM Field Maconomy Field Notes 

Specification 5 Dimension 
(ProjectCustomTabFields.C
ustSpecification5) 

Specification 5 
(JobHeader.Specification5Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Specification 6 Dimension 
(ProjectCustomTabFields.C
ustSpecification6) 

Specification 6 
(JobHeader.Specification6Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Specification 7 Dimension 
(ProjectCustomTabFields.C
ustSpecification7) 

Specification 7 
(JobHeader.Specification7Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Specification 8 Dimension 
(ProjectCustomTabFields.C
ustSpecification8) 

Specification 8 
(JobHeader.Specification8Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Specification 9 Dimension 
(ProjectCustomTabFields.C
ustSpecification9) 

Specification 9 
(JobHeader.Specification9Nam
e) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Specification 10 Dimension 
(ProjectCustomTabFields.C
ustSpecification10) 

Specification 10 
(JobHeader.Specification10Na
me) 

Dimensions are used only during job 
creation. No additional 
synchronization occurs.  

Template 

Fee Job = Fee Template 
(ProjectCustomTabFields.C
ustFeeJobTemplate) 

Proposal Job = Proposal 
Template 
(ProjectCustomTabFields.C
ustProposalJobTemplate) 

Job Template No. 
(JobHeader.TemplateJobNumb
er) 

 

Probability (PR.Probability) Probability % 
(JobHeader.ProbabilityPercenta
ge) 

For Fee jobs in quote only 

Proposal Job 

Deltek CRM Field Maconomy Field Notes 

Proposal Job No. 
(ProjectCustomTabFields.C
ustProposalJobNumber) 

Job Number 
(JobHeader.JobNumber) 

 

Proposal Job Name 
(ProjectCustomTabFields.C
ustProposalJobName) 

Job Name 
(JobHeader.JobName) 
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Deltek CRM Field Maconomy Field Notes 

Proposal Job Status 
(ProjectCustomTabFields.C
ustProposalJobStatus) 

Open/Closed 
(JobHeader.Closed) 

 

Proposal Job Update 

Deltek CRM Field Maconomy Field Notes 

Name (Project.Name) JobHeader.CrmOpportunityNa
me 

 

Stage (Project.Stage) JobHeader.CrmJobStage 
(Won/Lost) 

 

Fee Job 

Deltek CRM Field Maconomy Field Notes 

Client (Project.ClientID) Customer Number 
(JobHeader.CustomerNumber) 

 

Fee Job No. 
(ProjectCustomTabFields.C
ustFeeJobNumber) 

Job Number 
(JobHeader.JobNumber) 

 

Fee Job Name 
(ProjectCustomTabFields.C
ustFeeJobName) 

Job Name 
(JobHeader.JobName) 

 

Fee Job Phase 
(ProjectCustomTabFields.C
ustFeeJobPhase) 

Quote/Order 
(JobHeader.Status) 

 

Fee Job Status 
(ProjectCustomTabFields.C
ustFeeJobStatus) 

Open/Closed 
(JobHeader.Closed) 

 

Revenue (PR.Revenue) Total Budget 
(JobHeader.BudgetBillingPrice
Currency) 

Updated at job budget approval 

Currency 
(PR.ProjectCurrencyCode) 

Currency 
(JobHeader.Currency) 

Updated at job budget approval 

Fee Job State 
(ProjectCustomTabFields.C
ustFeeJobState) 

Job State 
(JobHeader.JobState) 

Updated when changed, usually upon 
job approval 
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Deltek CRM Field Maconomy Field Notes 

Date of last state change 
(ProjectCustomTabFields.C
ustStateChangedDate) 

Current Date Updated when Job State changes, 
usually upon job approval 

Start Date 
(PR.EstStartDate) 

Start Date 
(JobHeader.StartingDate) 

Updated when changed 

End Date 
(PR.EstCompletionDate) 

Expected Ending Date 
(JobHeader.ExpectedEndingDa
te) 

Updated when changed 

Project Manager 
(PR.ProjMgr) 

Project Manager 
(JobHeader.ProjectManagerNu
mber) 

Updated when changed 

Fee Job Update 

Deltek CRM Field Maconomy Field Notes 

Name (PR.LongName) JobHeader.CrmOpportunityNa
me 

 

ID 
(Opportunity.Opportunity) 

JobHeader.CrmOpportunityId  

Stage (PR.Stage) JobHeader.CrmJobStage 
(Won/Lost) 

 

Probability (PR.Probability) JobHeader.ProbabilityPercenta
ge  

Only if the Fee job is in quote 

Relationship Job Creation 

Deltek CRM Field Maconomy Field Notes 

 Job Number 
(JobHeader.JobNumber) 

From Maconomy number series 

Customer name + 
Template Job Name 

Job Name 
(JobHeader.JobName) 

 

Company No Customer No. 
(JobHeader.CustomerNumber) 

 

CustRelationshipJobOrgani
zation 

Company No. 
(JobHeader.CompanyNumber) 

 

 Currency 
(JobHeader.Currency) 

Currency is the currency of the 
Maconomy company. 
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Deltek CRM Field Maconomy Field Notes 

Relationship Job Template 
(UDF) 

(CustRelationshipJobTempl
ate) 

Job Template No. 
(JobHeader.TemplateJobNumb
er) 

 

 CRM Job Type 
(Jobheader.CRMJobType) 

Indicates job type. “Relationship” if 
the job was created as a Relationship 
job. 

Project Manager (UDF) 
(CustProjectManager) 

Project Manager 
(JobHeader.ProjectManagerNu
mber) 

 

Location Dimension 
(ClientCustomTabFields.Cu
stLocation) 

Location 
(Customer.LocationName) 

 

Entity Dimension 
(ClientCustomTabFields.Cu
stEntity) 

Entity(Customer.EntityName)  

Project Dimension 
(ClientCustomTabFields.Cu
stProject) 

Project 
(Customer.ProjectName) 

 

Purpose Dimension 
(ClientCustomTabFields.Cu
stPurpose) 

Purpose 
(Customer.PurposeName) 

 

Specification 1 Dimension 
(ClientCustomTabFields.Cu
stSpecification1) 

Specification 1 
(Customer.Specification1Name) 

 

Specification 2 Dimension 
(ClientCustomTabFields.Cu
stSpecification2) 

Specification 2 
(Customer.Specification2Name 

 

Specification 3 Dimension 
(ClientCustomTabFields.Cu
stSpecification3) 

Specification 3 
(Customer.Specification3Name 

 

Specification 4 Dimension 
(ClientCustomTabFields.Cu
stSpecification4) 

Specification 4 
(Customer.Specification4Name 

 

Specification 5 Dimension 
(ClientCustomTabFields.Cu
stSpecification5) 

Specification 5 
(Customer.Specification5Name 
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Deltek CRM Field Maconomy Field Notes 

Specification 6 Dimension 
(ClientCustomTabFields.Cu
stSpecification6) 

Specification 6 
(Customer.Specification6Name 

 

Specification 7 Dimension 
(ClientCustomTabFields.Cu
stSpecification7) 

Specification 7 
(Customer.Specification7Name 

 

Specification 8 Dimension 
(ClientCustomTabFields.Cu
stSpecification8) 

Specification 8 
(Customer.Specification8Name 

 

Specification 9 Dimension 
(ClientCustomTabFields.Cu
stSpecification9) 

Specification 9 
(Customer.Specification9Name 

 

Specification 10 Dimension 
(ClientCustomTabFields.Cu
stSpecification10) 

Specification 10 
(Customer.Specification10Nam
e 

 

Relationship Job 

Deltek CRM Field Maconomy Field Notes 

CustRelationshipJobNumbe
r 

Job Number 
(JobHeader.JobNumber) 

 

CustRelationshipJobName Job Name 
(JobHeader.JobName) 

 

CustRelationshipJobStatus Open/Closed 
(JobHeader.Closed) 

 

Employees 

Employees are created and maintained in Maconomy. 

A scheduled task synchronizes the Employee table in Deltek CRM with Maconomy data. 

During synchronization, the Terminated status is set for Employees with the Terminated Date earlier than 
the current date. 

Deltek CRM Field Maconomy Field Notes 

Employee Employee.EmployeeNumber Once Display leading zeroes is 
enabled, the employee number is 
appended with leading zeroes. 

FirstName FirstName When the Use both formal and 
preferred name on employees and 
contact persons system parameter 
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Deltek CRM Field Maconomy Field Notes 
is enabled and the Maconomy formal 
names are populated, the 
Vantagepoint Firstname, 
Middlename, and Lastname fields 
are also populated accordingly. In 
addition, the informal first name 
populates the Preferred First Name 
field in Vantagepoint. 

If the formal names are not populated 
in Maconomy, then the informal 
names populate the Vantagepoint 
name fields. 

MiddleName MiddleName  

LastName LastName  

Type N/A Always type E 

Country Employee.Country Maps the country name on the 
Maconomy employee to the country 
ISO code. 

 

Email Employee.ElectronicMailAddres
s 

 

Phone Employee.Telephone  

Status Employee.TerminationDate Status set to Terminated if the 
employee is terminated in Maconomy, 
and if the termination date ≥ current 
date in Maconomy. 

Hire Date Employee.DateEmployed  

Termination Date Employee.DateEndEmployment  

Companies 

Companies are created and maintained in Maconomy. 

A scheduled task synchronizes the Companies table in Deltek CRM with Maconomy data. 

Blocked companies in Maconomy are set to inactive in Deltek CRM. 

Maconomy to Deltek CRM: Company to CFGOrgCode 

Deltek CRM Field Maconomy Field Notes 

Code Company.CompanyNumber  
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Deltek CRM Field Maconomy Field Notes 

OrgLevel N/A Always 1 

Label Company.CompanyNumber  

Status  Type A (Active) 

If blocked in Maconomy = Type I 
(Inactive) 

Maconomy to Deltek CRM: Company to Organization 

Deltek CRM Field Maconomy Field Notes 

Org Company.CompanyNumber  

Name Company.Name1  

Status  Type A (Active) 

If blocked in Maconomy = Type I 
(Inactive) 

Dimensions 

Dimensions are created and maintained in Maconomy. 

You can configure synchronization of the Maconomy dimensions Location, Entity, Project, Purpose, 
Specification 1 - Specification 10 with corresponding user-defined tables for the opportunity in Deltek 
CRM. 

Blocked dimensions in Maconomy are marked as blocked in Deltek CRM. 

Maconomy to Deltek CRM 

Deltek CRM Field Maconomy Field Notes 

CustNumber Name  

CustName Description  

CustBlocked Blocked If Blocked = [Blocked] 

Otherwise = “ “ (single whitespace) 

Job Templates 

Job Templates are created and maintained in Maconomy. 

A background task synchronizes the Job Templates table in Maconomy with the corresponding user-
defined table in Deltek CRM. 
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Maconomy to Deltek CRM 

Deltek CRM Field Maconomy Field Notes 

CustNumber Job Number 
(JobHeader.JobNumber) 

 

CustName Job Name 
(JobHeader.JobName) 

 

CustCompanyNumber [ + Company Number + ] 
(JobHeader.CompanyNumber) 

 

Common Errors 
The following are common errors that you might encounter during integration between Deltek CRM and 
Maconomy. 

Functional Application Errors 

Error: The Create Customer from Deltek CRM task or Create Job from Deltek CRM task can fail due to 
wrong data being entered on the job or customer. 

Resolution: Find the error in the Result Log tab in the Background Task and adjust the data to avoid that 
error. 

Setup Errors 

Error: The task generated by CRM_ImportOpportunities can fail due to setup errors, such as wrong 
Deltek CRM IP; wrong currency code setup. 

Resolution: In this case, the task that runs the action Create Jobs from Deltek CRM Opportunities action 
fails and there are no job and customer creation tasks created. Find the error in the Result Log tab in the 
Background Task. 

Create Jobs from Deltek CRM Opportunities Does Not Create Any Background Tasks and Does Not 
Show Any Status Message 

Error: It can happen that the Create Jobs from Deltek CRM Opportunities action does not give a status 
message, and it looks as if it does not do anything. 

Resolution: Check coupling service logs. One of the reasons can be that the user does not have access 
to the BackgroundTaskLogging and ScheduledBackgroundTasks windows. 

User-Defined Hubs and Elements 
This section lists user-defined hubs (UDHs) and elements created in Deltek CRM. 

The following templates enable integration with Maconomy: 

• Proposal Templates, UDIC_ProposalTemplate 

• Fee Templates, UDIC_FeeTemplate 

• Relationship Templates, UDIC_RelationshipTemplate 
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Required Fields 

This section provides information on required fields and user-defined hubs to enable dimension 
synchronization in CRM. 

Label Internal Label Type 

Name CustName Name 

Number CustNumber Number 

Company Number CustCompanyNumber Name 

The following UDHs enable dimension synchronization: 

1. Locations, UDIC_Location 

2. Entities, UDIC_Entity 

3. Projects (Maconomy), UDIC_Project 

4. Purposes, UDIC_Purpose 

5. Specification 1s, UDIC_Specification1 

6. Specification 2s, UDIC_Specification2 

7. Specification 3s, UDIC_Specification3 

8.  Specification 4s, UDIC_Specification4 

9. Specification 5s, UDIC_Specification5 

10. Specification 6s, UDIC_Specification6 

11. Specification 7s, UDIC_Specification7 

12. Specification 8s, UDIC_Specification8 

13. Specification 9s, UDIC_Specification9 

14. Specification 10s, UDIC_Specification10 

Required Fields 

This section provides information on required fields for CRM. 

Label Internal Label Type 

Name CustName Name 

Number CustNumber Number 

Blocked CustBlocked Name 

User-Defined Elements 

These three opportunity user-defined elements are found on the Maconomy tab (CustTab_web1): 

1. Proposal Job 

2. Fee Job 
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3. Maconomy Dimensions 

 
Opportunity User-Defined Elements 

These section provides information on user-defined elements related to opportunities. 

Label Internal Label Type Notes 

Proposal Job CustDivider1 Divider Line 
 

Proposal Job 
Template 

CustProposalJobTemplate Proposal 
Template 
(UDH) 

 

Create Proposal Job CustCreateProposalJob Checkbox 
 

Proposal Job 
Number 

CustProposalJobNumber Character Locked for all roles 

Proposal Job Name CustProposalJobName Character Locked for all roles 

Proposal Job Status CustProposalJobStatus Dropdown Change Codes to 

0 (Open) 
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Label Internal Label Type Notes 
1 (Closed) 

Locked for all roles 

Fee Job CustDivider2 Divider Line 
 

Fee Job Template CustFeeJobTemplate Fee Template 
(UDH) 

 

Create Fee Job CustCreateFeeJob Checkbox 
 

Fee Job Number CustFeeJobNumber Character Locked for all roles 

Fee Job Name CustFeeJobName Character Locked for all roles 

Fee Job Phase CustFeeJobPhase Dropdown Change Codes to 

0 (Quote) 

1 (Order) 

Locked for all roles 

Fee Job Status CustFeeJobStatus Dropdown Change Codes to 

0 (Open) 

1 (Closed) 

Locked for all roles 

Fee Job State CustFeeJobState Character Locked for all roles 

State Changed Date CustStateChangedDate Date Locked for all roles 

Maconomy 
Dimensions 

CustDivider3 Divider Line 
 

Location Dimension CustLocation Location 
(UDH) 

 

Entity Dimension CustEntity Entity (UDH) 
 

Project Dimension CustProject Project (UDH) 
 

Purpose Dimension CustPurpose Purpose 
(UDH) 

 

Specification 1 
Dimension 

CustSpecification1 Specification 
1 (UDH) 

 

Specification 2 
Dimension 

CustSpecification2 Specification 
2 (UDH) 
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Label Internal Label Type Notes 

Specification 3 
Dimension 

CustSpecification3 Specification 
3 (UDH) 

 

Specification 4 
Dimension 

CustSpecification4 Specification 
4 (UDH) 

 

Specification 5 
Dimension 

CustSpecification5 Specification 
5 (UDH) 

 

Specification 6 
Dimension 

CustSpecification6 Specification 
6 (UDH) 

 

Specification 7 
Dimension 

CustSpecification7 Specification 
7 (UDH) 

 

Specification 8 
Dimension 

CustSpecification8 Specification 
8 (UDH) 

 

Specification 9 
Dimension 

CustSpecification9 Specification 
9 (UDH) 

 

Specification 10 
Dimension 

CustSpecification10 Specification 
10 (UDH) 

 

Fields to Support 
Workflow 

CustDivider4 Divider Line Hide this divider for 
all security roles. 
The fields under it 
are used for 
workflow only. 

Workflow Blocked 
Location 

CustWorkflowBlockedLocatio
n 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Entity 

CustWorkflowBlockedEntity Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Project 

CustWorkflowBlockedProject Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Purpose 

CustWorkflowBlockedPurpos
e 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 
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Label Internal Label Type Notes 

Workflow Blocked 
Specification 1 

CustWorkflowBlockedSpecific
ation1 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 2 

CustWorkflowBlockedSpecific
ation2 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 3 

CustWorkflowBlockedSpecific
ation3 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 4 

CustWorkflowBlockedSpecific
ation4 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 5 

CustWorkflowBlockedSpecific
ation5 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 6 

CustWorkflowBlockedSpecific
ation6 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 7 

CustWorkflowBlockedSpecific
ation7 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 8 

CustWorkflowBlockedSpecific
ation8 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 9 

CustWorkflowBlockedSpecific
ation9 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

Workflow Blocked 
Specification 10 

CustWorkflowBlockedSpecific
ation10 

Checkbox Hide this field for all 
security roles. This 
field is used for a 
workflow process. 

These Firm user-defined elements are found in Maconomy (CustTab_web1): 
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1. Maconomy Customer Information 

2. Relationship Job 

3. Maconomy Dimensions 

 
Firm User-Defined Elements 

This section provides information on user-defined elements related to firms. 

Label Internal Label Type Notes 

Maconomy 
Customer 
Information 

CustDivider3 Divider Line This is not required 
for the integration 
but is included on 
the tab to group 
fields. 

Account 
Manager 

CustAccountManager Employee 
 

Create 
Maconomy 
Customer 

CustCreateMaconomyCustomer Checkbox 
 

Customer 
Number 

CustMaconomyCustomerNumber Character Locked for all roles 
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Label Internal Label Type Notes 

Relationship Job CustDivider1 Divider Line This is not required 
for the integration 
but is included on 
the tab to group 
fields. 

Relationship Job 
Template 

CustRelationshipJobTemplate Relationship 
Template 

 

Project Manager CustProjectManager Employee 
 

Relationship Job 
Organization 

CustRelationshipJobOrganization Organization 
 

Create 
Relationship Job 

CustCreateRelationshipJob Checkbox 
 

Relationship Job 
Number 

CustRelationshipJobNumber Character Locked for all roles 

Relationship Job 
Name 

CustRelationshipJobName Character Locked for all roles 

Relationship Job 
Status 

CustRelationshipJobStatus Dropdown 
list 

Change Codes to 

0 (Open) 

1 (Closed) 

Locked for all roles 

Maconomy 
Dimensions 

CustDivider2 Divider Line This is not required 
for the integration 
but is included on 
the tab to group 
fields. 

Location 
Dimension 

CustLocation Location 
(UDH) 

 

Entity 
Dimension 

CustEntity Entity (UDH) 
 

Project 
Dimension  

CustProject Project 
(UDH)  

 

Purpose 
Dimension 

CustPurpose Purpose 
(UDH)  

 

Specification 1 
Dimension 

CustSpecification1 Specification 
1 (UDH) 
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Label Internal Label Type Notes 

Specification 2 
Dimension 

CustSpecification2 Specification 
2 (UDH)  

 

Specification 3 
Dimension 

CustSpecification3 Specification 
3 (UDH) 

 

Specification 4 
Dimension 

CustSpecification4 Specification 
4 (UDH) 

 

Specification 5 
Dimension 

CustSpecification5 Specification 
5 (UDH) 

 

Specification 6 
Dimension 

CustSpecification6 Specification 
6 (UDH) 

 

Specification 7 
Dimension 

CustSpecification7 Specification 
7 (UDH) 

 

Specification 8 
Dimension 

CustSpecification8 Specification 
8 (UDH) 

 

Specification 9 
Dimension 

CustSpecification9 Specification 
9 (UDH) 

 

Specification 10 
Dimension 

CustSpecification10 Specification 
10 (UDH) 

 

Fields to 
Support 
Workflow 

CustDivider4 Divider Line Hide this divider for 
all security roles. 
The fields under it 
are used for 
workflow only. 

Workflow 
Blocked 
Location 

CustWorkflowBlockedLocation Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked Entity 

CustWorkflowBlockedEntity Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked Project 

CustWorkflowBlockedProject Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 
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Label Internal Label Type Notes 

Workflow 
Blocked 
Purpose 

CustWorkflowBlockedPurpose Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 1 

CustWorkflowBlockedSpecification1 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 2 

CustWorkflowBlockedSpecification2 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 3 

CustWorkflowBlockedSpecification3 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 4 

CustWorkflowBlockedSpecification4 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 5 

CustWorkflowBlockedSpecification5 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 6 

CustWorkflowBlockedSpecification6 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 7 

CustWorkflowBlockedSpecification7 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 8 

CustWorkflowBlockedSpecification8 Checkbox Hide this field for 
all security roles. 
This field is used 



Integrations 

System Admin Guide 282 

 

Label Internal Label Type Notes 
for a workflow 
process. 

Workflow 
Blocked 
Specification 9 

CustWorkflowBlockedSpecification9 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Workflow 
Blocked 
Specification 10 

CustWorkflowBlockedSpecification10 Checkbox Hide this field for 
all security roles. 
This field is used 
for a workflow 
process. 

Project Flow Validations 
This section lists information on the validation used by the preconfigured workflows. 

Cannot Change Create Proposal Job if Job Already Exists 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Cannot 
change create 
proposal job if 
job already 
exists 

OpportunityCustomTabFields.CustCreateProposal
Job has changed 

 

Action Description Action Conditions 

Validate 
Error 

A proposal job already 
exists in Maconomy. Create 
Proposal Job cannot be 
changed. 

OpportunityCustomTabFields.CustProposalJobNu
mber (Old) not empty 

Cannot Change Create Fee Job if Job Already Exists 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Cannot 
change create 
fee job if job 
already exists 

OpportunityCustomTabFields.CustCreateFeeJob 
has changed 
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Action Description Action Conditions 

Validate 
Error 

A fee job already exists in 
Maconomy. Create Fee Job 
cannot be changed. 

OpportunityCustomTabFields.CustFeeJobNumber 
(Old) not empty 

Cannot Change Create Proposal Job to Yes if PM Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Project 
Manager is 
required to 
create 
proposal job 
(Change) 

Create Proposal Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Project Manager is 
required to create a 
proposal job. 

Project Manager empty 

Cannot Add Project with Create Proposal Job Equal to Yes if PM Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Insert Project Manager 
is required to 
create proposal 
job (Add) 

Create Proposal Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Project Manager is required 
to create a proposal job. 

Project Manager empty 

Cannot Change Create Proposal Job to Yes if Org Empty 

This section provides information on a validation error. 
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Workflo
w Table 

Type Description Workflow Conditions 

Project Change Organization is 
required to create 
proposal job 
(Change) 

Create Proposal Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Organization is required to 
create a proposal job. 

Organization empty 

Cannot Add Project with Create Proposal Job Equal to Yes if Org Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Organization is 
required to 
create proposal 
job (Change) 

Create Proposal Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Organization is required to 
create a proposal job. 

Organization empty 

Cannot Change Create Proposal Job to Yes if Proposal Job Template Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Proposal Job 
Template is 
required to 
create proposal 
job (Change) 

Create Proposal Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Proposal Job Template is 
required to create a 
proposal job. 

Proposal Job Template empty 
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Cannot Add Opportunity with Create Proposal Job Equal to Yes if Proposal Job Template Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Insert Proposal Job 
Template is 
required to 
create proposal 
job (Add) 

Create Proposal Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Proposal Job Template is 
required to create a 
proposal job. 

Proposal Job Template empty 

Cannot Change Create Fee Job to Yes if Proposal Job Template Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Fee Job 
Template is 
required to 
create fee job 
(Change) 

Create Fee Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Fee Job Template is 
required to create a fee 
job. 

Fee Job Template empty 

Cannot Add Project with Create Proposal Job Equal to Yes if Proposal Job Template Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Insert Fee Job 
Template is 
required to 
create proposal 
job (Add) 

Create Fee Job equals Yes 
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Action Description Action Conditions 

Validate 
Error 

Fee Job Template is 
required to create a fee job. 

OpportunityCustomTabFields.CustFeeJobTemplat
e empty 

Cannot Change Create Fee Job to Yes if PM Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Project Manager 
is required to 
create fee job 
(Change) 

Fee Job Template empty 

 

Action Description Action Conditions 

Validate 
Error 

Project Manager is 
required to create a fee 
job. 

Opportunity.ProjMgr empty 

Cannot Add Opportunity with Create Fee Job Equal to Yes if PM Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Insert Project 
Manager is 
required to 
create fee job 
(Add) 

Create Fee Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Project Manager is 
required to create a fee 
job. 

Project Manager empty 

Cannot Change Create Fee Job to Yes if Org Empty 

This section provides information on a validation error. 
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Workflow 
Table 

Type Description Workflow Conditions 

Project Change Organization is 
required to 
create a fee job. 

Create Fee Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Organization is required to 
create a fee job. 

Organization empty 

Cannot Add Opportunity with Create Fee Job Equal to Yes if Org Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Insert Organization is 
required to 
create fee job 
(Add) 

Create Fee Job equals Yes 

 

Action Description Action Conditions 

Validate 
Error 

Organization is required to 
create a fee job. 

Organization empty 

Cannot Change Primary Client, Organization, Currency, Estimate Start and End Dates, Project 
Manager, Dimensions or Template Job After Proposal Job Created 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Key fields are 
closed once a 
proposal job has 
been created 

Proposal Job Number not empty 

 

Action Description Action Conditions 

Validate 
Error 

The following fields cannot 
be changed once a 
Maconomy job has been 
created: 

• Primary Client 

Project Currency Code has changed OR 

Estimated Start Date has changed OR 

Estimated Completion has changed OR 

Project Manager has changed OR 
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Action Description Action Conditions 

• Organization 

• Currency 

• Estimate Start and 
End Dates 

• Project Manager 

• Dimensions 

• Template Job 

Location Dimension has changed OR 

Entity Dimension has changed OR 

Project Dimension  has changed OR 

Purpose Dimension has changed OR 

Specification 1 Dimension has changed OR 

Specification 2 Dimension has changed OR 

Specification 3 Dimension has changed OR 

Specification 4 Dimension has changed OR 

Specification 5 Dimension has changed OR 

Specification 6 Dimension has changed OR 

Specification 7 Dimension has changed OR 

Specification 8 Dimension has changed OR 

Specification 9 Dimension has changed OR 

Specification 10 Dimension has changed 

Cannot Change Primary Client, Organization, Currency, Estimate Start and End Dates, Project 
Manager, Dimensions or Template Job After Fee Job Created 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Project Change Key fields are 
closed once a 
fee job has 
been created 

Fee Job Number not empty 

 

Action Description Action Conditions 

Validate 
Error 

The following fields cannot 
be changed once a 
Maconomy job has been 
created: 

• Primary Client 

• Organization 

• Currency 

• Estimate Start and 
End Dates 

• Project Manager 

Primary Client has changed OR 

Organization has changed OR 

Project Currency Code has changed OR 

Estimated Start Date has changed OR 

Estimated Completion has changed OR 

Project Manager has changed OR 

Location Dimension has changed OR 

Entity Dimension has changed OR 

Project Dimension  has changed OR 
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Action Description Action Conditions 

• Dimensions 

• Template Job 

Purpose Dimension has changed OR 

Specification 1 Dimension has changed OR 

Specification 2 Dimension has changed OR 

Specification 3 Dimension has changed OR 

Specification 4 Dimension has changed OR 

Specification 5 Dimension has changed OR 

Specification 6 Dimension has changed OR 

Specification 7 Dimension has changed OR 

Specification 8 Dimension has changed OR 

Specification 9 Dimension has changed OR 

Specification 10 Dimension has changed 

Cannot Add Firm with Create Maconomy Customer or Create Relationship Job Checked if PM 
Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Project Manager 
is required to 
create a 
Maconomy 
customer or 
relationship job 
(Add) 

 

 

Action Description Action Conditions 

Validate  

Error 

Project Manager is 
required to create a 
Maconomy customer. 

ClientCustomTabFields.CustCreateMaconomyCus
tomer equals Y AND 

ClientCustomTabFields.CustProject Manager 
empty 

Cannot Change Firm with Create Maconomy Customer or Create Relationship Job Checked if PM 
Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Project Manager 
is required to 
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Workflow 
Table 

Type Description Workflow Conditions 

create a 
Maconomy 
customer or 
relationship job 
(Change) 

 

Action Description Action Conditions 

Validate  

Error 

Project Manager is 
required to create a 
Maconomy customer. 

ClientCustomTabFields.CustCreateMaconomyCus
tomer equals Y AND 

ClientCustomTabFields.CustProject Manager 
empty 

Validate 
Error 

Project Manager is 
required to create a 
relationship job. 

ClientCustomTabFields.CustCreateRelationshipJo
b equals Y AND 

ClientCustomTabFields.CustProject Manager 
empty 

Cannot Add Firm with Create Maconomy Customer or Create Relationship Job Checked if 
Organization Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Organization is 
required to 
create a 
Maconomy 
customer or 
relationship job 
(Add) 

 

 

Action Description Action Conditions 

Validate  

Error 

Organization is required to 
create a Maconomy 
customer. 

ClientCustomTabFields.CustCreateMaconomyCus
tomer equals Y AND 

ClientCustomTabFields.CustRelationshipJobOrga
nization empty 

Validate 
Error 

Organization is required to 
create a relationship job. 

ClientCustomTabFields.CustCreateRelationshipJo
b equals Y AND 

ClientCustomTabFields.CustRelationshipJobOrga
nization empty 
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Cannot Change Firm with Create Maconomy Customer or Create Relationship Job Checked if 
Organization Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Organization is 
required to 
create a 
Maconomy 
customer or 
relationship job 
(Change) 

 

 

Action Description Action Conditions 

Validate  

Error 

Organization is required to 
create a Maconomy 
customer. 

ClientCustomTabFields.CustCreateMaconomyCus
tomer equals Y AND 

ClientCustomTabFields.CustRelationshipJobOrga
nization empty 

Validate  

Error 

Organization is required to 
create a relationship job. 

ClientCustomTabFields.CustCreateRelationshipJo
b equals Y AND 

ClientCustomTabFields.CustRelationshipJobOrga
nization empty 

Cannot Change Relationship Job Organization or Project Manager on Firm if Relationship Job Has 
Been Created 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Key fields are 
closed once a 
relationship 
job has been 
created 

ClientCustomTabFields.CustRelationshipJobNumber 
not empty 

 

Action Description Action Conditions 

Validate  

Error 

Relationship Job 
Organization and Project 
Manager cannot be 
changed after a 
Maconomy job is created. 

ClientCustomTabFields.CustRelationshipJobOrganiz
ation has changed OR 

ClientCustomTabFields.CustProjectManager has 
changed 
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Cannot Select Blocked Entities when Adding a Project 

This section provides information on a validation error. 

Workflow Table Type Level Description Workflow Conditions 

Project Insert Project Blocked Entities cannot 
be selected (Add) 

 

 

Action Level Column (Field) Change Properties 

Column (Field) 
Change 

Project Column: Workflow Blocked Entity 
New Value SQL Expression: 
If this is True: (select custBlocked from UDIC_Entity where 
UDIC_UID='[:ProjectCustomTabFields.custEntity]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Cannot Select Blocked Entities when Editing a Project 

This section provides information on a validation error. 
Workflow Table Type Level Description Workflow Conditions 

Project Change Project Blocked Entities cannot 
be selected (Change) 

 

 

Action Level Column (Field) Change 
Properties 

Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow 
Blocked Entity  
New Value SQL 
Expression: 
If this is True: (select 
custBlocked from 
UDIC_Entity where 
UDIC_UID='[:ProjectCust
omTabFields.custEntity]')
='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This 
Calculation: 'N' 

Test if 
blocked 
Entity was 
selected 

Entity Dimension not 
empty AND 
Entity Dimension has 
changed 

Validate 
Error 

  
You've 
chosen a 

Workflow Blocked Entity 
equals Yes 
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Action Level Column (Field) Change 
Properties 

Description Action Conditions 

blocked 
Entity. 
Please 
select a 
different 
Entity. 

Cannot Select Blocked Locations when Adding a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow Conditions 

Project Insert Project Blocked Locations cannot be 
selected (Add) 

 

 

Action Level Column (Field) Change 
Properties 

Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow 
Blocked Location 
New Value SQL 
Expression: 
If this is True: (select 
custBlocked from 
UDIC_Location where 
UDIC_UID='[:ProjectCust
omTabFields.custLocatio
n]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This 
Calculation: 'N' 

Test if 
blocked 
Location 
was 
selected 

Location Dimension not 
empty 

Workflow Blocked 
Location equals Yes 

Cannot Select Blocked Locations when Editing a Project 

This section provides information on a validation error. 
Workflow 
Table 

Type Level Description Workflow Conditions 

Project Change Project Blocked Locations cannot 
be selected (Change) 
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Action Level Column (Field) Change 
Properties 

Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow 
Blocked Location 
New Value SQL 
Expression: 
If this is True: (select 
custBlocked from 
UDIC_Entity where 
UDIC_UID='[:ProjectCust
omTabFields.custEntity]')
='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This 
Calculation: 'N' 

Test if 
blocked 
Location 
was 
selected 

Location Dimension not 
empty AND 
Location Dimension has 
changed 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Location. 
Please 
select a 
different 
Location. 

Workflow Blocked 
Location equals Yes 

Cannot Select Blocked Projects when Adding a Project 

This section provides information on a validation error. 
Workflow 
Table 

Type Level Description Workflow Conditions 

Project Insert Project Blocked Projects cannot 
be selected (Add) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Project 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Project where 
UDIC_UID='[:ProjectCustomTabFields.
CustProject]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Project 
Dimension 
was selected 

Project 
Dimension 
not empty 
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Action Level Column (Field) Change Properties Description Action 
Conditions 

Validate 

Error 
Project 

 
You've 
chosen a 
blocked 
Project 
Dimension. 
Please select 
a different 
Project 
Dimension. 

Workflow 
Blocked 
Project 
equals Yes 

Cannot Select Blocked Projects when Editing a Project 

This section provides information on a validation error. 
Workflow Table Type Level Description Workflow 

Conditions 

Project Change Project Blocked Projects cannot be 
selected (Change) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Project 
New Value SQL Expression: 
If this is True: (select custBlocked 
from UDIC_Project where 
UDIC_UID='[:ProjectCustomTabFiel
ds.CustProject]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Project was 
selected 

Project 
Dimension 
not empty 
AND 
Project 
Dimension 
has 
changed 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Project 
Dimension. 
Please select 
a different 
Project 
Dimension. 

Workflow 
Blocked 
Project 
equals Yes 

Cannot Select Blocked Purposes when Adding a Project 

This section provides information on a validation error. 
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Workflow 
Table 

Type Level Description Workflow Conditions 

Project Insert Project Blocked Purposes cannot 
be selected (Add) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Purpose 
New Value SQL Expression: 
If this is True: (select custBlocked 
from UDIC_Purpose where 
UDIC_UID='[:ProjectCustomTabFiel
ds.CustPurpose]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Purpose was 
selected 

Purpose 
Dimension 
not empty 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Purpose. 
Please select 
a different 
Purpose. 

Workflow 
Blocked 
Purpose 
equals Yes 

Cannot Select Blocked Purposes when Editing a Project 

This section provides information on a validation error. 

Workflow Table Type Level Description Workflow 
Conditions 

Project Change Project Blocked Purposes cannot be 
selected (Change) 

 

 

Action Level Column (Field) Change 
Properties 

Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Purpose 
New Value SQL Expression: 
If this is True: (select 
custBlocked from 
UDIC_Purpose where 
UDIC_UID='[:ProjectCustomT

Test if 
blocked 
Purpose was 
selected 

Purpose Dimension 
not empty AND 

Purpose Dimension 
has changed 
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Action Level Column (Field) Change 
Properties 

Description Action Conditions 

abFields.CustPurpose]')='[BLO
CKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This 
Calculation: 'N' 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Purpose. 
Please select 
a different 
Purpose. 

Workflow Blocked 
Purpose equals Yes 

Cannot Select Blocked Specification 1s when Adding a Project 

This section provides information on a validation error. 

Workflow Table Type Level Description Workflow Conditions 

Project Insert Project Blocked Specification 1 cannot 
be selected (Add) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 1 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification1 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification1]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 1 
was selected 

Specification 1 
Dimension not 
empty 

Validate 
Error 

Project  You've chosen 
a blocked 
Specification 
1. Please 
select a 
different 
Specification 
1. 

Workflow 
Blocked 
Specification 1 
equals Yes 
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Cannot Select Blocked Specification 1s when Editing a Project 

This section provides information on a validation error. 

Workflow Table Type Level Description Workflow 
Conditions 

Project Change Project Blocked Specification 1 cannot be 
selected (Change) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Specification 
1 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification1 where 
UDIC_UID='[:ProjectCustomTabFields.C
ustSpecification1]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specification 
1 was 
selected 

Specification 1 
Dimension not 
empty AND 
Specification 1 
Dimension has 
changed 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Specification 
1. Please 
select a 
different 
Specification 
1. 

Workflow 
Blocked 
Specification 1 
equals Yes 

Cannot Select Blocked Specification 2s when Adding a Project 

This section provides information on a validation error. 

Workflow Table Type Level Description Workflow 
Conditions 

Project Insert Projec
t 

Blocked Specification 2 cannot be 
selected (Add) 
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Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Specification 2 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification2 where 
UDIC_UID='[:ProjectCustomTabFields.Cus
tSpecification2]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specification 
2 was 
selected 

Specification 
2 Dimension 
not empty 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Specification 
2. Please 
select a 
different 
Specification 
2. 

Workflow 
Blocked 
Specification 
2 equals 
Yes 

Cannot Select Blocked Specification 2s when Editing a Project 

This section provides information on a validation error. 

Workflow Table Type Level Description Workflow Conditions 

Project Change Project Blocked Specification 2 
cannot be selected 
(Change) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Projec
t 

Column: Workflow Blocked Specification 2 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification2 where 
UDIC_UID='[:OpportunityCustomTabFields.
CustSpecification2]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 2 
was selected 

Specification 
2 Dimension 
not empty 
AND 
Specification 
2 Dimension 
has changed 

Validate 
Error 

Projec
t 

 
You've chosen 
a blocked 
Specification 

Workflow 
Blocked 
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Action Level Column (Field) Change Properties Description Action 
Conditions 

2. Please 
select a 
different 
Specification 
2. 

Specification 
2 equals Yes 

Cannot Select Blocked Specification 3s when Adding an Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow Conditions 

Project Insert Project Blocked Specification 3 cannot be 
selected (Add) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Specification 
3 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification3 where 
UDIC_UID='[:ProjectCustomTabFields.Cu
stSpecification3]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 3 
was selected 

Specification 
3 Dimension 
not empty 

Validate 
Error 

Project 
 

You've chosen a 
blocked 
Specification 3. 
Please select a 
different 
Specification 3. 

Workflow 
Blocked 
Specification 
3 equals 
Yes 

Cannot Select Blocked Specification 3s when Editing an Project 

This section provides information on a validation error. 

Workflow Table Type Level Description Workflow 
Conditions 

Project Change Project Blocked Specification 3 cannot be 
selected (Change) 

 

 



Integrations 

System Admin Guide 301 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 3 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification3 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification3]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specification 
3 was 
selected 

Specification 3 
Dimension not 
empty AND 
Specification 3 
Dimension has 
changed 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Specification 
3. Please 
select a 
different 
Specification 
3. 

Workflow Blocked 
Specification 3 
equals Yes 

Cannot Select Blocked Specification 4s when Adding a Project 

This section provides information on a validation error. 
Workflow Table Type Level Description Workflow Conditions 

Project Insert Project Blocked Specification 4 cannot be 
selected (Add) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Specification 4 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification4 where 
UDIC_UID='[:ProjectCustomTabFields.CustS
pecification4]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 4 
was selected 

Specification 4 
Dimension not 
empty 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 4. 
Please select a 

Workflow 
Blocked 
Specification 4 
equals Yes 
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Action Level Column (Field) Change Properties Description Action 
Conditions 

different 
Specification 4. 

Cannot Select Blocked Specification 4s when Editing a Project 
This section provides information on a validation error. 
Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Change Project Blocked Specification 4 cannot be selected 
(Change) 

 

 

Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Specification 4  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification4 where 
UDIC_UID='[:ProjectCustomTabFields.CustSpecifi
cation4]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specification 
4 was 
selected 

Specificatio
n 4 
Dimension 
not empty 
AND 
Specificatio
n 4 
Dimension 
has 
changed 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Specification 
4. Please 
select a 
different 
Specification 
4. 

Workflow 
Blocked 
Specificatio
n 4 equals 
Yes 

Cannot Select Blocked Specification 5s when Adding a Project 

This section provides information on a validation error. 
Workflow 
Table 

Type Level Description Workflow Conditions 

Project Insert Project Blocked Specification 5 cannot be 
selected (Add) 
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Action Level Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked Specification 5 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification5 where 
UDIC_UID='[:ProjectCustomTabFields.CustSpe
cification5dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specification 
5 was 
selected 

Specificatio
n 5 
Dimension 
not empty 

Validate 
Error 

Project 
 

You've 
chosen a 
blocked 
Specification 
5. Please 
select a 
different 
Specification 
5. 

Workflow 
Blocked 
Specificatio
n 5 equals 
Yes 

Cannot Select Blocked Specification 5s when Editing a Project 

This section provides information on a validation error. 
Workflow 
Table 

Type Level Description Workflow Conditions 

Project Change Project Blocked Specification 5 cannot be 
selected (Change) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 5 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification5 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification5Dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 5 
was selected 

Specification 5 
Dimension not 
empty AND 
Specification 5 
Dimension has 
changed 
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Action Level Column (Field) Change Properties Description Action Conditions 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
5. Please 
select a 
different 
Specification 
5. 

Workflow Blocked 
Specification 5 
equals Yes 

Cannot Select Blocked Specification 6s when Adding a Project 

This section provides information on a validation error. 
Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Insert Project Blocked Specification 6 cannot be selected 
(Add) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 6  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification6 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification6dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 6 
was selected 

Specification 6 
Dimension not 
empty 

Validate 
Error 

Project  You've chosen 
a blocked 
Specification 
6. Please 
select a 
different 
Specification 
6. 

Workflow Blocked 
Specification 6 
equals Yes 

Cannot Select Blocked Specification 6s when Editing a Project 

This section provides information on a validation error. 
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Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Change Project Blocked Specification 6 cannot be selected 
(Change) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 6 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification6 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification6Dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 6 
was selected 

Specification 6 
Dimension not 
empty AND 
Specification 6 
Dimension has 
changed 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
6. Please 
select a 
different 
Specification 
6. 

Workflow Blocked 
Specification 6 
equals Yes 

Cannot Select Blocked Specification 7s when Adding a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Insert Project Blocked Specification 7 cannot be selected 
(Add) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 7  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification7 where 

Test if blocked 
Specification 7 
was selected 

Specification 7 
Dimension not 
empty 
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Action Level Column (Field) Change Properties Description Action Conditions 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification7dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Validate 
Error 

Project  You've chosen 
a blocked 
Specification 
7. Please 
select a 
different 
Specification 
7. 

Workflow Blocked 
Specification 7 
equals Yes 

Cannot Select Blocked Specification 7s when Editing a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Change Project Blocked Specification 7 cannot be selected 
(Change) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 7 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification7 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification7Dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 7 
was selected 

Specification 7 
Dimension not 
empty AND 
Specification 7 
Dimension has 
changed 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
7. Please 
select a 
different 
Specification 
7. 

Workflow Blocked 
Specification 7 
equals Yes 
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Cannot Select Blocked Specification 8s when Adding a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Insert Project Blocked Specification 8 cannot be selected 
(Add) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 8 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification8 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification8dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 8 
was selected 

Specification 8 
Dimension not 
empty 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
8. Please 
select a 
different 
Specification 
8. 

Workflow Blocked 
Specification 8 
equals Yes 

Cannot Select Blocked Specification 8s when Editing a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Change Project Blocked Specification 8 cannot be selected 
(Change) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 8 

Test if blocked 
Specification 8 
was selected 

Specification 8 
Dimension not 
empty AND 
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Action Level Column (Field) Change Properties Description Action Conditions 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification8 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification8Dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Specification 8 
Dimension has 
changed 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
8. Please 
select a 
different 
Specification 
8. 

Workflow Blocked 
Specification 8 
equals Yes 

Cannot Select Blocked Specification 9s when Adding a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Insert Project Blocked Specification 9 cannot be selected 
(Add) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 9  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification9 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification9dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 9 
was selected 

Specification 9 
Dimension not 
empty 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
9. Please 
select a 

Workflow Blocked 
Specification 9 
equals Yes 
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Action Level Column (Field) Change Properties Description Action Conditions 
different 
Specification 
9. 

Cannot Select Blocked Specification 9s when Editing a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Change Project Blocked Specification 9 cannot be selected 
(Change) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 9  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification9 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification9Dimension]')='[BLOC
KED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 9 
was selected 

Specification 9 
Dimension not 
empty AND 
Specification 9 
Dimension has 
changed 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
9. Please 
select a 
different 
Specification 
9. 

Workflow Blocked 
Specification 9 
equals Yes 

Cannot Select Blocked Specification 10s when Adding a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Insert Project Blocked Specification 10 cannot be selected 
(Add) 
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Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 10 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification10 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification10dimension]')='[BLO
CKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 
10 was 
selected 

Specification 10 
Dimension not 
empty 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
10. Please 
select a 
different 
Specification 
10. 

Workflow Blocked 
Specification 10 
equals Yes 

Cannot Select Blocked Specification 10s when Editing a Project 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow 
Conditions 

Project Change Project Blocked Specification 10 cannot be 
selected (Change) 

 

 

Action Level Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Project Column: Workflow Blocked 
Specification 10  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification10 where 
UDIC_UID='[:ProjectCustomTabFields.
CustSpecification10Dimension]')='[BLO
CKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 
10 was 
selected 

Specification 10 
Dimension not 
empty AND 
Specification 10 
Dimension has 
changed 
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Action Level Column (Field) Change Properties Description Action Conditions 

Validate 
Error 

Project 
 

You've chosen 
a blocked 
Specification 
10. Please 
select a 
different 
Specification 
10. 

Workflow Blocked 
Specification 10 
equals Yes 

Cannot Select Blocked Entities when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Entities cannot be selected 
(Add) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedEntity  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Entity where 
UDIC_UID='[:ClientCustomTabFields.cu
stEntity]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Entity was 
selected 

ClientCustomTabFields.Cu
stEntity not empty 

Validate 
Error 

 
You've chosen a 
blocked Entity. 
Please select a 
different Entity. 

ClientCustomTabFields.Cu
stWorkflowBlockedEntity 
equals Y 

Cannot Select Blocked Entities when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Entities cannot be selected 
(Change) 
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Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedEntity  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Entity where 
UDIC_UID='[:ClientCustomTabFields.cu
stEntity]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Entity was 
selected 

ClientCustomTabFields.Cu
stEntity not empty AND 

ClientCustomTabFields.Cu
stEntity has changed 

Validate 
Error 

 
You've chosen 
a blocked 
Entity. Please 
select a 
different Entity. 

ClientCustomTabFields.Cu
stWorkflowBlockedEntity 
equals Y 

Cannot Select Blocked Locations when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Locations cannot be selected 
(Add) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedLocation  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Location where 
UDIC_UID='[:ClientCustomTabFields.cu
stLocation]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Location was 
selected 

ClientCustomTabFields.Cu
stLocation not empty 

Validate 
Error 

 
You've chosen 
a blocked 
Location. 
Please select a 
different 
Location. 

ClientCustomTabFields.Cu
stWorkflowBlockedLocation 
equals Y 
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Cannot Select Blocked Locations when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Locations cannot be selected 
(Change) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedLocation  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Location where 
UDIC_UID='[:ClientCustomTabFields.cu
stLocation]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Location was 
selected 

ClientCustomTabFields.Cu
stLocation not empty AND 

ClientCustomTabFields.Cu
stLocation has changed 

Validate 
Error 

 
You've chosen 
a blocked 
Location. 
Please select a 
different 
Location. 

ClientCustomTabFields.Cu
stWorkflowBlockedLocation 
equals Y 

Cannot Select Blocked Projects when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Projects cannot be selected 
(Add) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedProject  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Project where 

Test if blocked 
Location was 
selected 

ClientCustomTabFields.Cu
stProject not empty 
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Action Column (Field) Change Properties Description Action Conditions 
UDIC_UID='[:ClientCustomTabFields.Cu
stProject]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Validate 
Error 

 
You've chosen 
a blocked 
Project. Please 
select a 
different 
Project. 

ClientCustomTabFields.Cu
stWorkflowBlockedProject 
equals Y 

Cannot Select Blocked Projects when Editing a Firm 

This section provides information on a validation error. 

Workflow Table Type Description Workflow Conditions 

Firm Change Blocked Projects cannot be selected 
(Change) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedProject  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Project where 
UDIC_UID='[:ClientCustomTabFields.C
ustProject]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Location was 
selected 

ClientCustomTabFields.Cu
stProject not empty AND 

ClientCustomTabFields.Cu
stProject has changed 

Validate 
Error 

 
You've chosen 
a blocked 
Project. Please 
select a 
different 
Project. 

ClientCustomTabFields.Cu
stWorkflowBlockedProject 
equals Y 

Cannot Select Blocked Purposes when Adding a Firm 

This section provides information on a validation error. 
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Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Purposes cannot be selected 
(Add) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedPurpose  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Purpose where 
UDIC_UID='[:ClientCustomTabFields.C
ustPurpose]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Purpose was 
selected 

ClientCustomTabFields.Cu
stPurpose not empty 

Validate 
Error 

 
You've chosen 
a blocked 
Purpose. 
Please select a 
different 
Purpose. 

ClientCustomTabFields.Cu
stWorkflowBlockedPurpose 
equals Y 

Cannot Select Blocked Purposes when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Purposes cannot be selected 
(Change) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedPurpose  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Purpose where 
UDIC_UID='[:ClientCustomTabFields.C
ustPurpose]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Test if blocked 
Purpose was 
selected 

ClientCustomTabFields.Cu
stPurpose not empty AND 

ClientCustomTabFields.Cu
stPurpose has changed 
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Action Column (Field) Change Properties Description Action Conditions 
Otherwise, Use This Calculation: 'N' 

Validate 
Error 

 
You've chosen 
a blocked 
Purpose. 
Please select a 
different 
Purpose. 

ClientCustomTabFields.Cu
stWorkflowBlockedPurpose 
equals Y 

Cannot Select Blocked Specification 1s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 1 cannot be 
selected (Add) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedSpecification1  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Specification1 where 
UDIC_UID='[:ClientCustomTabFields.C
ustSpecification1]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 1 
was selected 

ClientCustomTabFields.Cu
stSpecification1 not empty 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 1. 
Please select a 
different 
Specification 1. 

ClientCustomTabFields.Cu
stWorkflowBlockedSpecific
ation1 equals Y 

Cannot Select Blocked Specification 1s when Editing a Firm 

This section provides information on a validation error. 
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Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 1 cannot be 
selected (Change) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedSpecification1  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Specification1 where 
UDIC_UID='[:ClientCustomTabFields.C
ustSpecification1]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 1 
was selected 

ClientCustomTabFields.Cu
stSpecification1 not empty 
AND 

ClientCustomTabFields.Cu
stSpecification1 has 
changed 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 1. 
Please select a 
different 
Specification 1. 

ClientCustomTabFields.Cu
stWorkflowBlockedSpecific
ation1 equals Y 

Cannot Select Blocked Specification 2s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 2 cannot be selected 
(Add) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedSpecification2  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Specification2 where 
UDIC_UID='[:ClientCustomTabFields.C
ustSpecification2]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Test if blocked 
Specification 2 
was selected 

ClientCustomTabFields.Cu
stSpecification2 not empty  
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Action Column (Field) Change Properties Description Action Conditions 
Otherwise, Use This Calculation: 'N' 

Validate 
Error 

 
You've chosen a 
blocked 
Specification 2. 
Please select a 
different 
Specification 2. 

ClientCustomTabFields.Cu
stWorkflowBlockedSpecific
ation2 equals Y 

Cannot Select Blocked Specification 2s when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 2 cannot be selected 
(Change) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedSpecification2  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Specification2 where 
UDIC_UID='[:ClientCustomTabFields.C
ustSpecification2]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 2 
was selected 

ClientCustomTabFields.Cu
stSpecification2 not empty 
AND 

ClientCustomTabFields.Cu
stSpecification2 has 
changed 

Validate 
Error 

 
You've chosen a 
blocked 
Specification 2. 
Please select a 
different 
Specification 2. 

ClientCustomTabFields.Cu
stWorkflowBlockedSpecific
ation2 equals Y 

Cannot Select Blocked Specification 3s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 3 cannot be 
selected (Add) 
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Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedSpecification3  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Specification3 where 
UDIC_UID='[:ClientCustomTabFields.Cu
stSpecification3]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 3 
was selected 

ClientCustomTabFields.Cu
stSpecification3 not empty  

Validate 
Error 

 
You've chosen 
a blocked 
Specification 3. 
Please select a 
different 
Specification 3. 

ClientCustomTabFields.Cu
stWorkflowBlockedSpecific
ation3 equals Y 

Cannot Select Blocked Specification 3s when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 3 cannot be 
selected (Change) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: 
ClientCustomTabFields.CustWorkflowBl
ockedSpecification3  

New Value SQL Expression: 

If this is True: (select custBlocked from 
UDIC_Specification3 where 
UDIC_UID='[:ClientCustomTabFields.Cu
stSpecification2]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 3 
was selected 

ClientCustomTabFields.Cu
stSpecification3 not empty 
AND 

ClientCustomTabFields.Cu
stSpecification3 has 
changed 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 3. 
Please select a 

ClientCustomTabFields.Cu
stWorkflowBlockedSpecific
ation3 equals Y 
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Action Column (Field) Change Properties Description Action Conditions 
different 
Specification 3. 

Cannot Select Blocked Specification 4s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 4 cannot be 
selected (Add) 

 

 

Action Column (Field) Change Properties Description Action Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 
4  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification4 where 
UDIC_UID='[:ClientCustomTabFields.Cu
stSpecification4]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 4 
was selected 

Specification 4 Dimension 
not empty 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 4. 
Please select a 
different 
Specification 4. 

Workflow Blocked 
Specification 4 equals Yes 

Cannot Select Blocked Specification 4s when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 4 cannot be 
selected (Change) 
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Action Column (Field) Change Properties Descriptio
n 

Action 
Conditions 

Colum
n 
(Field) 
Chang
e 

Column: Workflow Blocked Specification 4  
New Value SQL Expression: 
If this is True: (select custBlocked from UDIC_Specification4 
where 
UDIC_UID='[:ClientCustomTabFields.CustSpecification4]')='[BL
OCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specificati
on 3 was 
selected 

Specification 
4 Dimension 
not empty 
AND 
Specification 
4 
Dimension  h
as changed 

Validat
e Error 

 
You've 
chosen a 
blocked 
Specificati
on 4. 
Please 
select a 
different 
Specificati
on 4. 

Workflow 
Blocked 
Specification 
4 equals Yes 

Cannot Select Blocked Specification 5s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 5 cannot be 
selected (Add) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 5 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification5 where 
UDIC_UID='[:ClientCustomTabFields.CustSpecification5
Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 5 
was selected 

Specification 
5 Dimension 
not empty  
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Action Column (Field) Change Properties Description Action 
Conditions 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 5. 
Please select a 
different 
Specification 5. 

Workflow 
Blocked 
Specification 
5 equals Yes 

Cannot Select Blocked Specification 5s when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 5 cannot be 
selected (Change) 

 

 

Action Column (Field) Change Properties Descriptio
n 

Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 5 
New Value SQL Expression: 
If this is True: (select custBlocked from UDIC_Specification5 
where 
UDIC_UID='[:ClientCustomTabFields.CustSpecification5Dim
ension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specificatio
n 5 was 
selected 

Specification 
5 Dimension 
not empty 
AND 
Specification 
5 Dimension 
has changed 

Validate 
Error 

 
You've 
chosen a 
blocked 
Specificatio
n 5. Please 
select a 
different 
Specificatio
n 5. 

Workflow 
Blocked 
Specification 
5 equals Yes 

Cannot Select Blocked Specification 6s when Adding a Firm 

This section provides information on a validation error. 
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Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 6 cannot be 
selected (Add) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 6  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification6 where 
UDIC_UID='[:ClientCustomTabFields.CustSpecification6
Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specification 
6 was 
selected 

Specification 
6 Dimension 
not empty 

Validate 
Error 

 
You've 
chosen a 
blocked 
Specification 
6. Please 
select a 
different 
Specification 
6. 

Workflow 
Blocked 
Specification 
6 equals Yes 

Cannot Select Blocked Specification 6s when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 6 cannot be 
selected (Change) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 6 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification6 where 

Test if 
blocked 
Specification 
6 was 
selected 

Specification 
6 Dimension 
not empty 
AND 
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Action Column (Field) Change Properties Description Action 
Conditions 

UDIC_UID='[:ClientCustomTabFields.CustSpecification6
Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Specification 
6 Dimension 
has changed 

Validate 
Error 

 
You've 
chosen a 
blocked 
Specification 
6. Please 
select a 
different 
Specification 
6. 

Workflow 
Blocked 
Specification 
6 equals Yes 

Cannot Select Blocked Specification 7s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 7 cannot be 
selected (Add) 

 

 

Actio
n 

Column (Field) Change Properties Descripti
on 

Action 
Conditions 

Colum
n 
(Field) 
Chan
ge 

Column: Workflow Blocked Specification 7  

New Value SQL Expression: 

If this is True: (select custBlocked from UDIC_Specification7 
where 
UDIC_UID='[:ClientCustomTabFields.CustSpecification7Dimensio
n]')='[BLOCKED]' 

Use this Calculation: 'Y' 

Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specificati
on 7 was 
selected 

Specificatio
n 7 
Dimension  
not empty  

Valida
te 
Error 

 
You've 
chosen a 
blocked 
Specificati
on 7. 
Please 
select a 
different 

Workflow 
Blocked 
Specificatio
n 7 equals 
Yes 
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Actio
n 

Column (Field) Change Properties Descripti
on 

Action 
Conditions 

Specificati
on 7. 

Cannot Select Blocked Specification 7s when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 7 cannot be 
selected (Change) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 7  
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification7 where 
UDIC_UID='[:ClientCustomTabFields.CustSpecification7Di
mension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specification 
7 was 
selected 

Specificatio
n 7 
Dimension 
not empty 
AND 
Specificatio
n 7 
Dimension 
has 
changed 

Validate 
Error 

 
You've 
chosen a 
blocked 
Specification 
7. Please 
select a 
different 
Specification 
7. 

Workflow 
Blocked 
Specificatio
n 7 equals 
Yes 

Cannot Select Blocked Specification 8s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 8 cannot be 
selected (Add) 

 



Integrations 

System Admin Guide 326 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 8 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification8 where 
UDIC_UID='[:ClientCustomTabFields.CustSpecificatio
n8Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 8 
was selected 

Specification 8 
Dimension not 
empty 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 
8. Please 
select a 
different 
Specification 
8. 

Workflow 
Blocked 
Specification 8 
equals Yes 

Cannot Select Blocked Specification 8s when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 8 cannot be 
selected (Change) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 8 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification8 where 
UDIC_UID='[:ClientCustomTabFields.CustSpecificatio
n8Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 8 
was selected 

Specification 8 
Dimension not 
empty AND 
Specification 8 
Dimension has 
changed 
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Action Column (Field) Change Properties Description Action 
Conditions 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 
8. Please 
select a 
different 
Specification 
8. 

Workflow 
Blocked 
Specification 8 
equals Yes 

Cannot Select Blocked Specification 9s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 9 cannot be 
selected (Add) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 9 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification9 where 
UDIC_UID='[:ClientCustomTabFields.CustSpecificati
on9Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if 
blocked 
Specification 
9 was 
selected 

Specification 9 
Dimension not 
empty 

Validate 
Error 

 
You've 
chosen a 
blocked 
Specification 
9. Please 
select a 
different 
Specification 
9. 

Workflow 
Blocked 
Specification 9 
equals Yes 

Cannot Select Blocked Specification 9s when Editing a Firm 

This section provides information on a validation error. 
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Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 9 cannot be 
selected (Change) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 9 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification9 where 
UDIC_UID='[:ClientCustomTabFields.CustSpecific
ation9Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 9 
was selected 

Specification 9 
Dimension not 
empty AND 
Specification 9 
Dimension has 
changed 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 
9. Please 
select a 
different 
Specification 
9. 

Workflow 
Blocked 
Specification 9 
equals Yes 

Cannot Select Blocked Specification 10s when Adding a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Blocked Specification 10 cannot be 
selected (Add) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 10 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification10 where 

Test if blocked 
Specification 
10 was 
selected 

Specification 10 
Dimension not 
empty 
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Action Column (Field) Change Properties Description Action 
Conditions 

UDIC_UID='[:ClientCustomTabFields.CustSpecific
ation10Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 
10. Please 
select a 
different 
Specification 
10. 

Workflow 
Blocked 
Specification 10 
equals Yes 

Cannot Select Blocked Specification 10s when Editing a Firm 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Blocked Specification 10 cannot be 
selected (Change) 

 

 

Action Column (Field) Change Properties Description Action 
Conditions 

Column 
(Field) 
Change 

Column: Workflow Blocked Specification 10 
New Value SQL Expression: 
If this is True: (select custBlocked from 
UDIC_Specification10 where 
UDIC_UID='[:ClientCustomTabFields.CustSpecific
ation10Dimension]')='[BLOCKED]' 
Use this Calculation: 'Y' 
Otherwise, Use This Calculation: 'N' 

Test if blocked 
Specification 
10 was 
selected 

Specification 10 
Dimension not 
empty AND 
Specification 10 
Dimension has 
changed 

Validate 
Error 

 
You've chosen 
a blocked 
Specification 
10. Please 
select a 
different 
Specification 
10. 

Workflow 
Blocked 
Specification 10 
equals Yes 
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Action Column (Field) Change Properties Description Action 
Conditions 

    

Validate 
Error 

 
You've chosen a 
blocked 
Specification 10. 
Please select a 
different 
Specification 10. 

Workflow 
Blocked 
Specification 
10 equals 
Yes 

Cannot Add Firm with Create Relationship Job Checked if Relationship Job Template Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Insert Relationship Job Template 
is required to create 
relationship job (Add) 

ClientCustomTabFields.CustCreateRelationshipJob 
equals Y 

 

Action Description Action Conditions 

Validate  

Error 

Relationship Job Template is 
required to create a relationship 
job. 

ClientCustomTabFields.CustRelationshipJobTem
plate empty 

Cannot Edit Firm with Create Relationship Job Checked if Relationship Job Template Empty 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Change Relationship Job 
Template is required to 
create relationship job 
(Change) 

ClientCustomTabFields.CustCreateRelationshipJob 
equals Y AND 

ClientCustomTabFields.CustCreateRelationshipJob 
has changed 

 

Action Description Action Conditions 

Validate  

Error 

Relationship Job Template is 
required to create a relationship 
job. 

ClientCustomTabFields.CustRelationshipJobTempl
ate empty 
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Cannot Delete Firm if Relationship Job Has Been Created (Affected by Bug 817602) 

This section provides information on a validation error. 

Workflow 
Table 

Type Description Workflow Conditions 

Firm Delete Cannot delete firm if relationship job 
exists in Maconomy 

 

 

Action Description Action Conditions 

Validate  

Error 

This firm cannot be deleted 
because a relationship job 
exists in Maconomy. 

ClientCustomTabFields.CustRelationshipJobNumber 
(Old) not empty 

Cannot Delete Project if Proposal or Fee Job Has Been Created (Affected by Bug 817602) 

This section provides information on a validation error. 

Workflow 
Table 

Type Level Description Workflow Conditions 

Project Delete Project Cannot delete project if proposal or 
fee job exists in Maconomy 

 

 

Action Description Action Conditions 

Validate 
Error 

This project cannot be deleted because a 
proposal job exists in Maconomy. 

Proposal Job Number (Old) not empty 

Validate 
Error 

This project cannot be deleted because a 
fee job exists in Maconomy. 

Fee Job Number (Old) not empty 

Cannot Create a Firm Address Without a Country 

This section provides information on a validation error. 

Workflow Table Type Description Workflow Conditions 

CLAddress Add Country is required for firm 
addresses (Add) 

 

 

Action Description Action Conditions 

Validate 
Error 

Country is required for firm addresses. Country empty 
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Cannot Edit a Firm Address Without a Country 

This section provides information on a validation error. 

Workflow Table Type Description Workflow Conditions 

CLAddress Change Country is required for firm addresses (Change) 
 

 

Action Description Action Conditions 

Validate  
Error 

Country is required for firm addresses. Country empty 

Sample Background Task Import 
This section contains examples of background task generator imports for running the Open Timed Out 
action as a scheduled task and running the Export or Update Employee in Deltek CRM action on a set 
of employees.  

Modify these examples to suit the customer need before use.  

 
KeyGeneratorHeader:Format Name Description ContainerName PaneName
 SemanticFieldName1 ShowMaxRowsDuringTest 

KeyGeneratorLine:Format KeyGeneratorName RestrictionExpression 

 

KeyGeneratorHeader AllEmployees All Employees Employees Filter EmployeeNumber
 500 

KeyGeneratorLine #KEEP true 

 

TaskGeneratorHeader:Format TaskGeneratorName Description TriggerTimePattern
 GeneratorType NextDueDate NextDueTime Active ContainerName PaneType
 PaneName ActionName ContainerKeyGenerator KeyField1Name KeyField1NameMapFrom
 IgnoreDisabledAction 

 

TaskGeneratorHeader CrmOpenTimedOut CRM Integration Open Timed Out 0 * * * * Single Task
 01012018 00:00:00 0 CrmIntegration Card Card OpenTimedOut
 CrmIntegrationSetup InstanceKey context.InstanceKey 1 

 

TaskGeneratorHeader SyncEmployeesWithCrm Synchronize Employees with Deltek CRM 0 * * * * Single 
Task 01012018 00:00:00 0 Employees Card Card
 ExportOrUpdateEmployeeInDeltekCrm AllEmployees EmployeeNumber
 context.EmployeeNumber 

CRM Steps 
This section provides step-by-step instructions for features related to the CRM integration. 
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Deltek CRM Setup 
This section provides information on the set up of Deltek CRM. 

Integration Setup 

Use these steps to set up Deltek CRM integration. 

To enable the Deltek CRM portion of the integration: 
7. From DPS, log in as setup user and complete the Activation steps in order. Fields with the info 

icon have context-sensitive help. Clicking the  icon shows additional information for the field. 

a. Activate Modules: Accept the default values by clicking Done Activating Modules. 

b. Activate Defaults: On the Industry Defaults tab, select the applicable industry and 
country and click Use Industry Defaults. In WBS Structure, accept the default values 
and click Set WBS Structure. Use the default values for work breakdown structure 
(WBS) settings. Note that Enable WBS2 is set to No and should not be changed, even if 
your organization is using WBS2. When done, click Done Activating Defaults. 

c. Activate Email: Provide the default email addresses and click Done Activating Email. 
d. Activate Currencies: On the Currency tab, select the main (functional) currency, provide 

details, and click Enable Multicurrency. On the Multicurrency tab, add the currencies in 
use and click Save. On the Exchange Rates tab, enter the exchange rate for each 
currency you use and click Save. When done, click Done Activating Currencies. 

 
e. Activate Organizations: Click No and enter the corporate name of your enterprise in the 

field. When done, click Done Activating Organizations. 

 
8. Click OK and Done in the popup messages that display. 

9. Log out from set up and log back in as admin user. 

10. Go to Utilities » Integrations » Maconomy and click Add Fields and Workflows. 

11. Proceed with setting up user-defined hubs (UDHs) and workflows (see User-Defined Hubs and 
Elements for details). 

12. From Deltek CRM, log in and go to Configuration » General » System Settings » 
Miscellaneous. 

13. Clear the Allow APIs to Trigger Workflows checkbox to prevent workflows from running every 
sync.  

Note: Because you are not using the DPS Accounting module, you do not need to 
enter exchanges rates frequently. However, you may need them for historical 
reporting purposes. 

Note: Even if you have several profit centers or business units that you track 
separately, you must always answer No for this section. The integration tool sets up 
your organization structure automatically. 
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14. Go to Configuration » Security » Roles and click New.  

 
 

 

15. For non-admin roles, clear the checkbox for the following UDHs: 

 Proposal Templates 

 Fee Templates 

 Relationship Templates 

Note: When creating roles, make sure to hide the Project fields in other hubs by clearing the 
checkbox. 

For all roles in Opportunities, hide the regular and promo project. 

For all roles in Activities, hide the project field. 

For all roles in Contacts and Firms, hide the projects grid. 

For all roles, clear the checkbox for Reports and Lookups. 
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 Locations 

 Entities 

 Projects (Maconomy) 

 Purposes 

 Specification 1–10 

16. Remove dimensions that are not used in UDHs, Opportunities, and Firms.  

17. Remove fields and workflow from UDHs. 

18. If Deltek CRM Firm numbers are used for Maconomy Customer numbers, Firm Auto Number 
must be configured: 

19. Go to General » System Settings » Numbering. 

20. Set Auto Number Source and Auto Number Format for the Firm Number field. 

21. Clear the Allow Override of Auto Number checkbox (read-only).  

22. Go to Configuration » Security » Users and ensure that Windows Authentication is selected. 

23. Enable the system setting Search on Active employees only when using employee quick 
lookup. 

 Employee key format: Employee length must be 20 and “Display leading zeroes” must be 
enabled. 

 Organizations key format: Organization level must be 1, and delimiter must be empty. The 
length must be 14. 

24. Add currency codes that correspond to the currency codes in Maconomy. 

25. Add country codes that correspond to the country codes in Maconomy. 

26. If Deltek CRM Company IDs are used for Maconomy Customer numbers, the Company ID Auto 
Number must be configured: 

27. Go to General » System Settings » Numbering. 
28. Set Auto Number Source and Auto Number Format for the Company ID field. 
29. Clear the Allow Override of Auto Number checkbox (read-only).  

 

Maconomy Setup for CRM 

When the background task creates jobs or customers in Maconomy, job or customer records are 
populated with information from Deltek CRM. Some of this information must be available in the 
Maconomy database for the record to be created successfully. The background tasks include an 
automatic synchronization of Employee, Job Template, select Dimensions, and Company data from 
Maconomy to Deltek CRM. You must maintain other standing data manually. You must synchronize the 
following tables in Deltek CRM manually with the corresponding data in Maconomy: 

 Users 

 Currencies 

Note: Your username must be associated with an employee record that has a language assigned to it 
in order to avoid workflow errors. If you are using a user that is not associated with an employee 
record, such as an admin user, many of the workflows will not work correctly. 
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 Countries 

In addition: 

 An opportunity in Deltek CRM is always linked to a company/customer, to an organization 
(Maconomy company), and to a project manager. Dimensions that are mandatory on the job in 
Maconomy must have values on the opportunity or be derived from the template job. 

 Template customers are used for customer creation in Maconomy. 

It is highly recommended to use approval workflows for customer and job creation in Maconomy. 

Enable System Parameters 

Use these steps to enable CRM integration. 

To enable CRM integration and functionality with system parameters: 
1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Search for Enable CRM Integration and enable the parameter. 

Selecting this parameter causes the CRM Integration workspace to display in Maconomy. 

3. Search for Use first/middle/last names on employees and contact persons and enable the 
parameter. 

4. Search for Use Deltek CRM Client ID as Customer No. and enable it to use the Deltek CRM 
Client ID as the Maconomy Customer No. 

 If you do not enable this parameter, the Maconomy customer number is defined by the 
number series in Maconomy. 

 If this parameter is enabled, Deltek CRM Client IDs cannot be empty, and they must be 
unique.  

Add “DeltekCRM” to Popup Field 

Adding the popup value “DeltekCRM” ensures that the actions Update Jobs from Deltek CRM and 
Update Customers from Deltek CRM get only the latest records from Deltek CRM using the ModDate 
field from Deltek CRM. 

The Integration Lines tab in Maconomy is used to store the ModDate from opportunities and clients, and a 
query is used to filter the number of results that are retrieved. This update requires the popup type 
IntegrationType to have the value "DeltekCrm". 

To add the value in the Workspace Client:  
3. Take one of the following actions: 

• Go to either Single Dialogs » Set-Up » Set-Up » Popup Fields. 

• Go to Setup » System Setup » Parameters and Numbers » Popup Fields.  

4. Search for Integration Type and add the value “DeltekCrm”.  

Create Template Jobs 

Use this step to create template jobs from Deltek CRM. 
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To choose a Maconomy template job when creating the Maconomy job from Deltek CRM: 
1. Use the CRM Job Type field on the template job to define whether a job is available for selection 

at creation of Fee, Proposal, or Relationship Job. 

Please note that dimensions that are mandatory on the job in Maconomy must have values on 
the opportunity in Deltek CRM or be derived from the template job. 

Set Up Dimension Synchronization 

Dimensions in Maconomy are typically used for marking a job with a certain attribute (for example, 
organization unit, project type, and so on). 

You can allow users to associate a Deltek CRM opportunity/firm with a Maconomy dimension upon 
creation, and then assign it to a corresponding job in Maconomy. 

This feature supports the synchronization of the following global dimensions: 

 Location 

 Entity 

 Project  

 Purpose 

 Specifications 1 to 10  

To setup dimension synchronization: 
1. Go to Set-Up » Set-up » CRM Integration Dimension Setup.  

2. Select Enabled to dimension synchronization between the Maconomy Relation Name field to 
the item in the CRM Custom Field Name field.  

3. Click Save CRM Integration Dimension Setup. 

Country and State Mapping 

Maconomy does not have a dedicated field for States. 

In a non-U.S. setup, the Country field is used for the list of Countries, and typically, the Name5 field on 
the customer (Name 5 is the internal field name used on customer, vendor, and employee) is used for the 
State. In a U.S. setup, the Country field is used for states, and the Name5 field is used for countries. 

You can configure the integration to map the Country/State field in Deltek CRM with either 
Country/Name5 or Name5/Country on Maconomy customers. You configure this in the Deltek CRM 
Setup workspace. 

By default, the integration supports a non-US setup. So, if you want to map the Country/State field in 
Deltek CRM with Country/Name5 in Maconomy, you do not need to set up any mapping. 

If you want to map the Country/State field in Deltek CRM with Name5/Country in Maconomy, you need 
to populate the Country mappings table. 

To map countries between Deltek CRM and Maconomy: 
1. Go to Set-Up » Set-up » CRM Integration Country Mappings Setup. 

2. On the Country Mapping Setup tab, fill in the Country ISO Code field for the country where you 
want to map the State in Deltek CRM to Country in Maconomy. 



Integrations 

System Admin Guide 338 

 

 
Example for Canada, US, and Australia. 

Enable Job Budget Synchronization 

The integration transfers job budgets from Maconomy to the opportunity upon approval of the job budget. 
The job budget type is determined by a job parameter, which must be set up on the job parameters in 
Maconomy. 

To enable job budget synchronization: 
1. Go to Setup » Job Cost Setup » Parameters » Job Parameters. 
2. Search for CRM Integration, Budget Type and enable the parameter. 

Set the Expected Revenue as Budget Value for Jobs 

You can opt to use the expected revenue instead of the job budget type to calculate the opportunity value 
in Deltek CRM. 

You can calculate the total expected revenue for main job and subjobs and send the information to the 
corresponding opportunity in Vantagepoint CRM. The expected revenue is calculated in the currency of 
the main job based on the current exchange rate. When you select this Boolean attribute, the budget type 
revenue is overwritten, and the expected revenue is used as the budget value to be transferred to Deltek 
CRM. 

 To set up the expected revenue as the budget value: 
1. Go to Setup » Job Cost Setup » Parameters » Job Parameters. 

2. Search for Job Parameter Type CRM Integration, and enable the parameter Use Expected 
Revenue as Opportunity Budget Value. 

Set Up Connection to Deltek CRM 

Use these steps to set up a connection to Deltek CRM. 

To set up the connection to Deltek CRM: 
1. Add the following lines to the file server.ini located at <Path to Maconomy 

installation>/CouplingService/configuration: 
url.deltekcrmwebservice = http://<servername>/vantagepoint/api 

url.deltekcrmiaccess = http://<servername>/vantagepoint/app 

url.deltekcrmdatabase = <Database shortname> 

url.deltekcrmclientid = <client ID> 

url.deltekcrmclientsecret = <client secret> 
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2. Select the Update Deltek CRM Connection Information action in the CRM Integration dialog 
box or the CRM Integration workspace and enter the following information: 

 Deltek CRM Login: Login for Deltek CRM 

 Deltek CRM password: Password for this Deltek CRM 

The integration will use the values that you entered. In the CRM Integration workspace, you can also see 
the currently set login. 

Set Up Background Integration Task 

You must set up background tasks to schedule automatic synchronization. 

You can specify a dedicated user on the background task. If no user is specified, the Administrator user is 
set by default.  

There are task generators for the CRM Integration. By default, these are deactivated, you need to 
activate these task generators to use them. You can change the standard trigger time pattern before you 
activate a task. 

To set up Background Tasks for automatic synchronization: 
1. Go to Setup » Background Tasks » Setup » List of Schedule Rules. 

2. Activate each of the task generators for the CRM Integration: 

 Export Companies to Deltek CRM 

 Export Dimensions to Deltek CRM 

 Export Employees to Deltek CRM 

 Export Job Templates to Deltek CRM 

 Import Jobs and Customers from Deltek CRM 

 Update Jobs from Deltek CRM 

 Update Customers from Deltek CRM 

 

Enable CRM Integration Dimensions 

You must enable CRM Integration Dimension Setup to support the use of dimensions in Deltek CRM. 

To enable CRM integration dimensions:  
1. Go to Set-Up » Set-up » CRM Integration Dimension Setup.  

2. Select Enabled for dimensions to allow dimensions in Deltek CRM.  

3. Click Save CRM Integration Dimension Setup. 

Note:  
 Read more about patterns in “Pattern syntax help”. 

 After syncing with Maconomy for the first time, link all users to Employee records in order to 
use the Calendar and Dashboard. 

http://www.sauronsoftware.it/projects/cron4j/manual.php#p02
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Set the Preferred Language 

You can define your preferred language in the server.ini file, using the url.deltekcrmlanguage 
parameter. If no language is specified, the default is set to en-US (English). If the corresponding language 
is not enabled in Vantagepoint, it will result in a bad request error. 

You can set your preferred language to match other languages installed on your database. 

To set up the preferred language: 
1. Locate the server.ini file at <Path to Maconomy installation>/CouplingService/configuration 

2. Add the parameter url.deltekcrmlanguage and specify the preferred language to use. 

If no language is specified, the default is set to en-US. 

3. Save the changes and close the file. 

CRM Routine Steps 
During routine synchronizations, you must perform the standard Deltek CRM to Maconomy 
synchronization, then identify and correct errors.  

The main background task is to schedule Create Jobs from Deltek CRM Opportunities to run regularly. 
This action pulls opportunities and customers from Deltek CRM and creates background tasks for 
creating jobs and customers in Maconomy. One task per job is created, and one task per customer. As an 
example, if there are five jobs to be created, five background tasks are created. 

Synchronize Customers Manually 

You can manually initiate the standard Deltek CRM: Maconomy synchronization if the background tasks 
are not used. 

To manually initiate synchronization:  
1. Go to Set-Up » Set-up » CRM Integration.  

2. Expand the Actions dropdown list and select Update Customers from Deltek CRM action. 

This action creates the background tasks for synchronizing customers. If there are synchronization tasks 
already created, this action no longer creates any synchronization task. 

Synchronize Jobs Manually 

You can manually initiate the standard Deltek CRM-Maconomy synchronization if the background tasks 
are not used. 

To manually initiate synchronization: 
1. Go to Set-Up » Set-up » CRM Integration.  

2. Expand the Actions dropdown list and select Update Jobs from Deltek CRM action. 

This action creates the background tasks for synchronizing jobs. If there are synchronization tasks 
already created, this action no longer creates any synchronization task. 

Synchronize Employees and Companies 

You use the Export Maconomy Employees to Deltek CRM and Export Maconomy Companies to 
Deltek CRM actions to look at all employees and companies in Maconomy and create background tasks 
in Deltek CRM if they do not already exist. 
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To determine if an employee or company exists, the system looks at EmployeeNumber for employees 
and CompanyNumber for companies. 

To synchronize employees and companies: 
1. Go to Set-Up » Set-up » CRM Integration. 

2. Expand the Actions dropdown list and select Export Maconomy Employees to Deltek CRM and 
Export Maconomy Companies to Deltek CRM. 

Running these actions produces a notification indicating whether any employee and/or organization 
creation tasks have been created. You can monitor the created tasks in the Background Tasks 
workspace. 

Link Maconomy Jobs and Customers to Deltek CRM Opportunities and Firms 

You can add CRM references on existing customers and jobs via import programs. This can be useful for 
customers migrating data when implementing the Deltek CRM integration.  
Link Existing Maconomy Job to Existing Deltek CRM Opportunity 
You can link an existing Maconomy job to an existing opportunity in Deltek CRM via the field 
CrmOpportunityKey on JobHeader using the import program for jobs. It is also possible to update the 
CRM Job Type via the import program. When the opportunity ID is added to the Maconomy job, 
Maconomy updates the opportunity in Deltek CRM with some data from the Maconomy job (such as job 
name). When the Update Jobs from Deltek CRM action is run, data is pulled from the Deltek CRM 
opportunity (such as opportunity name) and the job in Maconomy is updated accordingly. 
Link Existing Maconomy Customer to Existing Deltek CRM Firm 
You can link an existing Maconomy customer to an existing firm in Deltek CRM via the field 
CrmKeyCustomerKey using the import program for customers. When the Update Customers from 
Deltek CRM action is run, data is pulled from the Deltek CRM firm (such as address fields) and the 
customer in Maconomy is updated accordingly. 

Create or Update Employee in Deltek CRM 

You can select and update only a specific employee’s information or update a subset of employees using 
scheduled tasks 

Prerequisites: You must enable the Enable CRM Integration parameter to use this action. 

To create or update employee information: 
1. Go to Human Resources » Employees. 

2. Double-click the employee and click Export or Update Employee in Deltek CRM. 

Using the Open Timed Out Action 

This feature prevents a job from starting before a previous job is completed, and also prevents the 
integration from continuously trying to run a failing job. 

The Open Timed Out action in the CRM Integration workspace enables the Open field after a specified 
period of time. This can be useful if a synchronization action fails, leaving the integration closed, with no 
background tasks actually running. If the integration is closed, the workspace shows the date and time 
when it was closed. 

To use the Open Timeout action: 
1. Go to Set-Up » Set-up » CRM Integration. 
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2. Enter the maximum length of time (in minutes) for which the integration should stay closed before 
the Open Timeout action should reopen it in the Max closed time in minutes field. 

3. Select the Open Timeout action. 

If the integration has been closed for longer than the number of minutes specified in the Max 
closed time in minutes field, it is then opened. 

You can create a scheduled task to run this action on a regular basis. This is useful if the 
integration is experiencing intermittent issues such as connectivity problems. 

Set Employees as Terminated 

You can set an employee as Terminated by using the Terminated Date field. 

When exporting/updating employees in Deltek CRM, if the current date is later than the Termination Date, 
the Terminated status is sent to Deltek CRM during synchronization. Instead of blocking a terminated 
employee in Maconomy, the Termination Date field should be used instead. 

To update an employee:  
1. Go to Human Resources » Employees. 

2. Double-click the employee and go to the Employee Information tab. 

3. In the Employment card, enter the employee’s Termination Date. 

Check Background Task Log 

Use these steps to check the background task log. 

To check the background task log: 
4. Go to Setup » Background Tasks » Status » List of Background Tasks and double-click the 

background task. 

5. If the task’s Execution Result is “Failed,” open the result log to view the reason. 

The result log for Execute CRM Integration action may contain a number of warnings if one or 
more opportunities/clients have incorrect or missing data, which can lead to some jobs/customer 
creation tasks failing. This information can be used to identify what the issue is. 

Check Log Files 

Coupling service logging can be enabled to log the workflow of the integration. 

Enhanced Error Logging 
This extends the logging functionality of the Deltek CRM Integration by adding new log levels to improve 
troubleshooting the integration. This enables specifying the level of information depending on the selected 
log level configuration. 

 DEBUG: The general flow of the synchronization extension is logged. 

 TRACE: HTTP requests and responses sent and received by the integration extension are 
logged. 

 

Note: TRACE level logging should not be used for sustained periods because it can impact the 
performance of the application. It creates a huge log data that is unsustainable due to disk space 
or bandwidth constraints. 
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Log levels are changed in the logback.xml file in the Coupling Service:  

<Path to Maconomy Installation>/CouplingService/configuration/logback.xml 

Adding Log Levels 

Use these steps to add log levels. 

To add the logging for Deltek CRM Integration in the logback.xml file:  
1. Open logback.xml in the configuration folder of the Coupling Service directory. 

2. Add the following CRM integration log configuration to logback.xml: 
  <logger name="com.maconomy.extension.deltek.crm"> 
    <level value="DEBUG" /> 
    <appender-ref ref="FILE /> 
  </logger> 
 
  <logger name="com.maconomy.vision.integration"> 
    <level value=" DEBUG " /> 
    <appender-ref ref="FILE" /> 

3. Set the following level values as applicable: 

 DEBUG 
 TRACE 

4. Close and save the changes made. 

People Planner 
Deltek’s People Planner is a separate Deltek offering that combines graphical project and resource 
planning for your entire resource pool and project portfolio on a company-wide scale.  

You can integrate People Planner with any of the three Maconomy solutions (standard, CPA, or PSO) to 
combine its graphical planning capabilities with the advanced project economy management features of 
Maconomy. 
The suite of People Planner programs includes the following: 

 Deltek People Planner: Sometimes called the “People Planner Client,” it is not strictly a client 
because there is no server. It is sometimes just called “People Planner,” which can cause some 
confusion as to whether the reference is to the Deltek People Planner product or the entire suite 
of programs.  

 People Planner Admin Tool: You use this tool to perform the initial setup and maintenance of 
People Planner.  

 Deltek MyPlan: This is a light web page client. 

 Deltek People Planner API: This is the web service that integrates People Planner with the 
Deltek Maconomy software. 

 Deltek People Planner Outlook Web Service: This is the web service that integrates People 
Planner with Microsoft® Exchange® and Outlook®. 

 Deltek People Planner Service: A Windows service that is responsible for scheduling tasks.  

 Deltek People Planner Outlook AddIn: This is an add-in for Outlook. The People Planner 
Outlook Web Service, the People Planner Service, and this add-in form the components of the 
integration between People Planner and Exchange/Outlook.  
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People Planner Admin Tool 
Use the People Planner Admin Tool for the initial setup and maintenance. This tool enables you to create 
and maintain the People Planner database, add People Planner users, and create the configuration files 
used by the People Planner client. 

To test the integration using the Test Integration Settings in the People Planner Admin Tool, you must 
provide the People Planner integration user with temporary Read access to the System Parameters 
container. 

Integration with Microsoft Outlook 
The integration with Exchange/Outlook enables People Planner to use Outlook, instead of the People 
Planner client, as your personal planning tool. 

Integration with Maconomy 
You can use People Planner as a stand-alone resource planning tool; however, it can also be integrated 
with Maconomy. This integration enables the People Planner client to import master data from Maconomy 
that is relevant for project and resource planning.  

The Resource Management workspace enables you to access and control data based on the People 
Planner access you are granted. 

Enter the People Planner URL in the system parameter, URL for Resource Management; otherwise, the 
Resource Management workspace is hidden. 

People Planner can be integrated with the Maconomy X1 Service Pack 16 or later; or with Maconomy 2.0 
or later. 

To enable the Resource Management Workspace: 
1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the URL for Resource Management parameter. 

3. In the System Parameter subtab, enter the People Planner URL in the URL for Capacity 
Overview field. 

The URL uses the following format: 

http://<server>:<port>/PeoplePlannerWebComponents/RMViewPage.aspx 

4. Restart Maconomy. 

Periodic Job Budget System Parameters 
The following system parameters configure how the Update Periodic Job Budget from People Planner 
and Send Job to and Update Periodic Job Budget from People Planner actions behave. 

 Update Periodic Job Budget Planned Dates on update from People Planner: Updates the job 
budget planned dates after clicking the Update Periodic Job Budget from People Planner or 
Send Job to and Update Periodic Job Budget from People Planner actions. Enabled by 
default. 

 Submit Periodic Job Budget on update from People Planner: Automatically submits the 
budget after clicking the Update Periodic Job Budget from People Planner or Send Job to 
and Update Periodic Job Budget from People Planner actions. Enabled by default.  

The system parameters are enabled by default. Clear the system parameter to disable it. 
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To configure the Periodic Job Budget System Parameters: 
1. Go to Setup » System Setup » Parameters and Numbers » System Parameters. 

2. Double-click the Update Periodic Job Budget Planned Dates on update from People Planner 
parameter. 

3. In the System Parameter subtab, select the Update Periodic Job Budget Planned Dates on 
update from People Planner field. 

4. Click Show Filter List. 
5. Double-click the Submit Periodic Job Budget Planned Dates on update from People Planner 

parameter. 

6. In the System Parameter subtab, select the Submit Periodic Job Budget on update from 
People Planner field. 

Fields / Descriptions 

Field  Description 

Update Periodic Job Budget Planned Dates on 
update from People Planner 

Updates the job budget planned dates after 
clicking the Update Periodic Job Budget from 
People Planner or Send Job to and Update 
Periodic Job Budget from People Planner 
actions. Enabled by default. 

Submit Periodic Job Budget on update from 
People Planner 

Automatically submits the budget after clicking the 
Update Periodic Job Budget from People 
Planner or Send Job to and Update Periodic 
Job Budget from People Planner actions. 
Enabled by default. 

Capacity Overview Tab and the People Planner Tab 
The Resource panels user interfaces are renamed Capacity Overview and People Planner in the Jobs 
workspace: 

 In Jobs » Budgeting » Budget 
 In Jobs » Budgeting » Periodic Budget 
 In Jobs » Budgeting » Job Planning 

 In Jobs » Progress Evaluation 

The following labels are updated. 

Old User Interface Label Updated User Interface Label 

Capacity Overview Resource Assignment 

People Planner Resource Booking 
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Additional Fields Sent to People Planner 

In the Resource Assignment tab, the following additional fields required by the Assign to Budget action 
are sent to People Planner: 

 Employee Category No. 
 Line Type 
 Budget Type 
 Job Number 

Changing any of these fields in an open job automatically sends the updates to People Planner. 

Create Standard People Planner Integration User  
The PSO Solution configuration is enhanced to improve support for the People Planner integration. The 
access granted to the People Planner Integration user (using the import files) meets the minimum 
requirements for integration to function properly. 

However, in order to test the integration using the Test Integration Settings in the People Planner Admin 
Tool, you need to provide temporary Read access for the People Planner Integration user to the System 
Parameters container. 

Periodic Job Budget Action 
The Send Job to and Update Periodic Job Budget from People Planner action supports the 
previously used action sequence to send the job to People Planner and then update the Periodic Job 
Budget on the job. 

The following are recommendations for usage: 

 Use Update Periodic Job Budget from People Planner when the Periodic Job Budget has to 
be updated from People Planner but does not have to be updated in People Planner. 

 Use Send Job to and Update Periodic Job Budget from People Planner when the Job Budget 
has to be updated in People Planner before the updates are retrieved for the Periodic Job 
Budget. 

Integration with Web Client 
The Enable People Planner Web company-specific system parameter in the Workspace Client 
determines whether or not People Planner-related components and functionality are made available in 
your web client application. The company of the user determines if the new People Planner-related 
workspaces and actions are available for the user in the web client. 

Setup Instructions 
This section assumes that Maconomy People Planner integration is already enabled.  

To enable People Planner in the web client:  
1. In the Workspace Client, go to the System Parameters single dialog workspace. 

2. Search for Enable People Planner Web in the filter list. 

3. In the System Parameter tab, select the Enable People Planner Web checkbox either in the tab 
for all companies or in the table for a specific company.  

4. Click Save.  
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By default, this system parameter is disabled across all solutions, whether upgrading or setting up a new 
installation.  

 

System Architecture 
People Planner is based on Microsoft technology and is, in essence, a .Net application. The users can 
choose a Windows or a web-based client. The Windows client offers significantly more functionality over 
the web client. The Windows Client is primarily used by Resource Managers and Project Managers, 
whereas the web client is used by the individual employees (resources). It is possible to configure a 
People Planner installation where everybody uses the Windows client, allowing the web client to be 
optional. 

 
People Planner uses Microsoft’s SQL Server for data storage and communicates directly with this from 
the client.  

Administrative users log in to People Planner with a local account on the People Planner database 
server. Users get logged in automatically through their Windows user account.  

When configured with a Web client interface, this is handled by Internet Information Server (IIS). 

While People Planner can operate as a standalone solution, it typically interacts with the following 
external systems: 

 ERP: Projects are usually created in the ERP system, such as Deltek Maconomy, where they are 
assigned appropriate metadata (Project Number and so on). The project's baseline budget is also 
established there. After the project and the baseline budget are created in the ERP back end, 
they can be copied into the People Planner database so that the resource management workflow 
can begin (resource assignments and so on). People Planner can retrieve the information from 
the ERP system by reading a CSV/XLS file generated by that system, or through direct SQL 
access to the ERP database. Both methods can run on a scheduled basis through a scheduler 
tool.  
People Planner can also deliver information back to the ERP system, such as budget updates, 
changes to project completion dates, and so on.  

 Microsoft Exchange: When People Planner is integrated with Exchange, users can see People 
Planner bookings (made by the Project Managers) in their Outlook appointments. The integration 
with Exchange is done via the EWS Exchange Web Service.  

 Microsoft Excel: People Planner can export data to Excel for further manipulation. 

 Microsoft Project: People Planner can export a project to a Microsoft Project compatible file and 
also import Microsoft Project files as new People Planner projects.  

 BI: People Planner can deliver data to a Business Intelligence (BI) system for further analysis.  

This is typically done on a database level. 

The following information describes the logical tiers that are depicted in the following illustration.  

People Planner’s tiers are all logical tiers, which can be collapsed or allocated to as many physical 
servers as needed by your firm. Those determining factors are discussed in more detail as part of the 

Note: The People Planner-related actions and wizards in in the web client are only available for jobs 
with the Use Imported Budget Line Resource Allocation job parameter attribute enabled.   

Warning: It is not possible to deploy a People Planner solution without the Windows client because 
all of the resource management functionality resides in that client. 
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sizing planning section of this document and can include user concurrency, location, access expectations, 
and business needs. 

E-Invoicing with Pagero  
Maconomy allows electronic invoicing of customer invoices through an integration with Pagero, a third-
party provider of e-invoice products. Their solution supports e-invoicing in many countries and allows 
mapping to local formats, including the German XRechnung format. 

Originally intended to address a German statutory requirement, any company can use this functionality if 
they meet the following requirements: 

 They reside in a country that uses the PEPPOL BIS 3.0 format. 

Some countries may require country-specific updates to the mapping. 

 They have a Pagero account, and Pagero supports e-invoicing in their country. 

Note that only customer invoices sent to Pagero are covered (except for on account invoicing of sales 
orders and subscription orders, which will be supported in a future release). 

Setup Instructions 
E-invoicing is enabled on the level of the company customer. 

The following procedure assumes the following prerequisites are in place: 

 You already have a Pagero account and the accompanying login credentials. 

 
 You already added your customers to your directory in Pagero Online. 

To enable e-invoicing in Maconomy: 
1. Open the extension.ini file in the Coupling Service configuration/settings folder. 

 
2. At the end of the file, add the following information based on your Pagero account details: 

url.pageroclientid = <your Pagero client ID> 

url.pageroclientsecret = <your Pagero client secret> 

url.pageroauthurl = <the authentication URL for the Pagero API> 

url.pagerofileurl = <the file URL for the Pagero API> 

3. Define system natures by adding the following text immediately before the Pagero account 
information you specified in the previous step. 

Using the following format, add as many lines as you need for the number of test/production 
systems your company maintains.  
system.nature.<system shortname> = <system nature> 

4. Open the Workspace Client. 

Attention: For information on account creation and setup, go to: https://www.pagero.com/. 

Note: If you are a customer on Maconomy Cloud, skip steps 1-3 of this procedure, and file a 
support case with Deltek Cloud Operations. On-prem customers will need to provide their 
Pagero client ID and client secret. 

https://www.pagero.com/
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5. Go to the System Setup workspace » Parameters and Numbers.  

6. In the System Parameters filter list, double-click the Enable E-Invoicing system parameter.  
The Workspace Client closes the filter list. 

7. In the System Parameter tab, select the Enable E-Invoicing checkbox, and then click Save. 

This allows you to enable the functionality on the following levels: company, customers, and 
company customer. 

When you enable this system parameter, Maconomy also enables the four standard mappings, 
one for each of the mapping types. These are automatically set as the default mappings unless 
you create customized mappings and set those as the default. 

The four standard mappings are: 

 Job Cost Credit Memo 

 Job Cost Invoice 

 Order Credit Memo 

 Order Invoice 

8. Restart the Workspace Client. 

9. Go to Single Dialogs » Integrations » Pagero Setup single dialog. 

If you prefer to use the Pagero Setup workspace for the next steps, go to Setup » Pagero Setup 
workspace » Pagero Setup. 

10. Enter values for the following fields: 

 Pagero Username: Enter the email address used for your Pagero account. 

 Production Nature: If the current system is a production system, specify its corresponding 
production system nature as listed in the settings.ini file. 

 Test Nature: If the current system is a test system, specify its corresponding test system 
nature as listed in the settings.ini file.  

11. To set up the mapping between Maconomy data and fields in the PEPPOL BIS 3.0 format, go to 
Single Dialogs » Integrations » Peppol Mappings single dialog. 

If you prefer to use the Pagero Setup workspace for the next steps, go to Setup » Pagero Setup 
workspace » Peppol Mappings. 

12. Select a standard mapping type from the filter list.  

The Workspace Client closes the filter list. 

Since this is a standard mapping type, the only customizations you can perform at this point are: 

 To enable/disable this as the default mapping for the mapping type. 

 To show/hide unused lines. 
13. To create a customized mapping using the standard mapping as a base: 

a. On the Peppol Mapping Header tab, click the green plus sign icon (also known as the New 
Peppol Mapping Header action).  

b. Fill out the following fields: 

 Mapping Name (mandatory) 
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 Mapping Type (mandatory): Specify the mapping type you want to use as the base for 
your customized mapping. 

 PUF: If e-invoices are being sent to Pagero, this checkbox should always be enabled.  

 Standard Mapping: This checkbox indicates if the mapping name or mapping type you 
selected from the filter list is a standard mapping. You cannot edit or delete standard 
mappings. 

 Default Mapping: Select this checkbox if you want to use the customized mapping as 
the default mapping for the mapping type you specified. 

 Show Unused Lines: Select this checkbox if you want to show unused lines in the 
Peppol Mapping Line subtab. 

c. On the Peppol Mapping Line subtab, you can customize how Maconomy fields map to fields 
in the PEPPOL BIS 3.0 format.  

Specifically, you can use the following line fields: 

 Included: Select/clear this checkbox to include/exclude the current PEPPOL field from 
the output xml.  

Note that some PEPPOL fields are mandatory and cannot be excluded.  

 Maconomy Relation Name and Maconomy Field Name: Use these fields to specify 
which Maconomy database field value will be displayed on the current PEPPOL field 
when the output xml is generated. 

 Text: If you want the current PEPPOL field to display fixed text, use this field to specify 
that text. 

 Standard Calculation: If you want the PEPPOL field to display a value calculated from 
the values of other fields in the Maconomy database, use this field to make that 
specification. Select a value from the dropdown. The options available in this dropdown 
will depend on what you specify in the Maconomy Field Name field.  

You can also enter descriptive text on the Calculation Description field. 

 
d. Click Save. 

14. You can now enable e-invoicing and specify mappings at the various levels: company, customer, 
and company customer.  

Maconomy will begin to look for e-invoicing and mapping specifications at the lowest level 
(company customer). If nothing is specified at that level, it will follow the specifications at the next 
level (customer). If nothing is specified at that level, it will follow the specifications at the highest 
level (company).  

Note that you cannot enable e-invoicing (and make specifications) at a lower level if you have not 
enabled the functionality at the level immediately above it.  

15. To set up e-invoicing at the company level:  

a. Go to the Companies workspace.  

b. Select a company from the filter list.  

The Workspace Client closes the filter list. 

Note: For more information about the PEPPOL BIS 3.0 standard, go to 
https://docs.peppol.eu/poacc/billing/3.0/bis/#_document_structure.  

https://docs.peppol.eu/poacc/billing/3.0/bis/#_document_structure
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c. Go to Home » Information tab. 

d. Under the E-Invoicing island, fill out the following mandatory fields:  

 Enable E-Invoicing checkbox 

 Electronic Address 

 Electronic Address Scheme: For this field, use the following link for reference: 

https://docs.peppol.eu/poacc/billing/3.0/codelist/eas/  

e. Under the E-Invoice Mappings island, fill out the following fields. 

For each field, select any standard or customized mapping available for that mapping type.  

 Jop Cost Invoice Peppol Mapping  
 Job Cost Credit Memo Mapping 
 Order Invoice Mapping 
 Order Credit Memo Mapping 

f. Click Save.  

16. To set up e-invoicing at the customer level: 

a. Go to the Customers workspace. 

b. Select a customer from the filter list. 

The Workspace Client closes the filter list.  

c. Go to Home » Information tab. 

d. Fill out the mandatory fields under the E-Invoicing island. 

e. Fill out the fields under the E-Invoice Mappings island.  

For each field, select any standard or customized mapping available for that mapping type. 

f. Click Save.  

17. To set up e-invoicing at the company customer level: 

a. While still in the Customers workspace, expand the Company Customers subtab for your 
selected customer. 

b. Select a company customer from the filter list in the subtab. 

c. Expand the Details sliding panel in the subtab. 

d. Fill out the mandatory fields under the E-Invoicing island. 

e. Fill out the fields under the E-Invoice Mappings island.  

For each field, select any standard or customized mapping available for that mapping type.  

f. Click Save.  

18. You also need to ensure that your tax codes and tax tables are set up and mapped correctly, so 
that VAT is calculated on the outgoing invoice. 

Perform the following steps: 

a. Follow the procedure for creating an import file for the tax category option list.  

https://docs.peppol.eu/poacc/billing/3.0/codelist/eas/
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The format is the same for both on-premises and Cloud customers, but the contents of the 
import file depend on how the tax codes are set up on the system (varies from customer to 
customer).  

The following is a sample option list. 

 
Note the following: 

 The option list number should be TAXCATEGORY. 

 For each tax code in your tax code table, add an option to the list where: 

 Name = The tax code name 

 Description = The tax category for that tax code 

 
 Remark 1 = If you use the E tax category (Exempt from Tax), use this column to 

enter the tax exemption reason text. 

b. Import the import file to the Workspace Client. 

c. Proceed with the usual procedures for tax setup.  

Procedures for Addressing Common Errors 

Resend an Invoice 

To resend an invoice: 
1. Go to the Show All Invoices single dialog box. 

2. Open the invoice you need to resend. 

3. Click the Send to Pagero action. 

4. Accept the warning that Maconomy displays.  

Attention: For the list of PEPPOL BIS 3.0 tax categories, refer to the following: 

https://docs.peppol.eu/poacc/billing/3.0/bis/#_vat_category_codes > 

https://docs.peppol.eu/poacc/billing/3.0/bis/#_vat_category_codes
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Pagero-Generated Error 
If Pagero has stopped an invoice due to an error in Maconomy, create a Customer Care case. Include the 
error message from Pagero and the invoice information. 
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Maconomy Extender 
The Maconomy Extender is an integrated development environment (IDE) that is dedicated to 
customizing Maconomy. The Extender allows business consultants or technical consultants to change 
components or develop new components, to keep these under version control, and to deploy these 
components to test and production systems. 

 

Attention: For detailed information about the Maconomy Extender, refer to the Maconomy Extender 
manual. 
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Translations 

Getting Started with Localization 

Before You Begin 
Before you begin, complete the following:  

 Prepare for the translation by reading the latest documentation. Know the terminology used in the 
existing dictionary and the changes you plan to add. Knowing the functionality in which the strings 
to be localized are used are key factors for quality translations. 

 Learn the special notations used in the Maconomy dictionaries; see the “One Page Dictionary 
Guide.” 

 Install a good text editor. The preferred application in which to work with the dictionary is a regular 
text editor preferably with good search capabilities. Examples include Crimson and Notepad++.  

 
Try out the helping tools provided by Deltek. They can save you a lot of time and trouble and will also 
result in higher quality.  

 
Whether you translate manually, or use a Custom Dictionary Builder, following are some pitfalls to avoid:  

 Term variations: A term may appear in several forms. For example, “Project manager” appears 
also as “Project Mgr,” “Project Man.,” “Proj. Manager,” “ProjectManager,” or even just “PM.”  

 Case variations: “Job name,” “Job Name,” and “job name” should be considered individually. 
English has a tradition for uppercasing all words in field labels, but other languages have different 
conventions. 

 Correct grammar: Changing Job to Engagement implies changing “a job” to “an engagement.” In 
other languages, a change in the grammatical gender of words will have a similar effect on other 
neighboring words. Also, consider plurals like “Proj. Mgrs.”  

 The string length should be taken into consideration. Most of the Maconomy system can only 
handle strings up to 256 characters. In addition, layouts (both print and screen layouts) are to 
some degree sensitive to changing the length of field titles. Maconomy will try to adjust the 
layouts, but longer strings may look odd or cause printing beyond the paper margin. 

Become Familiar with Documentation 
The first thing you need to do before starting work on a missing list is to read the documentation on the 
procedures, guidelines, and requirements to formats and notation. Currently, the following documentation 
is available: 

 Dictionary Format and Notation Manual 

Warning: “Smart” programs like Microsoft Word or Excel are not recommended as they will 
often silently change the text, such as the number of spaces, or "quotes" to “quotes”. 

Attention: For further information about the tools and resources that can help you in your work, see 
the “Common Issues to Avoid” section. <Replace text> 
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The strings in the missing list originate from different sources in the Maconomy software, not just 
windows and printouts. Error messages, menu titles, and tool tips are also part of the dictionary, 
in addition to import programs and reports. You will therefore encounter placeholders, special 
characters, and notations that need to be handled in a specific way. This manual describes the 
most common types of notations and line types, making it easier for you to achieve the correct 
notation in the translation. The manual also describes how genders are specified and how to 
manage gender-dependent grammar in the dictionary. 

 Maconomy Online Help and Maconomy Information Center 

The online help provides detailed information about the functionality of the Maconomy system. 
The Maconomy Information Center is a hub for all Maconomy documentation at a single stand-
alone link you can bookmark. Make sure you have it.  

 
 Release Notes and Enhancements Guide 

The Release Notes and Enhancements Guide describes the new features introduced from one 
version of Maconomy to the next. By reading this information for the version whose missing list 
you are translating, you are acquainted with the functionality behind the strings in the missing list, 
which is a shortcut to deciding on the correct terminology.  

How to Update a Translation File 
This section provides instructions on how to complete each of the steps to update translation files (also 
known as Dictionaries). It does not cover what happens if there are errors in the files or if anything in 
general should go wrong. Therefore, Deltek recommends that you have a technical consultant on call 
during this process. 

Translation File Update Workflow 
The process of updating translation files is divided into four main steps, described below. 

Attention: For more information, refer to the Maconomy Information Center. 
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Create a Custom Translation File 
Maconomy installations come with Standard and Solution translation files. When installing Maconomy, 
make a new file with the terms that need a different translation for the client. Thus, the new file becomes 
a “client”-specific translation file.  

 

Example of a Standard Translation File 
 Translations.W_17_0.en_US 

Examples of Solution Translation Files 
 Translations.en_US_CPA 

 Translations.sv_SE_MCS 

where  

 Lowercase letters specify language 

 First uppercase letters specify country/region 

 Last uppercase letters specify dialect, Maconomy solution, or customer specification 

Example of a Client-Specific Translation File 
 Translations. W_17_0.fr_FR_ORC or W_17_0.sv_SE_MCSORC 

1
• Add empty custom dictionary file to 

Extender project

2
• Add/update strings with changed 

translations

3 • Stamp the file 

4 • Deploy using the Extender

Warning: Always make changes to the client-specific translation files to ensure that changes are not 
overwritten during upgrades or new service packs. 
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Update the Translation Files 
Translation files are kept in two locations: 

 Application server  

 Web server  

Whenever you change the translation file, you must update it in BOTH places. Additionally, each 
environment must be updated separately. 

 
Before you begin, it is important to note that each new instance of a word must be translated as a 
separate string. For example, to translate Job to Project, you must update the word in each of its forms 
and each time it occurs in a different string. 

You can either add a new term (if it is not in the translation to begin with) or update an existing term (if it is 
in the file but you want it to be translated to something else). See details below. 

To update the translation files: 
1. Open the document in a text editor (such as Notepad++ or Crimson Editor), keeping the original 

file format. 

 
2. Delete the stamp, which is all the leading lines starting with two hash marks (usually the first six 

lines), such as: 

##505783 

##encoding = UTF-8 

##VERSION W 17.0 p102 

##USERLANGUAGE en_US_ORC 

##CHARACTERSET Unicode 

Server Locations 
App Server 

D:\maconomy\<version><env>\MaconomyDir\Definitions 

where 

 <version> represents the version of Maconomy installed at the client.  

 <env> represents your current environment. 

For example: D:\maconomy\w_12_0.test\MaconomyDir\Definitions 

Web Server 
D:\maconomyweb\<shortname>\cgi-bin\Maconomy 

where 

 <shortname> represents the shortname. 

For example: D:\maconomyweb\orcktest\cgi-bin\Maconomy 

Warning: Deltek strongly discourages the use of Excel as it often automatically and 
incorrectly changes whitespace and special characters. 
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##MOTV Mon Oct 26 12:07:29 2015 

3. Add or update terms as needed.  

On the left side are the source (From) strings to be translated, on the right side are the target (To) 
strings.  

For example: 

Source Target Column 

Job Project 

The job <x> is in 
use 

The project <x> is 
in use 

job project 

jobs projects 

create new job create new project 

4. Stamp the translation file. 

5. Move the stamped translation file back to the server (and web server). 

6. Place the stamped file on both the Maconomy Server and the Web Server. 

Add a New Term 

To add a new term: 
1. Search for the term you want to add to confirm that the term does not already exist in the file. 

2. Add the new term to the bottom of the translation file. 

 

 

Update an Existing Term  

To update an existing term: 
1. Use CTRL+F to find the term you want to change. 

2. Update the target column by replacing the existing translation with the new translation (taking 
care not to change the From/source column. 

When you update terms, you are more likely to find every occurrence of the word/term because a 
developer has already identified them, or the term has been refined so many times that all the 
occurrences have been discovered. 

Warning: Since it is difficult to find every occurrence of new term throughout the system, 
usually this is an iterative process, as you find all lines where your terms appear and add to 
your dictionary. 

Attention: For more information, see “Getting Started with Localization” where the process is 
explained, and tooling (the Solution Dictionary program) is described. 
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In both adding a new term and updating an existing term, it is important to keep a log of the 
changes. Files should be under version control with commit messages, using a tool such as 
Extender, Jira, or MS Azure Dev-Ops to track change requests. It regularly happens that the 
customer does not pass on all changes at once. 

 

Stamp the File 
Use the following online validation tool to stamp the translation file: 

http://dictionary.maconomy.com/cgi-bin/motv.pl 

 
After you’re logged in, follow the step-by-step instructions, selecting from the dropdown options as 
detailed on the site and below. The site also features several documents with more information. 

To stamp/validate a file: 
1. From the Choose Version dropdown list, select the appropriate version. 

2. Select the user language: 

 For version 15.0 and below: FR=French, ES=Spain, and so on  

 For version 16.0 and above, fr_FR=French, es_ES=Spain, and so on 

3. Select the character set: 

 Standard for version 15.0 and below 

 Unicode for version 16.0 and above 

4. Select the encoding, such as ISO-8859-1 or UTF-8.  

This should match the characterset used when saving the dictionary.  

5. If your translation file is based on one of the Solution translation files (for example, en_US_CPA 
or en_US_MCS), select Solution; otherwise, select No Solution. 

6. For custom translation files, enter the customer designation, such as ORC (uppercase).  

It becomes part of the dialect and part of the language name. Leave the Custom solution blank if 
you are creating a translation file for a language not delivered with Maconomy. 

7. For the Complete dictionary checkbox, take one of the following actions: 

 Select the checkbox if the translation file contains all the terms in the system. Usually this is 
checked only when creating a dictionary for a new language.  

 Do not select the checkbox if the dictionary is based on a standard or solution dictionary (that 
is, it only contains custom translations). 

8. Browse to select your translation zip file. 

Note: If this is the first time you’ve ever worked on a translation file, start by making a couple of 
changes, Next, validate and use the online validation tool to make sure the file works properly. Then, 
add more changes as needed. 

Warning: This is an internal tool available to our consultants and partners – NOT for customers 
directly. 

http://dictionary.maconomy.com/cgi-bin/motv.pl
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9. Select the Convert to Unix format checkbox if the customer’s Maconomy Server is a Unix 
server; otherwise, do not select the checkbox. 

10. Select the Do extra Quality check checkbox for extra validation of the translation file.  

This produces a report with warnings and notifications regarding possible issues with the 
translations, such as duplicate translations, translations with wrong placeholders, and so on. 
Deltek recommends selecting this option. 

 
11. Click Upload.  

12. When complete, download the zip file back onto your computer. 

After stamping, new stamping rules are added. These rules start with two hashtags (##). Directly 
below this is a line for the country code. The name of the customer as specified during stamping 
is added to the country code.  

13. Verify that the name of the customer mentioned in the previous step is the same as the name of 
the file.  

During stamping, it can happen that, for example, an underscore is not included. If they are not 
the same, file name must be changed. 

Confirm Users are Off Server 

To ensure users are no longer logged into the environment: 
1. Open the command prompt. 

2. Run the Maconomy server executable with the --users option against the chosen Maconomy 
system: 

MaconomyServer.exe -i<system-name> -S<shortname> --users 
or: 

macoracle.<system-name> -S<shortname> --users  
where 

 <system-name> is the name of the Maconomy system. 

 <shortname> is the database shortname to connect to. 

For example: 

MaconomyServer.exe -imaconomy -Smacoprod –users 
A list of logged on users displays. 

3. Check that no users are logged on. 

If users are still logged on, see steps in the next section. 

Note: US and UK users must modify the time stamp. See details below. 



Translations 

System Admin Guide 362 

 

Tips & Tricks 

If Users Are Still Logged On 
If users are still logged on when you need to move files back to the server, follow the steps below to 
bump people off the server. Stop the service altogether to prevent people from getting back on the server, 
as needed. 

To bump people off the server: 
1. Double-check that no Coupling Services are running. 

2. From the command prompt, run the Maconomy server executable with the following options to 
remove all user sessions: --users:remove=all   

 

Change Language 
When users log into the system, they must select a language in addition to a username and password. If 
a customer-specific file has been created, the user must select this language once.  

To change the language: 
1. In the WSC, go to Edit » Preferences. 

2. Under the Language section, select the needed language.   

For SSO Users 
Copy to come.  

.Hash Files 

.Hash files are temporary files that are created the first time a translation file is accessed. You must delete 
the old one so that a new one can be generated by the new translation file you are about to install.  

 

Manual Update Workflow 
If deploying translation with the Extender fails, use the steps below to manually update translation files. 

Note: If there are still users logged on, seek advice from a (more) senior consultant. 

Attention: For further steps and locations, refer to the Move File Back to Server section. 
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Ensure Links Are Correct 
Maconomy installations come with Standard and Solution translation files. When installing Maconomy, 
make a new file with the terms that need a different translation for the client.,Thus, the new file becomes 
a “client”-specific translation file.  

 

Example of a Standard Translation File 

 Translations.W_17_0.en_US 

Examples of Solution Translation Files 

 Translations.en_US_CPA 

 Translations.sv_SE_MCS 

where  

 Lowercase letters specify language 

 First uppercase letters specify country / region 

 Last uppercase letters specify dialect, Maconomy solution, or customer specification 

Example of a Client-Specific Translation File 

 Translations. W_17_0.fr_FR_ORC or W_17_0.sv_SE_MCSORC 

Update the Translation Files 
Translation files are kept in two locations: 

 Application server  

 Web server  

Whenever you change the translation file, you must update it in BOTH places. Additionally, each 
environment must be updated separately. 

1
•Ensure links are correct

2
•Update the translation file itself

3
•Stamp the file 

4
•Move the translation file back to the servers

Warning: Always make changes to the client-specific translation files to ensure that changes are not 
overwritten during upgrades or new service packs. 
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Before you begin, it is important to note that each new instance of a word must be translated as a 
separate string. For example, to translate Job to Project, you must update the word in each of its forms 
and each time it occurs in a different string. 

You can either add a new term (if it is not in the translation to begin with) or update an existing term (if it is 
in the file but you want it to be translated to something else). See details below. 

To update the translation files: 
1. Copy and paste the custom translation file from the App server (for example, 

c:\Maconomy\w_17_0.orctest\MaconomyDir\Definitions\) onto your computer.  

2. Open the document in a text editor (such as Notepad++ or Crimson Editor), keeping the original 
file format. 

 
3. Delete the stamp, which is all leading lines starting with two hash marks (usually the first six 

lines), such as: 

##505783 

##encoding = UTF-8 

##VERSION W 17.0 p102 

##USERLANGUAGE en_US_ORC 

##CHARACTERSET Unicode 

##MOTV Mon Oct 26 12:07:29 2015 

4. Add or update terms as needed.  

On the left side are the source (From) strings to be translated, and on the right side are the target 
(To) strings.  

For example: 

Server Locations 
App Server 
D:\maconomy\<version><env>\MaconomyDir\Definitions 

where 

 <version> represents the version of Maconomy installed at the client.  

 <env> represents your current environment. 

For example: D:\maconomy\w_12_0.test\MaconomyDir\Definitions 

Web Server 
D:\maconomyweb\<shortname>\cgi-bin\Maconomy 

where  

 <shortname> represents the shortname. 

For example: D:\maconomyweb\orcktest\cgi-bin\Maconomy 

Warning: Deltek strongly discourages the use of Excel as it often automatically and 
incorrectly changes whitespace and special characters. 
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Source Target Column 

Job Project 

The job <x> is in 
use 

The project <x> is 
in use 

job project 

jobs projects 

create new job create new project 

1. Stamp the translation file. 

2. Move the stamped translation file back to the server (and web server). 

3. Place the stamped file on both the Maconomy Server and the Web Server. 

Modify the Time Stamp 
Since the validation tool is in Denmark, for US and UK users, the date and time of the stamp might be in 
the future (six hours for US, 1 hour for UK). If this happens, you must reset the date modified property 
before moving the file back onto the servers; otherwise, you will receive an error when accessing the link.  

 

To modify the time stamp: 
1. Shift-click the folder where the stamped translation file is located, and select Open command 

window here. 

2. On the command line, enter the following (replacing the translation file name): 

Copy /b Translations.W_17_0.en_US_CPA+,, 
Note the plus [ + ] and two commas [ ,, ] at the end. 

Move the Translation File Back to the Server 

To move the translation file back onto the servers: 
1. Confirm that no one is logged into the environment you are going to update.  

2. Create a subfolder named “Archive” and put the original file there as backup.  

If the new file is not accepted, restore the temporary old file. 

3. Shut down the coupling services on the App server (under Start » Services). 

4. Re-confirm that no users are logged on. 

5. Copy the stamped translation file to MaconomyDir\Definitions on the App server. 

6. Copy the stamped translation file to cgi-bin\Maconomy on the Web server. 

Note: Right-click a file and click Properties to see the Created and Modified properties as well as 
time stamps on the file. 
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7. Delete the .hash files related to the translation file you are updating in MaconomyDir\Definitions 
on the App server.  

8. Delete .hash files in cgi-bin\Maconomy on the Web server. 

Quotations in Text 
How texts are handled depends on where they appear. There can be issues if you use quotations in the 
middle of a phrase. Layout terms seem to be sensitive to quotes, but error messages are not. If you need 
quotes in layouts, use single quotes. 

Text in Curly Braces 
Text in curly braces (for example, {No Translation}) appears in the translation file, but it is not displayed 
for users. This text is used for two purposes:  

 As a hint to you, the translator, from Engineering, to give a hint as to the intended meaning of a 
term. 

 To indicate two uses of the same unique term, such as “Invoice,” which can mean both “to 
invoice” or “an invoice,” and which has different translations in Danish.  

Maconomy does not display anything inside curly braces, so your translation (after the tab character) can 
have anything you like inside, or you can leave them out altogether.  

In this case, {No Translation} is probably a hint that the term should not be translated, such as a term for 
demo data. 

In other cases, it might be a technical term used by the code which will stop working if it is translated. 

Workspace Client Gender Terms 
Workspace Client terms are added to the MOTV Dictionary validation site to accommodate gender 
specifications.  

 To indicate the list of possible genders, translate the term: 

|Gender|{gender}  
 To indicate that the target language has (M)asculine, (F)eminine, and (N)eutral genders, enter: 

|Gender|{gender} |M|F|N| 
 To indicate that the target language has only one gender, enter: 

|Gender|{gender} |N| 
 To indicate the gender of a term, specify the correct gender on the line. For example, to indicate 

that an A/P Entry is of Masculine gender, add the following line: 

Gender{A/P Entry} M 

Encoding 
Character encoding is used when saving the dictionary file in the text editor as opposed to the character 
set used on the server. The default so far has been Western European ISO-8859-1, Latin Alphabet No. 1, 
but the Workspace Client supports the use of other character sets. 

Currently, only single-byte character sets are supported. 
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Encoding can be specified by selecting an encoding in step 4 of the validation tool or directly in the 
dictionary by a line with the encoding specification: 

##encoding = ISO-8859-1 

Automatic Translations 
Many of the new terms for the Workspace Client can be translated automatically with a few prerequisites:  

 Translate the gender term: |Gender|{gender} 
 Translate a few generic, gender dependent terms:  

 |Add ^1| 
 |Create ^1| 
 |Delete ^1| 
 |Insert ^1| 
 |Move ^1 down| 
 |Move ^1 up| 
 |New ^1| 
 |Print ^1| 
 |Save ^1| 

For example: 

|New ^1|  |Neuer ^1|Neue ^1|Neues ^1| 
To get the suggested new translations, validate the dictionary by selecting the Do extra Quality check 
checkbox. When downloading the result, the zip file will include a new _Suggested.txt file with possible 
translations for missing terms. Verify the suggestions, add them to the dictionary, and make a new 
validation. 

To efficiently automate as many translations as possible: 
1. Translate the terms mentioned above. 

2. Validate the dictionary by selecting the Do extra Quality check checkbox.  

This should suggest translations for many gender terms like Gender{Entity}. These suggestions 
are based on the existing @Gender entries. 

3. Verify the suggestions and add them to the dictionary. 

4. Validate the dictionary to get a list of missing gender terms. 

5. Translate any remaining gender entries 

6. Validate the dictionary.  

This should suggest translations to the generic terms above. 

For example: 

New A/P Entry  Neuer Kreditoreneintrag  

New A/P Reconciliation Neue Kreditorenabstimmung 
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Tools and Resources 
Depending on whether you are creating a new dictionary from scratch or updating an existing dictionary 
as well as your experience with the Maconomy system, the translation can be a large and complicated 
project. Strings in the dictionary are out of context and may contain special comments, abbreviations, and 
notations that need to be explained. Deltek therefore provides you with tools and resources to help you in 
your translation work. 

Access the tools and resources from the Localization Center: 

https://home.deltek.com/sites/Maconomy/LocalisationCentre/default.aspx. 

Solution and Custom Dictionary Builder 
When creating a custom dictionary, finding the lines to be modified, moving them to the custom 
dictionary, and modifying the lines can be a tedious task, especially when starting for the first time. 

The Solution Dictionary tool helps with this process. This program finds lines in a dictionary that match a 
list of terms. When found in those lines, the standard translation of the original term is replaced with the 
solution term.  

The input to the program is: 

 A file with terms to change 

 A standard (or solution) dictionary with translations to change 

 A solution (or custom) dictionary with changed translations 

The program creates a file with suggestions for new lines to the custom dictionary.  

Following is an example used in the Danish solution dictionary: 
Job Job Projekt 

This line will handle lines containing “Job” and will replace the standard translation of “Job” with “Projekt.”  

In some cases, however, you want to exclude some “false positives.” The next example is more complex: 
(?<!Id)Entity Entity Udførende afd. 

This line uses regular expressions to handle lines containing "Entity" but not "Identity." Again, the 
standard translation of "Entity" on those lines will be replaced by "Udførende afd."  

 
The replacement is intelligent about casing and contracting words, but it is not perfect, so the output file 
should be carefully reviewed before adding it to the custom dictionary. 

Translation Procedures 

Use the Custom Program 

To use the custom program: 
1. Copy the standard dictionary to a working folder and rename it (for example, as:da_DK_total.txt). 

2. If updating an existing custom dictionary, copy it to the same folder and rename it (for example, 
da_DK_CUSTOM_total.txt). 

Tip: For tips on using regular expressions see http://www.regular-expressions.info/quickstart.html 

http://home.deltek.com/sites/Maconomy/LocalisationCentre/default.aspx
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Ensure that it contains the same prefix and postfix as the standard dictionary. 

3. Create a term list file with instructions on what to change (for example, 
da_DK_CUSTOM.Terms.txt) in the working folder.  

The format of the list is three tab-separated columns:  

 Search expression, where lines in the dictionary matching this regular expression are 
handled (see above) 

 Original English term 

 Custom translated term 

4. Consider variations of terms (opportunity/opportunities). 

5. Create a file with suggestions for the custom dictionary.  

6. Run one of the following commands to create <OutputPath>\Suggestions.txt:  
SolutionDictionary da_DK_CUSTOM.Terms.txt <OutputPath> 
SolutionDictionary -c s da_DK_CUSTOM.Terms.txt <OutputPath>  

The second command will attempt to take the connection character s into consideration (for 
example, sagSfremdrift).  

 
7. Review the contents of Suggestions.txt before adding them to the custom dictionary. 

Add New Terms 

To add new terms to the Terms.txt file: 
1. Update the translations in the existing custom dictionary by creating a Terms.txt file containing 

only the new terms, and run the program on the existing custom dictionary: 
SolutionDictionary da_DK_CUSTOM.Terms.txt <OutputPath> 

2. Add the terms to the existing terms file and replace any relevant suggestions in the existing 
dictionary. 

After Translation 
When you have translated a list of new strings for a dictionary, add the translated lines to the latest 
version of the existing dictionary (if any) and stamp it using the MOTV tool. Part of the stamping 
procedure includes a validation to ensure that the system will run using the updated dictionary (for 
example, no two lines have the same literal translation or use illegal characters). To upload a dictionary 
for stamping, place it in a zip file containing no other files and follow the instructions of the MOTV tool. 

If any problems occur in the validation, they are listed in the log files returned by MOTV. You will receive 
a list of the lines causing the validation to fail, and you can make the necessary adjustments. Errors must 
be fixed before the dictionary can be used. Warnings should be reviewed to ensure that the reported 
issues are acceptable. See the document “Fixing typical errors and warnings in translation files” for 
information about resolving these errors. 
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To use the program:  
1. Copy the standard dictionary to a working folder and rename it (for example, da_DK_total.txt). 

2. If an existing custom dictionary is being updated, copy it to the same folder and rename it (for 
example, da_DK_COMPANY_total.txt). 

Use the same prefix and postfix as the standard dictionary. 

3. Create a term list file with instructions on what to change (for example, da_DK_COMP.Terms.txt 
in the working folder).  

The format of the list is three tab-separated columns: 

 Search expression: Lines in the dictionary that match this regular expression will be handled 
(see above) 

 Original English term 

 Custom-translated term 

4. Consider variations of terms (opportunity/opportunities). 

Create <OutputPath>\Suggestions.txt: Run one of the following commands to create a file with 
suggestions for the custom dictionary: 
SolutionDictionary da_DK_COMP.Terms.txt <OutputPath> 

SolutionDictionary -c s da_DK_COMP.Terms.txt <OutputPath>  

The second command will attempt to take the connection character s (for example, sagSfremdrift) 
into consideration. 

 

Documentation 
The first thing that you need to do before starting work on a missing list is to read the documentation on 
the procedures, guidelines, and requirements for formats and notation. Currently, the following 
documentation is available: 

 Dictionary Format and Notation manual: The strings in the missing list originate from different 
sources in the Maconomy software, not just windows and printouts. Error messages, menu titles, 
and tool tips are also part of the dictionary in addition to import programs and reports. You will 
therefore encounter placeholders, special characters, and notations that need to be handled in a 
certain way. 

This section describes the most common types of notations and line types, thus making it easier 
for you to achieve the correct notation in the translation. This section also describes how genders 
are specified and how to manage gender-dependent grammar in the dictionary. 

 Maconomy Online Help: The reference online help (formerly the Reference Manual) provides 
detailed information about the functionality of the Maconomy system. 

 Product Information: The Product Information describes the new features that are introduced 
from one version of Maconomy to the next. By reading the product information for the version 
whose missing list you are translating, you become acquainted with the functionality behind the 
strings in the missing list, which is a shortcut to deciding on the correct terminology. 
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Automation and Customization 
Most customer systems require automations and/or customizations. The following sections discuss some 
of the tools/possibilities for customized solutions. 
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Troubleshooting 
This section contains troubleshooting tips for various sections. 

Maconomy Server 
This section contains a description of the most common errors encountered on a Maconomy Server. You 
can use the hints in this section to find and correct an error yourself, or to trace an error before creating a 
support case with Maconomy Customer Support Service. 

No Users Can Log in to the System 
If users are unable to log on in the morning or after a reboot of the server, you should check the following 
before contacting Maconomy CSS: 

 Can you log on to the Maconomy server? If not, there may be a hardware problem or a faulty 
network connection. 

 Is MaconomyDaemon running? 

 Is OracleServiceORCL running? 

 Is there a shortage of disk space? Perform the routines described in the “Regular Routines — 
Daily” section. 

 Is a backup process hanging, blocking the Maconomy system? Check your backup. Activate the 
DOS window with the backup process, and press CTRL+C to break the operation. Then start the 
Maconomy system. 

 On systems that are running MS SQL Server, the system may be set in single user mode. 

To resolve this, use the SQL Server administration program to set the number of connections to 
unlimited (0). 

 On UNIX systems, the folder FontSupport may have been renamed to 
FontSupport.DontUse to prevent users from logging in during backup. Rename the folder 
back to FontSupport. 

 On three‐tier systems, is the TNSLISTENER service running on the database server? 

I am the Administrator, and I have Lost my Password 
If you are the Maconomy administrator, and you forget your password to the Maconomy application or 
you enter a wrong password three times in a row, Maconomy shuts you out of the system. To remedy 
this, an SQL update must be performed. Contact Maconomy CSS. 

To reduce the likelihood of this happening, assign administrator rights to a trusted super-user of the 
Maconomy system. This is done in the Users window in the Maconomy Set‐Up module. Then, if either of 
you forget the password, the other can open up the account again without involving Maconomy CSS. 

The Users Keep Experiencing Client Crashes 
If users experience client crashes when updating data in the system, you can check the following: 

 Check the log files as described in the “Check the Maconomy Error Log” and “Check the 
Operating System Error Log File” sections. 
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 Is the database tablespace running low? Perform the routines described in the “Check for Free 
Space in the Oracle Database” section. 

 Is the database inconsistent as a result of an error or a bug? Contact Maconomy CSS. 

 Are the users’ clients compatible with the Maconomy TPU? Check the TPU release notes or 
contact Maconomy CSS. 

The System Is Very Slow 
If you experience a lag in the system’s response, consider the following: 

 Has a user started an Analyzer report without parameters? This can cause a considerable drain 
on server resources. Refer to the “Killing a Process in Oracle” section for information about killing 
the process in question (terminating the client is not sufficient). 

 Has a user initiated a huge print job (for example, printing all G/L entries for a year)? This will 
cause a system slowdown. 

 Is it around the end of a month or the beginning of a month? Sometimes many tasks need to be 
taken care of at the same time, such as invoicing, posting, reporting, and approving time sheets. 
Consider changing your routines to even the server load or upgrade the server hardware to 
match the maximum load. 

 Does the Maconomy server initialization file (MaconomyServer<shortname>.I) contain the option 
-d? That option turns on server debug information and can reduce overall system performance. It 
should only be on during the installation phase. 

 Does the file TestMasks exist in the MaconomyDir directory? That file, which is issued by 
Maconomy R&D, is used in some support incidents to run dynamic tests on the system. This will 
reduce overall system performance. After completion of the tests, the file is no longer needed and 
should be removed. 

 Is something else (other than Maconomy) using large amounts of system resources? On 
Windows, open Task Manager to see current processes.  

 

Background Tasks FAQs 
This section provides Frequently Asked Questions for Scheduled Background Tasks. 

Is the Background Task System Running? 
You need to check what background execution threads are running and verify that they are “alive.” 

To do that, go to Set Up » Background Tasks » Management » Execution Runtime » Execution 
Nodes. 

This view displays all execution nodes “recently known” as well as their activity level. 

Attention: For more information about performance, refer to the “Performance” section in this 
manual. 
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Each node of type “Tread” represents an execution thread that can run a task. The threads are grouped 
into running processes represented by the PID, grouped again under the host name of the computer 
hosting that process. 

Every time a thread makes itself known (to query for background tasks) the Latest Activity time stamp is 
updated.Using this field, you can see when a thread las made itself known. The Timeout timestamp 
means that if the thread does not make itself known again before that time, the system may consider the 
thread as timed out, and may remove it from this view. If the thread is believed to be running an actual 
background task at that time, that background task will automatically be aborted by the system. 

It is possible to Stop an execution node. That means that no new background task will be assigned that 
node. 

In the following screenshot, the node with PID 8884 is stopped, meaning that background tasks will not 
be assigned to any execution node belonging to this PID. The threads may still be rendered as active 
(their Latest Activity is updated), but no matter what background tasks will not be assigned to those 
nodes. 

 

 

I Need to Shut Down the Coupling Service – Should I Do Anything? 
You don’t have to do anything. But if the coupling service is executing a background task while you shut it 
down, that task will time out and be aborted by the system. 

To avoid this situation, you can stop background task execution for the specific process ID, and after all 
underlying task threads are done executing tasks, stop the coupling service. 

Note: If all threads are Suspended/Stopped, no background tasks are processed! 
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You can stop the execution of background tasks for specific processes in Set Up/Background Tasks » 
Management » Execution Runtime » Execution Nodes. 

After clicking the Stop button for the process ID corresponding to the coupling service to be stopped, the 
view may change similar to the following (assuming that tasks were running): 

 
By refreshing the view, you can see when the tasks are done: 

 
Now the process can be stopped without aborting the background tasks. 

I Need to Copy the Production Database to Test – Can I Do So Safely? 
When a database copy is done, the background tasks are also being copied (in their current state) since 
they are part of the data. For many tasks this is not a problem at all. 

However, if some background tasks communicate with external systems (mail servers, file system, and 
web services), it may be relevant to ensure that the production and test systems are configured to handle 
these external resources differently and/or to ensure that background tasks that should only run on one of 
these systems are annotated with a proper nature. 

Note: You cannot get damaged data simply by shutting tasks down, but you may end up having tasks 
that are marked as failed because they are aborted by the system. Such tasks can be rescheduled, 
but the decision to do so is a manual one. 
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Natures are defined in the settings.ini file as well as named file and URL references and 
mail servers. REfer to the documentation in the README.txt file for these properties. 

If this has been set up properly, database copies can be done without issues. 

Alternatively, you can disable background task execution for the short name to which to database is 
copied and manually examine the pending background tasks/background task schedule rules before 
enabling background task execution for such systems. 

What Is the Status of the Background Tasks? 
Background tasks can essentially be in one of the following states: 

 Pending: The task is ready to be picked up for execution (when it’s active, it’s due time is up, and 
there’s nothing to await). 

 Running: The task is currently being executed. 

 Committed: The logic of the background task has succeeded and has been committed; handling 
of output documents has not been finalized yet. 

 Incomplete: After the task was Committed, the handling of output documents failed for some 
reason. For example, it was not possible to send mails, or not possible to store files. 

 Succeeded: The task has succeeded. The logic has been done and committed, and all handling 
of output documents (if any) has been successfully completed. 

 Failed: The execution of the background task failed. The overall reason “kind” can be seen in the 
background task filter, along with a more detailed description in the log associated with the task. 

In case of a failed task, the Execution Result can have one of the following values: 

 Aborted: The execution of the background task was aborted by a user, or it was aborted 
automatically by the system because the background task timed out. 

 User Error: This happens when the background task attempts to do something that does not 
make sense or is not allowed. This is similar to an end user experiencing an error message when 
entering data that is not accepted by the system. 

 Internal Application Error: This happens in case of an internal error in the application. 
Situations like this should typically lead to support issues with customer care. 

 Data Fail Error: This may happen if the background task targets a record that does not exist, or if 
the background task declares the creation of an entry that already exists. For example, if you try 
to update an employee that has been deleted, this type of error may occur. 

 Data Busy Error: This may happen if the data being targeted is in use or being modified by other 
users while the background task is running. Usually, this error will trigger a re-attempt a while 
later. If this error keeps occurring, the task will fail with this error code at the end. 

 Access Error: This may happen if the user executing the background task does not have access 
to the container in question. 

 Setup Error: This may happen if the task has been set-up to submit a time sheet that is already 
submitted. 

 Other Error: This may happen for other types of errors. 

If you go to Set Up/Background Tasks » Status » List of Background Tasks, there are many 
possibilities of overviewing tasks of various categories. 
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In addition to the actual status, you can trace: 

 When the task was created 

 When the task was due 

 When the task was started 

 When the task was ended 

 Which host machine/PID/Thread ID executed the task 
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Why Did a Background Task Fail? 
A background task has failed. To understand why, examine the explanations provided in the log of the 
background task. The log is found in: Set Up/Background Tasks » Status » List of Background Tasks 
» Background Task » Result Log. 

In the case below, a time sheet was created with the input: EmployeeNumber = 11 and PeriodStart = 
2016-11-07, but the PeriodStart field is not open for data entry. 

 

How Can I Limit the Size of the Background Task Database Table? 
Background tasks make up an important trace of things that has been done, letting a system 
administrator monitor the status of things. 

It is possible to set up a schedule rule that automatically deletes completed background tasks that are 
older than X number of days. This is even a default rule. By default, this rule deletes all completed 
background tasks that are eight or more days old. 

It is possible to configure: 

 Whether this should happen 

 What the time range should be 

 When the rule triggers 

This can be done from: Set Up/Background Tasks » Setup » List of Schedule Rules » Schedule 
Rules » Parameters. 
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By editing the CleanCompletedBackgroundTasks rule, you can alter this. In this example, if you change 
the Value field in the Parameters table from 8 to 15, tasks will have to be at least 15 days old to be 
deleted. 

Just remember that the longer the duration, the larger the size of the Background Tasks database table. 

Can I See Tasks That Were Run as Another User? 
In the background task status filter, you can see if a background task was run on behalf of another user. If 
background tasks have been deleted, there may still be a chance that you can dig up some information. 

By default, any background task that is set up to run on behalf of some specific user (that is, not as the 
background administrator user) is stored in a condensed form in the HistoricBackgroundTask database 
table. You can decide: 

 Whether completed non-failing background tasks are stored in condensed form or not 

 If they are, whether or not only background tasks running on behalf of a specific user are stored 
like that (in order to keep the size of the table down) 

By default, there is no place where you can inspect this historic information in a workspace, and the table 
is not indexed. This means finding data might take a long time. 

Basically, you need to do it using SQLPlus or another database administration tool. 
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The settings declaring to what extend (if at all) background tasks are logged in the 
HistoricBackgroundTask table can be altered in Set Up/Background Tasks » Management » System 
Defaults. 

 
Whenever any of these fields are changed, it is logged (also in HistoricBackgroundTask) who made the 
change and what the implication of the change was. 

What Is the Purpose of the HistoricBackgroundTask table? 
The purpose is to resolve a situation where an entity says, for example, Approved by User name, but 
the user refuses any knowledge of that. In this case, you can search for a HistoricBackgroundTask that 
has done the approval action on behalf of that user. If such a HistoricBackgroundTask exists, the situation 
can be explained. Obviously, this can only be done if history trace is enabled. 

How Can I Limit the Size of the HistoricBackgroundTask Table? 
You can only limit if/to what extend data is stored in HistoricBackgroundTask. It is not possible to delete 
any records from this table from within Maconomy. Hence, the table will keep growing as time goes by. 

For this reason, it may eventually be necessary to delete old portions of this table. Doing so will have to 
be a manual task done by a DBA (for example, using SQLPlus). 
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Execution Threads are Active, but No Tasks Are Being Executed. Why? 
You need to figure out if the background tasks are ready for execution. This includes checking: 

 What is the due date/time for the background tasks? 

 Are the background tasks active or inactive? 

 Are the pending tasks awaiting some other task that isn’t completed, or isn’t due? 

 Are the tasks associated with a nature different from the nature of the current system? 

 Are there errors being reported by the task execution engine (see server log)? 

 Does the background administrator have adequate access rights? 

Properties of the tasks can be seen in Set Up/Background Tasks » Status » Background Task. 

 
In the above screenshot, you can see that the Waiting for root n tasks cannot be picked up for execution 
because they await the root task, and the root task awaits the due date/time before it can be picked up. 

Another cause could be related to more critical errors experienced by the background task execution 
engine. The status of this can be tracked by enabling logging in the logback.xml file found in the 
/configuration/settings folder in the coupling service installation folder. 

If you have an appropriate appender defined (it could be the FILE appender, or it could be one dedicated 
for background tasks execution), you can enable all logging concerning the background task execution 
engine by adding this to the logback.xml file: 
  <logger name="com.maconomy.coupling.service.batch" additivity="false"> 

    <level value="DEBUG"/> 

    <appender-ref ref="FILE" /> 

  </logger> 

Level TRACE will give an even higher amount of information from the background execution engine. 
Errors could include not being able to login, background task user not having adequate access, and so 
on. 

My Background Tasks Are Not Run at an Adequate Pace – Why? 
If background tasks are not picked up soon enough, it may indicate that the execution engine is too busy 
performing background tasks. 

You may need to consider: 

 How many background task execution threads are enabled (across all server machines)? 

 Are any of the execution threads stopped or suspended? 

 Are the pending tasks awaiting other tasks? 
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 Are the tasks being picked up for execution, but time out? In that case, is the maximum duration 
of the task set to an adequate amount of time? 

 Are any of the expected task assigned a nature different from the current systems? 

 Are the tasks activated? 

Most of these topics are mentioned elsewhere in this FAQ. 

The Maximum duration can be set specifically on a task as well as on task generator rules. The default 
maximum duration can be configured in Set Up/Background Tasks » Management » System Defaults. 

 
Maximum duration for tasks created by a schedule rule can be configured in: Set Up/Background Tasks 
» Setup » List of Schedule Rules » Schedule Rule. 

 
A value of 0 means apply the default maximum duration. 

My Background Task is Green, But It Didn’t Run – Why? 
If the task is green (that is, Succeeded), it means that the execution framework indicates that the task 
was successfully run. 
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There are a couple of things you can check: 

 Is the record key(s) referencing the expected record(s)? If not, the action was executed on 
something other than what you expected. 

 Is the record condition (if any) ruling out the expected record(s)? If so, the records you thought 
was being processes has been skipped. 

 How many records have been executed? If no records was actually executed, this is by default 
considered a successful background task. It is possible to flag a background task so that if the 
specified action is not applied for any record, it will be considered an error. 

In the log for the background task (in the Workspace), you can see exactly to which record keys the 
action has been applied. The log is located in Set Up/Background Tasks » Status » Background Task 
» Result Log. 
In this case, the action ran on one record: (EmployeeNumber = 11) 

 
In this case, the action ran on several records: (EmployeeNumber in {11, 12, 13, 14, 15, 31}) 

 

My Background Tasks Generator Hasn’t Run - Why? 
You should investigate: 

 When is the next due date/time of the background task generator? If this is sometime in the 
future, maybe the time trigger pattern is not what you think, and the rule really shouldn’t have run. 

 When was the task generator last run? 

 What is the validity date interval for this rule? If the rule is no longer valid (or not yet valid), this 
explains why. 

 Has the rule been set up to run a fixed number of times? If so, are there any runs left? If not, this 
could explain why. 

 Is the rule active? If not, this may explain why. 

You can investigate these things by going to Set Up/Background Tasks » Setup » List of Schedule 
Rules » Schedule Rule. 
If you can activate the rule, it is currently inactive. 
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Other settings can be seen here: 

 
If the rule is set to be run a maximum number of times, check if there are no runs left: 
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What Happens If Other Users Are Changing the Data of a Background 
Task? 
In case of the message “Data has been changed by another user,” the execution engine will automatically 
detect this situation and will re-schedule the background task to be attempted again soon. You can 
configure how many retries to attempt as well as the interval between retries. If the task keeps failing for 
this reason, it will eventually be marked as failed with a “Data Busy” error indication. 

You can track how many times a given task has been re-attempted. 

To set-up the default number of retries and duration between retries, go to Set Up/Background Tasks» 
Management » System Defaults. 

Here you can specify the default number of retries and the interval between retries. 
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It is possible to look up the settings for a given task, including the number of retries that occurred. 

 

Where Did the Output of a Background Task End Up? 
When a background task executes, sometimes output documents need to be taken care of. This could be 
printed journals, invoices, or log files (for example, from import programs). 

If a background task produces output, that output needs to be handled. If it is not specified how to handle 
output files (but the “core logic” otherwise succeeded), the task ends up having a status of Incomplete. 

The background task log lists the output documents that were produced and how/if they were handled. 

Basically, output files can be handled in two ways: 

 Sent by email to a specific recipient 

 Stored on the file system somewhere 

You can associate a file handler to a pattern. If you do, only output files having a name that matches will 
be handled by that handler. In this way, you can have PDF files stored in one location, and TXT files 
stored in another location. 

You can also choose to have some files both sent by email and stored on a file system. 

To see what output documents were produced and how they were handled, go to: Set Up/Background 
Tasks » Status » List of Background Tasks » Background Task » Result Log. 

In the example below, files where stored on a file system and sent by email. 
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Data Import Packages Troubleshooting 
You can troubleshoot Data Import Packages in several ways, including analyzing checksums, package 
integrity, and package history.  

Analyze Checksums 
Checksums show unique identifiers of this package, used for troubleshooting by advanced users. You 
can track the package throughout the system based on these checksum identifiers. These checksum 
fields can be used to verify the integrity of the package and track the package and package lines 
throughout the different systems.  

When you create a data import package, it is assigned a unique identification called Base Checksum. All 
the package lines created in this package are assigned the same Base Checksum. This checksum is 
assigned once, and it never changes. It can be used to track the package and package lines throughout 
different systems as well as validate the origin. 

Loaded Checksum and Saved Checksum fields are used when loading or saving packages from or to a 
file. When a package or package line is loaded or saved, the Current Checksum is transferred to the 
loaded/saved checksum. In this way, it is possible to track if the package has changed since it was 
loaded from a file or saved to a file. 

Additionally, the Imported Checksum field on package lines is set after the line is successfully imported. 
Maconomy transfers the value of the Current Checksum to this field. The Imported Checksum on the 
package holds the accumulated checksums of all the imported lines. This means that if all the lines in the 
package have been successfully imported, the value in this field will be equal to the value of the Current 
Checksum field.  

To analyze checksums: 
1. Go to Setup » Data Import Packages » Data Import Package tab » Advanced sliding panel. 
2. Review the checksums as needed and compare the unique identifiers as described above. 

 
Note: Additionally, an Advanced sliding panel for checksums is available in the subtab. 
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Verifications and Integrity Checks 
The Data Import Package workspace offers numerous fields that help you verify import data package 
information necessary for troubleshooting and confirming data integrity.  

To perform verification and integrity checks: 
1. Go to Setup » Data Import Packages » Data Import Package tab. 

2. In the Integrity island, review the Changed After Load and Changed After Save fields.  

A red color indicates a potential integrity breach.  

3. In the Package Information island, review validation and import details, including wall clock 
duration and execution duration.  

4. In the Last Execution island, review who scheduled the last validations and imports as well as 
when the action was performed.  

Package History 
Maconomy retains a record of import data package information for troubleshooting and data review 
purposes to track the lifetime of a package from its inception to import and purge. Details to help 
troubleshoot include the type of change (such as status change or import), the user who made the 
change, and the date.  

The information is retained as:  

 Summary format on the History tab  

 Detailed format on the All Lines History tab  

To review package history: 
1. Go to Setup » Data Import Packages » Data Import Package tab.  

2. Review data on the History or All Lines History sliding panel. 

Cancel Validation or Import  
Sometimes an issue occurs, and you must cancel a validation or import.  

To cancel a validation or import: 
1. Go to Setup » Data Import Packages » Data Import Package tab. 

2. Click Cancel Validation or Cancel Import, depending on which mode you are in. 

3. When a dialog box displays to confirm, click OK.  

After cancellation, correct the error and reschedule the validation or import.  

 

Killing Processes in Oracle 
Occasionally you will want to stop Maconomy from doing what it is doing. For example, this typically 
happens if a user starts running a very large Analyzer report without setting any parameters at all. When 
the user realizes how large the report is, or if they discover that it was the wrong report, the user will want 

Note: This information is logged in the Last Execution island on the Data Import Package tab. 
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to try to stop the report. The only way to do this, in the average user’s eyes, is by terminating the 
Maconomy client. 

However, since the processing of the report does not take place at the client, terminating the client does 
not end the the report-generating process. To stop a runaway process, you must terminate (kill) the 
process in the Oracle database. 

This section describes the way in which this is done. Note that only persons who have a thorough 
understanding of the Oracle database should perform the steps outlined in this document. 

The process of identifying and killing an Oracle process is very different depending on the platform. For 
this reason, the following description is divided into two sections: “Kill Process under Windows NT” and 
“Kill Process under Unix.” 

Kill Process under Windows NT 
This section describes how a runaway process is terminated if your Maconomy server is running under 
Windows NT. 

The OraEater Tool 
It is important to identify the correct Oracle process before killing it. With TPU 34 (27.00), a tool called 
oraeater was released. This tool determines which Oracle threads are using system resources 
intensively (such as Analyzer reports that do not have limiting selection criteria). The tool usually resides 
in the /bin directory of your Maconomy server. 

Usage 
oraeater <Oracle username> <password> [-a] 

This command displays a list that shows which Oracle threads have consumed the most CPU power for 
the last 20 seconds. The -a option shows the most CPU-consuming Oracle threads in total. The current 
thread and Oracle system threads are not shown. 

Example Output 

If an Oracle-eating process was found, the output from the tool might look like the following (without the -a 
option). 

-THREAD PROCESS USERNAM PROGRAM LOG_READS Last 20 secs 

-523 360:434 Claudia sqlplus.exe 27237,26 17119,91 

 -Active SQL     

 -select count(*) from code a, code b, code c, code d, code e 

The preceding output indicates that thread number 523 is consuming a large amount of Oracle resources. 
The Active SQL part of the output shows all currently active queries, not just those that are related to the 
threads listed. 

Resolution 
To kill the runaway process, use the Oracle tool orakill in the following way: 
orakill <ORACLE_SID> <threadno> 

For example, you can enter the following to terminate the problem process: 
orakill ORCL 523 



Troubleshooting 

System Admin Guide 390 

 

Kill Process under Unix 
This section describes how a runaway process is terminated if your Maconomy server is running under 
Unix. 

When a client logs in to Maconomy, and Maconomy resides on a Unix server, two processes are started: 
macoracle.r <application_id> oracle<SIDname> 

The <application_id> is the shortname of your Maconomy application(for example, W_7_0). An example 
of <SIDname> could be Orcl. The Parent Process ID (PPID) of <SIDname> is identical to the process ID 
(PID) of macoracle.r. 

To identify the correct process, it is important to know whether the client that initiated the process has 
been terminated or not (for example, if the Maconomy client has been forced closed while running an 
Analyzer report that does not have limiting search criteria). If the client has not been terminated, you can 
use the same method as you use when the client has been terminated, but not vice versa. 

Two‐Tier or Three‐Tier 
In a two‐tier Maconomy solution, the Maconomy server and the Oracle server reside on the same 
physical server. In a three‐tier solution, the Maconomy server and the Oracle server reside on two 
separate physical servers. Throughout the following description, the terms “Maconomy server” and 
“database server” are used. The principles are the same, regardless of whether you are running a two‐tier 
or a three‐tier system. 

Maconomy Server Executable Options 
This section describes the options that are available to the Maconomy server executable 
(maconomyserver on the Windows platform and macoracle on Unix). The following table provides an 
alphabetical overview of all server options. 

Command-Line Options 

 ‐DM<f> M‐Script‐related ‐t 

‐A<dir> ‐DS<f> ‐P ‐U<x> 

Analyzer‐related ‐E<f> ‐pC ‐v 

‐b ‐e<v> ‐‐port <portNo> ‐vv 

‐c<n> ‐f ‐Q Workflow‐related 

‐C<x> ‐FG ‐r<n> ‐W 

‐‐CreateDocumentTables ‐FV ‐R<r> ‐w<x> 

‐CS ‐h ‐s<c> ‐x<p> 

‐d ‐i ‐S<n> ‐Z<r> 

‐D<x> ‐I<f><!> ‐socket <s>  
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--DDLBuffers <n> ‐‐IP<str> ‐T  

Command line options are entered on the command line on Windows or as a Unix shell command. The 
command has the following form: 
Maconomyserver -[-]option[]<argument> 

Note that some options have one leading hyphen (-) and some have two (--). Also, some options require 
a space between the option and the argument, whereas most require the argument directly after the 
option. These differences are all reflected in the descriptions below. 

Index for MACONOMY_USERS 
To improve the index for MACONOMY_USERS, the command lines are migrated from the server 
command line i/f to the CouplingService command line i/f. 

For example, using the w_21_0.sp103 installation with shortname w21p3, a re-import and compile of 
print layouts look like the following: 
Cd C:\Maconomy\w_21_0. sp103\CouplingService 

CouplingService.exe -S m21p3 -UP 

 

Server Operation 
Query and/or manipulate the user session table as needed.  

Options can be chained and are processed in the order they appear. The options time and extended 
must appear before the options to which they apply.  

The following string abbreviations are permitted: 

exp(ired), abs(olute), rel(ative), int(ernal), ext(ended) 

Examples: 

--users:time=relative:list List all user entries, relative time 

--users:ext:list List all user entries, extended format 

--users:list=exp:remove:list List and remove expired user entries, then list all (remaining) user entries 

 

Option Description 

-f Start the server in foreground mode. The server listens by itself 
instead of using the inetd (UNIX) or MaconomyDaemon (Windows). 

-h Displays a help page with a brief explanation of each option in the 
Maconomy Server. 

Notes:  
 The process must occur in the folder where CouplingService.exe is installed. 

 A space MUST follow the -S option. 
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Option Description 

-I Prefix (basename) of .I file used when running (Windows only).  

Example: 
MaconomyServer -imaconomyserver.W_9_0 

Note that it is not necessary to include maconomyserver in the 
argument for this option. Hence, the preceding command can also be 
entered this way: 
MaconomyServer -iW_9_0 

In this case, the Maconomy server uses the initialization file called 
maconomyserver.w_9_0.I for reading startup options. 

-socket <s> Specify the socket to listen to (Windows only). 

-v Show the current version string. Result (example): 
MACONOMY SERVER for ORACLE vers. 33.02.0.330252 compiled 
Mar 3 2004 11:16:48 

-vv Show the current version string in extended format. This command 
lists the version numbers of the Maconomy server and other 
components such as MScript and MQL, and it also lists various other 
information regarding the current release of Maconomy Server. 

‐S<n> Set the shortname to <n> (avoid prompt). 

‐‐port <portNo> Make the server listen on TCP port <port no.>. This option is ignored 
if the option ‐f is not used. 

--DDLBuffers <n> The server caches <n> DDL files (Dialog Definition files). The default 
value is to cache 10 files. 

-x<p> Run the script/container specified by <p>. <p> can be a standalone 
program, a container, or a precompiled report. The server 
automatically detects whether <p> is invoked for interactive 
execution or for batch execution. 

--users[:<option>[=<value>]]* Query and/or manipulate the user session table. See details below. 

User Session Table Manipulation 

The following options and values can be used together with the --users[:<option>[=<value>]]* command 
line option: 

Option Value Description  

list all List all user entries (default) 

expired List only expired user entries 
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Option Value Description  

remove all Remove all user entries 

expired Remove only expired user entries (default) 

<Session ID> Remove a user entry by Session ID 

time absolute Print time values as absolute (default) 

relative Print time values as relative to now 

internal Print time values in internal representation 

extended n/a Use extended column layout (130 chars wide) 

Options can be chained and are processed in the order they appear. The options time and extended 
must appear before the options to which they apply.  

The following string abbreviations are permitted: 

exp(ired), abs(olute), rel(ative), int(ernal), ext(ended) 

Examples: 

--users:time=relative:list List all user entries, relative time 

--users:ext:list List all user entries, extended format 

--users:list=exp:remove:list List and remove expired user entries, then list all (remaining) user entries 

Import and Export 

Option Description 

-DM<f> Use Mac dictionary file <f> to translate relation names in import file. 

-DS<f> Use server dictionary file <f> to translate relation names in import file. 

-E<f> Export the current database to a file named <f>. 

-E<f> -as <filename> exports to stdout (UNIX only). 

-I<f><!> Import the export file <f> into the current database. If ! is specified, the application 
version check is ignored. 

-I<f><!>- as >filename> imports from stdin (UNIX only). 

Note that the options -UD and -UC are performed automatically when the import is run. 
First, all instance key constraints in the database to be imported are dropped. After the 
import, instance key constraints defined in the relation DatabaseRelations are created 
in the database. 
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Option Description 

-R<r> Apply the import/export on the relations specified in <r>, where <r> is a list of relation 
names delimited by a comma. If <r> is preceded by a hyphen, the import/export applies 
to all relations that are not in the list. 

-Q Create missing database users for view users, who are listed in the database but do not 
exist in the database.  

-T Tally: Count the number of records and relations in the database. When used with -I, 
the count is from the specified file to be imported. The database is always left 
unchanged when -T is specified. 

‐Z<r> Zero option. 

 
-Zt truncates current relation before import (used with -I). 

-Zr requires relation to be empty before importing (used with -I). 

-ZT truncates all relations, and terminates. 

-3 The server will update three party view group members. 

Layouts 

Option Description 

‐A<dir> Read Analyze, web, and special.txt Analyzer reports from directory <dir>. 

‐W The server import s and update the Window and Layout specification from the 
WindowLayoutList.txt file in the MaconomyDir/ScreenLayouts folder with the layouts 
found in the MaconomyDir/ScreenLayoutList/Design folder. 

-U<x> Update layouts and manipulate instance key constraints. The argument <x> for this 
option can be one of the following: 

 W: Install and update window layouts on the Standard and Solution layers (same as 
option -W). 

 P: Install and update print layouts. 

 LP: Install and update localized print layouts. Errors are reported in case of 
overlapping fields in the layout canvas. 

 L: Install layouts designed using Layout Designer. No MPL dumps will exist for 
these layouts. Consequently, they cannot be used as a base when defining new 
MPL layouts. 

 I: Update installation information in the database from the Dependencies file without 
the use of a client (faster when installing across a modem connection). 

Warning: Use this option with caution because records will be deleted from 
the database. 
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Option Description 
 A: Update Access Control Information. This is also called Enable Security. Updates 

the database so that users can only see licensed windows (for example, when 
searching for windows in the client Window Layouts window). This update is also 
performed the first time that a Windows or Macintosh client runs on a Maconomy 
system. 

 D: Drops all constraints on instance keys.  

This option has been deprecated. See -I<f><!>. 

 C: Creates all constraints on instance keys defined in the relation 
DatabaseRelations.  

This option has been deprecated. See ‐I<f><!>. 

 VP: Validate customized print layouts. 

 VW: Validate customized window layouts. 

 EP: Export all customized print layouts to MaconomyDir/ExportedLayouts/. 

EP:<path> Exports all customized print layouts to <path>. 

 EW: Export all customized window layouts to MaconomyDir/ExportedLayouts/. 

EW:<path> exports all customized window layouts to <path>. 

 IP: Import customized print layouts listed in 
MaconomyDir/ExportedLayouts/ExportedPrintLayouts.txt. 

IP:<path> imports customized print layouts listed in 
<path>/ExportedPrintLayouts.txt. 

 IW: Import customized window layouts listed in 
CustomizationDir/Solution/ScreenLayouts/ExportedWindowLayouts.txt. 
IW:<path> imports customized window layouts listed in 
<path>/ExportedWindowLayouts.txt. 

Analyzer‐Related 

Option Description 

‐‐CompileAnalyzer <path> With --CompileAnalyzer, the server compiles Analyzer 
reports. Use the following command: 

 For UNIX: 
macoracle.r.<appshortname> -S<shortname> --
CompileAnalyzer <path> 

 For Windows: 
MaconomyServer -i<appshortname> -S<shortname> 
--CompileAnalyzer <path> 

If the path name contains spaces, put it in quotes. For 
example: 
MaconomyServer -iW_8_0 -Sw80 --CompileAnalyzer 
"C:\My AnalyzerReports" 
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Option Description 
Any errors from the compilation are written to the screen. 

<path> can be a path to a directory or a path to a specific 
file. If it is a path to a directory, all files with the extension .gr 
in the directory in question will be compiled. Otherwise, only 
the specific file will be compiled. 

The compiled file(s) (with the extension *.grf) will be placed 
in a directory called CompiledFiles under the directory in 
question. 

--ConvertAnalyzerFiles The --ConvertAnalyzerFiles option is a shortcut for calling 
MBuilder with the option --Analyzer, followed by calling the 
Maconomy server with the option --AnalyzerViews. See the 
MBuilder manual for details. 

--CompileAndConvertAnalyzerFiles 
<path> 

The --CompileAndConvertAnalyzerFiles option is a 
shortcut for calling the Maconomy server with the options --
CompileAnalyzer and --ConvertAnalyzerFiles in 
succession.  

First, the Analyzer files in <path> are compiled as described 
for --CompileAnalyzer <path>. Then, if the compilation 
succeeded without errors, the compiled *.grf file(s) are copied 
to the Analyzer folder of the selected application. You are 
prompted before overwriting existing files in the folder. The 
compiled files are then converted as described for –
ConvertAnalyzerFiles. 

M‐Script‐Related 
These options enable you to run M-scripts using the Maconomy server executable instead of the 
MaconomyMScript executable on the web server. 

Option Description 

‐‐mscript <filename> Execute an M‐script (in Maconomy server command‐line 
context). This corresponds to executing the script in M‐Script 
stand‐alone context, only using the server executable rather 
than the MaconomyMScript executable.  

See the M‐Script Language Reference manual for details. 

‐‐mscriptLogFile <LogfileName> Specify where M‐Script should write its log file. If this option 
is not used, the log file will be written to 
Tmp/MaconomyMScript.log. However, this setting is subject 
to being overwritten by the corresponding setting in the .I file. 

‐‐mscriptIFile <InifileName> Specify which .I file to read when executing the M-script. If 
this option is not used, the server will attempt to read the 
MaconomyDir/Definitions/MaconomyMScript.I file if it 
exists. 
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Option Description 
Note that a number of the setup-related .I file options that are 
available to stand-alone M-Script cannot be used in an .I 
file on the Maconomy server. These options include: 

 ServerIP DaemonPort 
 ListenFrom 
 Connection 
 MaxListenPorts 
 WaitForServer 
 WaitForDaemon 

For more information, see the M-Script Language Reference 
manual. 

‐‐mscriptQueryString <QueryString> Specify a query string to send to the server. This corresponds 
to the -q option for stand-alone MScript. This option can be 
used multiple times in the same call to the Maconomy server. 

‐‐mscriptConfigurationLine 
<key=value[;key=value]> 

Specify a configuration line. This corresponds to adding the 
line to the bottom of the .I file. This option can be used 
multiple times in the same call to the Maconomy server. 

Workflow‐Related 

Option Description 

‐‐DumpWorkflow template 
LIFECYCLEDEFINITIONNUMB
ER [OUTDIR] 

This command is used for dumping pre-MWL workflows as a 
template on the server. 

LIFECYCLEDEFINITIONNUMBER is the definition number of the 
life cycle. OUTDIR is the output folder where the server will dump 
the MWL workflow template. If not specified, this option defaults to 
the current working directory.  

See the Maconomy Workflow Language Reference manual for 
details. 

‐‐InstallWorkflow MWLFILE This command installs the MWL workflow specified in MWLFILE to 
the custom branch of the server. 

MWLFILE is the MWL specification file. The associated M‐script 
and configuration file must have same base name. That is, if the 
MWL file is named timesheetheader.mwl, the other files must be 
located in the same folder and named timesheetheader.1.ms and 
timesheetheader.I. If timesheetheader.mwl is located in the 
subfolder myworkflows relative to the current working directory, it 
can be installed by issuing the command: 
maconomyserver -f --InstallWorkflow 
myworkflows/timesheetheader.mwl 
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Option Description 
When you install the workflow, the Maconomy server renames the 
installed workflow files to match the workflow name, if they are 
different. Workflows are installed in the 
<Appl_home>\MaconomyDir\MScripts\Workflows folder. General 
monitors are installed in the 
<Appl_home>\MaconomyDir\MScripts\Workflows\GeneralMonitors 
folder.  

See the Maconomy Workflow Language Reference manual for 
details. 

‐‐VisualizeLifecycle 
<inputfilename> 
<outputfilename> 
[internal|external] 

This option tells the Maconomy server to look for the Maconomy 
Workflow Language file specified as inputfilename, produce a 
visualization of the specified workflow in a file called 
outputfilename, and then terminate. The type of the output file is 
determined by the file extension. If the extension is .gif, the output 
format will be GIF, and similar for the other formats: SVG and 
PNML. 

The optional third argument specifies which titles should appear on 
the output graphics:  

 internal: The stages and transitions will be labeled with the 
value of their Name attribute. 

 external: The Title attribute will be used (if it exists). 

Other Tools 

Option Description 

-FV Validates all foreign keys, and writes errors to standard output. 

-FG Generates SQL commands on standard output, updating foreign key 
references with invalid spelling (lower case/upper case problems). 

--
CreateDocumentTab
les 

With --CreateDocumentTables, the server creates the tables 
TEXTDOCUMENT and BINARYDOCUMENT (with indexes) in the database. 

--IP<str> IP security: Denies or allows server connections based on the 
remote IP address. This applies to clients, WebDaemons, and CGI 
programs. The options are: 

 --IPdeny <addresslist>: Add addresses to the list of IP numbers denied 
access. 

 --IPallow <addresslist>: Add addresses to the list of IP numbers allowed 
access. where <addresslist> has the format: 
<address> [ '-' <address> ] { ';' <address> [ '-' 
<address> ] } 

The --IPdeny and --IPallow options can be specified in all 
initialization files.  
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Option Description 
Examples: 
--IPdeny 10.22.33.44 

--IPallow 127.0.0.1; 10.22.33.0 - 10.22.33.255 

The check algorithm is as follows: 

1. Look for address in deny list. If found, Reject connection. 

2. Look for address in allow list. If found, Accept connection. 

3. If not found in either list, Reject connection. 

If --IPdeny or --IPallow are not specified, all connections are allowed. 

 

Initialization Files 

A number of options are set in initialization files. A total of five initialization files exist. 

<appl_ID>.I Read by MaconomyServer 

Maconomy.ini Read by MaconomyServer 

.W Read by the server when the Windows client is launched 

.M Read by the server when the Macintosh client is launched 

.D Read by the server when the web client (Java client) is launched 

The primary server initialization file has the extension .I. The prefix (or first name) of the file is usually 
MaconomyServer.<appl_ID>, but another prefix can be specified using the -i option. The standard 
Maconomy.ini file is located in the MaconomyDir/Definitions folder of the server application to which they 
apply. Additional files with custom settings can be placed in the CustomizationDir/Custom/Definitions and 
CustomizationDir/Custom.<shortname>/Definitions folders.  

The server initialization files (.I and .ini) are read by MaconomyServer after the server has started and 
executed any command line options. 

The client initialization files (.W, .M, and .D) are read by MaconomyServer when a client of a given type is 
launched. This way, it is possible to specify different options for clients on different platforms. 

MaconomyServer.<appl_ID>.I 
The following options can be entered in the initialization file for the Maconomy server. 

Note: Remember to quote the options if giving this option on the command 
line.  

Example: 
--IPallow "127.0.0.1; 10.22.33.0 - 10.22.33.255" 
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Server Operation 

Option Description  

-b Enables server batch print mode. See also the Product Note “Maconomy Batch 
Printing.” 

-c<n> Uses CC_Table <n> as the default. A CC_Table performs character conversion 
between platforms. 

-d Activates debug output. Debug output can be relevant when resolving problems. 
However, activating debug output can hit server performance. 

-D<x> When the debug file reaches <x> bytes, close it and open a new one with the 
same name (overwriting the old one) to save disk space. Debug files are created 
in the MaconomyDir/Tmp directory and named in the following way:  

<x>Debug<y..y>, where <x> can have the following values: 

 O: When running an Oracle™ database. 

 M: When running an Microsoft SQL Server™ database. 

 X: When running MaconomyServer with the ‐x<p> option 

 I: When importing a database into Maconomy with the ‐I<f><!> option.  

The <y..y> part of the debug filename is a random name. The length varies 
according to platform. 

-e<v> Sets an environment variable. <v> has the form VAR=VALUE. You can, for 
example, use this to specify Oracle and Maconomy home or the current 
language. Examples: 
-eMACONOMY_HOME=F:\MaconomyNT\Maconomy\w_8_0 

-eORACLE_HOME=d:\oracle\ora81 

-eORACLE_SID=ORCL 

-eNLS_LANG=AMERICAN.WE8ISO8859P1 

-r<n> Sets the record container cache size. Limits the number of lines (<n>) that can 
be displayed in one dialog box in the Java client and in a dialogGet executed in 
M-Script. The default value is 5000. 

Increasing this value will increase memory usage by 16 bytes * <n> * the number 
of Maconomy servers. Increasing the value significantly will also increase CPU 
usage. 

-s<c> Oracle only  

Uses <c> as SQLNET connect string (in three-tier setups with the database on 
another host). 

-t NT only 

Enables stack trace which can be used for debugging on the Windows platform. 
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Option Description  

‐P Sybase only 

Uses stored procedures instead of direct executes.  

This option has been deprecated; do not use. 

-CS Shows the server’s current configuration settings. 

Web Operation 

Option Description 

-w<x> The server waits <x> milliseconds before timing out when communicating with a 
CGI client in web mode. The default value is 30000 milliseconds (30 seconds). 
This can be set in the .D initialization file as well. 

-C<x> The server caches <x> Analyzer layouts during web execution. The default value 
is 5. This can be set in the .D initialization file as well. 

Options Both on Command Line and in Initialization Files 

The following options can both be set on the command line and in the server initialization file. Please refer 
to the preceding descriptions for the following options: 

 -f 
 --AnalyzerViews 
 --CreateDocumentTables 
 --IP<str> 
 -A<dir> 

Maconomy.ini 
The settings in this file are read by the Maconomy server. The file resets to default settings every time 
that you upgrade Maconomy. The file has the format of ordinary Windows initialization files with section 
headings in the form [section] and entries in the form key=value. 

To add or change settings which should be preserved during upgrades, you can create a new 
Maconomy.ini file in the Maconomy server’s customization folder hierarchy, either in 
CustomizationDir/Custom/Definitions or CustomizationDir/Custom.<shortname>/Definitions (for 
shortname-specific configuration settings). Settings read from these files take priority over any settings in 
the standard Maconomy.ini file. 

Settings in ServerConfig 
The following settings can be specified in the [ServerConfig] section. The LIST value type means that 
you can specify one or more of the following values: WebClient, WinClient, MacClient, ALL, and NONE, 
separated by a comma if you specify more than one. 
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Name Type Description 

NoRestrictionOptimization None This key does not have a value. Maconomy 
simply checks for the existence of the key. 

AllowNonSSLClients LIST If you need to run the Macintosh client in an 
SSL environment, you must set this key to 
the value MacClient. 

AllowOldClients LIST  

AllowWinClientSansXE BOOLEAN This is the language used when localizing 
set-up data. Example: W 

DefaultEncoding STRING In this section, specify a character encoding 
scheme to be used by the Maconomy client 
or the Java™ platform. Specify the 
character set used by the server.  

DefaultReportEncoding STRING This is the default user language in the 
clients. If this is not set, the setting for 
EnterpriseLanguage is used. Example: 
W_MCS 

DisableSSL LIST This specifies whether ro not Secure 
Sockets Layer (SSL) should be activated for 
the server when using the client(s) specified 
in LIST. 

IPAddress STRING  

LifeCycleCheckHighLevelLock BOOLEAN 

 

If this setting is true, Life Cycle Actions are 
only enabled if no other user holds a high-
level lock on the current record. 

LogAllUpdates BOOLEAN This enables logging of all updates in the 
application for relations defined in the 
UpdateLog.cnf file. For more information, 
see the chapter “Advanced Logging.”  

 

ROCacheActivated BOOLEAN If the value is true, Maconomy caches all 
universe and Analyzer reports run by users, 
according to the specifications set by the 
other RO* options specified in the file.  

The caching system prevents the 
recalculation of universe and Analyzer 

Important Note: This setting is 
experimental and may cause duplicate 
entries in the update log. 
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Name Type Description 
reports when printing a report. Activate the 
caching system to improve performance.  

If the value is false, the other RO* options 
do not apply. 

ROCacheNumOfRowsMAX LONG This controls the number of Report Objects 
to be cached. The default value is 100 
objects. When the number of objects 
reaches this value, the oldest object is 
flushed (deleted) from the cache. 

ROCacheTimeoutMIN LONG This is the Report Object timeout value in 
minutes. The default value is 10 minutes. 
After this time, the report object is deleted. 

ROMaxNumberOfRows LONG This sets the maximum number of table 
rows to process in MPL1-3 prints. 

ROMaxNumberOfRowsStrict LONG This is similar to ROMaxNumberOfRows 
except the print will fail if the limit is 
exceeded. 

ScriptCustomizationDisabled BOOLEAN This specifies if string comparisons are 
case-sensitive. String comparisons were 
made case-sensitive as of version 7.1. This 
option can be set to false by M-Config if you 
are using a case-insensitive SQL Server 
database. 

RPC_UserIdleTimeout INTEGER This is the timeout of idle users connected 
via the RPC protocol. This includes the 
Workspace Client and REST API. 

RPC_Log = true|false BOOLEAN This specifies if the collected information will 
be written to log files beneath the specified 
folder path, or to the default temporary 
directory (for example, 'X:\Maconomy\Tmp' 
or '/tmp'), with the following naming scheme: 

RPC_Log-<PID>-<TIMESTAMP>.log 

RPC_LogFolder STRING <folder-path> 

RPC_LogTruncateOn ENUM This is a comma-separated list with log 
events on which to truncate the RPC log. 
Any combination of the following log events 
can be set: login, reconnect, detach, logout, 
and/or all. 



Troubleshooting 

System Admin Guide 404 

 

Name Type Description 

DB_DisableRequestCancellation BOOLEAN This flag disables progress monitoring and 
cancellation for long running database 
operations. 

The default value is false. 

DB_Cancellation_InitialDelay INTEGER This is the initial delay in seconds before the 
progress bar appears for long running 
database operations. 

The default is 2 seconds. 

DB_Cancellation_PollInterval INTEGER This is the maximum reaction time in 
seconds for the progress bar if the user 
decides to cancel the long running database 
operation. 

The default is 2 seconds. 

DB_Cancellation_DefaultTimeout INTEGER This is the default timeout before a long 
running database operation is automatically 
cancelled. 

MConfig will set this value, but otherwise 
the internal default is 300 seconds (5 
minutes). 

DB_CancellationCompletionTimeout INTEGER This is the maximum time the server will 
wait for the database to respond to a 
cancellation request. If the running 
database request is not successfully 
cancelled within this time, the database 
session will be forcefully terminated. 

The default value is 10 seconds. 

Settings in ApplicationConfig 

The following settings can be specified in the section [ApplicationConfig]. 

Name Type Description 

ApplicationVersion STRING This is the Maconomy version running on the 
current server. 

DefaultSimpleSearchTab INTEGER This specifies if “simple search” should be the 
default when pressing CTRL+F in the Windows 
client. 

EnterpriseLanguage STRING This is the language used when localizing setup 
data. Example: W 
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Name Type Description 

LifeCycleCache BOOLEAN The Maconomy server by default caches life cycle 
(workflow) scripts (such as custom action guard 
scripts). However, during development of such 
scripts, it is beneficial to set this option to false so 
that you do not have to restart the Maconomy 
server every time you change the script. 

MSLCaseSensitive BOOLEAN This specifies if string comparisons are case-
sensitive. String comparisons were made case 
sensitive as of version 7.1. This option can be set 
to false by M-Config if you are using a case-
insensitive SQL Server database. 

MPMLogDirectory STRING The path specified here indicates where the 
Maconomy Performance Monitor output log is 
placed. If this option is not present, or if the folder 
is not accessible for some reason, the MPM 
functionality is turned off completely.  

See the “Maconomy Performance Monitor” 
section. 

PPUSQLAccess ENUM ENUM can have the value write (default), read, or 
off. This makes it possible to grant full access to 
modify the contents of the database using 
PPUSQL.  

Full access is only granted if certain other criteria 
are met (see the PPUSQL manual for more 
details). If set to read, the contents of the 
database can only be read with PPUSQL. Setting 
this to off completely prohibits PPUSQL from 
connecting to the database. 

ReportLeftMargin LONG This creates an additional left margin in RGL 
printouts. The extra margin is specified in points. 

ReportTopMargin LONG This creates an additional top margin in RGL 
printouts. The extra margin is specified in points. 

SSO ENUM ENUM can have the value off (default), 
namematch, or namemapping. This specifies if 
Single Sign On is enabled, and the authentication 
method used if enabled.  

See the “Single Sign On with Kerberos” section. 

SSODomain STRING This is a list of domain names. If Single Sign On 
(the old version without external verifier) is 
enabled, the user must exist in a domain specified 
here.  

See the “Single Sign On” section. 
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Name Type Description 

SSOAllow STRING See the description for SSODeny. 

SSODeny STRING Together with SSOAllow, these options define a 
range of valid IP addresses when using Single 
Sign On (the old version without external verifier).  

See the “Single Sign On” section. 

TechMissingStageMessage BOOLEAN You can choose to let the workflow engine issue 
very technical error messages or more general 
messages.  

If this setting is false or undefined, a message 
might look like this: “The Life Cycle Definition ʹ^0ʹ 
for the object does not allow the operation to be 
executed. (Transition ʹ^1ʹ cannot be executed as 
Stage ʹ^2ʹ is not active).This is useful while 
debugging workflows.  

If this setting is true, the same message would be 
something like: “The operation cannot be 
completed as it is in conflict with the workflow.” 

UserLanguage STRING This is the default user language in the clients. If 
this is not set, the setting for 
EnterpriseLanguage is used. Example: W_MCS 

ExportAccessControl BOOLEAN This controls whether or not access to "Export..." 
in the Groups window also controls access to "File 
» Export Table..." in the Java client. The default is 
true to allow access control table and search 
result data exports. 

International Settings 
By default, the Maconomy server is configured to use Danish settings for date and number formats. This 
can be changed in the Maconomy client, but when running reports directly on the server, you need to 
customize the server to use the date and number formats that apply at your location. 

The date and number configuration is stored in the environment variable INTL_SETUP.  

 

Default Settings 
By default, the environment variable INTL_SETUP has the following value: 
/DMY110:010000C,.0011,00011·A····A···· 

The value contains a a total of 38 digits, where “∙” indicates a blank value (a space). 

Attention: For information about changing this variable, please refer to the documentation of the 
operating system of your server, or see the description of the initialization file parameter -e<v> . 
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The following table specifies the meaning of each digit, starting with digit “0.” The value “1” means “true.” 
Alphabetic characters (“A”–”Z”) are converted to decimal values, where “A” equals “0,” “B” equals “1,” and 
so forth. Hence, if you want the value “2” in digit 14 (No. of decimals for integers), you should enter “C” 
because “C” equals “2.“ This is to avoid having to enter the ambiguous number “0.” 

Digit Pertains to Function Default 

0 Date functions Date separator 
 

- 

1 Format: sequence of day, month, 
year 

 

D 

2 M 

3 Y 

4 Leading zero, day 
 

1 

5 Leading zero, month 
 

1 

6 four‐digit year 
 

0 

7 Time functions Time separator 
 

: 

8 Leading zero, hour 
 

1 

9 Include seconds 
 

1 

10 12‐hour clock (AM/PM) 
 

0 

11 Integers Thousands separator 
 

0 (none) 

12 Parenthesis around negative 
numbers 

 

0 

13 Trailing minus 
 

0 

14 Amounts No. of decimals 
 

C 

15 Decimal separator 
 

, 

16 Thousands separator 
 

. 

17 Parenthesis around negative 
numbers 

 

0 

18 Trailing minus 
 

1 

19 Trailing decimal zeros 
 

1 

20 Leading integer zeroa  
 

1 

21 Reals Decimal separator 
 

, 
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Digit Pertains to Function Default 

22 Thousands separator 
 

0 (none) 

23 Parenthesis around negative 
numbers 

 

0 

24 Trailing minus 
 

0 

25 Trailing decimal zeros 
 

1 

26 Leading integer zeroa 
 

1 

27 No. of decimals 
 

<blank>b 

28 Time Strings Length of string for “Morning” (AM) 
 

Ac 

29 “Morning” character 1 
 

<blank> 

30 “Morning” character 2 
 

<blank> 

31 “Morning” character 3 
 

<blank> 

32 “Morning” character 4 
 

<blank> 

33 Length of string for “Evening” (PM) 
 

Ac 

34 “Evening” character 1 
 

<blank> 

35 “Evening” character 2 
 

<blank> 

36 “Evening” character 3 
 

<blank> 

37 “Evening” character 4 
 

<blank> 

a. Zero before decimal if number is less than 1 
b. <blank> specifies the default number of decimals, which is 2. This can also be written as “C.” 
c. “A” = 0 ‐ AM/PM is not entered. Remember to set digit 10 = 1. Max. number of characters is “E” (four characters). 

Example 
If you want to run a myReport.grn report and you want the real numbers in your output to be displayed 
with five decimals, perform the following steps (for example, from Windows NT): 

1. Change the international settings with the following command: 
set INTL_SETUP=/DMY110:010000C,.0011,00011FA····A 

“∙” signifies a blank (space). Note that it is not necessary to enter all the digits. Only enter those 
up to and including the digit whose value you want to change. For example, in the command 
above, the last four blank values have been left out. 

2. Run the report using the –x option: 
maconomyserver -i<inifile> -xmyReport.grn 
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Shortcut to the INTL_SETUP Variable 
If you have set up your system to support batch printing, you can retrieve a properly formatted 
INTL_SETUP from an option file created by the batch printing system. 

When a Maconomy client sends a print job to the server, an option file is created. The second line in this 
file is the date and number format string, which is formatted according to the above specifications. 
However, the string does not contain the default value of the Maconomy server; it contains the setting of 
the client that issued the print job. 

Hence, you can set up a client (using the window Preferences) to use the formats you want in the report, 
send a batch print job to the server, and then take the format string from the batch job option file on the 
server and use it as input to the SET INTL_SETUP command mentioned above. 

 

CheckOracle 
You use the CheckOracle utility to check the condition of the Maconomy database. 

To run CheckOracle: 
1. Open a command prompt/shell. 

2. Run the following command: 
CheckOracle system/manager [-a] 

If you are running Windows and the command is not recognized, change to the <MaconomyHome>\bin 
directory before running the command. 

The -a option produces a more detailed report.  

 

Utility Reference 
This section lists all the tools and utilities in the Maconomy /bin directory. It is intended as a short 
overview of what each tool does. Some tools are described further in this document or elsewhere in this 
manual; whenever that is the case, a reference to the section in question is made. 

Note that several the utilities are only used when installing or updating Maconomy. This is only done by 
Maconomy consultants and partners, and the utility is, therefore, only described very briefly. 

Executable Files 
The following table contains a description of each executable file in the Maconomy /bin directory. The 
tools are listed in alphabetical order. 

Attention: For more information about running reports on the server, see “Product Note: Running 
Programs and Reports on the Server.” 

Attention: For more information about batch printing, see “Batch Printing” in this manual. 

Attention: For detailed information regarding the CheckOracle utility, refer to “Check Oracle” in 
“General Server Maintenance” section.  
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Name of Executable Description 

binsum.exe Help utility for checking the contents of files that have been transferred 
from a UNIX machine to see if the transfer was successful 

ByteSwapResourceFile.exe For internal use 

ConvertTextFile.exe Used by switch CC (Character Conversion) files between UNIX and 
Macintosh formats. Usage:  
ConvertTextFile [-recurse] [-cctable <path>] [-v] [-r] [-n] 
[-l] <Filename>* 

 -recurse: all subdirectories are searched using * 

 -cctable <path>: Path to CC tables (CC_Table and 
CC_Table.MacToServer) 

 -v: Print version info and exit 

 -n: Normal conversion (FROM Mac) — default 

 -r: Reverse conversion (TO Mac) 

 -l: No conversion (change line feeds only) 

 -h: This help 

DBLocalize.exe For internal use 

Display2.exe This is the program that displays the “old” Maconomy client (version 2) 
for the Java™ platform. The executable is placed in the web server cgi-
bin directory if used. 

EditStringNrResource.exe For Maconomy consultants only 

EditStringResource.exe For Maconomy consultants only 

Jobserver.exe The Maconomy executable that controls batch jobs on the server  

 

MaconomyDaemon.exe The Maconomy service  

 

MaconomyMScript.exe The Maconomy M‐Script executable. This should be placed in the web 
server cgi-bin directory and can be renamed. 

MaconomyPrinterDriver.exe A Maconomy printer driver, which outputs reports to printers 

Attention: For more information, see the “Introduction” in the 
“Batch Printing” section.  

Attention: For more information, see the “Maconomy Server 
Options and Parameters” section.  
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Name of Executable Description 

 

MaconomyServer.exe The Maconomy server executable for Oracle databases. This can be 
run to perform server functions, such as validating print layouts and so 
on.  

 

MaconomyServerMSQL.exe The Maconomy server executable for MS SQL Server databases. This 
can be run to perform server functions, such as validating print layouts, 
and so on.  

 

MBuilder.exe Used for installing Universes (MUL files), Reports (MRL files), Report 
Layouts (MPL files), and external relations to a Maconomy installation 
(MOL files) on the Maconomy server 

 

MDumper.exe A Maconomy installation contains a huge amount of information. To 
gain access to some of this information, extracts must be made in 
specific formats to use it properly. The MDumper  tool extracts, or 
dumps, information from a Maconomy installation.  

The information dumped by MDumper is used in various independent 
ways. Some of the installation information is valuable knowledge when 
developing customized extensions to Maconomy, such as Universes 
and Universe Reports.  

To support easy access to this information, MDumper features the 
MDoc tool that generates a set of hyperlinked HTML files with which 
you can visually browse through the basic structures of the Maconomy 
installation. 

 

mkconf.exe For internal use 

ModifyExportFile.exe For use by Maconomy consultants only 

Used for removing data from an export file, leaving only setup data. 

Attention: For more information, see “MaconomyPrinterDriver” in 
the “Batch Printing” section.  

Attention: For more information, see the “Maconomy Server 
Options and Parameters” section.  

Attention: For more information, see the “Maconomy Server 
Options and Parameters” section.  

Attention: For more information, see the MBuilder Reference.  

Attention: For more information, see the MDumper Reference.  
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Name of Executable Description 

MPLDumper.exe Used for dumping old‐style (pre‐MPL) print layouts (created using the 
Layout Designer) to a text file 

MStamper.exe A Maconomy solution can contain a large number of data, format, and 
script files that are used for reporting, integration, and web‐based 
presentation. The authenticity and integrity of all these files is 
paramount to ensure smooth operations, and information concerning 
who wrote what is essential for directing questions and support calls to 
the right parties. 

Maconomy solves these issues by providing all such files with a stamp 
that protects the files from accidental corruption or malicious tampering. 
The stamp also contains essential information about the origin of the 
file, such as author and creation date, and can also be used to restrict 
the distribution of the file in various ways. 

The MStamper tool enables external consultants and Maconomy 
partner organizations to stamp their products as they see fit, thereby 
getting the same high level of control over the authenticity and 
distribution of their work. 

 

precompile.exe For use by Maconomy consultants only in connection with 
installing/upgrading Maconomy 

Used for generating platform‐specific installation scripts from a cross‐
platform foundation 

PrintToPDF.exe A Maconomy printer driver, which outputs reports in PDF format 

 

PWChange.exe For use by Maconomy consultants only  

Used with Oracle databases for generating clear‐text passwords in 
connection with changing passwords on servers with extended security 
(that is, where the database user password differs from the Maconomy 
user password) 

PWChangeMSQL.exe Same as above, but for MS SQL Server databases 

Sleep.exe For internal use 

TAR.EXE Used for unpacking UNIX‐style “tarballs” (files that contain a number of 
other files), which may or may not be compressed. For example, the 
Maconomy DPU consists of a tarball that contains the online reference 
manual in HTML format. 

Attention: For more information, see the MStamper Reference.  

Attention: For more information, see “PDF Printing” in the “Font 
Administration in Maconomy” section.  
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Name of Executable Description 

ViewGenerator.exe For use by Maconomy consultants only 

Used for generating the database views through which Maconomy 
users view data 

vttool.exe For internal use 

Script Files 
The following table contains a description of each command/batch file (.cmd) in the Maconomy /bin 
directory. 

 
They are listed in alphabetical order. 

Name of Command File Description 

CheckOracle.cmd Used for checking the status of the Oracle database 

Delete3PStuff.cmd Script for deleting third-party stuff. Used in connection with 
upgrades. 

DeleteAnalyzerViews.cmd Script for deleting Analyzer views. Used in connection with 
upgrades. 

DeleteDHViews.cmd Script for deleting DialogHandler views when updating the 
application version 

oraeater.cmd This tool reveals the most “resource-eating” Oracle threads 
for the last 20 seconds. It is used for fault-finding. Usage: 
oraeater <username> <password> [-a] 

The -a option displays the most resource-eating Oracle 
threads since Oracle was last launched. The current thread 
and the Oracle system threads are not shown. 

To kill an Oracle thread, use:  
orakill <ORACLE_SID> <threadno> 

Recreate3PStuff.cmd Used in connection with upgrades 

UpdateFieldsAndRelations.w_8_0.cmd Used in connection with upgrades 

Coupling Service Installation and Configuration 
This section describes the basic steps involved in installing and configuring the Coupling Service. 

Note: Many of the scripts listed are for use by Maconomy consultants only. 
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MConfig can install and provide basic configuration of the Coupling Service, including the setup that is 
needed to run it as a service on the server. More advanced configuration changes can be done through a 
small number of configuration files, which are described in this section. 

Folder Structure 
The Coupling Service is installed in its own folder structure, similar to the folder structure of a web server. 
By default, MConfig creates the folder structure below. 

The following information describes the most important elements in this folder structure: 

 /configuration: This folder contains Maconomy-specific configuration files: 

 server.ini: Configuration settings for the Coupling Service managed solely through MConfig 

 maconomy.security.config: Specification of JAAS login rules that are available to the 
Coupling Service 

 /configuration/settings: This subfolder contains the manually managed configuration files for 
general settings and various logging configuration: 

 settings.ini: Configuration settings for the CouplingService. This includes general system 
settings and settings for batch framework, cache, client, mail, security, and web services.  

 extension.ini: Configuration settings specific for extensions 

 logging.ini: General settings for logging 

 monitor.ini: Configuration settings for monitor logging 

 mpm.ini: Configuration settings for Performance Monitor 

 logback.xml: Specification file for the built-in logging framework. 

 /log: This folder is the default output directory for log files that are generated by the built-in 
logging framework. 

 /exportlog: This folder contains a tool to export log files and system configuration as a zip/tar file. 

 /servicewrapper: This folder contains the wrapper tool that is used for wrapping the coupling 
service as a Windows service. The configuration of the Windows service is generated by MConfig 
and stored in the servicewrapper/conf/wrapper.equinox.conf file. 

 /dropins: This folder can be used for custom/third-party OSGi bundles. The contents of this folder 
are preserved during service pack installation. 

 /plugins: This folder contains all of the OSGi bundles that are distributed as part of the 
CouplingService. It is normally not needed or recommended to make any manual changes to this 
folder because its contents may be completely replaced during service pack installation. 

 /CouplingService(.exe): The platform executable for the Coupling Service 

 /CouplingService.ini: A file that contains command-line options for the Coupling Service 

 /version.info: A file that contains version information and compatibility rules for the Coupling 
Service. See the following information. 

/configuration/server.ini 
This file contains the configuration settings that are managed through MConfig. All settings in this file 
must be set through MConfig. Any manual changes may at any time be overwritten by MConfig. 

The format of the file is several lines, each of which contains one property value assignment, with the 
syntax <property>=<value>. 
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The mandatory settings are: 

 server.address=<name or IP address> and server.port=<port-number>: The address and 
port number of the Maconomy Application server. 

 web.port=<port-number>: This port is used for Maconomy 2.0 web services and by the 
Maconomy 2.0 Workspace Client to connect to the Coupling Service. It must be accessible from 
all network locations where users are expected to connect. 

The most important optional settings are: 

 server.max=<number>: The maximum number of server processes that the Coupling Service is 
allowed to start to serve requests. The default value is 10. 

 server.pool=<number>: The number of server processes that the Coupling Service is allowed to 
keep in its server pool to serve future requests. The default value is 3. 

 server.lifetime=<seconds>: The number of seconds that a server is permitted to exist before it 
is terminated. The default is 60,000 (about 16.6 hours). 

 server.timeout=<seconds>: The number of seconds that a server will wait on a connection 
between commands. The default is 600 (10 minutes). The Coupling Service ensures that idle 
servers are kept alive, so this option only controls how long an active server should wait for a 
(non-responsive) client before disconnecting. 

 coupling.proxy.encryption=<true/false>: Specifies whether or not proxy encryption has been 
configured between the Coupling Service and external clients. 

 client.notifications.recalculation.interval=<seconds>: The interval between client requests for 
notification recalculation. The default is 1800 seconds (30 minutes). 

 cache.client-configuration.update-on-request=<true/false>: Specifies whether the client 
cache should be updated on every request. This parameter in server.ini corresponds to the 
variable <<IsDevelopmentSystem>>. The value is true for a development system. The default 
value is false. 

 log.config=<path>: The path to the configuration file for the built-in logging framework. 

 metrics.csv.enabled=<true/false>: Controls whether or not metrics should be written as 
comma-separated values (CSV) to a configurable file system location (specified by 
metrics.csv.location). The metrics feature is an extended form of logging that can be used for 
monitoring of the Coupling Service’s service level. 
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/configuration/maconomy.security.config 
This file contains the specification of Java Authentication and Authorization Service (JAAS) login rules 
that are available to the Coupling Service. The basic syntax of the file is: 
<login-rule> { 

    <module-path> <status-flag> 

        <module-options> 

} 

The complete syntax is beyond the scope of this document, but it is possible to perform simple 
modifications to the file to enable various features, and these are described in the following sections. 

Kerberos SSO (Single Sign On) 
The following change is needed to enable Kerberos SSO for the Maconomy 2.0 Workspace Client. In the 
Maconomy login rule, there are two commented-out lines: 
//org.eclipse.equinox.security.auth.module.ExtensionLoginModule sufficient 

//extensionId="com.maconomy.lib.coupling.MaconomySSOLoginModule"; 

To enable Kerberos SSO, the comment tag (//) should be removed from these lines. 

The Maconomy server must, of course, be configured for Kerberos SSO as well, as described elsewhere. 

Business Objects Login 
The following change is needed to allow the Maconomy 2.0 Workspace Client to authenticate with the 
Business Objects server. 

In the BusinessObjects login rule, the following parameters must be set to match the local system setup: 
host, port, and authenticationType. 

Note: A Technical Note about the Server Pool 
The server pool is not just one pool but a collection of pools, each of which serves a single 
database/language combination. In addition, there is usually one extra server pool used for serving 
specific request types that should not occupy servers in the other pools. 

Example 
If a Coupling Service instance is serving two databases (a test system and a live system) with three 
languages installed, such as US, DK, and ES, there are 6 (2×3) server pools for serving each 
database/language combination plus the extra pool, for a total of 7 server pools. 

The server pool parameters (server.pool and server.max) apply to every pool. So with the default 
settings, the system in the last example can have as many as 70 server processes running 
simultaneously, assuming that all database/language combinations are experiencing constant high 
load. 

However, in the typical scenario, a few of the server pools suffer most of the load, so the server 
pools should be dimensioned to handle the expected peak load of the most active server pools. 
When idle, the remaining pools scale down gracefully to hold at most server.pool idle servers, so this 
parameter should generally not be set too high. 
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Note that currently you can only associate one Business Objects server with a Coupling Service 
installation. If the Coupling Service is connected to several databases (for example, both a test and a live 
system), the same Business Objects server will be integrated into all of them. This limitation will be 
addressed in the future. 

/configuration/logback.xml 
This is the specification file for the built-in logging framework.  

 

/CouplingService.ini 
This file contains command-line options for the Coupling Service executable. It must be placed next to the 
executable and have the same name, except for the file extension. The syntax of the file is one argument 
per line. 

This file is used for low-level arguments to the executable itself or the underlying Java Virtual Machine, 
such as the maximum allowed heap size and various other memory management characteristics. 

This file is also used to set global system properties that can be used to control aspects of the platform 
that cannot be changed in any other way. 

The set of properties that can be set in this way is huge and requires in-depth technical understanding of 
the components to which they relate. 

/version.info 
This file contains version information and compatibility rules for the Coupling Service. Compatibility rules 
state which specific client versions or version ranges are compatible with the Coupling Service. 

The syntax is ALLOW/DENY <start> <end>, where the ALLOW keyword is used to specify allowed 
versions, and the DENY keyword is used to specify denied versions. The <start> and the optional <end> 
tokens specify individual versions (for example, 15.0.3 for major version 15, minor version 0, and service 
pack 3). If no end version is specified, the allow/deny rule is specific to an individual version. 

Note that this file is overwritten during an upgrade. 

Displaying System Information on Clients 
Companies may want to display the details of the system to which their Maconomy installations are 
connected. While system information is not displayed by default on any client, you can configure your 
Workspace and web clients to display this information on their respective interfaces. When you perform 
this configuration, the system information displays on the menu dock in the Workspace Client (that is on 
the left side/margin of the interface) and along the top margin in the corresponding web client.  

To display the system name on both your Workspace and web clients, configure the content of the menu 
dock in the MCSL file of the Coupling Service. The configuration might look like the following example: 
<Binding namespace="client:menudock"> 

<Fields> 

<Field name="Title" valueString="^{'Logged into: ' + shortname()}"/> 

Attention: For additional details about the values of these parameters, refer to the Business Objects 
documentation. 

Attention: For more information, refer to the “Logging and Debugging” section. 
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</Fields> 

</Binding> 

Additional Specifications for the Workspace Client 
Other attributes you can specify to customize how the system name is displayed in the Workspace Client 
are: 

 Color: To specify a color, assign a Color field to a valueString that uses one of the following 
formats: 

 rgb=num,num,num (where num is a decimal number in the range 0-255) 

 rgb=#xxyyzz (where xx, yy and zz are two-digit hexadecimal numbers in the range 00-FF) 

 TopToBottom: Indicates whether the text is drawn top-to-bottom (this is the default) or bottom-to-
top (if you specify the value false). 

 FontHeight: Indicates the font height to use. The default is 12. 

Your configuration might look like the following example: 
<Binding namespace="client:menudock"> 

<Fields> 

<Field name="Color" valueString="rgb=#abba76" /> 

<Field name="TopToBottom" valueString="false" /> 

<Field name="FontHeight" valueString="8" /> 

</Fields> 

</Binding>  

Additional Specifications for Web Client 
To specify background and foreground color coding for your corresponding web client installation, 
immediately after the "client:menudock" specification, you can enter something like the following example: 
<Binding namespace="client:menudock:web"> 

<Fields> 

<Field name="backgroundcolor" valueString="#ff0000"/> 

<Field name="foregroundcolor" valueString="#ffffff"/> 

</Fields> 

</Binding> 

Logging and Debugging 
The Coupling Service has a built-in logging framework that can be used to log various events in the 
Coupling Service, filtered on the source and severity level of each event. You can only log already 
declared events, meaning that you cannot retrieve information that the Coupling Service programmers 
have not already chosen to make available for logging. 

Logging is controlled through a configuration file that is located in configuration/settings/logback.xml by 
default. The file format is XML and is relatively easy to edit using a normal text editor. The following 
information provides a brief introduction to the use of the logging framework. Additional information about 
the logback configuration file format can be found here: http://logback.qos.ch/manual/joran.html#syntax 

The configuration file consists of two main sections: appenders and loggers. 

An appender declares a destination for the log output. Typical output destinations include the console 
standard output and output files. Each appender specifies the desired format of the log entries, including 

http://logback.qos.ch/manual/joran.html#syntaxl


Troubleshooting 

System Admin Guide 419 

 

parameter substitutions as well as such other settings as the rolling policy for splitting long log files on 
size or time interval. 

A logger declares which events should be logged as well as the appenders to which they should be 
logged. Loggers can be restricted on Java package path and the severity level of the event. The defined 
levels (from least to most verbose) are: 

 OFF 

 ERROR 

 WARN 

 INFO 

 DEBUG 

 TRACE 

 ALL 

Example 
During normal service, an appropriate log level is typically to log everything at the ERROR level so that 
only error situations are logged. This is expressed in the following default logger rule: 
  <logger name="com.maconomy"> 

    <level value="ERROR" /> 

    <appender-ref ref="FILE" /> 

  </logger> 

If a reproducible error is observed in a module, it is possible to escalate the level of logging for that 
module by adding an additional logger rule. This might yield useful information about the operations 
leading up to the error: 
  <logger name="com.maconomy.<path-to-module>" additivity="false"> 

    <level value="DEBUG" /> 

    <appender-ref ref="FILE" /> 

  </logger> 

The additivity parameter is used here to prevent the events from being matched by other loggers, which 
would otherwise result in multiple log entries for the event. 

The default logback.xml file that is distributed with the Coupling Service contains several example 
loggers, with log level set to “OFF,” because examples of log events often prove useful when 
investigating runtime problems.  

Export Log Tool 
The log files, metrics, and configuration files of a given Coupling Service can be exported using the 
Export Log tool. This tool wraps all relevant log and configuration files as a zip/tar file that can be used to 
communicate system and configuration information during support cases. The tool is executed using 
either the .bat file or the .sh shell script, which is located in the /exportlog/scripts folder. 

Monitoring and Tracing with JVisualVM 
JvisualVM is a very useful tool that is distributed by Oracle as part of the standard Java Development Kit 
(JDK). With this tool, you can connect to a running Java process on the current machine (and even on a 
remote machine) and extract all sorts of useful information, such as thread count, processor load, 
memory consumption, and much more. 
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In addition, you can install various plugins to greatly extend the capabilities of JVisualVM. Deltek 
recommends that all technical consultants familiarize themselves with this tool. 

With a systematic top-down approach, the built-in logging framework and JVisualVM can be powerful 
tools to track down and understand otherwise unexplainable system behavior. However, sometimes the 
required log events are simply not available, usually because the original developer did not take logging 
into consideration. 

In these cases, you might want to take a more “low-level” approach and implement the Coupling Service 
directly using external tools. One such tool is the BTrace plugin to JVisualVM. This plugin is included in 
the standard JVisualVM distribution and can be installed with a few mouse clicks. 

To use the BTrace plugin, you must first tell the Coupling Service bootloader to allow BTrace access to 
the system internals. You do this by adding the following line to CouplingService.ini: 
org.osgi.framework.bootdelegation=com.sun.btrace, com.sun.btrace.* 

After you restart the Coupling Service and JVisualVM is connected, you can use BTrace to write custom 
probes that trigger on various events within the system, such as method calls, errors, and other events. 
You can use these probes to get detailed information about code execution paths that are not otherwise 
logged. 

External Links 
For more information about JVisualVM and the BTrace tool, please consult their websites: 

 http://visualvm.java.net 

 http://kenai.com/projects/btrace 

Transcript of a ssh-host-config Session 
Here is a complete transcript of an ssh-host-config session: 
$ ssh-host-config 

 

*** Info: Generating missing SSH host keys 

ssh-keygen: generating new host keys: RSA DSA ECDSA ED25519 

*** Info: Creating default /etc/ssh_config file 

*** Info: Creating default /etc/sshd_config file 

 

*** Info: StrictModes is set to 1yes1 by default. 

*** Info: This is the recommended setting, but it requires that the POSIX 

*** Info: permissions of the user1s home directory, the user1s .ssh 

*** Info: directory, and the user1s ssh key files are tight so that 

*** Info: only the user has write permissions. 

*** Info: On the other hand, StrictModes don1t work well with default 

*** Info: Windows permissions of a home directory mounted with the 

*** Info: 1noacl1 option, and they don1t work at all if the home 

*** Info: directory is on a FAT or FAT32 partition. 

*** Query: Should StrictModes be used? (yes/no) yes 

 

*** Info: Privilege separation is set to 1sandbox1 by default since 

*** Info: OpenSSH 6.1. This is unsupported by Cygwin and has to be set 

*** Info: to 1yes1 or 1no1. 

http://visualvm.java.net/
http://kenai.com/projects/btrace
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*** Info: However, using privilege separation requires a non-privileged account 

*** Info: called 1sshd1. 

*** Info: For more info on privilege separation read /usr/share/doc/openssh/README.privsep. 

*** Query: Should privilege separation be used? (yes/no) yes 

*** Info: Note that creating a new user requires that the current account have 

*** Info: Administrator privileges. Should this script attempt to create a 

*** Query: new local account 1sshd1? (yes/no) yes 

*** Info: Updating /etc/sshd_config file 

 

*** Query: Do you want to install sshd as a service? 

*** Query: (Say "no" if it is already installed as a service) (yes/no) yes 

*** Query: Enter the value of CYGWIN for the daemon: [] 

*** Info: On Windows Server 2003, Windows Vista, and above, the 

*** Info: SYSTEM account cannot setuid to other users -- a capability 

*** Info: sshd requires. You need to have or to create a privileged 

*** Info: account. This script will help you do so. 

 

*** Info: It1s not possible to use the LocalSystem account for services 

*** Info: that can change the user id without an explicit password 

*** Info: (such as passwordless logins [e.g. public key authentication] 

*** Info: via sshd) when having to create the user token from scratch. 

*** Info: For more information on this requirement, see 

***  Info: https://cygwin.com/cygwin-ug-net/ntsec.html#ntsec-nopasswd1 

 

*** Info: If you want to enable that functionality, it1s required to create 

*** Info: a new account with special privileges (unless such an account 

*** Info: already exists). This account is then used to run these special 

*** Info: servers. 

 

*** Info: Note that creating a new user requires that the current account 

*** Info: have Administrator privileges itself. 

 

*** Info: No privileged account could be found. 

 

*** Info: This script plans to use 1cyg_server1. 

*** Info: 1cyg_server1 will only be used by registered services. 

*** Query: Do you want to use a different name? (yes/no) no 

*** Query: Create new privileged user account 1NODE\\cyg_server1 (Cygwin name: 1cyg_server1)? 
(yes/no) 

*** Info: Please enter a password for new user cyg_server. Please be sure 

*** Info: that this password matches the password rules given on your system. 

*** Info: Entering no password will exit the configuration. 

*** Query: Please enter the password: 

*** Query: Reenter: 

 

*** Info: User 1cyg_server1 has been created with password 1<something>1. 

*** Info: If you change the password, please remember also to change the 

*** Info: password for the installed services which use (or will soon use) 
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*** Info: the 1cyg_server1 account. 

 

*** Info: The sshd service has been installed under the 1cyg_server1 

*** Info: account. To start the service now, call 'net start sshd1 or 

*** Info: 'cygrunsrv -S sshd1. Otherwise, it will start automatically 

*** Info: after the next reboot. 

 

*** Info: Host configuration finished. Have fun! 
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COMMANDS 
Copy to come.  
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Appendix 

Analyzer 
The Workspace Client allows opening the Java Analyzer window directly from the Workspace Client so 
that all the Analyzer capabilities and reporting functionality are also available in Workspace Client. 

In addition, you can define which specific report to open in Java Analyzer and perform an automatic user 
login to Java Analyzer without the user having to enter credentials manually every time. 

The Java Analyzer window is the same as the standard Java Client, which contains all the functionality 
that is related to the Analyzer reports.  

The Maconomy Server for Oracle allows you to use query-specific Oracle "hints” when executing SQL for 
Analyzer reports, filters, value pickers and notifications. 

Workspace Client Analyzer 
Java Analyzer is built into the Workspace Client and can be embedded in any MDML layout. The Java 
Analyzer uses the MaconomyWeb login rule for automatic user login without the user having to enter 
credentials, after an initial specification. In addition, the Java Analyzer uses the URL for connecting to the 
Maconomy Server, which also must be specified. 

Analyzer MDML Specification 
The Java Analyzer can be opened via MDML Report tag, similar to the Business Objects reports. 

The current MDML specification for the <Report> tag has not changed, except for a new attribute engine 
that defines which external system (like Business Objects or Analyzer) to use for reporting. 

In the current implementation, you can only use the Action <Report> tag to run the Analyzer report, unlike 
Business Object reports that can also be embedded in the View. 

You can use the <Report> tag to open an Analyzer report in a new window. The <Report> tag can open a 
Java Analyzer in a new window, or it can open a specific Java Analyzer report if the view attribute 
specifies the name of the report to open. 

In addition, the detailed specification of the <Report> tag in the Report Action is described in the 
following: 

 If the all attribute on the <Actions> tag is True, the <Report> tag overrides individual properties of 
the Report action. 

 If the all attribute is False, the <Report> tag is also used to include this action. 

Attribute Name Type Usage 

name Key This attribute is the unique name of this action. Use this to 
distinguish actions with the same source. If no name is specified, 
the name defaults to the same name as the source. This attribute 
is general for all Actions. 

ref Key Use this attribute in the context of the <Order> tag to refer to 
previously defined actions during re-ordering. The ref attribute is 
the only legal attribute in this context. This attribute is general for 
all Actions. 
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Attribute Name Type Usage 

icon Id This attribute is the resource identifier for an icon associated with 
this action. This attribute is general for all Actions. 

title Display This attribute is the displayable title of this action. If nothing is 
specified, the action receives its title from the server specification. 
This attribute is general for all Actions. 

appearance (Action 
Appearance 
Type) 

The visual appearance of an action determines how it is rendered 
in the user interface. This attribute is general for all Actions. 
Determine if the title, icon, or both should be displayed. Valid 
values are: 

 Standard 

 All 
 Title 

 Icon 

tooltip Display This attribute indicates the tooltip title that displayeswhen the 
mouse hovers above the action. If nothing is specified, the tooltip is 
the same as the title. This attribute is general for all Actions. 

engine (Engine 
Type) 

This attribute indicates the engine type of the report. It is specific 
for the Report Action. There are two different types of reports 
supported: Business Objects report and Analyzer report. Valid 
values are: 

 businessObjects 
 analyzer 

This attribute is optional and the default value is businessObjects. 
If no value is specified, the Business Objects report is opened to 
support all existing layouts. 

source Expression 
(String) 

This attribute indicates the source of the report. It is specific for the 
Report Action. The precise definition of the source depends on the 
third-party system that produces the report. This attribute is 
required, and the default value is an empty string. Currently, this 
attribute is not used for Analyzer report. 

view Expression 
(String) 

This attribute indicates the view to be used from the source of the 
report. It is specific for the Report Action. The precise definition of 
the view depends on the third-party system that produces the 
report. The default value is an empty string. For the Analyzer 
report, this defines then name of the specific report. 

output (Output 
Type) 

This attribute is the output format of the report. It is specific for the 
Report Action. You can use a report action to open a report inline 
or in an external window. The default format of the report is HTML. 
Valid values are: 
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Attribute Name Type Usage 
 Html 
 pdf 
 xls 

This attribute is not used for Analyzer report. 

preTrigger Key This attribute is the identifier of the trigger associated with this 
report action. It is general for all Actions. When you specify a 
preTrigger, invoking the action calls the trigger to run before the 
action is executed. 

If the trigger runs successfully, the action is executed normally. 

If the trigger fails, the action is never executed, and the error 
message is displayed. 

Analyzer Login Rule Specification 
The login rule for the Analyzer should be specified in Coupling Service configuration similar to the 
Business Object login rule. Add the following to the 426aconomy.security.config file: 
MaconomyWeb{ 

  org.eclipse.equinox.security.auth.module.ExtensionLoginModule required   

    extensionId=”com.maconomy.lib.coupling.MaconomyWebLoginModule”;     

}; 

This allows users to log in to Java Analyzer automatically from Workspace Client.  

 

Analyzer URL Specification 
To use Java Analyzer, the URL to the web server for Maconomy should be specified. The URL is 
database- and language-specific. MConfig handles this process automatically. The URL is stored in the 
analyzer.json file, which is distributed similar to the maconomy.security.config file. The following shows 
the template analyzer.json file: 
// Substitute the DATABASE_SHORTNAME, LANGUAGE and URL to match your web server 

[ 

  { 

    "database" : " DATABASE_SHORTNAME ", 

    "urls" : [ 

      { 

        "language" : " LANGUAGE ", 

        "url" : "HOST:PORT/cgi-bin/Maconomy/Jaconomy.DATABASE_SHORTNAME.LANGUAGE.exe" 

      } 

    ] 

  } 

] 

Attention: For details about the login process, refer to the “Login Handling” section. 
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MConfig automatically replaces the DATABASE_SHORTNAME, LANGUAGE, and URL to match the 
current Web Server. 

The Workspace Client reads the analyzer.json file from a web service, which will be started by the 
Coupling Service. The Workspace Client queries specific URL for the currently running database and 
language. 

In addition to that, this analyzer web service is a simple http service; therefore, you can run the queries 
directly in the browser. This allows users to check if the Analyzer is configured correctly on the Coupling 
Service. 

For example, after the Coupling Service is started, the user can run the following query in the browser: 
http://<coupling_service_host>:<port>/analyzer/v1?database=<value>&language=<value> 

The result of this request should be a valid URL to the web server where the Java Analyzer is installed, 
which is database- and language-specific. 

Shared Format Preferences 
In addition, the Java Analyzer shares Format preferences with the Workspace Client for the dates, time, 
currency, integers and decimals. For example, if the user changes any of the Formatting Preferences in 
the Workspace Client, the changes are reflected automatically when the user opens a new Analyzer 
report. 

Analyzer Start and Quit 
Java Analyzer can be started from a Workspace Client. Java Analyzer starts up in a separate Java 
process using JRE that is already embedded in the Workspace Client, and it has a direct process 
communication with a Workspace Client. Every time the user opens a new Report, the Workspace Client 
can determine if the Java Analyzer is already started and can open the Report in the same Java process. 
If the Java Analyzer is not started or was closed previously, the Workspace Client starts up a new Java 
Analyzer process again. 

The user can also quit the Java Analyzer independently of the Workspace Client, using the Quit menu 
option. Closing the Report window in Java Analyzer does not quit the Java Analyzer, like the Java Client. 
Another Report can still be opened from the top Analyzer menu. 

Java Analyzer shares the “dirty” state with the Workspace Client. For example, if the user quits the 
Workspace Client, but the Java Analyzer still has unsaved data, the user is notified and can save the 
data. 

Login Handling 
It is not necessary for the user to log in to the Java Analyzer. The login process is handled automatically 
for the user via the MaconomyWeb login rule, which must be specified on the Coupling Service, similar to 
the Business Objects login rule. 

The MaconomyWeb login rule can produce a token, which is handed to the Workspace Client via 
principal. The token plus the username can be then used by the Java Analyzer to connect to the server, 
validate the token, and get the access automatically. If the token cannot be validated, the user is 
prompted with the user/password window. 
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Java Analyzer URL 
In addition to the login information and the name of the specific report to open in Java Analyzer, it is 
necessary to specify the URL to the web server of the Maconomy system, which is database- and 
language-specific. 

Workspace Client (WSC) 
The Workspace Client is available for both Windows and Macintosh users. Each Maconomy release 
contains a TPU package, which in turn contains a WSC package containing a ZIP file, a Windows-
installable package (.MSI), and a Macintosh-installable package (.DMG).  

A Maconomy system contains several different server components and different client interfaces. 

All client interfaces communicate with a server complex that in the smallest installation all reside on one 
computer; a larger installation is scaled out on multiple computers and in more instances. 
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